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1.1

1.2

1.3

1. Navigation

This document provides an overview of the basic template, navigation, common operations
that can be performed, and keyboard short cuts available in Oracle Financial Services
Lending and Leasing. Since this section details the general options available in the User
Interface, some or all the parts of this section are applicable to you as per access provisions
& licensing.

The document is organized into below topics:
e Logging In
e Template and Navigation

e Common Operations
e Hot Keys

Note

The application can be best viewed in 1280 x 1024 screen resolution.

Audience

This document is intended to all Prospective Users who would be working on the application.

Conventions Used

Term Refers to

The system/application Oracle Financial Services Lending and Leasing

Mnemonic The underlined character of the tab or button

Logqging In

The pre-requisites to log into the system are a valid user ID and a password, defined by the
system administrator in Administration > User screen.

You can login to the system using a valid user ID and a password defined by the system

administrator, in Administration > User screen. A User ID is disabled automatically by the
system if it is inactive for a specified number of days.
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1.4

1.41

When you invoke the application, the Sign In screen is displayed.
ORACLE: B O

Financial Services Lending and Leasing

sign In

Please enter userid and password

e User ID — Specify a valid User ID.
e Password — Specify a valid password for the specified User ID.

The system accepts the User ID and password in upper case only. After specifying valid
credentials, click Sign In to sign into the application.

Template and Navigation

This section provides a brief input on the template and navigation of the system. Details are
grouped into two categories to enable easy understanding. These include:

e Home screen
e Screens

Home Screen

Once you login to the application with valid credentials, the system authenticates the details
and displays the Home screen.

The Home screen consists of the following components:

e Header
e Left Pane
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e Right Pane/Work Area

ORACLE"
Financial Services Lending and Leasing

ovn - EISEE O

DashBoard
4 Dashgoard
DashBoard
Users Productivity
System Monitor
Producer Analysis
Process Files

> Origination
> Servicing
> Collections
> WP

> Tools

> Setup

You can view the application version details and copyright information by clicking About link
at the right bottom corner of the screen.

About

Oradke Finandal Services Lending and Leasing 14.3.1.0.0
Buld OFSLL_14.3.1.0.0_B253.

Copyright © 1885,2017, Oracle andior fs afflstes. Al ights reserved.

Oracke and Java are registered trademarks of Oracke andlor s af filates. Otfer names may be trademarks of thei respective owners.

property laws. Except as expressly perited in your lcense agreement or alowied by law, you may not use, copy, reproduce, ranslate, broadcast, modify, liense,
transmit, distribute, exhibd, perform, publish or display any part in any form, o by any means. Reverse engineering, disassembly, or decomplation of tis software,
unless required by law for nteroperabilty,is prohibted.

The information is subject

If you find any errors, please report them o us in wriing.

that US. Government or behalf of the U S. Govemment, the following notice i
appicable:

U.S. GOVERNMENT END USERS: g tem, any hardware, andior
documentation, delivered o U.S. - Jation and agency-
‘specific supplemental reguiations. As Such, use, duplication, disclosure, modificaton, and adaptation of the: programs, inciuding any operating system, inegrated
software, any programs installed on the hardware, andior documentation, shal be Subject o icense terms and icense restrictons applicable to the programs. o
other rights are granted to the U.S. Government

This software or hardware is developed for general use n 3 variety r use in any nherently
dangerous applications, including create 5 risk o pe jury. f you use this soft hardware in dangerous applications, then you shal
be responsibe to take all appropriate falsafe, backup, redundancy, use.

liabitty for any damages caused by use of this Software or hardware in dangerous applicafions.

may informaton on content, products and services from third parties. Oracle Corporation and ts
y respect o third-party content, products, and services. Oracle Corporation and
s affilates wil not be responsile for any loss, costs, or damages incurred due {0 your access to or use of tird-party conten, products, or Services.

| Qo |

Header
In the Header, system displays the following:

e User ID that you have currently logged/Signed in. Click the adjoining drop-down arrow,
the system displays the following options:

AIDYA ~

* Welcome, & Sign Out[QA]
Change Password

m  UserInfo i3]

— Change Password — Click to change the current password.
L 7 I— TR

-
ek

Ir

s
e
-
-

1-3 ORACLE



Specify the current password in the Current Password field and a valid password,
you wish to maintain as a new password, in the New Password field. Re-enter the
password in Confirm Password field and click Submit to change the password.

User Info — Click to view the current user info.

Oracle Financial Services Lending and Leasing ®
User Info
Organization DMC Time Zone |JSER TIME ZONE ¥
Division U301 Level
First Name VARSHA User Time Zone UNDEFINED
Last Name VAIDVA Company US/CENTRAL (CENTRAL STANDARD
) i Branch Time TIME)
Responsibility SUPERUSER S
GLPost Date 02/10/2016 Server Time  ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT v Skin Family Skyros (Default) v

Debug Enabled Ind

|_—|5 Submit | 3% Close

In this screen, apart from viewing the user info, you can also set Session Language,
enable error log, and specify the time zone preference.

Session Language — Select a language that you need to set for the session, from
the drop-down list.

Debug Enabled Ind — Check this box to enable the debug indicator.

On selection, system records all the debugs into logs files depending on the
following two types of system parameters:

System Parameter Condition to record debug data

CMN_DEBUG_METHOD If parameter value is 1, then debug data is
recorded into a file in Database Server.

If parameter value is 4, then debug data is
recorded into the table LOG_FILES HEADER.

CMN_DEBUG_LEVEL If parameter value is greater than 0, only then the
debug data is recorded.

The debug data can be viewed from Dashboard > System Monitor > Database
Server Log Files.
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You can click on 3= List Files button to view the list of logged files.

ORACLE’
Financial Services Lending and Leasing

FRAKRRAD o

DashBoard 3 System Monitor [3] Close

BatchJobs  Jobs  Services Database Server Log Files = Parked Transactions | Users -

Database Server Log Files

View v Format~ Freeze i Detach Wrap W) :=Svstries [ Download File
File Name File Type File Size File Time
JSVPRC_EN_000_01 DB12C_2084400 fob 5706 02/18/2016 06:14: 11 AD »
ALERT lob 395 02/22{2016 03:59: 16 AN
CSYPRC_EN_100_01_DB12C_3794335 lob 6390 02/22/2016 04:53:00 AP =
CSVPRC_EN_100_01 _DB12C_3854338 lob 116750 02/22/2016 05:36:42 A
JSYPRC_EN_000_01_DB12C_2094362 lob 5706 02/18/2016 10:57:09 AP -

v
File Content
View * Format v Freeze  CfiDetach ol Wrap B ©Begring@End #oflines 50 [E] Show File

Text

: 45:FLL:1v_use BI::¥
cmnsyp_cl_000_D1.get_syp parameter value value:
get_syp_parameter_value wvalu http://ofss2221142.in.oracle.com:..

get_syp parameter value value: http://ofss2221142.in.oracle.com:

weblogic

cunsyp_cl_|
crnsyp cl

emnsyp_cl_

_0l.get_syp parameter value value: /scratch/work area/DEV/QA143REL/r
cunsyp cl 000 01.

_0l.get syp parameter value paramerer
cunsyp_cl_000_01.
: cmnsyp_cl_000_01.get_syp parameter value parameter:

Click on & Show File button to view the selected file contents in the ‘File Content’
section. You can also click & Download File button to extract a copy of debug

details.

Time Zone Level - Select the time zone preference as User/Company Branch/

Application Server Time Zone from the adjoining options list.

For more details on time zone selection, refer to Time Zone Preference section of

this user manual.

Click Submit to save the changes or Close to close the screen without changes.

Refer accessibility document for further details.
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Accessibility — Click the link to view accessibility features of the system.

NextGenUI - This is Next Generation User Interface option which is an enhanced
interface provided in OFSLL using the Oracle JavaScript Extension Toolkit (Oracle JET)
frame work. This is an additional interface supported from OFSLL to the existing system
and both intended to coexist in the system till further updates.

This option is enabled only if the corresponding system parameter is enabled in the
base system as configured by your system administrator. For more information, refer to
‘Appendix - Oracle JET Interface’ section in Servicing guide.

Sign Out — Click the link to sign off from the application. You can also click on ==
icon to sign off from the application.
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Left Window

In the left pane, system lists and provides drop-down links for various modules available in
the product. Click > to expand the Module Master Tabs and « to collapse them.

> DashBoard

> Origination

Servicing

Eles :

Customer Service
Securitization
Transaction Authorization
Post Date Checks
Escrow Transactions
Account Documents i
Collateral Management

m

Reports
Producers
vendors
Batch Transactions
Interfaces
AP Transactions
GL Transactions ~
> Collections
> WFP
> Tools

> Setup

To open a screen, navigate to Module Master Tab to which the screen belongs, expand the
tabs, and click the screen link you wish to open.

Menu Search in Left Window

In the left window you can make use of the search option to directly search and open the
screen that you are familiar with, and avoid multiple steps of navigation from the LHS menu.

The Search box in the LHS facilitates for an intuitive search of required screens in Oracle
Financial Services Lending and Leasing. For example, on typing the first letter of the screen,
the search box displays a list of all available screens starting with the letter entered in
alphabetical order. You can click on the required screen and press ‘Enter’. The screen is
displayed in the main window/work area.

ORACLE’ ) SSHEKAR ~ 1 sgnout ©
Financial Services Lending and Leasing

4 @8 | Access x (3 Close:

Appication Retrieval(Origination) Data Sween Reports | Corespondence | Transaction
Applcation Documents (Crigination)
hsset Types(setup Products) Aeoes Gild o add || ZEit | Elven || 2 auit
Account Documents(Servicing) o e Freeze i Detach —_—"

Organization Division Company Branch Alowed

. r ) DMC usoL AL ALL
‘Application Entry(Origination) oG NLO2 AL ALL

Audit Tables{setup System) e sA03 AL AL
Advances(Servicing Batch Transactions) e P04 AL AL

Access(Setup User) |
AP Transactions{Servicing Interfaces)

¥
¥
Y
Y

> Origination
> Servicing
> Collections
> WEP

» Tools

> Setup

When there are multiple matches with same screen name, you can filter the results through
the module from which the screen is accessed which is indicated in angular brackets. For
example typing 'VEN' displays the following options for selection - Vendors(Collections),
Vendors(Origination), Vendors(Servicing), Vendors(Setup System). For subsequent search,
you need to clear the data in the search field.
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Right Window

The Right Window can also be termed as work area. When you click the screen link on left
pane, system displays the corresponding screen in the right pane.

ORACLE
Financial Services Lending and Leasing

# Welcome, vAVAIYA - DSEREREE —

Sales Lead x [EEE

124081987

> sarviang
> Collections
> wrp
> 1ools

> setup

You can open a maximum of 15 screens at a go. Once the maximum limit is reached, the
system displays an error message.

RACLE
Financial Services Lending and Leasing
T

ocessing Details
=3 Freeze i Detach Wrap L]

> Collections
- wee
> 100ls
> setup

Each active screen is displayed as a tab at the top of right pane, across its width. To view a
screen, click the screen tab. You can identify the active screen with its white background.
Also, operation on any of the screen will not affect the data in other screens.

You can also open multiple Accounts at the same time as separate tabs in the right window,
provided your system administrator has enabled the option 'Mac_Multi_tab_Ind'="Y’ in
MENU_ACCESS table.

Having this option enabled you can view and update a maximum of 15 Accounts in parallel
tabs and Oracle Financial Services Lending and Leasing renders dynamic data across all the
opened tabs.

However, this option is restricted only to the following screens in Servicing Module Master
Tab. In the Left Menu of Servicing Module Master Tab, you can open multiple accounts by
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clicking on the Customer Service link. Each successive click, opens a new Customer Service
tab.

ORACLE HEGR 1 signout O
Financial Services Lending and Leasing
@8 Customer Service 3 | Customer Service % || Customer Senvice || Customer Service ¢ | Customer Service (@ Close
Search  Customer Service: 20160700010076  Review Request (Pending: 0)  Queue Assignment Z
> DashBoard
 Origination Account(s): 20160700010076: MILLEN JOHN Even | o adt
View ~ Format v Freeze Detach Wrap £ © Current(® Show All ©) Group Follow-up
Serviding & o P ® &
Company Branch Sub Unit Account ¥ Product Days Past Due Currency Pay Off Amt Amount Due St
Servicing NLO2 NLHQ UNDEFINED 20160700010076 LOAN VEHICLE (FR) -23 ELR. 50,089.31 0.00 m
Customer Service Al = = = ———— = = =
Securitization

Transaction Authorization
i e Summary | Customer Service | AccountDetals | Customer Detsils  Transaction History | PmtModes  Bankruptcy | RepojForedosure | Defidency  Colateral | Bursau | CrossfUp Sell Activi > ~
ost Date Ches

Escrow Transactions

Account Documents Alerts Conditions
Collateral Management
Reports Alerts Conditions
Producers Alert Condition StartDt Followup Dt
Vendors PRIM CUSTOMER ( JOHN MILLEN ) MARKED AS DECEASED, UPDATED PERMISSION TO CALL FLAG AVAILABLE FOR REPOSESSION 08/09/2016 08/30/2016
Batch Transactions 4 AS N FOR ALL CONTACTS DEFICIENCY 08/09/2016 08/30/2016 |
Advasices LIEN PERFECTED 08/09/2016 08/30/2016 =
Payments
Fees
Interfaces
Account Details Other Information
2P Transactions
GL Transactions .
Dues Collateral Information
Conversion Accounts |
Descrption Identification Year  AssetClass  AssetType
0.00 0.00 0.00 0.00 0.00 0 TOYOTA CAMRY a useD VEHICLE
R il 0 PR i G
Delg Due 0,00 Todays Payoff 50,089.31  AmtPaid Excess 0.00 ’ .
> Collections LCOwe 0.00 Future Payoff 50,158.61 Mermo Excess 0.00 Qitous lnformato
< 2 ik Customer
s NSFDUe 20,00 Future Payoff 08/15/2016 . Name Relation SN National
2 Date Paid Tern 0 -
ouroe 9 000000... JOHN MILLEN PRIMARY socxxx-3456 -45478
> Tools TotalDue  20.00 Future PmtDt 08/28/2016  Remaining Term 6 = = 5
> setup OldestDue Dt 08/28/2016  Days to Time Bar q
e R | %

Few screens in Servicing and Collections are identical and are linked. Hence, when multi tab
option is not enabled, you can open only one screen at a time from the group. A sample of the
grouping structure is given below, based on stages of the screens:

Collection:

e Collection

e Bankruptcy

e Repossession
e Deficiency

As per the above listing, you will be able to open only one screen in the corresponding list and
need to close the same to open any other screen.

Right Splitter/Action Window

The Right Splitter/Action Window has quick access to search and other options to avoid
switching between tabs or navigating into sub tabs periodically. You can access the Right
Splitter/Action Window while working on an Application or Customer Service screens. You
can click ﬂ and |: to toggle the view of Right Splitter/Action Window.
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Origination Screens

In Origination > Application screens, you can use the Right Splitter/Action Window to do the
following:

ORACLE" % Welcome, VAVAIDYA o
Financial Services Lending and Leasing
Close.
e origiation x EE
Search/Tack | Funding: 0000000378 | Review Requests (Pending: 0)
Application: 0000000378: TIFFANY RUSSEL / GRACE ER
View~ Formatv B} | (]| Freeze g Detach wsp B OvemideOK v WamingOK ¥
pre
o nop sub it status Origination Stege g cer ame Co Bstng Customer  2UP1C contact
tu
oxjosf2012 0000000378 UNGEFINED APPROVED-FUNDED  FUNDED GA-000D4 : ADVANCELER... . N N
, Summary
Requested  Approved
Advance 1500000 15,000.00
Summary | Applicant | Request || Decision | Contract || Collateral | Comments || Tracking || Document || Verification | Correspondence || Toals o R FHoa00
Tem 3 S
> Applicant Grade  DGRADE S 0
v 00
Stated PTI9s4
4 D Ratios Book 10,000
» Bureau
Queve FUNDED APPLICATIONS QUELE
b Checklist Change Status
Status APPROVED - FUNDED
Collateral Change Status
Colbateral Add Comment
Asset Type SubType Primary  Vear Vake Vodel Hileage New Wholesale Value 3
~ Serviding VEHICLE AR B 2012 CHEVROLET MONTE CARLO on 10,000.00 Alert
> Collections *Type v
> “sub v
RaWED, Trade-Tn Type
> Tools * Comment
b Setup Trade-In o -

Use Quick Search to search for an application based on application number, last 4
digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”.

Summary section displays critical information that has to be referred repeatedly during
origination like — DTI, PTI, Book Value, Grade, FICO Score, Approved Advance, Rate
and Term.

Use Change Status section to change the application status to next level. If the
application edit status is restricted, then the ‘Change Status’ will be read-only.

Use Add Comment section to post an alert or comment during Underwriting and
Funding stages.

For detailed information on the above options, refer to respective sections in the
document.
Servicing and Collection Screens

In Servicing and Collection > Customer Service screens, you can use the Right Splitter/Action
Window to do the following:

RACLE
Financial Services Lending and Leasing

Dues
09302017

osj0/2017
003 50,

003

o7 ooy osjojmr
3 o 15%.

col

dlector DEMOCOLL

Colateral Information
Py Descpton Ldentication #
2006 CHEVROLET MONTECARLO R

Customer Information
CSON ame Relaten

000000... MADHAN ORAGLE PROUARY

Enai EDW.SRSIGGMAL COM

Tive

Malng  Address

HouE v v 745 newyork MA-34038

Employment Information

BAPASGURITES2 06 NEW

Customer service (3§ Cose
Searh
Account(s): 2017010001007 Elvew [ LAt
Vews Fomate | B | MFeen Elivent o | W B ©CurentSon MO GromFlowss
Conpany wanch bunt Dayspastoue usrency Payoffant  Amountoue Stais OdstoueDt  DxQReason
st sk ) 150155 250021 (T N /017 15 PaveNT . ——
Bsbnt | [ @aex
Somary | (| [ S| At [ s G Pk T oy Pt [y e Do [l o] (o [ e A v ey
Qe Conditin =]
Meris Conditons Atorun
B textAccount
Rlerts Conditions ik
At AccontConiton Contionsrtot
No data o dlay Repossession s o FEEEES
oenauEn oy o P m——
=
=
AecountDetais Other Information

ew  Bssetcass AsetTpe  SbType
BiaE  om

National D a0t Gender

o o372s/sses uosneD

vy OptOut ¥

Phone

yses337

Eeestoment | [ G oer

=
=
=
=

B Fostcal vty | [ @ Cear
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e Use Quick Search to search for an account based on account number, or customer Id,
or last 4 digits of SSN (SSN of the primary applicant) or identification number. If multiple
applications or accounts are found during ‘Identification # search, the system displays
an error message as “Multiple Matches found for the Identification #, Please use normal
Search”. You can also select the Queue Condition and Auto Run options during search.
Clicking ‘Next Account’ button opens the subsequent account listed in search and
clicking ‘Filtered Account’ opens the subsequent account fetched during a queue search
and listed in Queue Assignment section.

e Use Add Comment section to post an alert or comment based on Type and Sub Type.

e Use Add Call Activity section to post all types of call activities including promise to pay,
account conditions and so on, irrespective of the screen you are working on. This is
similar to the option available in ‘Call Activities sub tab’ under Customer Service tab.

For detailed information on the above options, refer to respective sections in the
document.

The height of Header and width of the Left and Right Panes do not change, with resizing of
application screen.

The system facilitates toggling Header and Left and Right Panes of the home screen to
increase the visible area of the screens. Click =i to toggle upper pane and j to toggle left
pane. To un-toggle click == and |: respectively.

1.4.1.1 Time Zone Preference

Oracle Financial Services Lending and Leasing ®
User Info

Organization DMC Time Zone |JSER TIME ZONE v
Division US0L Level
First Name VARSHA User Time Zone  UNDEFINED
o e A Company US/CENTRAL (CENTRAL STANDARD
) : Branch Time  TIME)
Responsibility SUPERUSER e
A T Server Time ASIA/CALCUTTA (INDIA STANDARD
Last Login Date 02/10/2016 03:21:07 AM Zone TIME)
Session Language DEFAULT b Skin Family Skyros (Default) »

Debug Enabled Ind

Dh? Submit || 3% Close

You can select any of the following three time zones from the User Info screen:

e Application Server Time Zone
e Company Branch Time Zone
e User Time Zone

The time zones set up at each of these levels are displayed in the user info screen. However,
data is always stored in the application server time zone and based on the user preference of
time zone, the display time would be User or Company or Application Server time zone. Any
time zone related changes done at Ul does not impact the other time bound activities which
are dependant on database time.

Application Server Time Zone (Server Time Zone)

The Application Server Time Zone by default is the Production Server Time Zone. Selecting
this time zone will have all date and time fields defined as per the time stored in application
server. There is no offset in time if both storage (database server) and display (application
server) are in the same time zone.
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1.4.2

Company Branch Time Zone (Organization - Division Time Zone)

This is the Company time zone and is setup at the organization - division definition level. The
various divisions defined under an organization can be set up with different time zones
depending on geographical locations. This time can be modified as per requirement.

To modify the Company Branch Time Zone:

e Navigate to Setup > Administration > User > Organization and select the company or
division listed under 'Division Definition'.

e Inthe Display Formats tab, select Time Zone and click ‘Edit’.

e Inthe Format field, select the required time zone from the adjoining options list and click
‘Save’.

If'Company Branch Time Zone' is selected as the time zone in User Info screen, then on save,
all the time and date fields are automatically updated with the time zone of the company
branch.

User Time Zone

User Time Zone or User Preference Time Zone can be set up at the User Level in the User
Definition screen. Various Users under same divisions defined under an organization can be
set up with different time zones depending on geographical locations.

To modify the User Time Zone:

e Navigate to Setup > Administration > User > Users.
e Select the required User record listed in “User Definition” section and click Edit.

e Inthe Time Zone field, select the required time zone from the adjoining options list and
click Save.

If 'User Time Zone' is selected as the time zone in User Info screen, then on save, all the time
and date fields are automatically updated with the current updated time.

Screens

Details in few main screens are grouped into different sections. These sections are displayed
as tabs, horizontally within the screen. In turn, details in few of these tabs are again grouped
horizontally. The details are displayed when you click the tab under which they are grouped.
As similar to the main screen tabs, you can identify the active tab with its white background.

For example, Customer Service main screen has four main tabs. When you click on
‘Customer Service’ tab, the corresponding tabs are displayed.

Customer Service @

‘SEE\(\! Customer Service: 20120200010231 Pme.uR!qhe:t‘\Penmug:D)‘

Account(s): 20120200010231: YUTAKA OZAKA |/ AKANE [E]view | o audt

Vieww Format 5} Freeze i Detach ap | W) & @ curent O ShowAll © Group Follow-up
Company Branch Sub Unit Account # Product Days Fast Due Currency Pay Off Amt Amount Due Status Oldest Due Dt
usi1 USk1 UNDEFINED 0120200010231 LEASE VEHICLE 0 UsD 0,00 0.00 ACTIVE 02/10/2015
[ summary | Jcustomer Service] | Account Detil || Customer Detalls| TransactionHistory | Pt Modes | Bankruptey | Repo/Foredosure | Deficiency  Colleteral Bureau _Crosslp Sell Acivies |
‘ Call Activities | Maintenance Comments Promises | Checklists Tracking Attributes | References | Correspondence | Letters  Document Tracking
call Activities dpadd | ZEit | [Fvien | o audt
Views Formatv [ Freeze A Detach wap @
Action Result Contact Reason Cancel Promise Dt Promise Amt Condition Appointr Followup Dt Time Zone Adj Follovup Dt Cor
AT PH ANSWERING MACHINE N 12300015 1,000.00 NONE N 1f0j01s 12{29/2015 12:30:00 P

AT PH ANSWERING MACHINE N 12/302015 1,000.00 NONE N 12/30/2015 12/29/2015 12:30:00 PM
b

You can click # to view the hidden tabs, if any.
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1.5 Common Operations

Some of the operations are common to most of the screens. These are grouped into three
categories, based on their features.

e Basic Operations

e Basic Actions

e Personalization Options

e De-supported Special characters
e Skip Zip Code Validation

e Export data to Excel

1.5.1 Basic Operations

All the screens contain buttons to perform all or few of the basic operations. The four basic
operations available are:

e Add
o Edit
e View
e Audit

e add | S Edit | 5 view | o Audit

When you click any of the operation tabs, system displays the corresponding records inline,
below the respective setup tables.

The table below gives a snapshot of them:

Basic Operation Description

Add Click to add a new record. When you click Add, the system displays
a new record enabling you to specify the required data. It is
mandatory to specify details for the fields marked with *’ symbol.

Edit Click to edit an existing record. Select the record you want to edit
and click ‘Edit’. The system displays an existing record in editable
mode. Edit the required details.

View Click to view an existing record. Select the record you want to view
and click ‘View’. The system displays the record details in display
mode.

Audit Click to view audit info. If an audit is set for a field, then the system

tracks the changes for that field. Select the record for which you
want to view the audit info and click ‘Audit’. The system displays the
details tracked for that field.

Close Click to close a screen or a record. When you try to close an
unsaved, modified record, then the system alerts you with an error
message. You can click ‘Yes’ to continue and ‘No’ to save the
record.
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1.5.2

Basic Actions

Most of the screens contain buttons to perform all or few of the basic actions.

All or few of these actions are enabled when you select any of the Basic Operations.

Save and Add

[ save and stay

[ save and Return

<3 Return

The table below gives a snapshot of them:

Basic Actions

Description

Save And Add

Click to save and add a new record. This button is displayed when
you click ‘Add’ button.

Save and Stay

Click to save and remain in the same page. This button is displayed
when you click 'Add/Edit' button.

Save And Return

Click to save and return to main screen. This button is displayed
when you click ‘Add’ or ‘Edit’ buttons.

Return

Click to return to main screen without modifications. This button is
displayed when you click ‘Add’, ‘Edit’ or ‘View’ buttons.

The Payment maintenance screens consist of the following actions.

Post and Stay

E Post and Return

<:] Return

The table below gives a snapshot of them:

Basic Actions

Description

Post and Stay

Click to post the transaction and remain in the same section. This
button is displayed when you click 'Modify Payment/Modify
Payment Transaction' button.

Post and Return

Click to save and return to main section. This button is displayed
when you click ‘Modify Payment/Modify Payment Transaction’
buttons.

Return

Click to return to main section without modifications. This button is
displayed when you click ‘Modify Payment/Modify Payment
Transaction’ buttons.

The summary screens consist of the following navigations. The table below gives a snapshot

of them:

Basic Actions

Description

Click to navigate to the first record.

Click to navigate to the previous record.

< [F[E

Click to navigate to the next record.
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1.5.3

Basic Actions Description

| A| Click to navigate the last record.

Along with the basic actions, the following buttons are available for specific actions. The table
below gives a snapshot of them:

Basic Actions Description

Ij Show File - Click to view the details of selected file.

List Files - Click to generate and view the list of files maintained in
the system.

|__|43r Download File - Click to download the details of selected data.

Personalization Options

You can personalize the data displayed in setup tables. Once personalized, system saves the
settings for that User ID until next personalization.

|“FlieWY Format « % Freeze HEDetach o] hirap E’ﬂl

The table below gives a snapshot of them:

Options Description

View Click to personalize your view. The drop-down list provides the
following options of customization:

e Customize columns you wish to view
e Sort the order of displayed data
e Reorder columns

Additionally, the drop-down list provides selection of options
adjoining ‘View'.
M Format » | [Ep Freeze i Detach

Columns 4 Show Al
| : + Product |
Detach + Description |
Sort v ¥ StartDt
Reorder Columns... + End Dt
Query By Example + Direct
+ Enabled

+ Collateral Type

+ Collateral Sub Type

+ Credit Bureau Portfolio Type
+ Credit Bureau Account Type

Manage Columns...
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Options Description

Format Click to resize columns or wrap a data in the table cells.
|
Select the column you need to resize and select Resize Columns
option from the Format drop-down list.

Resize Column m I

Column DESCRIPTION

width | 100 [&] [pixels  [=]
| OK | Cancel

Specify the Width and unit for the selected column. Click OK to
apply changes and Cancel to revert.

Query by Example | Click to query for the data by an example. When this option is
selected, the system displays an empty row above column heads.
You can specify all or any of the details of the record you wish to

query.
View = Format *’ Freeze ﬁ Detach A Wrap a!}
i i i | B [
Freeze Select the column at which you need to freeze the table and click

Freeze. Function is similar to the freeze option in MS excel.

Detach Click to detach the setup table from the screen. An example of the
detached table is provided below.

Wrap Select the column in which the data needs to be wrapped and click
Wrap.

Product Definition . TN L= R T I |
view - [Faimats] | B | [Freee ffivetcn | [N | @ nes ¢
[poduct ot Jenaot
Wioan+e LOANHOME (R)  P1/01/1800 12/31/4000

LOAN SECURED
LoaNSG 12/31/4000

|Coliateral Type  |Collateral Sub Type: 15;;:@@:
HOME COLLATERAL® REAL PROPERTY HOM INSTALLMENT

HOUSEHOLD GOODS PERSONAL PROPERT INSTALLMENT

WR)

LOAN-AUN B SRR 011500 12/31/4000
LOANAE EOANVERICLE(FR)! b1/01/1800 12/31/4000
D1 [ 3/08/1863

UNSECURED COLLATIUNSECURED INSTALLVENT

VEHICLE COLLATERA PERSONAL PROPERT INSTALLENT
VEHICLE COLLATERA PERSONAL PROPERT INSTALLMENT

MURABAHA = 1/01/1500

NDS1 NORM DSER. 3/11/1853 31/2000
NPOL neos 1/01/201 12/31/4000

HOME COLLATERAL  REAL PROPERTY HOR INSTALLMENT

UNSECURED COLLATIUNSECURED INSTALLVENT
HOME COLLATERAL REAL PROPERTY HORMORTGAGE

Click to refresh the data in the table.

View Last For usability and performance, some of the data intensive screens
have ‘View Last’ option to sort the volume of data being displayed
on screen based on elapsed days.

ViewLast ©) 1Day @) 1Week D) 1Month@ By Date  startDt 07/01/2017 b EndDt 092002017 b &8

You can select the ‘View Last’ option as 1 Day / 1 Week / 1 Month /
By Date. When ‘By Date’ is selected you can specify a date range
(within 3 months) in ‘Start Dt and ‘End Dt  fields using the adjoining
calendar and clicking ‘Search’.

Print option in Customer Service screen

The Print button option in Customer Service/Collection screen facilitates you to print the
contents on the screen as is without scroll bars. This button is available along with other
options in the Action block. Clicking on this provides a browser print functionality and a new
tab is opened where the print content is displayed.
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Detach

ORACLE
Financial Services Lending and Leasing

. Welcome, vavaY: - ERSEISIGN O

Close
e L3 customerseve ¢ e
ORI Search | G quest (Pending: 0) 7
Servicing
Sencing Account(s): 20120200010231: YUTAKA OZAKA / AKANE [Elview || «2 Audt
Citacienserae Views Fomatv B [[Freze HiDetach Jwap @) & © Curent O ShowAll O Group Follow-up
Secuitzation Company Branch sub Unit Account = Days Past Due Currency Pay Off Ant Amount Due Status Oldest Due Dt
Transaction Authorization usog Usk1 UNDEFINED 0120200010231 LEASEVEHICLE 015D 000 0.00 ACTIVE 02j10/2015
Post Date Checks
S Trbedive Summary | Customer Service | Account Detals | Customer Details | Transaction History Pt fodes || Sankruptey | Repo/Foreclosure | Deficency | Collateral | Bureau | Cross/up Sel Activities
Account Documents
Collateral Management Call Activities  Maintenance Comments Promises ChecKists Tracking Attributes References Corespondence  Letters Document Tracking
Reports
Producers i .
Vit Transaction Batch Information padi | et | Bvew | o auit
Batch Transactions View~ Format~v [ Freeze £ Detach Wrap W {5 post [ void
Adiances Date Monet Transaction status Batch
Pajments | 02/10/2016 'ADD CUSTOMER ADDRESS PHONE POSTED ]
Fees oot v TERMINATE ERROR ]
Interfaces 01/06/2016 ¥ TERMINATE Vo N «
P Transact 01050016 EXTENSION vom N
Detached Table x
Vieww Formatv [ Frecze [HDRRAR] o wp | @ 1 Vaid
Date Honetary Transaction Status Batch
zj10/2015 N ADD CUSTOMER ADDRESS PHONE POSTED N
01/07/2016 Y TERMINATE ERROR N
01/06/2016 Y TERMIATE o N
01/06/2016 Y EXTENSION vo N
12232015 Y PAYOFF QUOTE LEASE POSTED ]
Views Formatv [ Freeze G Detach wap @
> Caollections Transaction Frocessing Details
S WP Transaction Posting Successful =+
> Tools
> Setup

Click ‘Add’, ‘Edit’ or ‘View’ button to open a new screen in expanded mode with details.

Drop-down List

The system provides an option to select the required data from LOV, for few fields. You can
either select the record from list or enter first alphabet of the value you want. When you
provide the alphabet, system limits the selection to the values starting with the specified
alphabet. These lists are grouped into two types:

e Drop-down list — Provides the selection option. You can either select a record from the
list or enter first alphabet of the required value.

e Combo drop-down list — The LOV contains huge data and provides both selection and
search option. These drop-down arrows are smaller in size, when compared to normal
drop-down arrows, thus enabling easy identification.

2 Welcome, VAVAIDYA o

ORACLE"
Financial Services Lending and Leasing

> DashBoard
» Origination
Servicing

Senvidng

Customer Service x.

Search | G ice: :0)

Account(s): 20151200010012: MADHU BOBBURI

Customer Service
Securitization

View~ Fomat +
Company

Transaction Authorization vsor

Post Date Checs

Escron Transactions

Account Documents

Collateral Management

Call Activities
Reports

Producers

Vendors Transaction

Batch Transactions.

Date
Fayments

02/10/2016
Fees ‘ 04/25/2016
Interfaces 01/2212016
AP Trans: 030712016
12/15/2015
Transaction
Parameters
P View v Fomat
\ Parameter
> WFP o data to display.
> Tools
> Setup

Result

Summary | Customer Service | Account Details

Maintenance | Comments  Promises

View v Format v

B ] Freeze i Detach wap | G & ' cument O Showall O Group Follovi-up
Branch sub Unit Account = Days Past Due Currency
uskg 2015120001012 LOAN VEHICLE (FR)

Customer Details || Transaction History | Pt Modes | | Bankruptey | Repofroredos ¢ o o

Checkists || Tracking Attributes || References || Correspondence || Letters [ Jsamrch

Matfh @ all O Any
Batch Information

53 Freeze Efipetach | Jwap @

Transaction

et Ghvod

¥ — = ACCOUNT NG
™ i ADIUSTMENT}

Batch Information

search
Date 02/10/2016
* Monetary @) et
tv & Freeze &t Detach Wrap 5]

(3] Close.
Elview || o audit
Pay OFf Amt Amount Due Status Oldest Due Dt
5031881 EECEN v oeLo:non perro. (TR
x
Advanced
b dd | 7 i || Elvew || Pasdt
[ search Transactlhe
|
Search Basic

Match ® All ) Any
Tn Code

| Description
n

| [ Reset | [ AddFields || Reorder

Desciption
o rous to dis

Greater than or equal to
Betueen

oK || cancel

Value Required

Click the arrow button available before ‘Search’ to toggle the search options.

Buttons/Menu

Do this

Basic

Click ‘Basic’ for normal search.
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1.5.5

Buttons/Menu Do this

Advanced Click ‘Advanced’ for advanced search. In this mode, you can select
the search option from drop-down list adjoining the search criteria.
Selected record will be highlighted (Hover to select).

Match Select ‘All’ to display results exactly matching the specified
characters. Select ‘Any’ to display results matching any of the
specified characters.

Search Click to search for values based on the specified search criteria.
The search results are displayed below with the details in respective
columns.

Reset Click to reset the search criteria.

Add Fields Click to add additional fields to search criteria.

The search criteria are provided below the ‘Match’ field. These criteria vary based on the Field
for which the search is executed.

Also, the system remembers your recent search options and demarcates them from the actual
ones.

| * Channel | WEB ENTRY = * Producer Name [
NY-02: PR HOLTSVILLE 43125313212
MT-00001 : SGFSADDF RAMEY 23132132
LR} SR A 1
TIF-OUOO L T TEST-00T RTINS T 1
MN-00001 : TERMINATE AGUADA a
MT-00001 : SGFSADDF RAMEY 23132132
NY-02: PR HOLTSVILLE 43125313212
Search...
Comments

In all the user input screens wherever comments are accepted, the system allows an input of
4000 characters of information in the comment(s) field.

De-supported Special characters

OFSLL ‘does not’ support the following special characters while accepting data through Ul,
web service and file upload process.

<>{}N\*[1"
Hence, ensure that the same is not used while processing any input data in the system.

Skip Zip Code Validation

While accepting data for interdependent fields through User Interface, OFSLL validates and
auto-populates the values for subsequent fields based on previous selection.

Accordingly, when a specific ‘Country’ is selected from drop-down list which is populated

based on COUNTRY_CD (COUNTRY CODE) lookup code, OFSLL validates and populates
the list of corresponding zip codes maintained in Zip Code setup.
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However, in case the zip code validation is to be skipped for a specific Country, then define
the Sub Code as NO_ZIP_VAL against the COUNTRY_CD in lookups screen as indicated

below:
Lookups x 38 Close
Lookup Type W add || ZEdit || 5] View || & Audit
View v Format v {Ef Freeze ;j‘ Detach Wrap @
Yes
& %COUNTRY%%
No
A System Defined
Lookup Type Description Yes/No Enabled
COUNTRY_CD COUNTRY CODE (SORT BASED ON CODE) Yes () No Y
»
Lookup Code P Aadd || ZEdit || ] view || & Audit
View ~ Format ~ (i) Freeze B Detach Wrap 2}
é Yes
%NOY
YoNO% o
Lookup Code Description Sort Sub Code SysromibHined Enabled
Yes/No
UK UNITED KINGDOM 1{NO_zIP_VAL Yes (. No Y
SG SINGAPORE 1|NO_zZIP_VAL Yes (' No =

On Selecting that particular Country from drop-down in any of the Ul screen, only the default
value ‘0000000000’ is available for Zip field drop-down list. On selecting the same, the City
and State fields are set as UNDEFINED.

Producer Details

[ save and Stay, || [ Save and Return || @ Retum

Producer # CO-00004 Address Line 1 2145 HWY 50 WEST Max Float 99,999
Old Producer # C0-00004 RS TiRE Remaining Float 99999
* |
Name DALE SPRADLEY MITSUBISHI Country | UNITED KINGDOM v Enabled
Company  ARGO1 v =
Zip 0000000000 Subvention Participation
Branch | ARO1 v ) 0000000000 UNDEFINED UNDEFINED
Zip Extn
Start Dt 05/27/1994 &y et
City MO T
End Dt 12/31/4000 | @ )
State UNDEFINED v Collection Type ' STATEMENT i
JACK -
Contact * Permission to Collection Frequency MONTHLY ¥
Group  NOT DEFINED i/ . pemussiaf‘::: Refund Disbursement 'NONE v
Method
Grade v Text Re o T =
egion
Type DEALER i Phone 1 (719)-543-6710 J
Territory | ALL 2
Status | ACTIVE v EinilG i,
Sales Agent % * Permission to License Details
Underwriter | DEMO UNDERWRITER v £l
* Permission t
Funides v e Valid From 01/01/1800 B
Collector  DEMO COLLECTOR v Phone 2 Valid To  12/31/4000 &

Note

Skipping zip code validation has significant impact in the system since the change impacts
all the Ul screens - Setup screens, Origination, Servicing and Collection module screens,
Interface, Customer Credit Limit, Collateral Management, and so on. Hence it is recom-
mended to be done with careful consideration and OFSLL is not responsible for any im-
pact/mismatch resulting out of this change.

1.5.6 Export data to Excel

While working on any of the screens in User Interface, OFSLL provides a flexibility to Export
the data that is displayed on screen to an Excel file. This helps to download and view the data
offline especially with data intensive screens.
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1.6

Clicking ‘Export to Excel’ option provides option to save the data to .xIs file.

Summary = Collections Customer Service =~ Account Details = Customer Details =~ Customer Preferences = Transaction History =~ Pmt Modes = Bankruptcy =~ Repo/Foreclosure — Deficien > ¥

Call Activities Comments = Promises =~ Checklists = Tracking Attributes | Field Investigation = References = Correspondence = Letters = Document Tracking =~ Scen: > ¥

Transaction Batch Information padd | AEdt | [ view | & Audit
View v Format v [ Freeze Efi Detach Wrap [0 % post Void | | Export to Excel
Date Monetary Transaction Status Batch
10/29/2020 i PAID OFF POSTED N
10/23/2020 N ADD CUSTOMER ADDRESS PHONE POSTED N

Parameters
View v Formatv [ Freeze B Detach Wrap ®
Parameter Value Required
TXN DATE 02/11/2020 Y
WRITE OFF INDICATOR YES Y

However, ‘Export to Excel’ option is currently available only to following screens and is also
access controlled depending on configuration defined in setup.

Queues/Search Results - Origination, Servicing, and Collections
Account Information

Balances

Call Activities

Maintenance

Promises

Due Date History

Collateral

Tracking Attributes

Condition Details / Condition / Queue History

In additional, OFSLL displays the total count of records fetched from database. The count is
displayed in the right bottom corner of records table. However, note that this is not the total
count of all the records in the database but only the records which are fetched based on
specific selection. For example, if there are 50,000 records in database and Ul is fetching
1,000 records, then the count is displayed as 1,000.

Keyboard Compatibility

The system facilitates keyboard compatibility. You can perform most of your tasks using
keyboard short cuts also termed as ‘Hot Keys’. These hot keys are single keyboards or a
combination of keyboards. The available options are listed below:

1.

Shift + Alt + mnemonic to activate buttons in the screen. For example, to open
‘Accessibility’ screen, press ‘Shift + Alt + y’.

Tab for forward navigation in the application. Shift + Tab for backward navigation in the
application. When the required link/tab/button/field is highlighted, press enter on the
keyboard to edit.

Space bar to check or uncheck ‘Check Box'.

Arrow Keys to hover within the drop-down list.
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1.6.1

1.7

1.8

1.8.1

Keyboard Compatibility

The application is made compatible with keyboard only-operations. However, there is a
change in key combination based on the browser on which the application is running.

Browser Operating Key Combination Action
System

Google Chrome Linux Alt + mnemonic Click

Google Chrome Mac OS X Control + Option + mne- | Click
monic

Google Chrome Windows Alt +mnemonic Click

Mozilla Firefox Linux Alt + Shift + mnemonic Click

Mozilla Firefox Mac OS X Control + mnemonic Click

Mozilla Firefox Windows Alt + Shift + mnemonic Click

Microsoft Internet Windows Alt + mnemonic Set focus

Explorer 7

Microsoft Internet Windows Alt + mnemonic Click or set focus

Explorer 8

Apple Safari Windows Alt + mnemonic Click

Apple Safari Mac OS X Control + Option + mne- | Click
monic

Also, one can use the following keyboard shortcuts in order to increase or decrease the zoom
level.

Shortcut Action

Ctrl++ To increase zoom level.

Ctrl+- To decrease zoom level.

Ctrl+0 To set zoom level to default level.
Tool Tips

The system is facilitated with tool tip option. When the cursor is moved to any of the field in
the screen, a popup is displayed with a tip on the action to be performed.

Accessibility

Understanding Accessibility

Accessibility is making the application usable for multiple user groups, which includes users
with physical challenges. One of the most important reasons to make the application
accessible is to provide them the opportunity to work. The four main categories of disabilities
are visual, hearing, mobility and cognitive.
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1.8.3

A person with disability might encounter one or more barriers that can be eliminated or
minimized by making the electronic information user-friendly and approachable.

Application Accessibility Preferences

Oracle Financial Services Lending and Leasing is facilitated with the feature of Accessibility
to make the application more usable for the people who are differently abled.

By default, the following accessibility options are provided and there is no need to define
special accessibility preference in the application:

e The application user interface contents are readily accessible for all types of users
without the need to select special accessibility modes.

e The components within the user interface are optimized for use with a screen reader by
default.

e The contents are zoomable by default, eliminating the need for an application large fonts
mode.

e The user interface components auto-detect if operating system (OS) is set to high
contrast mode and automatically render content that is compatible with OS high
contrast, eliminating the need for an application high contrast mode.

Note that, Oracle Financial Services Lending and Leasing application user interface is built
on Oracle Application Development Framework (ADF) and the default accessibility feature
supported by ADF are made available. For additional information, refer to ADF documentation
on accessibility preferences.

Documentation Accessibility Preferences

Apart from assigning the logical sequence and organizing topics, the following techniques are
used to enhance the accessibility of documentation.

e Addition of text equivalent to all graphics

e Usage of standard fonts and avoiding shadow or reversed text

e Usage of strong foreground and background color contrast

e Color usages as per Oracle Accessibility guidelines have been ensured
e Usage of styles and formatting elements

e Documentation in simple language to ensure easy understanding

e Including accurate and effective navigational features, such as cross-reference, tables
of content and bookmarks as appropriate
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2. Administration System

In Administration > System, you can record setup data related to the application’s overall
functionality and performance. This data affects;

e The mechanics of the system
e The processes of the system
e The search for Location of files to complete the tasks.

Navigating to Administration System

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > System

The System drop-down link records the following data:

e System Parameters

e Lookups

e User Defined Tables

e Audit Tables

e User Defined Parameters
e Transaction Codes

e Data Files

e Securitization

e Events
e Batch Jobs
e Reports

e Error Messages
e Translations
e Label Configuration

e Seed Data
e Data Masking
e Webhook

Using these parameters, you can control the behavior of the system from a technical
perspective. For example, determine parameter values, define what information is audited,
and record default values. The product provides default values for all these screens.

System Parameters

System parameters define information or values used throughout the system. They act as
switches that control the manner in which a function is implemented, or whether or not the
system performs a particular task. Parameters are used throughout the system to control
everything from user access to what information is stored on any given form. Parameters also
define configuration data, such as the location of the system files, the URLSs for the report and
image servers, and other administration controlled data. Some of the system parameters are
setup when the system is installed, but the values associated with the parameters need to be
reviewed and maintained.
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There are three types of parameters in the system, grouped by what part of the system they
affect:

Parameter Type: Parameter Range:

System parameters These parameters apply to the entire system.

Examples: batch processes, archiving, aging.

Organization parameters These parameters apply to the organization, division,
and user responsibility.

Examples: User login control, password expiration.

Company parameters These parameters apply to the company and branch.

Examples: decision fax control, scoring model.

Hence, the System Parameters screen contains the following three tabs:

e System Parameters
e Organization Parameters
e Company Parameters

System Parameters Setup

The System Parameters Setup screen displays and records each system wide parameter,
along with its current value and whether or not it is enabled. These parameters relate to the
overall processing of the system, such as application server file locations and data purging
configuration.

To set up the System Parameters

1. Click Setup > Setup > Administration > System > System Parameters > System. The
system displays the System Parameter screen
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2. In the System Parameters section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE

Financial Services Lending and Leasing

= Welcome, PRAKRRAO ~ o

DashBoard
> Origination
> Servicing
> Collections
> WFP
> Tools
Sefup
Setup
Administration
System
System Paramets
Loakups
User Defined Tat
Audit Tables
User Defined Def
Transaction Code
Data Files
Dedupe
Securitization
Events
Batch Jobs
Producer Cycles
Vendars
Callection Cydles
Reports
Error Massages
Translations
User
Organization
Companies
Access
Users
Credit Bureau
Correspondznce
General Ledger
Queaues
Printers
Bank Details
Chack Details
Standard Payees
Currencies
Zip Codes
Products

< >

System Parameter y; [3€] Close

System | Organization | Company

System Parameters deadd | FEdit | 2] view | & Audit

View v Formatv [ F
Parameter Paramater
AAIPRC_B]_100_0... AAIPRC_B)
ACAPRC_BJ 100_.. ACAPRC_B]
ACA_DLQ_AMT_E... EXCLUDE DE
ACA_PAYMENT_A
ACA_PRENGTE_D.

Paramater Value Enabled

2
2
NCY AMOUNT FOR ACCOUNT ACH N
ENT LOAD FROM ACOOUNT ACH ¥
DAYS FOR PRENOTE TO GOCUR FOR ACCOUNT ACH 7

2

'S BEFORE DRAFT DAY FOR ACCOUNT ACH PROCESS
AYS BEFORE DEEIT DAY FOR ACH PROCESS IN FIRST TIME/ONE-TIME CASE 32.00
100_01_DEBUG_LEVEL

ACCDMP_BT_100_
ACCVAL B 111__ A
ACCVAL B 112__ A
ACCVAL B] 121_
ACHPRC_BJ 100_... ACHPRC_E) 100 01

SRR

ACH_PAYEE_PREN... NI
ACMPRC_BI_112_
ACPPRC_BJ_100_
ACYPRC 1 100
AC(PRC_EM_100_
anmmv <FRvER

N
2
¥

¥
¥
=
N
N
N
N
Y
N
N
¥
N
N
N
N
v

bt Hashfnars o comeRnn T fer

System Parameters
Save and Add || [ Save and Stay || [ Save and Retun || (3 Retum

Parameter * Enabled []
* Parameter Des

* Parameter Value

A brief description of the fields is given below:

Field

Do this

Parameter System parameter of the specified parameter description is
displayed here.

Parameter Select the description of system parameter from the drop-down list.

Description

Parameter Specify the value for the system parameter (required).

Value

Enabled

Check this box to enable the parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

For a detailed list of available parameters, refer to Appendix “System Parameters” chapter.

FCUBS Integration

Oracle Financial Services Lending and Leasing (OFSLL) is integrated with Oracle
FLEXCUBE Universal Banking System (FCUBS) with the capability to integrate the
centralized CIF (Customer Information Files), ELCM (Enterprise Limits and Collateral
Management) and CASA (Current Account and Savings Account) modules.

To work with the integrated environment functionalities, you need to enable the following core
banking indicator.

Parameter

Parameter Description

CMN_CORE_BANK CORE BANKING INTERFACE INDICATOR
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Note

Re-qualification is pending for Core and Direct Banking Integration.

For detailed information about integration changes, you can refer to ‘FCUBS Integration
Documents’ section at OTN library (http://docs.oracle.com/cd/E59770_01/homepage.htm).

Organization Parameters

The Organization parameters control the system functions related to user log in, such as
passwords and expiration dates, responsibility levels and the ability to access the system
features. Individual parameters can be created with different values for uniquely defined
organizations, divisions, and responsibility combinations.

When determining which parameter to use, the system selects the best match based on a
hierarchical sort by the Organization, Division, and Responsibility fields, with values of ALL
being a lower order match than an exact match.

For example:

Assume the organization parameter UIX_APP_VIEW_ALL_APPS (VIEW ALL
APPLICATIONS) is as follows:

e If auser belongs to an organization as ‘DMC’ with a responsibility of SUPERUSER and
is using the Underwriting screen of Lending menu, the system will return with a value N,
and the system will not allow the user to view all applications.

e If the user belongs to any organization with a responsibility of SUPERUSER, and is
using the Underwriting screen of Lending menu, the system will return with a value Y,
and the system will allow the user to view all applications.

Note

Be aware that while the system allows for Organization parameters to be defined at all
three hierarchical (organization, division, and responsibility) levels, not all will be applica-
ble to each parameter. For example, while you can define the UIX SMTP_SERVER
(EMAIL SERVER FOR USER) for a responsibility, you would normally want only to define
this parameter based on organization or division.

To set up the Organization Parameters

1. Click Setup > Setup > Administration > System > System Parameters >
Organization tab.
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2. Inthe Organization Parameters section, perform any of the Basic Operations mentioned
in Navigation chapter.

ORACLE

Financial Services Lending and Leasing

DashBoard
»> Origination
> Servicing
> Collections
» WFP
> Tools
Setup
Setup
Administration
System
System Paramets
Lookups.
User Defined Tat.
Audit Tables
User Defined Def:
Transaction Code.
Data Files
Dedupe
Securitization
Events
Batch Jobs
Producer Cydles
Vendors
Collection Cycles
Reports
Error Messages
Trenslations.
User
Organization
‘Comgpanies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queuss
Printers
Bank Details
Check Details
Standard Payess
Currencies
Zip Codes
Products

< »

~

System Parameter 36 Close
System  Organization  Company
Organization Parameters padd | edt | [Eview || of audit
View v Formate [ Freeze i Detach Wrap @
Parameter Parameter Description Parameter Value Organization Division Responsibility Enabled
MAX_PASSWORD._... SET THE NUMBER TO RESTRICT PASSWORD REPETL.. 0.00 AL AL ¥
UCS_GROUP_FOL .. DAYS TO CONSIDER FOR GROUP FOLLOW-UP, WHE... 10 AL ALL AL Y o]
UCS_REVIEW_QU... REVIEW QUEUE ALLOWED WITHOUT ENTERING CAL.. N AL AL ALL ¥
APPLICATIONS ¥ AL AL AL ¥
TRICTED DATE (FOR EXAMPLE 55N#) ¥ AL AL AL ¥
EMAIL SERVER FOR USER INTERFACE internal-maik-router.oraclecorp.com AL AL AL ¥
VIEW SECURED ACCOUNTS ¥ AL AL AL ¥
VIEW SECURED APPLICATION ¥ AL AL AL ¥
2] USER LOGIN DAY END HOUR 24 AL ALL ALL ¥
ULG_DAY_START  USER LOGIN DAY START HOUR o AL AL AL ¥
USER LOGIN MAXIMUM FAILED LOGIN TRIALS BEFO... 853999999999 AL ALL AL ¥
JSER LOGIN MAXIMUM INA DAYS BEFORE D... 99999999999 AL AL AL ¥
ALL AL AL ¥
AL AL AL ¥
AL AL AL Y
AL AL AL ¥
AL AL AL v
AL AL AL ¥
ALL ALL AL ¥ i
an an an v

A brief description of the fields is given below:

Field

Do this:

Parameter Parameter of the specified parameter description is displayed here.

Parameter Select the description of system parameter from the drop-down list.

Description

Parameter Value Specify the value for the system parameter.

Organization Select the organization for which the parameter will be valid from
the drop-down list.

Division Select the department for which the parameter will be valid from

the drop-down list.

Responsibility

Select the responsibility for which the parameter will be valid from
the drop-down list.

IMPORTANT: In selecting which organization parameter to use,
the system searches for a best match using the following attributes:

1. Organization
2. Division
3. Responsibility

Hence, Oracle Financial Services Software recommends creating
a version of each organization parameter, where ALL is these
fields.

Enabled

Check this box to enable the parameter.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

For a detailed list of available parameters, refer to Appendix “System Parameters” chapter.

Company Parameters

The Company parameters control the system processes associated with functions that may
vary for different companies or branches. These parameters address credit scoring, credit
bureau interfaces, fax services, and fax generation. Individual parameters may be set up with
different values for uniquely defined company and branch combinations.

When these parameters values are requested by the system, the system responds with the
“best” match based on a hierarchical sort ordered on company and branch fields, with values
of ALL being a lower order match than an exact match. For example, assume the company
parameter UIX RUN_AAI ACT (ONLINE ACCOUNT CREATION AND ACTIVATION) has
been defined as:

The system uses these two parameters to determine whether to create and activate an
account online.

e When processing items for the company US01, the system will return a value N and not
create and activate an account online.

e When processing items for the company other than US01 and within the value ALL, the
system will return with a value Y and create and activate an account online.

To set up the Company Parameters

1. Click Setup > Setup > Administration > System > System Parameters > Company
tab.

2. Onthe Company Parameters screen, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’
Financial Services Lending and Leasing
Close
DashBoard System Parameter x E3fe
> Origination System | Organization =~ Company
> Servicing
> Collections Company Parameters Hadd | Sede | Huvew | F audt
p— View v Fomatv [E Freeze i Detach o] Wrap o]
Faramster Parameter Description Parameter Valus Company Division Enabled
> Tools ™)
Setup AUD_ADV_REASO... AUTO DECISION ADVERSE ACTION REASON MODEL FICO AL AL ¥ ~
Sl AUD_SCORING_M... APPLICATION SCORING METHOD PRIM AL AL ¥
. P AUD_SCORING_M... APPLICATION SCORING METHOD WITH IN ALL BUREAU MAX_SCORE AL AL ¥
Administration
St CBU_DATA, R DATA SELECTION CRITERIA MONTHLY AL ALL ¥
EEr— CBU_DATA_SET_S... METRO 2 FILE DATA SELECTION CRITERIA MONTHLY uso1 usHQ N
LR CBU_FILE_FORMAT METRO 2 FILE FORM 830 AL ALL ¥
u
@ DD it CMN_ASE_VALIDA... VALIDATE A AKE MODEL DURING DATA ENTRY N AL ALL ¥
::’t : ;:e = CMN_CME_DEFAU... DEFAULT PRINTER NAME UNDEFINED AL ALL Y
& 'D'i Esd i CMN_WEEKLY_NO... WEEKLY NON-BUSIN Y UNDEFINED ALL AL ¥
e : COR_STORAGE_D... ORACLE DIRECTORY OBIECT NAME FOR CORRESPONDENCE DOC STORAGE COR_DIR_QA143REL_HQ ALL AL ¥
Transation Cocd DBR_JOINT_INC_... COMBINE INCOME AND DEBT WITH SPOUSE AND 2NDRY N AL AL ¥
Data Files DBR_JOINT_INC_ N AL ALL ¥
Detkipe DDP_CRE_EXPIRA... DEDUPING CREDIT BUREAU EXPIRATION DAYS 999008 AL AL Y
Secitiztion: DDP_DEDUP_DEB. . DEDUP CREDIT BUREAU LIABILITIES WITH SPOUSE AND SECONDARY N AL ALL ¥
e DDP_| DEDUP CREDIT BUREAU LIABILITIES WITH SPOUSE N AL AL ¥
Baich Jobs i) DOT_STOf ACLE DIRECTORY OBJECT NAME FOR ACCOUNT DOCUMENT LOADING  DOT_DIR_QA143REL_HQ AL AL ¥
Producer Cycles ECB_EDIT. BUREAU EDIT WILL FAIL IF ANY BUREAU FOR ANY APL WILL N AL AL ¥
Vendars ECB_U: RUN CREDIT BUREAU EDITS ONLY ON CURRENT SCORE Y A AL ¥ v
Callection Cycles FIN TMBGE STAT  NEFALIT TMAGE STATIIS FONF ENR FAY TN SERVICE n s an v
Reports
Error Messages Company Parameters
USJE"S‘E“MS saveand add || Bl save and stay || [ save and Retum | CaRetum
Organization
S Paromctr * Campany AL =
A Parameter Description - @ty (T =
Users . "
Parameter Value * Eriabled
Credit Bureau Enabled []
Comespondence
General Ledger
Queues
Printers
Bank Details
Cherk Details
Standard Payess
Currencies
Zip Codes w
Products
« i >
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A brief description of the fields is given below:

Field Do this:

Parameter The system displays the parameter, when you select parameter
description.

Parameter Select the description of system parameter from the drop-down list.

Description

Parameter Value | Specify the value for the system parameter.

Company Select the portfolio company for which the parameter will be valid
from drop-down list.

Branch Select the portfolio branch for which the parameter will be valid from
the drop-down list (required).

IMPORTANT: In selecting which company parameter to use, the
system searches for a best match using the following attributes:

1. Company
2. Branch

For this reason, the Software recommends creating a version of
each company parameter where ALL is the value in these fields.

Enabled Check this box to enable the parameter.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

For a detailed list of available parameters, refer to Appendix “System Parameters” chapter.

Lookups

The Lookups setup screen defines the contents in many drop-down fields used throughout
the system. Fields that make use of drop-down field will accept only entries that are stored on
this screen.

The Lookups screen contains two sections: Lookup Types and Lookup Codes. Lookup
types and codes can be system-defined or user-defined. The lookup types describe the
function of the related lookup codes.

For system-defined lookup types, only the Description field may be changed.

A system-defined lookup type (Lookup Types block, System Defined is selected) is one that
is critical to the system and cannot be changed. However, you can still modify the lookup type
description and Record indicator (Enabled/Disabled).

A user-defined lookup type (Lookup Types block, System Defined is not selected) is one
that can be modified, depending on a user's business needs. You can modify the description,
system indicator and record indicator. If a lookup type is user-defined, the lookup code
belonging to that lookup type can either be system-defined or user-defined.

A system-defined lookup code (Lookups screen, System Defined is selected) is one on

which the system processing is dependent. Without this lookup code, the process produces
incorrect results or fails.
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A user-defined lookup code (Lookups screen, System Defined is not selected) is one that
can be defined or altered by a user.

WARNING: System-defined lookup types are those that are required by the system. Their
related lookup codes will also be system defined. If you update and save a user-defined
lookup type as a system-defined-lookup type (that is, change the System Defined button from
No to Yes in the Lookup Type sub screen), the system will not allow you to change the lookup
type back to user-defined in the future.

Note

Lookup codes cannot be deleted, as they may have been used in the past, and the display
and processing of that data is still dependent on the existing setup.

Typically, the system Administrator would modify the descriptions of lookup codes and add
new lookup codes to the existing lookup types as needed.

To set up the Lookups

1. Click Setup > Setup > Administration > System > Lookups. The system displays the
Lookups screen. The details are grouped into two:

e Lookup Types
e Lookup Codes

2. Inthe Lookup Types section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’
Financial Services Lending and Leasing

s
DashBoard o G

> Origination
Lookup Type dradd | At | [Hvew | o audic

> Servicil
% View » Fomatw [Ep Freeze ) Detach ol Wrap (5]

> Collections
> WEP
> Tools

Lookup Type Description

1098_POINTS_DISCOUNTS_ITM_CD 1098 ITEMIZATION TYPES
Setup
Setup
Admiristration
System
System Paramete
Lookups
User Defined Tat.
Audit Tables
User Defined Def
Transaction Codd ACH_ACCOUNT_TYPE_CD ACH ACCOUNT TYPE CODES
Data Files
Dedupe Lookup Type
Securitization
Events
Batch Jobs «
Producer Cydles
Vendors * Description
Callection Cydles * System Defined Yes/No () Yes®) No
Reports
5‘1;:s|:\::gh Lookup Code Fadd | FEdt || 5 view | o Audt
User View~ Fomatv Ep Fresze i Detach | ol wrap ®

ACCESS GRID TYPE CODES
ACCRUAL BASE METHOD CODES
ACCRUAL CALCULATION METHOD CODES

~

ACCRUAL START DT BASIS CODES
_TXN_] ACCRUED TXN BALANCE TYPE CODES

ACC_CONDITION_CD ACCOUNT CONDITIONS / ACCOUNT QUEUE TYPES (SUB OODE USED FOR DEFAULT QUEUE)
ACC_STATUS_CD ACOOUNT STATUS CODES

[ saveand add | [ save and stay Save and Return | 3 Return

“Enabled [

Organization =
rganization System Defined Enabled

Lookup Code: Description Sort Sub Code Ve

Companies
Access No data to display.
Users
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payees
Currencies
Zip Codes
Products
< >

A brief description of the fields is given below:

Field Do this:

Lookup Type Specify the lookup type.
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2.3

Field Do this:

Description Specify the description for the lookup type .

System Defined | Select ‘Yes', if you wish to maintain the lookup type as system defined
Yes/No and ‘No’, if you wish to maintain lookup type as User defined.
Enabled Check this box to enable the lookup type.

Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Lookup Codes section, you can setup individual codes that a field or process using
the related lookup type can have. Perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Lookup Code Specify the lookup code. These are solely dependent on the
function of the Lookup Type.

Description Specify the lookup code description. This may be changed as per
your business requirement.

Sort Specify the sort order for the lookup code. This determines the
order these lookup codes are displayed or processed.

Sub Code Specify the sub code for the lookup code.

System Defined | Select ‘Yes', if you wish to maintain the lookup code as system
Yes/No defined and ‘No’, if you do not want to maintain it as system
defined. System defined lookup codes cannot be modified,
except for changing the Description or Sorting fields. If the lookup
type is not system defined, then the code can be modified.

Enabled Check this box to enable the lookup code.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

User Defined Tables

In User Defined Tables you can maintain user-defined tables, such as the data attributes the
system uses on its Search screens.

In the following example, the list of attributes in the Criteria column are computed from the
User Defined Tables screen.

To set up a user-defined table, you must:

1. Define the fields on the table.
2. Join the related tables.

3. Assign the table a lookup type.
You can create tables for different products, funding, and collateral types.

After creating the user-defined tables, the system sorts the attributes to make the system
usage more efficient. These details are used with different functions of the system, including:

29 ORACLE



e Tracking follow-up items
e Creating details in bankruptcy, foreclosure/repossession, and deficiency

Note

Many of these tables, (ASSET TRACKING ATTRIBUTES for example) may be configured
during the initial setup of the application to provide for your specific business needs. Oth-
ers, such as APPLICATION SEARCH, may be changed whenever your business needs
change. Still others should not be changed without consulting Oracle Financial Services
Software, as changing them would require changes to existing code for the expected re-
sults to be implemented. As a thumb rule, it is better to add or disable information on the
User Defined Tables screen than to edit existing entries.

To set up the User Defined Tables

1. Click Setup > Setup > Administration > System > User Defined Tables. The system
displays the User Defined Tables screen. The details are grouped into two:

e User Defined Tables
e User Defined Table Attributes

2. In the User Defined Tables section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE Welcome, PRAKRRAO + o
Financial Services Lending and Leasing
Close:
DashBoard User Defined Tables x xd
> Origination
e User Defined Tables 4 add | AEdt | 5 vew | o audit
rvicing 5
e Viewv Formatw  [E Freeze g Detach Wrap {50
Collections
o Table Usertable Type  Description ifs;,i‘: Defined  probed Product Type Funding Type Collateral Type View Name SQL Statement
e Yes o ho N UNDEFINED
~
e SEARCH_WFP_PR... SEARCH : WFP PR... WFP PRODUCER S... ¥ AL AL AL SELECT f*+ FIRS,
B SEARCH_UPD_AC.. SEARCH : POSTD... POST DATED CHE ¥ AL AL AL SELECT /*+ FIRS
Sef
;Z it ~ DLR_TRACK_MAP... MAPFING: INTERF... DLR_TRACK MAPP.. ¥ AL AL AL SELECT 1 FROM [
iministration
S SEARCH_UBT_AD.. SEARCH : ACCOU.. BATCH ENTRY AC. ¥ ALl ALl AL SELECT /*+ FIRS
System Paramel SEARCH_UBT_FEE.. SEARCH : ACCOU.. BATCH ENTRY AC ¥ AL AL AL UNDEFINED SELECT /*+ FIRS
Lookups SEARCH_UTA_TXN  SEARCH: TRANSA... TRANSACTION HL Y AL AL AL UNDEFINED SELECT /*+ FIRS
User Defined T2 SEARCH_UBT_PM... SEARCH : ACCOU.. BATCH ENTRY AC. ¥ AL AL AL UNDEFINED SELECT f*+ FIRS
it Tabl
AL Tobles CHGOFF_TYPE_D... TABLEATTRIBUT... DEFICIENCY DETA Y AL AL AL UNDEFINED SELECT 1 FROM [
User Defined De. v
Transaction G CPY_APP_SETUP  SETUP: APPLICAT... APPLICATION CO. ¥ AL AL AL UNDEFINED SELECT 1 FROM [
Data Files < >
Dedupe

Securitization User Defined Tables

i saveand add | [ saveand stay | [ save and Retum | (@ Retum

ek =Table * Enabled [] = View Name | UNDEFINED
Callection Cycle: * User table Type [~] *Product Type ALL
Reports
Error Messages
Translations
User
Organization
‘Companies *Sort O
Access

*SQL Statement

* Description = Funding Type |ALL

[ [ [

* System Defined Yes/No () Yes ® No = Collatersl Type ALL

Users

User Defined Table Attributes g add | A Ede
Credit Bureau
Correspondence View v Formatw [ Freeze g Detach 1l Wrap =)
Genciel | Ser Attribute Description Data Type Length Sart Operator S Dtk

Queues Yes/No
Printers No data to display.

7 Audit

Enabled Sub Attribute LOV Type

Bank Details < >
Check Details
Standard Payee
Currencies
Zip Codes
Products
< >

A brief description of the fields is given below:

Field Do this:

Table Specify the user-defined table name.

User Table Type Select the user-defined table type from the drop-down list. This
determines where and how the related data is being used.
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Field

Do this:

Description

Specify the description for user-defined table.

System Defined
Yes/NO

Select ‘Yes', if you wish to maintain the User table type as system
defined and ‘No’, if you do not want to maintain it as system
defined. System defined entries cannot be modified. If the entry is
not system defined, then it can be modified.

Enabled

Check this box to enable the user-defined table (optional).

Product Type

Select the product type from the drop-down list.

Funding Type

Select the funding type associated with the user-defined table from
the drop-down list.

Collateral Type

Select the collateral type associated with the user-defined table
from the drop-down list.

View Name

Specify the view name.

SQL Statement

Specify the SQL version of the statement.

For Example: For SEARCH_ACC_ACCOUNTS table, the SQL is as
follows:

SELECT /*+ FIRST_ROWS */ ACC_AAD_ID FROM ACCOUNTS
WHERE

Note: For the above SQL, the where criteria is part of the User
Defined Table Attributes

Sort

Specify the sort order for the user-defined table relative to other
tables of the same type.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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4. Inthe User Defined Table Attributes section, perform any of the Basic Operations
mentioned in Navigation chapter.

ORACLE
Financial Services Lending and Leasing
Close
T User Defined Tables 5, o
> Origination
T User Defined Tables Bl wew | o audit
rvicing
e View v Formatw B Freeze £ Detach ] Wrap o]
Collections
Table Usertable Type  Description System Defined. | apieg Product Type FundingType  Colltersl Type  View Name SQL Statement
> WFP Yes/No
> Tools SEARCH_WFP_PR.. SEARCH : WFP PR.. WFP PRODUCER 5. [ AL AL ALL UNDEFINED SELECT /*+ FIR
— SEARCH_UPD_AC... SEARCH : POST D... POST DATED CHE... Y AL AL AL UNDEFINED SELECT /*+ FIR;
P DLR_TRACK_MAP.. MAPPING: INTERF... DLR_TRACK MAPP. Y AL AL ALL UNDEFINED SELECT 1 FROM
Ser
;mehm" A SEARCH_UBT_AD.. SEARCH :ACCOU.. BATCHENTRY AC. Y AL AL ALL UNDEFINED SELECT /*+ FIR:
Sys;m SEARCH_UBT_FEE... SEARCH : ACCOU... BATCH ENTRY AC ¥ AL AL ALL UNDEFINED SELECT /*+ FIR
System Paramete SEARCH_UTA_TXN  SEARCH: TRANSA... TRANSACTION HI ¥ AL AL AL UNDEFINED SELECT /*+ FIR
Laokups SEARCH_UBT_PM... SEARCH : ACCOU... BATCH ENTRY AC. Y AL AL AL UNDEFINED SELECT /*+ FIR:
User Defined Tat PE_D.. TABLE ATTRIBUT.. DEFICIENCY DETA Y ALL AL ALL UNDEFINED SELECT 1 FROM
it Tabl
ek s UP  SETUP: APPLICAT... APPLICATION CO... ¥ AL AL AL UNDEFINED SELECT 1 FROM
User Defined Def v
Transaction Code SEARCH_ACC_AC.. SEARCH : ACCOUNT ACCOUNT SEARCH ¥ ALL AL ALL UNDEFINED SELECT /*+ FIR:
Data Files
Dedupe
Securitization
Events user Defined Table Attributes Hadd | FEde || Sl view | o audit
Batch Jobs “ = .
View v Format = Freeze ] Detach p
Producer Cycles & o @
Vendors Attribute Description Data Type Length Sort Operator Enabled Sub Attribute LOV Type
Collection Cyck
Collection Cydles w o
Reports
Error Messages PRO_NAME PRODUCER NAME CHARACTER 80 1 UKE Y NO LOV
Translations WPR_STATUS_CD PRODUCER STATUS  CHARACTER 30 2 LIKE ¥ O LOV
User WPR_TOT_CREDIT_L . TOTAL CREDIT LIMIT ~ NUMBER 30 3 EQUAL Y NO LOV
Organization >
Companies
Access -
i User Defined Table Attributes
Credit Bureau [ Save and Add saveand Stay | [ Ssve and Retun || {3 Retum
Correspondence
General Ledger * Attribute * Operator [~ = LOV Validation Ind []
Queues . " * €yctorn Defi INo = ookup Typ:
SR Description System Defined Yes/No () Yes®) No Lu:kuu vpe
Bank Details * Data Type [~] = Enabled (] Default Value
Check Details *Length 0 Sub Attribute
Standard Payees
ot 0 LOV Type v
Currencies (- & 22
Zip Codes -
Products
< mimiam >

A brief description of the fields is given below:

Field

Do this:

Attribute

Specify the user-defined table attribute.

Description

Specify the description for the user-defined table attribute.

Data Type

Select the data type for the attribute (CHARACTER, NUMBER, or
DATE) from drop-down list.

Length

Specify the maximum length of the user-defined table attribute.

Sort

Specify the sort order of the user-defined table attribute. If the sort
order is changed it will only affect new instances of the User Defined
Table, and will not affect existing data.

Operator

Select the operator for the user-defined table attribute from the drop-
down list.

System
Defined Yes/No

Select ‘Yes', if you wish to maintain the User table attribute as system
defined and ‘No’, if you do not want to maintain it as system defined.

System defined entries cannot be modified. If the entry is not system

defined, then it can be modified.

Enabled

Check this box to enable the user-defined table attribute so that the
attribute will be considered when creating new instances of the User
Defined Table.

Sub Attribute

Specify the sub-attribute for the attribute (sub attributes are used to
associate related attributes).
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2.4

Field Do this:

LOV Type Select the list of value (LOV) type for the user-defined table attribute
from the drop-down list.

LOV Validation Check this box to enable LOV validation of the user-defined table
Ind attribute. This indicates whether the data must come from the LOV.

Lookup Types Specify the lookup type of the LOV associated with the user-defined
table attribute.

Default Value Specify the default value for the user-defined table attribute.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Audit Tables

The system allows you to track changes in the database during origination. This includes the
tracking of:

e Account status history
e Audit history of specified fields

The Audit Tables Setup screen records the tables and columns requiring an audit. the system
stores the following details for the fields you want to audit for changes:

e Current value in field

e New value field

e User who changed the field’s content

e Date and time when the value was changed

IMPORTANT: The system recommends that only a database administrator perform the
following steps.

To set up the Audit Tables

1. Click Setup > Setup > Administration > System > Audit Tables. The system displays
the Audit Tables screen. The details are grouped into two:

e Audit Tables
e Audit Columns
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2.
chapter.

ORACLE’

Financial Services Lending and Leasing

In the Audit Tables section, perform any of the Basic Operations mentioned in Navigation

DashBoard
 Origination
> Servicing
> Collections
 WEP
» Tools
Setup
Setup
Administration
System
System Paramet:
Lookups
User Defined Tat.
Audit Tables
User Definad Def
Transaction Code
Data Files
Dedupe
Securitization

A

Vendors
Collection Cycles
Reports
Error Messages
Translatians
User
Organization
Companies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queuss
Printers
Bank Details
Check Details
Standard Payess
Currencies
Zip Codes
Products

< >

Audit Tables » [ Close.
Audit Tables [ et | Elview | o audi
View v Format~ [ Freeze g Detach I Wrap ) 45 cenerate
Table Description Display Dascription  Display Column Reset RowID Enabled Primary Key 1 Primary Key 2 Primary Key 3 Primary Key 4
INDEX_RATES INDEX RATE DETA... TYPE IRT_INDEX_TYPE.. N ¥ TRT_INDEX_TYPE.. TRT_START_DT
INSURANCES INSURANCES DET... INSURANCE TYPE  INS_INSURANCE_.. N ¥ INS_AAD_ID INS_ID ()
1085 OB DETAILS DESCRIFTION J0B_DESC N Y 1OB_JBS_CODE 1OB_CODE
108_BUCKETS 108 BUCKET DET... ID JBB_ID N ¥ JB8_ID
J0B_HOLIDAYS  JOB HOLIDAY DET... DESCRIPTION JBH_DESC N Y IBH_DT
JOB_SETS JOB SET DETAILS ~ DESCRIPTION JBS_DESC N Y JBS_CODE
JOB_THREADS 0B THREAD DET... CODE JBT_3JOB_CODE N ¥ JBT_IBS_CODE JBT_JOB_CODE JBT_THREAD
LOOKUPS LOOKUP DETAILS  DESCRIPTION LKC_DESC N i LKC_LKT_TYPE  LKC_CODE
LOOKUP_TYPES LOOKUP TYPE DE.  DESCRIPTION LKT_DESC N Y LKT_TYPE
MESSAGES MESSAGE DETAILS TEXT MSG_TEXT N Y MSG_CODE MSG_PTC_COMPA_ MSG_PCB_BRANCH MSG_SUPER_PR
< >
Audit Tables
{a Retum
Table INDEX_RATES Primary Key 2 IRT_START_DT Primary Key 9
Description  INDEX RATE DETAILS Primary Key 3 Key 10
Display Description TYPE Primary Key 4 1
Display Column IRT_INDEX_TYPE_CD Primary Key 5 12
Enabled ¥ Primary Key & 3
Resef RowID _ Primary Key 7 Primary Key 14
Primary Key 1 IRT_INDEX_TYPE_CD Primary Key 8 Primary Key 15
Audit Columns FPadd | Fede | [Evew | o audit
View v Format~ (5 Freeze Eff Detach o) Wrap o]
Column Description Data Type Enabled

No data to display

A brief description of the fields is given below:

Field

Do this:

Table

The table name on which audit trigger needs to be
created is displayed here (the system table being
audited).

Description

Specify the table description.

Display Description

Specify the column description to be displayed on audit
screen.

Display Column

Select the table column to be displayed on audit screen
from the drop-down list.

Enabled

Check this box to enable the audit table so that it will be
considered while generating the database triggers.

Reset Row ID

Check this box to allow resetting the row identifier.

Primary Key 1 (unlabeled)

The table primary key column 1 is displayed here.
(These columns define how to access the data in the
table.)

Primary Key 2 (unlabeled)

The table primary key column 2 is displayed here.

Primary Key 3 (unlabeled)

The table primary key column 3 is displayed here.

Primary Key 4 (unlabeled)

The table primary key column 4 is displayed here.

Primary Key 5 (unlabeled)

Table primary key column 5 is displayed here .
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Field Do this:

Primary Key 6 (unlabeled) Table primary key column 6 is displayed here.

Primary Key 7 (unlabeled) The table primary key column 7 is displayed here.

Primary Key 8 (unlabeled) The table primary key column 8 is displayed here.

Primary Key 9 (unlabeled) The table primary key column 9 is displayed here.

Primary Key 10 (unlabeled) | The table primary key column 10 is displayed here.

Primary Key 11 (unlabeled) The table primary key column 11 is displayed here.

Primary Key 12 (unlabeled) | The table primary key column 12 is displayed here.

Primary Key 13 (unlabeled) | The table primary key column 13 is displayed here.

Primary Key 14 (unlabeled) The table primary key column 14 is displayed here.

Primary Key 15 (unlabeled) | The table primary key column 15 is displayed here.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Audit Tables Columns section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Column Specify the column name on which the audit needs to be created from
drop-down list (column in the table that is being audited)

Description Specify the column description (description of the data contained in the
column).

Data Type The data type for the attribute is displayed here.

Enabled Check this box to enable the audit column.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

User Defined Parameters

The User Defined Parameters setup screen facilitates to define field-level configurations
which helps to perform various day to day business specific calculations. In this screen you
can define parameters and logic for each field to compute and populate data.

For example, you can setup User Defined Parameters in the system to calculate Trade Equity,
Collateral Coverage Ratio, Net Rental Yield and so on.

Note

Currently system supports defining user defined parameters for entities like Account and
Collateral. The computed values are populated into Customer Service > Account Details
> Account Information section and Servicing > Collateral Management > Collateral Details
screen respectively on clicking Calculate Parameters button.
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Defining user defined parameters basically involves identifying a scenario and creating/
configuring the required parameters. Here, a scenario can refer to what category of accounts
are to be considered for computation.

User defined parameters consists of the following two types of configurable parameters:

Parameter Description

Target Parameters These parameters store values for the customizable user
defined fields in user defined tables and is used for calculation
based on Selection Criteria.

These parameters are available as per the ‘View Name’ defined
in user defined tables for each Account and Collateral Entity
and persist the calculation values into the table columns of
database after its first execution.

Formula Parameters These parameters are used for computation of the target
parameters. These contain the generic formula/logic that can be
used for any computation based on System Defined Functions
and Table Columns. These parameters does not persist the
calculation values into the table columns of database.

Since system supports Account and Collateral entity types, the configurable user defined
Target/Formula parameters along with selection criteria can be defined using specific table
type as indicated below:

Entity Parameter Description
Type Type P
Accounts Formula Formula parameters are used for computation of the target

Parameters | parameters for Account Entity.

OFSLL supports predefined set of calculation based Formula
Parameters. These parameter definitions start with’ $’ in User
Defined Tables.

These parameters does not have any selection criteria.
Existing factory shipped seed data provided by OFSLL
product like GL date, System Date, ACC_DLQ_DAYS and so
on is based on below User Defined Table Type:

USER DEFINED: ACCOUNTS FORMULA PARAMETERS
USER DEFINED: COMMON FORMULA PARAMETERS
USER DEFINED: COMMON CUSTOMER SERVICE
FORMULA PARAMETERS

Target These calculations are based on formula parameters and
Parameters | other target parameters.

A selection criteria is available for each calculation.

These are based on User Defined Table Type: USER
DEFINED: ACCOUNT TARGET PARAMETERS

Selection These parameters define the criteria on which accounts are
Criteria picked for calculation of defined target parameters.

These are available only for Target parameters and are based
on User Defined Table Type: USER DEFINED: ACCOUNT
CRITERIA PARAMETERS
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Entity Parameter

Type Type Description

Collateral | Formula These Formula parameters are used for computation of the
Parameters | target parameters for Collateral Entity.

They are based on below User Defined Table Type:

USER DEFINED: COLLATERAL FORMULA PARAMETERS
USER DEFINED: COMMON FORMULA PARAMETERS
USER DEFINED: COMMON CUSTOMER SERVICE
FORMULA PARAMETERS

Target These are based on User Defined Table Type: USER
Parameters | DEFINED: COLLATERAL TARGET PARAMETERS

Selection These are available only for Target parameters and are based
Criteria on User Defined Table Type: USER DEFINED:

COLLATERAL CRITERIA PARAMETERS

Note

The execution of User Defined Parameters require additional processing at the server lev-
el and can have significant performance impact delaying the EOD processing. Hence it is
recommended to have careful consideration while defining the Target and Formula param-
eter configurations.

In this framework, you can either create new parameters and/or use the available pre-defined
formula parameters to populate computed values to custom user defined fields.

For example - a formula parameter can be defined with an expression as
*$TOTAL_ITM_GRP_IEQ + $PAID_BAL_ADV which is total equity in itemizations on account
added with total advance amount paid. An expression can have a stored function
(represented with $ sign) and Account Columns (fields).

There are some formula parameters in the system with basic pre-defined calculation which
can readily be used for configuration along with account fields. Pre-defined formula
parameters are associated with specific acronyms appended with parameter name for
identification. The table below lists the available per-defined formula parameters. However,
you can also define custom formula parameters with acronyms.

User Defined Column Description | Description

$GL_DATE Value of GL Date System Parameter
$SYSTEM_DATE Current System Date
$COLLATERAL_VALUE Sum of all collateral current valuation

$PRIMARY_COLLATERAL_VALUE | Sum of all primary collateral current valuation

$ASE_GRAND_FATHER_POINTS | Sum of all grandfather points

$ASE_TIER POINTS Total Tier Points

$INTEREST_ACCRUED Interest Accrued on Account for a specific date.
This is used to calculate Trade Equity Calculation.
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User Defined Column Description | Description

$SOUTSTANDING_AMOUNT Current Account Outstanding Amount
$OUTSTANDING_BAL_ (BALANCE | This is a dynamic balance value calculation based
TYPE *) on type variable.

For example:

- SOUTSTANDING_BAL_ADV - Will calculate
outstanding Advance/Principal amount
- SOUTSTANDING_BAL_LSR - Will calculate
outstanding Lease Receivable amount

$PAID_BAL_(BALANCE TYPE *) This is a dynamic balance value calculation based
on type variable.

For example:

- $PAID_BAL_ADV - Will calculate paid Advance/
Principal amount

- $PAID_BAL_LSR - Will calculate paid Lease
Receivable amount

$SUM _PRIN_ESC _MAX_ EXPIRY_ | Thisis used to calculate sum of total principal
DT amount till Extended Service Warranty Max Expiry
Date.

$TOTAL_ITM_GRP_ (ITM GROUP?*) | This is a dynamic itemization group value
calculation based on type variable.

For example:

- $TOTAL_ITM_GRP_IDC - Will calculate total
ITM LOAN AMOUNT DOWN PAYMENT CASH
group amount

- $TOTAL_ITM_GRP_IPF - Will calculate total

ITM PREPAID FEE group amount

STOTAL_ITM_ (ITM*) This is a dynamic itemization value calculation
based on type variable.

For example:

- $TOTAL_ITM_IDC_1 - Will calculate total ITM
DOWN PAYMENT amount

- $TOTAL_ITM_IUN_4 - Will calculate total ITM
CASH DOWN amount

Both the parameters (formula and target) supports the following data types:
e Number/ Integer (both are considered as floating numbers)
e Date
e Character

While defining specific parameter, system auto-filters the variable list based on the supported
data type.

To enable any target parameters, ensure that there is at the least one enabled formula

parameter and selection criteria defined. Also while defining target parameters, ensure that
there is no circular dependency where two or more parameters are either directly or indirectly
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dependent on each other. For example, If formula parameter A is defined as ACC_FIELD1 +
formula parameter B, and formula parameter B is defined as ACC_FIELD2 + formula

parameter A. In such a case, system displays an error indicating ‘CIRCULAR DEPENDENCY

DETECTED FOR PARAMETER:<<PARAMETER NAME>>".

The user defined parameters calculation can be triggered in any of the following ways:

in SET-CUP batch job-set

Option Trigger Action Type
User Clicking ‘Calculate Parameters’ | System calculates and updates target
Interface button in Account Details parameter through background job
screen, Account Information process which is created to update
section. UDP values asynchronously.
Target parameters of Error/Validation messages received
Frequency = None and Daily during calculation of user defined fields
are computed and updated for | are displayed under Background job
an account and all collaterals and not displayed in Ul.
associated to the account.
Clicking ‘Calculate Parameters’
button in Collateral
Management, Collateral Details
screen.
Target parameters of
Frequency = None and Daily
are computed and updated
only for the selected collateral.
Batch Job On executing batch jobs - On execution, this batch job calculates
for Account | USER DEFINED ROOT all target parameters defined for
Target BATCH JOB and USER Account that satisfy the selection
Parameters | DEFINED ACCOUNT TARGET | criteria.
update PARAMETER CALCULATOR

Root batch job is parent batch job and
is executed first to pick all accounts
eligible for calculation for the child
batch job i.e. Account Target
Parameter Calculator. This helps to
enhance system performance.

The batch job periodically calculates for
target parameters of frequency other
than None and updates the Next Run
Date for parameter as per frequency
defined.

Note that, batch job picks-up accounts
only once per day and refers to
company specific GL date.

Accounts in OFSLL are associated to
specific company - branch
combination. Hence this batch set and
job should be configured at every
company branch level.
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Option Trigger Action Type
Batch Job On executing batch jobs - On execution, this batch job calculates
for USER DEFINED ROOT all target parameters defined for
Collateral BATCH JOB and USER collateral entity that satisfy the
Target DEFINED COLLATERAL selection criteria.
Parameters | TARGET PARAMETER L .
update CALCULATOR in SET-CUP{ | 0ot batch job is parent batch job and
batch job-set is executed first to pick all accounts
eligible for calculation for the child
batch job i.e. Collateral Target
Parameter Calculator. This helps to
enhance system performance.
The batch job periodically calculates for
target parameters of frequency other
than None and updates the Next Run
Date for parameter as per frequency
defined.
Note that, batch job picks-up accounts
only once per day and refers to
company = ALL GL date.
Collateral in OFSLL are not associated
to any specific company hence this
batch set and job should be configured
for company = All.
Event Configured Event Action Type - | Update Account/Collateral Target
1. UPDATE ACCOUNT USER | Parameters of frequency = None and
DEFINED PARAMETERS Daily when specific type of changes
2 UPDATE COLLATERAL g\c/:gtrj]:selrr:ti?FSLL for Account/Collateral
USER DEFINED Y-
PARAMETERS
For more details on defining
event action type, refer to
‘Events (New Framework)’
section.
RestfulWeb | Calculate Parameter Update When third-party system post a request
Service Service (available in common to update specific or all Target

Swagger module)

Parameters for a single Account, single
Collateral or all collateral associated to
an account based on 'Entity Type'
parameter updated in web service
request.

This parameter accepts only ACC for
accounts and ASE for Collateral target
parameters. Target parameter of
frequency None and Daily are updated
through this web service.

Refer swagger documentation for more
details.
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During executing, system looks into the enabled user defined parameters, and considering
only those accounts matching the selection criteria, values are computed into the user defined
fields.

During computation of target parameters, system displays an error if there are more than one
definition defined for a target parameter.

To set up the User Defined Parameters

1. Click Setup > Setup > Administration > System > User Defined Parameters.

ORACLE # Welcome, ABSHEKAR ~ 1 Sign out &
Financial Services Lending and Leasing

User Defined Parameters x (3 close
Parameters W+ Add |/ Edit View 7 Audit
View v Format v [ eeze [ Detach Wrap @)  New Parameter Create Copy Show Expression

Module Entity Type Parameter Type Parameter Name  Description Data type Priority Frequency Run Date Next  Enabled

CUSTOMER SERVL.. COLLATERALS TARGET PARAMETER ASE_UDF2_CHAR  ADDITIONAL PLA... CHARACTER [ NONE Y

CUSTOMER SERVL.. ACCOUNTS TARGET PARAMETER ACC_UDF2_CHAR  ADDITIONAL PLA... CHARACTER [ DAILY 04/17/2020 N

CUSTOMER SERVL... COLLATERALS TARGET PARAMETER ASE_UDF1_DATE  ADDITIONAL PLA... DATE [ DAILY 04/18/2020 Y

CUSTOMER SERVL... COLLATERALS TARGET PARAMETER ASE_UDF1_NUM  ADDITIONAL PLA.. NUMBER 0 DAILY 04/18/2020 Y

CUSTOMER SERVL... ACCOUNTS TARGET PARAMETER ACC_UDF7_NUM  ADDITIONAL PLA... NUMBER [ DAILY 04/21/2020 Y

CUSTOMER SERVL.. ACCOUNTS TARGET PARAMETER ACC_UDF1_DATE  ADDITIONAL PLA.. DATE 0 DAILY 04/21/2020 Y

CUSTOMER SERVL.. ACCOUNTS TARGET PARAMETER ACC_UDFS_ NUM  ADDITIONAL PLA.. NUMBER 0 NONE Y

CUSTOMER SERVL.. ACCOUNTS TARGET PARAMETER ACC_UDF7_NUM  ADDITIONAL PLA.. NUMBER [ NONE Y

CUSTOMER SERVL... ACCOUNTS TARGET PARAMETER ACC_UDFS_NUM  ADDITIONAL PLA.. NUMBER 0 NONE Y

CUSTOMER SERVL... ACCOUNTS TARGET PARAMETER ACC_UDF4_ NUM  ADDITIONAL PLA... NUMBER 0 NONE Y -

M Parameters
& save and Stay, || [ Save and Return || GaRetum

Module CUSTOMER SERVICE Parameter Name -ADDITIONAL PLACEHOLDER STRING 2 *Priority 0

Entity Type COLLATERALS Description ADDITIONAL PLACEHOLDER STRING 2 - =

parameter type TARGET PARAMETER Data type CHARACTER
*Enabled @
Formula Expression
Expression
Formula Definition  Selection Crteria
Formula Definition P Add Edit View 7 Audit
View v Format~ [ Freeze [} Detach Wrap o

Seql( Variable Constant Value Mathematical ) Enabled -

2. In the Parameters section, do one of the following:

e Use the ‘Create Copy’ feature to quickly create new parameter with the existing
parameter details. For Target Parameters, select required record and click ‘Create
Copy’. For Formula Parameters, select required record, specify ‘New Parameter’ name
and click ‘Create Copy’. The new parameter created this way will be in disabled state
by default.

e Add/Edit user defined parameter by performing any of the Basic Operations mentioned
in Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Module Select the module from the drop-down list. The list is displayed
based on the modules that support User Defined Parameters
calculation. Currently only Customer Serving (accounts) is
supported.

Entity Type Select the required entity for which calculation is to be defined
from the drop-down list. The list is populated based on entity type
maintained in CUP_ENTITY_CD lookup code.

Currently, system supports ACCOUNTS and COLLATERALS
entity types.

Note that, entity can be selected only while creating User Defined
Parameter and the same cannot be modified in Edit mode.

Parameter Type Select the type of parameter to be defined as either Target
Parameter or Formula Parameter from the drop-down list.
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Field Do this:

Parameter Name For Target Parameter, system displays the list of custom fields
available in user defined table for selection. Select the required
Parameter from the drop-down list. By default the first field in the
user defined table is selected.

For Formula Parameter, this is a text field to record the new
parameter name. Specify the name of the formula parameter.

Description For Target Parameter, the description is auto-populated from user
defined table and is Read-Only.

For Formula Parameter, specify the description of the formula
parameter.

Data Type For Target Parameter, the data type associated for the parameter
is auto-populated from user defined table and is Read-Only.

For Formula Parameter, select the data type as one of the
following from the drop-down list - INTEGER, DATE, NUMBER, or
CHARACTER

Priority Specify the order in which system should evaluate the parameter
definitions while executing the batch job or on clicking ‘Calculate
Parameters’ button.

For example, if a formula parameter A has dependency on
parameter B, then B has to be calculated first in the order and
priority is set as ‘0.

Frequency Select the required frequency at which the target parameters are
to be calculated from the drop-down list.

Frequency field is applicable only for Target Parameters and the
list of frequency supported is populated based on values
maintained in CUP_FREQUENCY_TYPE_CD lookup code.

Note the following:
- Frequency can be defined only in Edit mode.
- Frequency is not applicable for Formula Parameters.

- Frequency ‘None’ can be selected for target parameters that are
required to be calculated on adhoc basis.
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2.5.1

Field

Do this:

Run Date Next

View the date on which the Target parameter is calculated. The
Run Date Next is auto calculated based on frequency defined.

This field is applicable only for Target parameters and for
frequency other than ‘None’.

Note the following:

- For multi-company implementation, it is recommended to add
same User Defined Parameter definition multiple times for each
company. This in-turn updates ‘Run Date Next’ for each company
and supports updating values at different zone based on batch job
setup.

- Currently the ‘Run Date Next’ is updated even if not all the
records are computed based on selection criteria. Since this
impacts to restart failed records, the same shall be addressed in
subsequent patch releases.

Enabled

Check this box to enable the parameter definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Formula Definition

The Formula Definition section allows you to define a mathematical expression of the
formula to evaluate the parameter definition. The expression may consist of one or more
sequenced entries. All arithmetic rules apply to the formula definition. If errors exist in the
formula definition, the system displays an error message in this section when you choose
Show Expression.

4. In the Formula Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Seq

Specify the sequence number (the order in which the formula definition
variable will be assembled and evaluated).

Specify a left bracket, if you need to group part of your formula definition.
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Field: Do this:

Variable Select the variable from the drop-down list which consists of a validated
list derived from user defined table type as indicated below:

- For Number, system displays only numeric fields

- For Date, system displays numeric + date fields

- For String, system displays numeric + character fields

Parameters for ‘Account’ entity type in Customer Service is derived from:
USER DEFINED: ACCOUNTS FORMULA PARAMETERS

USER DEFINED: COMMON FORMULA PARAMETERS

USER DEFINED: COMMON CUSTOMER SERVICE FORMULA
PARAMETERS

Parameters for ‘Collateral’ entity type in Customer Service is derived
from:

USER DEFINED: COLLATERAL FORMULA PARAMETERS
USER DEFINED: COMMON FORMULA PARAMETERS

USER DEFINED: COMMON CUSTOMER SERVICE FORMULA
PARAMETERS

Constant Specify the constant value (optional).
Value

- For Number, system supports only numeric constants
- For Date, system supports only humeric constants
- For String, system supports both numeric and character constants

Note: System displays an error indicating ‘VARIABLE OR CONSTANT
VALUE IS REQUIRED’ if both Variable and Constant Value or None is
provided.

Mathematical | Select the math operator to be used on the adjacent formula definition
Operator rows, from the drop-down list. The list is derived and displayed based on
data type / variable as indicated below:

- For Number, system allows all numeric operators (+, -, x, and %).
- For Date, system supports (+ and -) operators.

- For String, system supports concatenation (i.e. +) operator.

) Specify a right bracket, if you are grouping part of your formula definition.

Enabled Check this box to enable the formula and indicate that it is included when
building a parameter definition.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. In the Parameters section, click ‘Show Expression’. The mathematical expression
appears in the Formula Expression section (in sequential order) in the Expression field.

2.5.2 Selection Criteria

The sub tab is enabled only for Target Parameters and facilitates to define the selection
criteria indicating the type of accounts to be picked for computation. The parameters are
derived from user defined table - USER DEFINED: ACCOUNT CRITERIA TYPE CODE and
USER DEFINED: COLLATERAL TYPE CODE as per Account and Collateral Entity type.
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2.6

1. In the Selection Criteria section, perform any of the Basic Operations mentioned in
Navigation chapter. A brief description of the fields is given below:

Field: Do this:

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list. The list is

populated based on the values maintained in user defined
table - Customer Service: USER DEFINED: CUSTOMER
SERVICE CRITERIA PARAMETERS.

Comparison Operator Select comparison operator from the drop-down list.
Criteria Value Specify criteria value.

) Specify right bracket.

Logical Expression Select logical operator from the drop-down list.
Enabled Check this box to enable the selection criteria.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

3. Click ‘Check Criteria’ for system to validate the query and display the results.

If the formula expression is mathematically incorrect when parameters are calculated, system
displays error indicating ‘INVALID FORMULA EXPRESSION: <<FORMULA PARMETER>>".

Transaction Codes

The system uses transaction codes to define the actions and tasks it can perform; for
example, activating an account, changing a due date, applying a late fee, and charging off an
account.

The Transaction Codes Setup screen catalogs and defines these core system actions.
Three sub screens, Parameters, Access Grid, and Products, record any additional information

required to perform a transaction, the user types that can perform the transaction, and the
product type to which the transaction codes apply.

Note

The Software recommends that you restrict the access to the seed data once you are in
production.

To set up the Transaction Codes

1. Click Setup > Setup > Administration > System > Transaction Codes. The system
displays the Transaction Codes screen.
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2.

ORACLE

Financial Services Lending and Leasing

In Transaction Super Group section, you can view the following information

DashBoard
> Origination
1 Servicing

Transaction Codes 5

Transaction Super Group

View ~ Format w Freezs 5 ol Wrap
T & Freeze ifiDetach ol wirep (e
Super Group.
> WFP ACCOUNT MONETARY TXN
* Tools ACCOUNT NON MONETARY TXN
AMORTIZATION TXN
Setup
Setup
Administration ' Transaction Codes
System =
s Vieww Format~ B Freeze i Detach Al wrap o)
Lookups Tan Code Description Group Adtion Monetary
User Defined Tables
EADV ESCROW ADVANCE  ESCROW poST 7
Audit Tables
User Defined Defaults EADV_AD]_MINUS ADJUSTMENT TO_.  ESCROW ADIUST MINUS L
Transaction Codes EADV_ADJ_MINUS_REV ~ REVERSE ADJUST.. ESCROW REVERSE ¥
Data Files: EADV_AD]_PLUS ADJUSTMENT TO... ESCROW ADIUST PLUS Y
Dyt EADV_AD] PLUS REV  REVERSE ADIUST... ESCROW REVERSE Y
Securitization
—_— EADV_BILL ESCROW ADVANC... ESCROW BILL Y
Batch Jobs §  EADV_BIL REV REVERSE ESCRO...  ESCROW REVERSE Y
Producer Cycles EADV_CHGOFF CHGOFF ESCROW... ESCROW CHARGE OFF/WRITE... Y
Vendors
Collection Cydles
Reports Parameters  Access Grid | Products
Error Messages
Translations
Aeee Transaction Parameters
Organization . R
gt View~ Format~ [Ep Efipetach | ol Wiap 7]
e Parameter code Defaut
jeiien No data to display.
Credit Bureau
Comespondence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Fzyess
Currencies
Zip Codes
Products
Asset Types W

30 Close:
A
v
Fpadd | Aedie | [S]view | o it
System Defined g o1 TyryBal Type Statement Tin Type Batch
Yes/No
Yes® No Y ESCROW ADVANCE ESCROW ADVANCE N
Yes@ No Y ESCROW ADVANCE ADJUSTMENT TO ESCROW. N i)
Y ESCROW ADVANCE REVERSE ADJUSTMENT TO. N
Y ESCROW ADVANCE ADIUSTMENT TO ESCROW. N
Y ESCROW ADVANCE REVERSE ADJUSTMENT TO. N
¥ ESCROW ADVANCE ESCROW ADVANCE BILLED N
Y ESCROW ADVANCE REVERSE ESCROW ADVANC.. N v
Y ESCROW ADVANCE CHGOFF ESCROW ADVANCE N
>
Fpadd | Ledt | Blvew | o audit
Sort Displayed? Yes/No Required? Yes/No

A brief description of the fields is given below:

Field

Do this:

Super Group

Select the Super Group you want to work with in the Transaction
Codes screen.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.

Navigation chapter

ORACLE’

Financial Services Lending and Leasing

In the Transaction Codes section, perform any of the Basic Operations mentioned in

Transaction Codes x

Transaction Super Group

Transaction Codes

View v Formatv [ Freeze [ Detach Wrap
Super Group
ACCOUNT MONETARY TXN
ACCOUNT NON MONETARY TXN
AMORTIZATION TXN
Transaction Codes
View v Format v (G0 Freeze [ Detach Wrap
@ WACTIVE%
Txn Code Description Group
ACTIVE ACTIVE STATUS CHANGE
ACTIVE_REV REVERSE ACTIVE STATUS CHANGE

Txn Code  ACTIVE
* Description ACTIVE
*Group STATUS CHANGE

* Action POST
* Monetary
Parameters  Access Giid  Products

Transaction Parameters

OYes
ONo
- System Defined
Action Monetary VIZNG Enabled Txn/Bal Type
POST ¢ Yes No y NONE
REVERSE Y Yes @No vy NONE
* System Defined Yes/No (C
* Enabled
= * Tx/Bal Type NONE
v

* Statement Txn Type NONE
*Batch (J

[3€] Close

4 add | A Edit View o Audit

Recalc

Statement Txn Type Batch Manual ﬁ:fme”‘ GL Event Maste
T
NONE N N N N N Y

NONE N Y N N N N -
R caunand ey | [ save and Retumn || GaRetum

Check box If the transaction is a manual transaction
* Manual
* Statement Print
*GL
* Event
* Recalc Master Txns

% add

/ Edit

View

4 Audv&
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A brief description of the fields is given below:

Defined Yes/
No

Field Do this:

Txn Code Specify the transaction code (required).

Description Specify the description for the transaction.

Group Select the transaction group (the group within the Transaction Super
Group that the transaction code belongs to) from the drop-down list.

Action Select the action type code for the transaction (what action will take
place when the transaction occurs) from the drop-down list.

Monetary Check this box to maintain the transaction as a monetary transaction. If
unchecked, then the transaction is nonmonetary.

System Select ‘Yes’, if you wish to maintain the transaction code as system

defined and ‘No’, if you do not want to maintain it as system defined.
System defined entries cannot be modified. If entry is not system
defined, then it can be modified.

Enabled

Check this box to enable the transaction.

Txn/Bal Type

Select the transaction / balance type affected by the Transaction from
the drop-down list.

Master Txns

Statement Select the statement transaction type (how the transaction should

Txn Type appear on the customer statement) from the drop-down list.

Batch Check this box to perform the transaction in a batch process.

Manual Check this box, if the transaction is a manual transaction. If you define a
transaction as manual, the system recommends that the transaction
that reverses it also be defined as manual.

Stmt Print Check this box to print the transaction on customer statements.

GL Check this box, if the transaction is a general ledger transaction.

Event On selecting this check box, the particular Monetary/Non-Monetary
transaction is considered for triggering of respective Monetary and Non-
monetary transaction posting Event type. The particular Monetary/Non-
Monetary transaction is available while defining Event Actions.

For more information, refer to Events (New Framework) section.

Recalc Check this box for system to recalculate and repost consolidated fee at

Master Account level. This is done automatically by identifying those
monetary transactions which should trigger recalculation of Late
Charge, Cycle Based Late Fee and Cycle Based Collection Late Fee at
Master Account level when backdated transaction is posted on any
Associated Account that is marked for fee consolidation.

For more information, refer to ‘Cycle Based Fees’ and ‘Fee
Consolidation’ sections in ‘Contract’ setup screen.

5. Perform any of the Basic Actions mentioned in Navigation chapter.
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2.6.1 Transaction Codes sub screens

The Transaction Codes screen contains three sub screens:
e Parameters
e Access Grid
e Products

Note

Please contact your System Administrator / Implementation Manager before making any
changes in these sub screens.

2.6.1.1 Parameters

Here, you can define the parameter information for the associated transaction. The
Parameters apply exclusively to these super groups:

e AMORTIZATION TXN

e PRODUCER MONETARY TXN
e FUNDING TXN

e ACCOUNT CONDITION TXN

e CORRESPONDENCES

e FEE ASSESSMENTS

(For manual transactions, these are the parameters that appear when you click Load
Parameters on the Customer Service screen’s Maintenance screen.)

Note

Treat the Transaction Parameters sub screen as containing view-only information. This is
very sensitive data and you should not change it without consulting Oracle Financial Ser-
vices Lending and Leasing.

To set up the Parameters

1. Click Setup > Setup > Administration > System > Transaction Codes > Parameters.

2. Inthe Transaction Parameters section, perform any of the Basic Operations mentioned
in Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Parameter Select the parameter code associated with the transaction code, from
Code the drop-down list.

Default Specify the default value for the transaction parameter (value to initially

populate, or used if no value is supplied).

Sort Specify the sort order for the transaction parameter.
Displayed? Select ‘Yes’ to display the parameter and ‘No’ if you do not want to
Yes/No display in current use.

2-28 ORACLE



2.6.1.2

Field Do this:

Required? Select ‘Yes’ if the parameter is required and ‘No’ if you do not require the
Yes/No parameter. (You must select Required as empty values are not allowed.)

3. Perform any of the Basic Actions mentioned in Navigation chapter.
Access Grid

The Access Grid sub screen allows you to control access to each transaction according to
user responsibility, account status, and account condition. It allows the administrator to
control when these transactions may be conducted. Normally, you would create or modify the
access based on either the user responsibility or account condition. Account status access is
left unchanged.

To set up the Access Grid sub screen

1. Click Setup > Setup > Administration > System > Transaction Codes > Access Grid.

2. Inthe Transaction User Access Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Access Type | Select the access grid function type (ACCOUNT CONDITION AND
ACCOUNT STATUS) that is being used to control the creation of the
associated transaction, from the drop-down list.

Access Select the access function grid value from the drop-down list (based on a
Value lookup associated with the Access Type. Multiple entries for each access
type may be created as long as each has a different access value).

Allowed? Select ‘Yes' if the access is allowed and ‘No’ if the access is not allowed
Yes/No (indicates whether the current Access Type / Access Value may create
the associated transaction).

System Select ‘Yes', if you wish to maintain access type as system defined and

Defined Yes/ | ‘No’, if you do not want to maintain it as system defined. System defined

No entries cannot be modified. If entry is not system defined, then it can be
modified.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.6.1.3 Products

The Products sub screen allows you to define the products to which the transaction codes
apply. It allows the administrator to control if the associated transaction code will be available
for use for specific product types and or funding types.

Normally, an Access Value of ALL is defined for one or more Access Types with a given

Allowed value. Additional Access Values are then defined for the same Access Types with the
opposite Allowed value. This controls access to the associated transaction.

To set up the Products sub screen

1. Click Setup > Setup > Administration > System > Transaction Codes > Products.
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2. Inthe Transaction Product Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Product Type Select the product type associated with the transaction code from
the drop-down list.

Funding Type Select the funding type associated with the transaction code from
the drop-down list.

Allowed? Yes/No | Select ‘Yes’ if the transaction is allowed and ‘No’ if the transaction is
not allowed (indicates whether the current Access Type / Access
Value may create the associated transaction).

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Data Files

The Data Files Setup screen organizes information pertaining to the various input/output data
files that the system can generate. The system uses the Data Files Setup screen to outline
the file layouts of each data file produced/received within the system, including the length and
data type of each column name.

These files are typically produced during the nightly process.
One major advantage for the system-defined data files is the format mask of each column
name within each data file. A format mask is like a stencil that forces data input to be of the

same format before accepting the data.

You can change the order in which the fields are displayed in the file.

Note

Any addition or removal of a field or change in the data type length requires the Software
involvement.

Data Files screen consists of the following two tabs:

e Output
e Input

Output tab

The Output tab in the Data Files screen allows you to define the structure of output data file
through the following sections:

e Data File Definitions
e Record Definitions
e Column Definitions

Data File Definitions

The Data File Definitions section defines specific data files. Each is associated with a specific
Output Data Definition (ODD) batch job that gathers the data that the file will contain. While
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new data file definitions may be created they will have no use unless a batch job is also
created to populate the data.

To set up Data File Definitions

1. Click Setup > Setup > Administration > System > Data Files > Outpout tab.

2. Inthe Data Files Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’
Financial Services Lending and Leasing

@8 Barkuptcy x || Data Files x [3€] Close
Output | Input

* DashBoard

iti i add || 2 Edt view || o Audit
* Origination Data File Definitions G ZE El w o Audi
> Serviding View  Format ~ [0 Freeze EliDetach | ol Wrap 5]
- " %BANKO% a
?» Collections ¢ =
= Name Description File Name Directory Path System Defined Yesjho
MR UNDEFINED s Ol
Gk BANKO_INTERFACE LMY BANKO INTERFACE L _banko_output_S(COMPANY_CODE... UNDEFINED
Setup <
Setup
Administration Data File Definitions
System \ [ save an dadd || [ saveandstay || [ seveandRetum || GaRetn
System Parameter g
Loy *Name * Directory Path | UNDEFINED
User Defined Tables =
- System Defined Yesio () Yes(® No
Audit Tables i s
User Defined Defaults *File Name Ensbled [F}
Transaction Codes
Record Definitions o Add = & A
Vview > Formatv Freere L Detach tirap 50

Record Type Desaription Record Format. Delmiter Terminator
o data to display.

Column Definitions o Add || 2 Edit
Vview v Formatv Freeze G Detach Wrap 20}
Seq Column Name Data Type Format Mask Length DataCoumn  Output Column
o data to display.

A brief description of the fields is given below:

Field Do this:

Name Specify data file type (name of data file definition).

Description Specify data file description.

File Name Specify data file name. Prefix used for files generated for this Data

File. This is the only field on the Data File Definitions screen that can
or should be modified by your Administrator. The generated file name
will be in the form of <FILE NAME> <COMPANY ID> <BRANCH
ID> <MMDDYYYY> <PROCESS ID>.DAT. The inclusion of
_<COMPANY ID>and <BRANCH ID> depends entirely on the
associated batch process.

Directory Path Specify the directory path.

System Defined | Select ‘Yes’, if you wish to maintain the data file definition as system
Yes/No defined and ‘No’, if you do not want to maintain it as system defined.
System defined entries cannot be modified. If the entry is not system
defined, then it can be modified.

Enabled Check this box to enable the data file definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.7.1.2 Record Definitions

Each data file definition is made up of one or more record definitions. These define
organization of the data. The associated batch file determines how these records are used.
The order in which the data is populated determines the order in which those records will
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appear in the output file. This is generally related to the order the records appear in the Data
File Definition section.

1. In the Record Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field

Do this:

Record Type

Specify the type of record being defined.

Description

Specify record description.

Record Format

Select the format of output data (FIXED, VARIABLE) from the drop-

down list.

Delimiter Specify the delimiter (column separator used with VARIABLE
format).

Terminator Select the record terminator code (how the end of each record is

CARRIAGE RETURN AND LINE FEED) from the drop-down list.

indicated within the file -- CARRIAGE RETURN, LINE FEED, or

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Column Definitions

Each record definition is made up of one or more column definitions. These define the output
of the data. Much of this data is informational; it indicates what data is being provided by the
associated batch job. Unless otherwise noted, the data should not be changed without
changing the associated batch job.

1. In the Column Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field

Do this:

Seq

Specify the order in which the output data dump will process the
column information.

Column Name

Specify name/description of the column (informational only).

Data Type

Specify the data type. This describes the type of data the column is
expected to contain (CHARACTER, DATE, or NUMBER). This effects
how the ODD process handles the data, and should not be changed

Format Mask

Select the format mask for the column from the drop-down list. For
DATE or NUMBER columns, this field defines the output format of
the data. For example; Date fields may be entered using the MM/DD/
YYYY format, Number fields may be entered as decimal numbers
with varying degrees of precision. Other formats for each data type
are available.
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Field Do this:

Length Specify the column length (the maximum number of characters of the
output data to be included in the output file). Each output data details
column may contain up to 240 characters of data. If the output data
details column contains more data than the length value the data will
be truncated. For VARIABLE records the length should be set to “-1”
or a Delimited file will be created with FIXED LENGTH columns.

Data Column Specify the data column sequence. This is the column that will be
used to select the data that is being output. This should not be
changed.

Output Column Specify the output column sequence. This is the column that will
appear in Output File. The Output Data Dump process allows for the
output of 250 columns of data per record. No output column should
be repeated in the setup for a record.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

2.7.2 Input tab

Oracle Financial Services Lending and Leasing facilitates processing of a input data file
received from external interface into the system through an automated batch job
(IDDPRC_BJ_000_01) triggered on regular intervals.

The Input tab in the Data Files screen allows you to define the input data file through the
following sections:

e Input Data File Definitions
e Column Definitions

2.7.2.1 Input Data File Definitions

In the Input Data File Definitions section, you can define and maintain the structure of input
data file to populate data from external system.

Oracle Financial Services Lending and Leasing also supports bulk upload of data into the
system through input file processing for a set of process listed in Setup > Administration >
System > Lookups > Lookup Code section.

Lookup Type: INCOMING_FILE_TYPE_CD

Description: INCOMING LOG FILE TYPE CODE

In addition, there is also an option for configurable bulk upload of data in which the input file
delimiter is configurable to required value. For more information, refer to Configurable Bulk
Upload section.

To set up Input Data File Definitions

1. Click Setup > Setup > Administration > System > Data Files > Input tab.

2. Inthe Input Data Files Definitions section, you can make use of the copy option to copy
the Input file definition and corresponding column definitions. To do so, click on the
required record in the list, select the target company for which records needs to be
created from ‘Company’ drop-down list and click ‘Create Copy’. The following records are
copied:

— ITU_TXN_UPLOAD
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— ASSET_ASE_UPLOAD
— ASSET_ATA_UPLOAD
— ASSET_ATR_UPLOAD
— ASSET_AVL_UPLOAD
— CURE_LTR

— BKRP_NEW

— BKRP_UPDATE

Records for above files are created with 'External Table Name' as 'External Table
Name_Company code'.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

ORACLE’ & Welcome ABSHEKAR ~ o
Financial Services Lending and Leasing
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API_ACCOUNTS api_acc_111.dat ACCOUNTS RECORD APL B VARIABLE APLACC_LOAN_E... ALL 7 ~
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API_ACCOUNT_REPMT_SCHEDULE api_acp_111.dat ACCOUNT REPAYMENT SC... API i VARIABLE APL_ACP_LOAN_EXT ALL Y

API_ASSETS api_ase_111.dat ASSETS RECORD APT ) VARIABLE API_ASE_LOAN_EXT ALL Y v

»
Column Definitions P Add | ZEdt | [ View | & Audit
View v Formatv [ Freeze |} Detach Wrap W

Seq Column Name Column Description DataType  Format Mask  Length sort Enabled

194 'ACC_AAG_END_DT ACCOUNT AAG END DATE DATE MM/DD/YYYY 8 194 ¥ ~
195 ACC_AAG_IND ACCOUNT AAG INDICATOR CHARACTER NOT APPLIC... 30 195 Y

193 ACC_AAG_START_DT ACCOUNT AAG START DATE DATE MM/DD/YYYY 8 193 L4

8 ACC_ACCRUAL_DT_LAST /ACCOUNT ACCRUAL DATE LAST DATE MM/DD/YYYY 8 8 Y

210 ACC_ACCRUAL_DT_START  ACCOUNT ACCRUAL DATE START DATE MM/DD/YYYY 8 210 Y

9 ACC_ACCRUAL_STOP_IND  ACCOUNT ACCRUAL STOP INDICATOR CHARACTER  NOT APPLIC... 30 9 Y

2% ACC_ACH_ACCOUNT_NBR_C... ACH ACCOUNT NUMBER CURRENT CHARACTER  NOT APPLIC... 30 2% Y

23 ACC_ACH_ACCOUNT_TYPE _... ACH ACCOUNT TYPE CODE INDICATOR CHARACTER  NOT APPLIC... 30 3 Y

21 ACC_ACH_BANK_NAME_CUR  ACCOUNT ACH BANK NAME CURRENT CHARACTER NOT APPLIC... 30 21 L4

22 ACC_ACH_BANK_ROUTING_... ACCOUNT ACH BANK ROUTING NUMBER CURRENT CHARACTER NOT APPLIC... 30 22 Y v

A brief description of the fields is given below:

Field Do this:

Name Specify a unique name for the input data file.
File Name Specify the data file name with the correct prefix.
Description Specify data file description.

Directory Path Specify the directory path configured within OFSLL Database server
to process the input data file.

Delimiter Specify the delimiter used to separate column data. (Ex: Comma).

Record Format | System defaults the record format as ‘VARIABLE'.

External Table View the name of external table from which input data is populated.
Name

Company View the company name selected in external table.

Enabled Check this box to enable the input data file definition.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
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2.7.2.2 Column Definitions

Each input data file definition is made up of one or more column definitions. These define the
structure of data to be loaded from external system.

1. In the Column Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Seq Specify the order in which the input data dump will process the
column information.

Column Name Specify name of the column.

Column Specify description of the column.

Description

Data Type Select the data type from the drop-down list. The selected data type

describes the type of data the column is expected to contain such as
INTEGER/DATE/NUMBER/CHARACTER. This effects how the input
data file processing handles the data, and should not be changed.

Format Mask Select the format mask for the column from the drop-down list. The
list displays the format depending on the Data Type selected.

For example; Date fields may be entered using the MM/DD/YYYY
format, Number fields may be entered as decimal numbers with
varying degrees of precision. Other formats for each data type are
available.

Length Specify the column length (the maximum number of characters of the
data to be included in the input file).

Each input data details column may contain up to 240 characters of
data. If the output data details column contains more data than the
length value the data will be truncated. For VARIABLE records the
length should be set to “-1” or a Delimited file will be created with
FIXED LENGTH columns.

Sort Specify the order in which the column definitions are to be sorted for
display in the external interface screen (Customer Service > External
Interfaces). There can be a maximum of 61 column definitions.

Enabled Default selected. If not, you can check this box to enable the column
definition.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

2.7.2.3 Configurable Bulk Upload

In the process of configurable bulk upload of data, the input file delimiter is configurable to
required value and data is processed based on the column definitions defined. This option is
supported for Transactions and Collateral uploads to create new transactions and asset
records in bulk.
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2.8

For bulk upload of data, the input CSV (comma separated values) file is to be constructed in
specific format as defined in Setup > Data Files > Input screen’s ‘Input Data File Definitions’
and ‘Column Definitions’ sections.

For example, consider the following Column Definition details:

Seq | Column Name Column Description Data Type Length | Sort

1 ASE_OPERA- OPERATION IND CHARACTER | 30 1
TION_IND

2 ASE_NBR ASSET NUMBER NUMERIC 30 2

3 ASE_REGN_DT | REGISTRATION DATE | DATE 30 3

If the delimiter in Input Data file definitions is set as ‘,’ (comma), then the csv can be
constructed in same format and sequence of column definition as indicated below with each
row as one record:

ASE_OPERATION_IND,ASE_NBR,ASE_REGN_DT
NEW,20151200010476,12/08/2015
EXISTING,20111300010468,13/10/2011
NEW,20101400010812,14/11/2016

The CSV file is to be paced in the directory path/work area which is the base path defined in
system parameter - UIX_INCOMING_FILE_PATH (INCOMMING FILE PATH OF APP
SERVER) by the system administrator and further appended by the configurable sub folder
name such as ITU or ICC. For example: /scratch/work_area/<domain name>/input/itu.

Following are the Lookup code maintained in Setup > Administration > System > Lookups >
Lookup Code section for respective process type:

Process Type Lookup Code | Description
Transaction File Upload | ITU TRANSACTION UPLOAD
Asset File Upload ICC INPUT CREATE COLLATERAL

e For Transaction File Upload, only one csv file can be created with multiple records and
on processing, the data is populated into Servicing > Customer Service > Transaction
> History > Transactions tab.

e For Asset File Upload, separate csv files are to be created to upload the data into
Collateral Management screen’s Collateral details, Valuation, Addons/Attributes, and
Tracking sections respectively.

On executing the scheduled batch job in SET-IFP, IDDPRC_BJ 000 02 (BULKINPUT DATA
INSERTION), the data in csv file is processed and is displayed in Servicing Customer Service
> External Interfaces tab. Such data does not need authorization and is directly uploaded on
validating the sequence, position, and format.

The status of batch job can be viewed in DashBoard > System Monitor > Batch Jobs screen.
The records which resulted in error are listed in the bad file.

Securitization

With the Securitization Setup screen, the system provides a powerful tool that enables
financial institutions to create account pools, to track and manage portfolios.
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The Securitization Setup screen enables you to:

e Query account information

e Select accounts based on selection criteria

e Create a pool of selected accounts for sale

e Maintain the pools created and report transactions on these accounts
e Report on investors

e Repurchase pools or specific accounts from pools.

Securitization screen enables you to define the securitization cycles, as well as the

responsibilities that can access the various statuses in each cycle. The following diagram
demonstrates the status cycle:

transacnon
liquidate or repurchase
Pending

m Y transaction

pool sale

Held for sale

To create a cycle

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > System > Securitization. The system displays the Status Cycle set
up screen. The details are grouped into three:

e Status Cycle
e Current/Next Status
e Status Change Responsibilities

2. In the Status Cycle section, you can view the following details.

opacte

Financial Services Lending and Leasing

itizatic Close
T Securitization x [ed
) Origination =
i Status Cycles [ view
5
jaseang Views Fomate B [ Frece i Detach w @
) Collections o =
S WEP POO_POOL ACC_STATUS SECURITIZATION POOL ACCOUNT STATUS CYCLE
PO0_POOL STATUS SECURITIZATION POOL STATUS CYCLE
» Tools
Setup
setup Current/ Next Status badd | Elview | o audt
Administation Views Fomaty [ [ Freee B Detach wap @
spen Curent Sttus Next Status
System Parameter
Lo ACTIVE CHARGED OFF
User Defined Tables e LQUIDATE
Audit Tables ACTIVE PAID OFF
User Defined Defaults ACTIVE REPURCHASED
Transaction Codes ACTIVE von
Data Files 4 crarceD OFF ACTNE
Dedupe CHARGED OFF LIQUIDATE
Seuritization CHARGED OFF PAID OFF
By CHARGED OFF REPURCHASED v
Batch Jobs
Froducer Cycles Current/ Next Status
Vendors
dswveandat | [ soveandstay | [l sveand Retum | Gagetum
Collcton Cydes Disereandsia | © ARE @
Reports
. Status v
Ertor Messages s
Translations Neit Status v
> User
) Products Status Change Responsibilities deadd | Lt | Eview | o audt
> Wi
Yoe Vieww Fomatv [} | Freeze i Detach wap @
Responsiilty Allowed
o data to display.
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A brief description of the fields is given below:

Field: Do this:
Cycle View the cycle code.
Type View the cycle type.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Current/Next Status section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Current Status Select the current status from the adjoining drop-down list.
Next Status Select the next status from the adjoining drop-down list.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Inthe Status Change Responsibilities section, you can define the responsibilities that
are authorized to change the code. Perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Responsibility Select the responsibility that will be capable of executing this
transition, from the drop-down list.

Allowed Select ‘Yes’ to allow change to the status responsibility and ‘No’ to
disallow.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Events

In the current version of Oracle Financial Service Lending and Leasing, the Events framework
has undergone changes in the processing type from earlier Engine based framework to Entity
based framework and OFSLL is enabled to support both old and new type of events
processing.

If you have upgraded from an older version of OFSLL, the existing events listed in ‘Event
Types’ tab and action types listed in ‘Event Action Types’ tab will still be functional as intended
but cannot be added or modified. Along with these two tabs, the data in ‘Online’ and ‘Batch’
tab are also displayed in read-only mode. However, new events and action types can only be
created in ‘Events’ tab.

e For existing events defined in the system, refer to Events (Existing Framework).
e To work with new events framework, refer to Events (New Framework).
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2.9.1

2911

Events (Existing Framework)

During account processing, when an account moves from one status/sub status to another,
or changes condition, the system can trigger an event and perform the associated event
actions. This can occur either online or in batch mode.

Note

Only predefined events and actions can be set up on the Events Setup screen. You cannot
create new event types or action types.

As processing events and associated actions require additional processing at the server level,
the performance of the transactions, for which the events are setup, may be adversely
affected dependent upon your specific configuration.

In the Events screen you can view “trigger events” with associated actions which the system
performs during account processing. The fields on this screen are both system and user
defined. There are four sub screens on the Events screen to set up and maintain these
events:

e Events Types

e Event Action Types
e Online

e Batch

Event Types and Action Types sections of this screen provide a master table for setting up
the online and batch events. This setup triggers the event, which in turn triggers the actions
associated with the events, during account processing.

Navigating to Events

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Events.

Event Types

Click Setup > Setup > Administration > System > Events > Loan > Events Types.
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2.
system.

In the Event Types tab, you can view the existing events and its details maintained in the

ORACLE me, APKELKAR v o

Financial Services Lending and Leasing

> DashBoard Sxemex 8 G

> Onginatian Loan |Lne | Lease

> Servicing Event Types | EventAction Types | Orline | Batch

> Collections

> wep Event Types

> Tools view v Format~ B Freeze  §fi Detach Wrap &

Setup Event Type Code Description Process Type Entity Type Engine Type Enabled Sys

Event ACCOUNT LEVEL BATCH EVENT #01 BATCH ACCOUNTS MONETRARY TRANSACTIONS PROCESSING 2 5] ~
oy R = EvED: APPLICATION LEVEL BATCH EVENT #01 BATCH APPLICATIONS ~ CREDIT BUREAU PROCESSING v JE|
S EvED2 ACCOUNT LEVEL BATCH EVENT 202 BATCH ACCOUNTS MONETRARY TRANSACTIONS PROCESSING ¥ Ol |

System Parameter EvED2 APPLICATION LEVEL BATCH EVENT #02 BATCH APPLICATIONS ~ CORRESPONDENCE v G
Lookups EVED3 ACCOUNT LEVEL BATCH EVENT 203 BATCH ACCOUNTS CCONDITION/ASSIGNMENT PROCESSING L4 e
tsenbe e Tables, EVED3 APPLICATION LEVEL BATCH EVENT %03 BATCH APPLICATIONS APPLICATION STATUS CHANGE Y °
Ak [atles EVED4 ACCOUNT LEVEL BATCH EVENT #04 BATCH ACCOUNTS CONDITICN/ASSIGNMENT PROCESSING Y e
cosdsineoisaall EvEgs APPLICATION LEVEL BATCH EVENT #04 BATCH APPLICATIONS  APPLICATION STATUS CHANGE L4 S
pinieaEn 3 BVl ACCOUNT LEVEL BATCH EVENT #05 BaTCH ACCOUNTS CONDITION/ASSIGNMENT PROCESSING ¥ S
Dedupe EveDs APPLICATION LEVEL BATCH EVENT 05 BATCH APPLICATIONS  APPLICATION STATUS CHANGE v S -~
Seauritzation « it v
Events 4
Batch Jobs
Producer Cydes
Vendors

Collection Cycles
Reports
Error Messages
Translations
User
Organization
Comparnies
Access

Users
Credit Bureau

Correspondenc
General Ledger

Bank Details
Check Details
Standard Payees
Currencies

A brief description

of the fields is given below:

Field:

Do this:

Event Type Code

View the event type code.

Description

View the event description.

Process Type

View the event action processing type (BATCH or ONLINE).

Entity Type

View the entity type (ACCOUNTS or APPLICATIONS).

Engine Type

View the engine type (MONETARY TRANSACTIONS PRO-
CESSING, NON-MONETARY TRANSACTION PROCESSING,
CONDITION/ASSIGNMENT PROCESSING, APPLICATION STA-
TUS CHANGE, CREDIT BUREAU PROCESSING, LETTERS
PROCESSING or CORRESPONDENCE).

Enabled

‘Y’ indicates event type is enabled and ‘N’ indicates disabled.

System Defined

If “Yes’ indicates that the event type is system defined. If ‘No’
indicates that the event type is user defined.

2.9.1.2 Event Action Ty

pes

The Event Action
the system.

Types section is system defined and lists the action codes supported in
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1. Click Setup > Setup > Administration > System > Events > Loan > Event Action
Types.

ORACLE s APELAR - I O
Financial Services Lending and Leasing

> DashBoard Fréitr e
> Origination Loan | line | lease
7 Servicing EventTypes Event Action Types | Onine | Batch
»» Collections
> WFP Event Action Types
> Tools View = Format~ [ Freeze  Efi Detach rap [zh)
Setup Action Code Desaiption Process Type Entity Type Engine Type Enabled
POST_CONDITION_TRANSACTION_ACC_ONLINE  POST CONDITION TRANSACTION ONLINE ACCOUNTS CONDITICN/ASSIGNMENT PROCESSING ¥
SEh»’J\Em\msh i POST_MONETARY_TRANSACTION_ACC_ONLINE POST MONETARY TRANSACTION ONLINE ACCOUNTS MONETRARY TRANSACTIONS PROCESSING Y
System POST_NON_MONETARY_TRANSACTION_ACC_ON... POST NON MONETARY TRANSACTION ONLINE ACCOUNTS NON-MONETRAY TRANSACTION PROCESSING il
System Parameter SEND_CRB_REQ_ACC_ONLINE SEND CREDIT BUREAU REQUEST ONLINE ACCOUNTS CREDIT BUREAL PROCESSING Y
Lookups SEND_CRB_REQ_APP_ONLINE SEND CREDIT BUREAU REQUEST ONLINE APPLICATIONS CREDIT BUREAU PROCESSING i
User Defined Tables SEND_LETTER_ACC_BATCH SEND LETTER BATCH ACCOUNTS LETTERS PROCESSING Y
At Dtie s SEND_LETTER_ACC_ONLINE SEND LETTER ONLINE ACCOLNTS LETTERS PROCESSING ¥
User Defined Defaults
SEND_LETTER_APP_BATCH SEND LETTER BATCH APPLICATIONS LETTERS PROCESSING v
Transaction Codes | &
Rl SEND_LETTER_APP_ONLINE SEND LETTER ONLINE APPLICATIONS ~ LETTERS PROCESSING ¥
Dedupe <l i r
Securitization §  Cobmnstidden 1
Events
Batch Jobs
Producer Cycles
Vendors
Collection Cydes
Reports
Error Messages
Translations
User
Organization
Companies
Acczss
Users
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payees
Currendies i

A brief description of the fields is given below:

Field: Do this:

Action Code View the action code.

Description View the action description.

Process Type View the event action processing type (BATCH or ONLINE).

Entity Type View the entity type.

Engine Type View the engine type.

Enabled ‘Y’ indicates event action type is enabled and ‘N’ indicates disa-
bled.

System Defined | If ‘Yes’ indicates that the event action type is system defined. If
‘No’ indicates that the event action type is user defined.

2.9.1.3 Online

The Online tab allows you to view the online events defined in the system along with the event
criteria actions. The system supports the following online events:

1. For change in account’s status system processes the event's actions when the:
e Account status of ACTIVE is reversed
e Account status is changed to PAID
e Account status change to PAID is reversed
e Account status is changed to CHARGE OFF
e Account status change to CHARGE OFF is reversed.
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2. The opening or closing of an accounts conditions. The system processes the event’s

actions when the:
e Account condition DELINQUENT is opened
e Account condition DELINQUENT is closed
e CHG OFF Reversal
e Paid Off Reversal
e BKRP is closed
e BKRP Is Opened
e When Queue is Closed

e When status/ Sub status changed to 'Approved- Rehashed'

e Account condition SCHG is closed
e Account condition SCHG is Opened

3. The posting of a non-monetary transaction to the account.

The events that can be performed online after each of the events listed above are as follows:

e Send correspondence for an account
e Generate correspondence for an account

e Send a credit bureau request for an account

e Post a monetary transaction for an account
e Post a condition transaction for an account

To view Online Event

Click Setup > Setup > Administration > System > Events > Loan > Online.

ORACLE’
Financial Services Lending and Leasing

capeLcr - N <

Transaction Codes

Translations
User

Organization

Companies

Access

Users

Credit Bureau

Correspondznce

General Ledger

Queues

Printers

Bark Detais

Check Detais

Standard Payees
Currendes

EVE_TCN_ONLINE_CO1 EVE_TCN_ONLINE_C01

> DashBoard i
 Origination Loan | Lire | lease
> Servicing EventTypes | EventActonTypes Online | EBatch
> Collections
 WFP Events
> Tools View v Format~ Freeze [iDetach Wirap (5]
Schiip, Event Code Event Type
" EVE_TCN_ONLINE_OPEN_SCHGOFF
Setup TEST
Admiristration <
System
System Parameter
Lookups s
User Defined Tables Event Criteria
Audit Tables View v Formatv [ Freeze G Detach wirap
Vs efied DR Tais Query Name Description

Dats Files

Dedupe

Securitization Criteria Details  Action

Events

Batch Jobs Criteria

Froducer Cydes v - o

Vendars View - Fomat - [ Freeze  pffiDetach Wrap )

Collection Cydles Seq ( Parameter Comparison Operator
Reports 1 PRODUCT COBE EQUAL

Error Messages 2 ACCOUNT STATUS EQUAL

Criteria Value
LOAN-VE
OPEN

Frequency
ALWAYS
DALY

)

[ ese

Synchronous Enabled
5 Y

N N

Enabled
Y

Logical Expression  Enabled
Y
Y

A brief description of the fields is given below:

Field:

Do this:

Event Code

View the event code.
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Field: Do this:

Event Type View the event type.

Synchronous | ‘S’ indicates that the event is synchronous (i.e. any failure in triggering
the event will fail to trigger the entire transaction). If ‘A’ indicates that
the event is asynchronous (i.e. any failure in the event will not affect the
transaction, which will be successfully completed).

Enabled ‘Y’ indicates event type is enabled and ‘N’ indicates disabled.

The Event Criteria section allows you to view the query defined for an event.

A brief description of the fields is given below:

Field: Do this:

Query Name | View the query name.

Description View the query description.

Enabled ‘Y’ indicates event criteria is enabled and ‘N’ indicates disabled.

Criteria Details

The Criteria Details sub tab allows you to view the defined selection criteria for the event.
System uses these criteria to determine which account to include in the event action.

A brief description of the fields is given below:

Field: Do this:

Seq View sequence number.

( Indicates opening bracket.

Parameter View the parameter selected for the criteria.

Comparison Operator | View the comparison operator selected for the criteria.

Criteria Value View the criteria value.
) Indicates closing bracket.
Logical Expression View the logical operator selected for the criteria.
Enabled Y’ indicates event selection criteria is enabled and ‘N’ indicates
disabled.
Actions

In the Actions sub tab, you can view the actions that the system performs when event is
triggered. There can be more than one event action for a particular event and the Seq field
defines the order in which the event action should occur.
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A brief description of the fields is given below:

Field: Do this:

Description View the event action description.

Seq View sequence number defined for the action.

Enabled ‘Y’ indicates event action is enabled and ‘N’ indicates disabled.

For each event action, view the Action Parameters defined. A brief description of the fields
is given below:

Field: Do this:

Description View the parameter description.

Value View the parameter value.
Required ‘Y’ indicates action parameter is required and ‘N’ indicates not-required
29.1.4 Batch

The Batch screen allows you to view the events performed as a batch transaction by the
system. The system supports the following predefined batch events for account processing.
(These batch events are listed in the Events Types tab):

e ACCOUNT LEVEL BATCH EVENT #01
e ACCOUNT LEVEL BATCH EVENT #02
e ACCOUNT LEVEL BATCH EVENT #03
e ACCOUNT LEVEL BATCH EVENT #04
e ACCOUNT LEVEL BATCH EVENT #05
e ACCOUNT LEVEL BATCH EVENT #06
e ACCOUNT LEVEL BATCH EVENT #07
e ACCOUNT LEVEL BATCH EVENT #08
e ACCOUNT LEVEL BATCH EVENT #09
e ACCOUNT LEVEL BATCH EVENT #10
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To view the Batch Event
Click Setup > Setup > Administration > System > Events > Loan > Batch.

ORACLE"

Financial Services Lending and Leasing

»» DashBoard
» Origination
> Servicing
> Collections
> WEP
> Tools
Setup
Setup -
Administration [
System
System Parameter
Lookups
User Defined Tables
Audit Tables
User Defined Defaults
Transaction Codes
Data Files
Dedupe
Securitization
Events
Batch Jobs
Producer Cydles
Vendors
Calection Cyces
Reports
Error Messages
Translations
User
Organization
Comparies
Access
Users.
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bank Details
Check Details
Standard Payees
Currencies

Events

Loan  Line | Lesse

EventTypes | EventActionTypes  Onine = Batch

Events
View = Format~ B Freeze  EfiDetach ol Wrap 157
Event Code: Event Type
EVEOI_ACC
TESTL
cilF T
Event Criteria
View~ Fomate B2 Fress= 5 Detach wep @
Query Name Description
EVED1_ACE_01 EVED1_ACC_01

Criteria Details  Action

Criteria
View v Format v [Ep Fresze G Detach rap [z}
Seq ( Parameter Comparison Cperator
i PRODUCT CODE EQUAL

Criteria Value
LOAN-VE

Frequency
DALY
DALY

)

[ Close

Synchronous Enabled
A Y
N Y
}
Enabled

¥

Logical Expression  Enabled

A brief description of the fields is given below:

Field:

Do this:

Event Code

View the event code.

Event Type

View the event type.

Frequency

View the event frequency.

Enabled

‘Y’ indicates event type is enabled and ‘N’ indicates disabled.

The Events Criteria section allows you to view the query name and event description defined

for an event.

A brief description of the fields is given below:

Field:

Do this:

Query Name

View the query name.

Description

View the event description.

Enabled

Y’ indicates event criteria is enabled and ‘N’ indicates disabled.

Criteria Details

The Criteria Details sub tab allows you to view the defined selection criteria for the event.
System uses these criteria to determine which account to include in the event action.
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A brief description of the fields is given below:

Field: Do this:

Seq View sequence number.

( Indicates opening bracket.

Parameter View the parameter selected for the criteria.

Comparison Operator | View the comparison operator selected for the criteria.

Criteria Value View the criteria value.
) Indicates closing bracket.
Logical Expression View the logical operator selected for the criteria.
Enabled 'Y’ indicates event selection criteria is enabled and ‘N’ indicates
disabled.
Action

In the Actions sub tab, view the actions that the system performs after the event is triggered.
There can be more than one event action for a particular event. The Seq field defines the
order in which the event action should occur. System supports the following batch event
actions:

e Send letter for an account
e Generate correspondence for an account

A brief description of the fields is given below:

Field: Do this:

Description View the event action description.

Seq View sequence number defined for the action.

Enabled ‘Y’ indicates event action is enabled and ‘N’ indicates disabled.

For each event action, view the Action Parameters defined. A brief description of the fields
is given below:

Field: Do this:

Description View the parameter description.

Value View the parameter value.

Required ‘Y’ indicates action parameter is required and ‘N’ indicates not-required

Events (New Framework)

Events in OFSLL refers to user/system generated actions on the system such as updating an
account condition as delinquent or moving the status of a collateral from ‘INACTIVE’ to
‘ACTIVE’ and so on. Whenever such a type of event occurs some defined action can be
performed by the system.
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When there is change in entities like Account, Customer and so on by performing an insert/
update operation on the base table, system can trigger a defined event with an associated
event action to expose the same for third-party applications through JMS message or perform
OFSLL actions like posting Comment/Call Activity and so on.

The Events tab serves as a common framework for Loan, Line and Lease modules. In a single
flow you can define ‘events’ with associated actions for entities like Account, Customer and
so on with the type of processing mode as either Online or Batch mode. Further, you can
define one or more event criteria as a trigger when the corresponding event occurs. For each
defined criteria you can define the available event action and associated action parameter(s)
to initiate corresponding action in external / internal system.

Events Workflow

Online/Batch

I Commit - Commit Mzin Trensaction D: End |

™,
\ !
o ~ —

_ X
. _~Event Definition™..
. < - No—
EEE R . Available?

o

s

Start

s
A

k4

Customer Service

Commit Transaction

h 4

M e
Place a Message { I ™~
( DB f ) s Meet
In DBAQto check —»| - »< 52 i 3 .
Event criteria I'\ e |‘ -} “~Event Criteria 2~ e
.
h 4
0 Run Batch Run Event Loginto
Loginta > » > -
EVENT ENTITIES SET-EVE Action EVENT_ACTION_LOG
'y A
Batch
14
" Oucomer T— Bhalbes Create
e Background Job

> Publish Message
to IMS

As per the above workflow:

e During Servicing stage, when an event is triggered, the main transaction is committed
and a new parallel transaction is created to check if there is an event definition available.

e If there is an event definition available, system places an AQ (Advanced Queueing)
message in database to check for any matching event criteria. There can be one or
more criteria for an event in database which is further evaluated to get the matching
criteria. On identifying a matching criteria, the defined event with criteria is logged into
event entities.

e Based on the Event Type, system executes the associated Event Actions.
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— Ifthe event is configured to Batch mode, the event action is performed when the
following batch jobs - EVEPRC_BJ_100_01 (BATCH EVENTS PROCESSING for
the Entities Account/Application/Assets) and/or EVEPRC_BJ_100_03 (BATCH
EVENTS PROCESSING for the Entities Customer/Business/Vendors/Producers) is
executed.

— If the event is configured to Online mode, system performs the corresponding
actions immediately.

e If the Event Action is defined as JMS, a json message is generated with the below
format. You can configure additional details into the message by using response User
Defined Tables. The data added in this table will be represented in Custom Block as
illustrated in the example below.

i

"EventDetail”: {
"EventID": 8535,
"EventType": "ACC_CREATE",
"EventMessage": "ACO CREATE ACCOUNT LINE",
"EntityNbrT 201000000007,
"Eventstartbot”: "2019-04-05T02:48:35",
"EventProcessedDt”: "2019-04-05T02:48:35",
( "Custom": [
"CustomTabName": "User Defined Table 1",
"Datepata” : [{
"KeyName": "CreationDate",
"Keyvalue": "2017-12-18T00:00:00"

1L
"NumberData" : [{
"KeyName": "BusinessPhoneNumber”,
1 "Keyvalue": 1234567890
"stringbata” : [{
"KeyName': "OrgName",
"Keyvalue": "oracle"

i

el

"CustomTabName": "User Defined Table 2",
"Datepata” : [{
"KeyName": "CreationDate",
"Keyvalue": "2017-12-18T00:00:00"

1L
"NumberData" : [{
"KeyName": "BusinessPhoneNumber”,
1 "Keyvalue": 1234567890
"stringbata” : [{
"KeyName': "OrgName",
"Keyvalue": "oracle"

i

}

e The following table indicates parameters available for JMS action type definition.

Parameter Description Display
EVENTID System Generated Sequence N
EVENTTYPE Lookup Code of Event Type Code N
EVENTMESSAGE User entered event action message. Y
ENTITYNBR Entity Number. For example, Account / N
Customer Number
EVENTSTARTDATE Event Generation Date and Time N
EVENTPROCESSDATE | Event Process Date and Time N
Note

The parameter marked as ‘Y’ in Display column are only available in event action screen
for user configuration. Other parameters are system defined and will be part of every
event.
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e For each Event Action, there is a User Defined Table maintained in the system and the
same is configurable. There is also User Defined Table maintained based on Response
Parameters and the response fields can be used to configure Entity Key, Non-Key and
Data columns for custom block of json message. Following combination of Eventto UDT
mapping are maintained in the system:

— Entity Type | Event | Criteria UDT Type
— Entity | Event Action | UDT Type | UDT Response Type

For complete list of the Events and Actions mapping maintained in the table
'‘event_action_type mapping’, refer to the reference below:

https://docs.oracle.com/cd/F40454 _01/pdf/refdocs/Events_UDT_Mapping.pdf

Navigating to Events

On the Oracle Financial Services Lending and Leasing home screen, click Setup >
Administration > System > Events > Events tab.

To define an Event

1. Click Setup > Setup > Administration > System > Events > > Events tab.

ORACLE’ # Welcome, ABSHEKAR + o
Financial Services Lending and Leasing
Events x [ Close
Loan | Line | lease Events
Events Padd | Zedt | Eview || & Audit
View v Format v [ Freeze i Detach Wrap W@
Event Code Description Entity Type Event Type Processing Type
'CUST ADDR UPDATE CUST ADDR UPDATE CUSTOMERS EVENT TO PROCESS ACTIONS WHEN ADDRESS DATA IS UPDATED 'ONLINE
EVENT_TNM_POST CALL ACTIVITY POST ACCOUNTS EVENT TO PROCESS ACTIONS WHEN NEW NON MONETARY RECORD IS POSTED 'ONLINE
INSERT_CALL_ACTIVITY CALL ACTIVITY PRODUCERS EVENT TO PROCESS ACTIONS WHEN PRODUCER DATA IS UPDATED ONLINE
SEC_ADD_ACC_POOL_BATCH SEC_ADD_ACC_POOL_BATCH SECURITIZATION EVENT TO PROCESS ACTION WHEN NEW ACCOUNT ADDED TO POOL. BATCH
SEC_ADD_ACC_POOL_ONLINE SEC_ADD_ACC_POOL_ONLINE SECURITIZATION EVENT TO PROCESS ACTION WHEN NEW ACCOUNT ADDED TO POOL. 'ONLINE
SEC_REM_ACC_POOL_BATCH SEC_REM_ACC_POOL_BATCH SECURITIZATION EVENT TO PROCESS ACTION WHEN ACCOUNT REMOVED FROM POOL BATCH
SEC_REM_ACC_POOL_ONLINE SEC_REM_ACC_POOL_ONLINE SECURITIZATION EVENT TO PROCESS ACTION WHEN ACCOUNT REMOVED FROM POOL 'ONLINE
>
» Event Criteria Fadd | Zedt | Elvew | 2 Audit
View v Format v [ Freeze i Detach Wrap W check Criteria
Query Name Description Enabled
CUST ADDR UPDATE ONLINE  CUST ADDR UPDATE ONLINE 7
Criteria Details ~ Action
Actions Padd | Zedt | Elvew | & audt
View v Format v [ Freeze i Detach Wrap (o))
Action Type Action Code Seq Enabled
POST COMMENT NONE
WEBHOOK NONE 1Y
POST COMMENT NONE 2N
Action Parameters
View v Format v [ Freeze i Detach Wrap &) '

Copyright © 1998,2020, Oracle and/or its affiliates. All rights reserved. About

A brief description of the fields is given below:

Field: Do this:

Event Code Specify the unique event code.

Description Specify the event description.

Entity Type Select the entity type from the drop-down list. The list is popu-

lated based on EVENT_ENTITY_TYPE_CD lookup code.

Event Type Select the event identification type for the entity from the drop-
down list. The list is populated based on EVENT_TYPE_CD

lookup code.
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Field: Do this:

Processing Type Specify the processing type as either ONLINE or BATCH from
the drop-down list. The list is populated based on
EVENT_PROCESS_TYPE_CD lookup code.

- For Online events, when the event is triggered corresponding
actions are processed immediately. Here all the event action
executions are asynchronous and does not impact main trans-
action.

- For Batch events, the event is triggered when the following
batch jobs - EVEPRC_BJ_100_01 (BATCH EVENTS PRO-
CESSING for the Entities Account/Application/Assets) and/or
EVEPRC_BJ_100_03 (BATCH EVENTS PROCESSING for the
Entities Customer/Business/Vendors/Producers) is executed
and actions are processed.

Enabled Check this box to activate the event type.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

In the Event Criteria sub tab, you can create a query to an event.

3. Inthe Event Criteria sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Query Name | Specify the unique query name.

Description Specify the event criteria description.

Enabled Check this box to enable the event criteria.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Criteria Details

The Criteria Details sub tab allows you to define the selection criteria for the event. System
uses these criteria to determine which account to include in the event action.

5. In the Criteria Details sub tab, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Seq Specify sequence number.

( Specify the opening bracket.

Parameter Select the parameter from the drop-down list.

Comparison Operator | Select comparison operator from the drop-down list.

Criteria Value Specify the criteria value.
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Field: Do this:

) Specify the closing bracket.
Logical Expression Select the logical operator from the drop-down list.
Enabled Check this box to enable the criteria details.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

Actions

In the Actions sub tab, you can define the event action that the system need to perform when
the event is triggered. You can define more than one event action for a particular event and
use the Seq field to define the order in which the event action should occur.

7. Inthe Action sub tab, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Action Type Select the action type from the drop-down list. The list is populated
based on EVENT_ACTION_TYPE_CD lookup code.

Action Code | The action code is displayed as ‘None’ by default.

Seq Specify the sequence number of executing the event action.

Enabled Check this box to enable the event action.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

Action Parameters
In the Action Parameters sub tab, you can define the action parameters with corresponding
values for each event action.

9. To define the Action Parameters, in the Action sub tab, click Add or Edit. You can also
perform any of the Basic Operations mentioned in Navigation chapter.

10. Click ‘Load Parameters’. The applicable Action Parameters are loaded for update.

A brief description of the fields is given below:

Field: Do this:

Description System auto populate the description from user defined table based on
Action code selected.
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2.10

Field: Do this:

Value Type Select the value type as one of the following which is to be included dur-
ing event action execution from the drop-down list. The list is populated
based on EVENT_VALUE_TYPE_CODE lookup code.

- CONSTANT
- SYSTEM DRIVEN
- USER INPUT

- COLUMN VALUE (For this value type, the Action Parameter values are
displayed from User Defined Tables based on the Event Type. However,
note that if the column value cannot be fetched due to multiple records or
if no record exist, then action parameter value is displayed blank/null).

For SEND CORRESPONDENCE Action Type, there are additional
parameters - USER DEFINED ELEMENT and USER DEFINED CON-
STANT available in Setup > Correspondence screen to provide input dur-
ing execution of Event Action.The same is available in Events screen
and can be modified before triggering the event action.

Value If the Value Type is selected as CONSTANT, specify the required action
parameter value.

If the Value Type is selected as SYSTEM DRIVEN, you can add the fol-
lowing values for system to derive the parameter values during the exe-
cution of the Event.

$GLDATE - GL DATE System Parameter Value
$PAYMENTAMOUNT - Account Monthly Payment Amount
$OUTSTANDINGAMOUNT - Account Total Outstanding Amount
$RATE - Account Rate

$TOTALTERM - Account Total Term

$AVAILABLETERM - Account Available Term

Required ‘Y’ indicates the action parameter is required, else No.

11. Perform any of the Basic Actions mentioned in Navigation chapter.

Monitoring JMS Event Actions

You can verify the status of events and event actions on the Monitor Jobs screen of the
System Monitor screen.
To monitor events

1. On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > System Monitor > JMS Queues.

The JMS Queues screen displays the ‘Status’ for all asynchronous events processed in
the system.

For more details, refer to Dashboard > System Monitor section in any of the User Guides.

Batch Jobs

“Batch jobs” refer to the back-end processes that automatically run at a certain time. There
are two types of batch jobs:
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e Business processes (such as billing and delinquency processing)
e Housekeeping tasks (such as application aging and application purging)

Batch Jobs

The Batch Job screen allows you to set up, monitor, and maintain batch jobs in the system.

Batch jobs can be set up to be performed on a daily, weekly, monthly, and ad-hoc basis. Batch
jobs can also be configured to trigger an e-mail or phone message if a batch job fails.

Critical batch jobs control job flow and system date rollover to allow recovery during errors.
Errors are instances where a process did not successfully complete. Failures indicate that a
particular job encountered errors that require remedial action. The number of errors allowed
before failure is defined for each job. Some errors automatically result in a failure.

Navigating to Batch Jobs:

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > System > Batch Jobs. The Batch Jobs details are further grouped
into two tabs:

e Batch Jobs tab
e Job Holidays tab

Batch Jobs

In the Batch Job Setup screen, you can track and maintain all batch processes within the
system. Using this form, the system administrator can configure the frequency and start time
of each batch process, as well as set the number of threads to improve performance.

“Threading” allows a specific job to be separated into smaller units that are processed at the
same time. This allows Oracle Financial Services Lending and Leasing to complete the job in
less time.

You can set up multiple batch jobs within a batch set. In the Batch Job Sets section, each
process is listed with the last run date (Last Run Dt field) and the next scheduled process date
(Next Run Dt field). In the Freq Code and Freq Value fields, you can determine the frequency
of each batch set, such as daily, weekly and monthly. You can also set up batch sets to
incorporate a dependency on another batch set. This way, if the initial batch fails, the
dependent set will not be processed.

In the Batch Jobs section, you can configure the process to run on weekends and holidays
using the respective option boxes.

CAUTION: As the batch job setup widely affects the Oracle Financial Services Lending and
Leasing system, Oracle Financial Services Software suggests that the system administrator
has a clear understanding of the various functionalities within Oracle Financial Services
Lending and Leasing before creating and updating the batch processes.

For the standard job set please review the Visio document,
dbk_std_detail_design_job_sets.vsd

Configure Batch Jobs at Company Level

OFSLL is enabled to process the configured batch jobs at each Company level giving a
flexibility to schedule and run batch job or EOD processing at desired time zone. Irrespective
of Company or Branch, the batch jobs can be run independently on specific time in scheduler.
For more details on configuring the batch job at each company definition level, refer to
Appendix - Configuration at Company Level chapter.
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To setup a Batch job
1. Click Setup > Setup > Administration > System > Batch Jobs.

2. In the Batch Job Sets section, you can make use of the copy option to copy the whole
batch job set at one go with header and detailed records for each company definition. To
do so, select the Company from drop-down list and click ‘Create Copy’. System copies
the batch job sets from the selected Company record to the Company selected from drop-
down list. All those batch job set which are not already available in the selected Company

are copied.
Note that:

The ‘Create Copy’ option can be used multiple times.

The Company drop-down list is displayed based on the User Access defined for the
logged-in user.

3. Perform any of the Basic Operations mentioned in Navigation chapter.

ORACLE’
Financial Services Lending and Leasing

# Welcome ABSHEKAR v o

Batch Jobs (3 Qlose
Batch Jobs  Job Holidays ~
Batch Job Sets PAdd | ZEdt | G View | 2 Audit
View v Format v [ Freeze i Detach Wrap W company AL 52 Create Copy
Company Set Code Job Set Description Frequency Frequency value  Start Time Critical Enabled Last Run Dt Next
AUSO01 SET-AAL ACCOUNT CREATION DAILY DAILY 09:00 AM N N 08/08/2003 09/1 A
ALL SET-AAL ACCOUNT CREATION DAILY DAILY 16:00 PM N N 08/08/2003 09/1
WBW_US SET-AAL ACCOUNT CREATION DAILY DAILY 16:00 PM N N 08/08/2003 09/1
WAR USA SET-AAT ACCOUNT CREATION DAILY DAILY 16:00 PM N N 08/08/2003 09/1
NLO2 SET-AAT /ACCOUNT CREATION DAILY DAILY 16:00 PM N N 08/08/2003 09/1
uso1 SET-AAT ACCOUNT CREATION DAILY DAILY 09:00 AM N N 08/08/2003 09/1
UKO1 SET-AAL ACCOUNT CREATION DAILY DAILY 15:00 PM N N 08/08/2003 09/1
Jpo4 SET-AAL /ACCOUNT CREATION DAILY DAILY 23:00 PM N N 08/08/2003 09/1
IND SET-AAL ACCOUNT CREATION DAILY DAILY 19:30 PM N N 08/08/2003 09/1
B wveap SET-ACR ACCRUALS AND DELINQUENCY DAILY DAILY 22:30 PM Y N 08/07/2003 09/1v
< >
Batch Jobs P Add | ZEdt || [ View | o Audit
View~ Format~ [ Freeze [ Detach wap @
Seq Job Type Job Code Job Description Threads Commit Count Errors Allowed  Weekend Holiday
1.0000 PROCEDURE AAIPRC_BJ_100_01 APPLICATION TO ACCOUNT INTERFACE 1 100 Y Y
2.0000 PROCEDURE TXNACT_BJ_100_01 ACCOUNT ACTIVATION 1 100 50 id L4
< >
Batch Job Threads FpAdd | ZEdt | [ View o Audit
View v Formatv [ Freeze i Detach Wrap 0]
Thread Trace Level Enabled
1 0 |
v

A brief description of the fields is given below:

Field: Do this:

Company Select the company from the drop-down list. The list is popu-
lated only with those Company Definitions to which you have

been provisioned access.

This company is considered if system is setup to process batch
jobs at Company level. For more information, refer to ‘Appen-
dix - Company Level GL Date Configuration’ section.

Set Code

Specify the code for the batch job set.

Job Set Description

Specify the description for the batch job set.

Frequency

Select the frequency at which the job set is to be executed
from the drop-down list.

Frequency Value

Select the frequency value from the drop-down list. The fre-
quency value will be displayed based on the frequency code
selected.

Start Time

Specify the start time for the job set.
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Field: Do this:

Critical Check this box to set job as critical. A “critical” job is one that
prevents the General Ledger (GL) post date from rolling for-
ward, should the job fail.

Enabled Check this box to enable the job set.
Last Run Dt The system displays the last run date of the job set.
Next Run Dt Specify the next run date for job set. You can select the data

from adjoining calendar icon.

Parent Select the parent job set from drop-down list.
Dependency Select the type of dependency on the parent from drop-down
list.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Batch Job section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Seq Specify the batch job sequence number.

Note: Within a job set, jobs are executed sequentially based on the
sequence number assigned.

Job Type Select the batch job request type from the drop-down list.

Job Code Specify the batch job request code.

Job Description Specify the batch job description.

Threads The system displays the number of threads used by the job.

Commit Count Specify the number of rows after which auto-commit is triggered.

Errors Allowed Specify the number of errors allowed.

Weekend Check this box to perform batch jobs on weekend.

Holiday Check this box to perform batch jobs on a holiday. (Holidays are
defined on the Job Holidays screen.)

Enabled Check this box to enable the batch job.

Parent Select the parent batch job from the drop-down list.

Dependency Select the dependency clause of the batch job from the drop-down
list.

Command Specify the command line for the job (required).

RollbackSegment | If you choose, use this field to specify the rollback segment for job.

6. Perform any of the Basic Actions mentioned in Navigation chapter.
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7. Inthe Batch Job Thread section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Thread Specify the name of thread.

Trace Specify the SQL trace level (0, 1, 4, 8, 12). The higher the number, the
more activities the system can trace.

Enabled Check this box to enable the thread.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

2.10.1.2 Job Holidays

The system allows you to define holidays within the company on Job Holidays screen. You
can then use the Batch jobs screen to set up whether you want the system to perform batch

jobs on these days or not, using the Holiday box of Batch Jobs section .

To define job holidays
1. Click Setup > Setup > Administration > System > Batch Jobs > Job Holidays.

2. Inthe Job Holidays section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’

Financial Services Lending and Leasing

# Welcome ABSHEKAR ¥ o

Batch Jobs

Balch Jobs  Job Holidays

Job Holidays
View v Formatv [

Job Holidays

Holiday Dt Description

eeze i Detach Wrap W

Company

E

06/13/2020 QUEENS BIRTHDAY UKO1 Y
06/13/2020 QUEENS BIRTH DAY AUSO1 Y.
12/25/2002 CHRISTMAS Y
09/21/2002 THANKS GIVING DAY ALL Y
¥

Y

Y

Y

Y

ALL

07/05/2002 INDEPENDENCE DAY AL
12/25/2001 CHRISTMAS
09/22/2001 THANKS GIVING DAY AL
» 07/04/2001 INDEPENDENCE DAY AL
12/25/2000 CHRISTMAS

AL

ALL

[ saveand sty || [ Saveand Retun | GaRetun

Holiday Dt 06/13/2020 * Enabled [7]
* Description  QUEENS BIRTHDAY
* Company UKO1 ~

A brief description of the fields is given below:

Field: Do this:

Holiday Dt Specify the date of the job holiday. You can select the date from the
adjoining calendar icon.

Description Specify the job holiday description (required).

Company Select the company from the drop-down list. The list is populated only

with those Company Definitions to which you have been provisioned
access.

This company is considered if system is setup to process holiday at
Company level. For more information, refer to ‘Appendix - Company
Level GL Date Configuration’ section.
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Field:

Do this:

Enabled

Check this box to enable the holiday.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

2.10.2 Batch Jobs Available

The below table provides a list of Batch Jobs maintained in the system and a brief description

to each:
& 5 c
L o
Ea Description ?:ktfh Description § :E '% "g' Comment
=] 2 2|23
c = 0| O] =
w Olwm|O| a
AAE Application aaiprc_b- | APPLICA- N | Y | N | C | This process peri-
Account j_100_01 | TIONTO o | e | o | o | odically picks up
Interface ACCOUNT s m | applications in
INTERFACE m | 'Approved-Veri-
o | fied' status and
n | creates accounts.
ACH | ACH acaprc_b | ACCOUNT N |Y | N| C | This process pro-
Accounts j_100_01 | ACH PRO- 0 | e | o | o | ducesthe ACH file
CESSING s m | for the eligible cus-
m | tomer payments.
o}
n
ACH | ACH Produc- | acp- PRO- Y | Y | N| C | This process pro-
ers prc_b- DUCER e | e | o | o | ducesthe ACH file
j_100_01 | ACH PRO- s |s m | for the eligible pro-
CESSING m | ducer payments.
o]
n
ACH | ACH Ven- acvprc_b | VENDOR N |Y | N| C | This process pro-
dors j_100_01 | ACH PRO- o | e | o | o | ducesthe ACH file
CESSING S m | for the eligible ven-
m | dor payments.
o}
n
ACH | ACH Pro- acx- ACH Pro- Y | Y | N| C | This process pro-
ducer/Ven- prc_b- ducer/Ven- e | e | o | o | ducersthe ACH
dors/ j_100_01 | dors/ s |s m | file for the eligible
Customer/ Customer/ m | Producer/Vendors/
Third Party Third Party 0 | Customer/Third
n | Party
AGE | Aging Appli- | agaap- APPLICA- Y | N | N | C | This process puts
cations p_b- TION e | o | o | o | applications into
j_100_01 | AGING s m | 'Aged-Application’
PROCESS m | substatus.
o]
n
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& 5| o €
Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
AGE | Aging Con- agcco- CON- Y | N | N | C | This process puts
tracts n_b- TRACT e | o | o | o | contracts into
j_100_01 | AGING s m | 'Aged-Contract’
PROCESS m | substatus.
o}
n
ALT- | ALLOT- PFSEFT- | BACKUP N [Y | N | C | This process cre-
PFS MENT PRC_B- | EFT o |e |0 | o | atesthe Backup
EXTRACT J 110 s m | EFT file
FILE DUMP 1 m
o]
n
ALT- | ALLOT- PFSL- POSTING N | Y | N | C | This process posts
PFS MENT BAPRC_ | ALLOT- o | e |0 | o |thepaymentsfrom
EXTRACT BJ_100_ | MENT PAY- s m | the allotment file
FILE DUMP 01 MENTS m | received from the
o0 | bank
n
ALT- | ALLOT- PFSOD- | ALLOT- N |Y | N| C | This process
PFS MENT DALT_B- | MENT o0 | e | o | o | sends the allot-
EXTRACT J 100 0 | EXTRACT s m | mentdraft notice to
FILE DUMP 1 FILE DUMP m | the bank
0
n
ALT- | ALLOT- PFSNS- | NSFBATCH | N | Y | N | C | This process posts
PFS MENT FPRC B o | e |0 | o |theNSFfile
EXTRACT J_100_0 S m | received from the
FILE DUMP 1 m | bank
o]
n
API API Accounts | accaa- API AAI N |Y | N|C | This process cre-
i_b- o | e |0 | o | atesaccountsfrom
j_100_01 s m | validated conver-
m | sion applications/
0 | contracts
n
API API Accounts | accd- MOVE N | Y | N | C | This process cop-
mp_b- API_XX TO o | e | o | o | iesdatafromcon-
j_100_01 | ITABS s m | version API tables
m | to conversion
o | applications table
n
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Engine Type

Description

Batch
Job

Description

Comment

>
3

API| Accounts

accval_bj
_111_01

VALIDATE
ITABS
(LOAN)

© Z | Origination

® ® < | Servicing

© Z | Collection
S © O ™| Product

This process vali-
date all conver-
sion applications
loan accounts by
running the edits

API

API| Accounts

accval_bj
_112_01

VALIDATE
ITABS
(LINE)

]

—

® S5 =

This process vali-
date all conver-
sion applications
line of credit
accounts by run-
ning the edits

API

API Accounts

acm-
prc_b-
j_100_01

LOAD
AP|_COM-
MENTS

]

53 03300

This process cre-
ates account com-
ments from
conversion appli-
cations/contracts

API

API Accounts

APID-
MP_B-
J_100_0

LOAD API
RECORDS

@

3 03300

This process
directly reads data
from database
folder and using
the external tables
loads it into API
tables for creating
accounts.

This eliminates the
need/dependency
of SQL loader and
Control files.

Ensure that
account data in
Input file has same
structure as
defined in Setup >
Data Files > Input
definition specifi-
cally for Loan, Line
& Lease accounts.
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Engine Type

Description

Batch
Job

Description

Comment

SET-
API2

ASYN-
CHRO-
NOUS
ACCOUNT
CREATION

ACX-
VAL_B-
J_100_0

VALIDATE
IAPP TABS

® ® <| Origination

® © < | Servicing

® ®© < | Collection

S5 © 3 3 ° 0| Product

This process is
used to validate
the data from the
Account On-
Boarding request.

This process is the
first stage in pro-
cessing asynchro-
nous account
creation using
Account on-board-
ing web service
and is controlled
based on value
defined in system
parameter -
ACCOUNT_PRO-
CESSING_-
THRESHOLD.
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Engine Type

Description

Batch
Job

Description

Comment

SET-
API2

ASYN-
CHRO-
NOUS
ACCOUNT
CREATION

ACXAA-
|_B-
J_100_0

ASYN-
CHRO-
NOUS
ACCOUNT
CREATION

® © < | QOrigination

® ®© < | Servicing

® ®© < | Collection

S © 3 39 O] Product

This process is
used for asynchro-
nous accounts cre-
ation using
Account on-board-
ing web service.

This process is the
next stage after
successful valida-
tion of account cre-
ation request
without any errors.

Based on the
request and sys-
tem parameter
value in
ACCOUNT_PRO-
CESSING_-
THRESHOLD
accounts are cre-
ated in the system
with all the details
and with Status of
account as Active,
Error, Void.

Note: These
Accounts can have
Account Number
generated exter-
nally or require
OFSLL to generate
these number.

COL

Appointment
Cancellation

cap-
prc_b-
j_100_01

APPPOINT-
MENT CAN-
CEL
PROCESS-
ING

]

535 03300

This process can-
cels all the expired
appointments.

COL

Payment
Promise Pro-
cessing

cppprc_b
j_100_01

BROKEN
PROMISE
PROCESS-
ING

(]

53 03300

This process
updates any bro-
ken promises as of
the run time.
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& 5| o €
Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
CRB | Credit cbuutl_b- | CREATE N [Y | N | C | This process cre-
Bureau j_100_01 | METRO2 o|e |0 | o | atesthe METRO2
Reporting FILE s m | file for Credit
m | Bureau reporting
o | for the specified
n | date.
DOT | Document dolprc_b- | ACCOUNT N |Y |Y | C | Thisprocessreads
Tracking j_000_01 | DOCU- o|e |e | o | acct doc load
Load MENT s | s | m | directory. Attach
LOAD m | the documents to
o | specified accounts
n | and move docu-
ments to appropri-
ate directory
DLX | Accounts ODX- ACCOUNTS | N | Y | Y | C | This process gen-
Dialer Exclu- | PRC_B- | DIALER o | erates a dialer
sion J 100 0 | EXCLU- m | exclusion file with
1 SION m | account details
o | and checks if the
n | maintained call
action result entry
is made on any
account during the
specified time
interval.
GLP GL Interface | gliprc_b- | GLSUMMA- | N | Y | N | C | This process sum-
j_100_01 | RIZATION o | e | o | o | marizes GL trans-
S m | actions for the day.
m
o}
n
GOV | Debt Report- | gdraap_ | IRS1099-A | N | Y | N | C | This process gen-
ing IRS bj_100_0 | PROCESS- |0 | e | o | o | erates the 1099-A
1099A / 1 ING S m | flat file for govern-
1099C m | ment reporting.
o]
n
GOV | Debt Report- | gdrcad_b | IRS1099-C | N | Y | N | C | This process gen-
ing IRS j_100_01 | PROCESS- | o | e | o | o | eratesthe 1099-C
1099A / ING S m | flat file for govern-
1099C m | ment reporting.
o]
n
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GOV | HMDA ghr- IRS HMDA Y | N | N | C | This process gen-
Reporting prc_b- PROCESS- | e | o | o | o | erates the HMDA
j_100_01 | ING s m | flat file for govern-
m | ment reporting.
o}
n
GOV | Interest girprc_b- | IRS 1098 N |Y | N| C | This process gen-
Reporting j_100_01 | PROCESS- |0 | e | o | o | eratesthe 1098 flat
IRS 1098 ING s m | file for government
m | reporting.
o]
n
JOB Scheduler jsctst_b- | Scheduler Y | Y | Y| C| This process test
j_000_01 e | e | e | o | thejobscheduler
s |s|s|m
m
o]
n
LBP Lockbox Ibxprc_b- | LOAD N | Y | N | C | This process loads
j_100_01 | LOCKBOX o | e |0 | o | anylockbox files
PROCESS- s m | available. This pro-
ING m | cess can be set to
0 | run periodically
n | throughout the day.
LNT Lien Tracking | OFD- OUTPUT N [Y | N | C | This process gen-
PRC_B- | LIEN o | erates output file
J_111_0 | TRACKING m | with changes in
3 FOR DATA m | customer informa-
CHANGE o | tion such as
n | Address/Phone
no./Borrower/Co-
borrower name.
LNT Lien Tracking | OFD- OUTPUT N |Y | N| C | This process gen-
PRC_B- | LIEN 0 | erates output file
J_111_0 | TRACKING m | for 'Void Accounts'
4 FOR VOID m | to be sentto dealer
ACCOUNT o | track.
n
LTR Collections Icolt1_b- | GENERATE | N | N | Y | C | This process gen-
Letter j_100_01 | FIRSTCOL- | 0o | o | e | o | erates the first col-
LECTION s | m | lection letter for
LETTER m | eligible accounts.
o}
n
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LTR Collections Icolt2 b- | GENERATE | N | N | Y | C | This process gen-
Letter j_100_01 | SECOND o | o |e | o | eratesthe second
COLLEC- s | m | collection letter for
TION LET- m | eligible accounts.
TER o}
n
LTR Collections Icolt3_b- | GENERATE | N | N | Y | C | This process gen-
Letter j_100 01 | THIRDCOL- | o | o | e | 0 | erates the third col-
LECTION s | m | lection letter for
LETTER m | eligible accounts.
o]
n
LTR Customer Icspdf_b- | PAID IN N |[Y | N|L | This process gen-
Service Let- | j_111_01 | FULL LET- o |e |o | o | eratesthe paid-in-
ter TER S a | full letter for the
n | relevant accounts.
LTR Customer Icspo- PAYOFF N Y | N | C | This process gen-
Service Let- q_b- QUOTE o | e |0 | o | eratesthe payoff
ter j_111_01 | LETTER s m | quote letter for the
m | requested
o | accounts.
n
LTR Customer Icsst- CuUs- N [Y | N | C | This process gen-
Service Let- | m_b- TOMER o | e | 0| o | eratesthe cus-
ter j_100_01 | STATE- s m | tomer/business
MENT LET- m | statement letter for
TER o | requested
n | accounts.
LTR Customer Icswel_b- | WELCOME N |[Y | N|L | This process gen-
Service Let- | j_111_01 | LETTER o | e | o | o | eratesthe wel-
ter S a | come letter for the
n | newly funded
accounts.
LTR Origination loraco_b- | Origination Y | N | N | L | This process gen-
Letter j_111_01 | Adverse e | 0o | o | o | eratesthe adverse
Action Let- S a | action letter for rel-
ter(Condi- n | evant applications.
tional)
(Loan)
LTR Origination loradv_b- | Origination Y | N | N | L | This process gen-
Letter j_111_01 | Adverse e | 0 | o | o | eratesthe adverse
Action Let- S a | action letter for rel-
ter (Loan) n | evant applications.
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ODD | Coupon ocn- CuUs- N Y | N | C | This process gen-
Book Dump prc_b- TOMER O | e | o | o | erates coupon
File j_100_01 | COUPON s m | books, if appropri-
BOOK GEN- m | ate.
ERATION o}
n
ODD | Output Data | odd- CREATE Y | Y |Y | C| This process cre-
Dump File prc_b- OUTPUT e | e | e | o | ates any defined
j_000_01 | DATADUMP | s | s | s | m | output data dump
FILES m | files set in the sys-
o | tem.
n
ODD | Collections olclt1_b- | COLLEC- N [N | Y | C | This process gen-
Letter j_100_01 | TION LET- o0 | 0o | e | o | erates the first col-
TER 1 FILE s | m | lection letter for
CREATION m | eligible accounts.
o]
n
ODD | Collections olclt2_b- | COLLEC- N [N | Y | C | This process gen-
Letter j_100_01 | TION LET- o0 | o | e | o | eratesthe second
TER 2 FILE s | m | collection letter for
CREATION m | eligible accounts.
o}
n
ODD | Collections olclt3_b- | COLLEC- N | N|Y | C | This process gen-
Letter j_100_01 | TION LET- 0 | o |e | o | erates the third col-
TER 3 FILE s | m | lection letter for
CREATION m | eligible accounts.
o}
n
ODD | Origination olo- ADVERSE Y | N| N | C | This process gen-
Letter aco_b- ACTION e | o | o | o | eratesthe adverse
j_100_01 | CONDI- s m | action letter for rel-
TIONAL m | evant applications.
LETTER o]
FILE CRE- n
ATION
ODD | Origination oload- ADVERSE Y | N| N | C | This process gen-
Letter v_b- ACTION e | 0o | o | o | eratesthe adverse
j_100_01 | LETTER s m | action letter for rel-
FILE CRE- m | evant applications.
ATION o}
n
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ODD | Customer olspdf_b- | PAID IN N [Y | N | C | This process gen-
Service Let- | j_100_01 | FULL FILE 0 | e | o | o | erates the paid-in-
ter CREATION s m | full letter for the
m | relevant accounts.
o]
n
ODD | Customer olspo- PAY OFF N [Y | N | C | This process gen-
Service Let- q_b- QUOTE o | e |0 | o | eratesthe payoff
ter j_100_01 | FILE CRE- s m | quote letter for the
ATION m | requested
0 | accounts.
n
ODD | Customer ols- WELCOME N Y | N | C | This process gen-
Service Let- wel_b- LETTER o | e | o | o | eratesthe wel-
ter j_100_01 | FILE CRE- S m | come letter for the
ATION m | newly funded
0 | accounts.
n
ODD | Producer opsprc_b | DEALER N [Y | N | C | This process gen-
Statement j_100_01 | STATE- o0 | e | o | o | eratesthe dealer/
Dump File MENTS s m | producer state-
GENERA- m | ments at the speci-
TION o | fied frequency.
n
ODD | Customer ostprc_b- | CUS- N [Y | N | C | This process gen-
Statement j_100_01 | TOMER o | e | o | o | eratesthe cus-
Dump File STATE- S m | tomer/business
MENTS m | statement for eligi-
GENERA- o0 | ble accounts.
TION n
PRQ | Payable pcu- CUS- N |Y | N| C | This process cre-
Requistion prc_b- TOMER o | e | o | o | atesrequisitions
Customer j_100_01 | REFUND s m | for customer/busi-
PAYMENT m | ness overpayment
REQUISI- o | refunds.
TIONS n
PRQ | Payable ppores b | MONTH N |Y | N|C | This process cre-
Requisition j_100_01 | END o0 | e | o | o | atesrequisitions
Producer DEALER s m | for dealer compen-
RESERVE m | sation payments
PAYMENT o0 | on month-end.
REQUISI- n
TIONS
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PRQ | Payable pvn- VENDOR N [Y | N | C | This process cre-
Requisition prc_b- INVOICE o0 | e | o | o | atesrequisitions
Vendor j_100_01 | PAYMENT s m | for vendor invoice
REQUISI- m | payments
TIONS o}
n
PUR | Archive pacarc_b | ARCHIVE N |Y |Y | C | This process
Accounts j_100_01 | ACCOUNT o | e | e | o | archives account
DATA TO s | s | m| datafrom
OTABLES m | ACCOUNTS table
o | to OACCOUNTS
n | table.
PUR | Archive pacarc_b | ARCHIVE N |Y |Y | C| This process
Accounts j_100_02 | ACCOUNT o | e | e | o | archives account
DATA TO s | s | m| data from OAC-
OOTABLES m | COUNTS table to
o | OOACCOUNTS
n | table.
PUR | Archive paparc_b | ARCHIVE Y | N | N | C | This process
Applications | j_100_01 | APPLICA- e | o | o | o | archives applica-
TION DATA | s m | tion-related data
TO m | from APPLICA-
OTABLES o | TIONS to OAPPLI-
n | CATIONS table.
PUR | Archive paparc_b | ARCHIVE Y | N| N | C | This process
Applications | j_100_02 | APPLICA- e | o | o | o | archives applica-
TION DATA | s m | tion-related data
TO OOT- m | from OAPPLICA-
ABLES 0 | TIONS to OOAP-
n | PLICATIONS
table.
PUR | Archive GL pglarc_b- | ARCHIVE N |Y |Y | C | This process
j_100_01 | GLDATATO |0 | e | e | o | archives General
OTABLES s | s | m | Ledger data from
m | GL tables to OGL
o | tables.
n
PUR | Archive GL pglarc_b- | ARCHIVE N |Y |Y | C | This process
j_100_02 | GLDATATO | o | e | e | o | archives General
OOTABLES s | s | m | Ledger data from
m | OGL tables to
o | OOGL tables.
n
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PUR | Purge Job pjrirg_b- | Purge Job Y |Y | Y| C | This process
Requests j_100_01 | Requests e |e | e | o | purgesjob
s | s | s | m| requests from the
m | system.
o}
n
PUR | PurgeOutput | pododh_ | PURGE N |Y |Y | C | This process
Data Dump bj_100_0 | OUTPUT o | e |e | o | purges Output
1 DATA s | s | m| DataHeaders from
HEADERS m | the system.
o]
n
PUR | Archive ppaarc_b | ARCHIVE N |Y | N | C | This process
Securitiza- j_100_01 | POOLDATA |0 | e | o | o | archives securiti-
tion TO S m | zation data from
OTABLES m | TABLE to corre-
o | sponding OTABLE.
n
PUR | Archive ppaarc_b | ARCHIVE N |Y | N| C | This process
Securitiza- j_100_02 | POOLDATA | o0 | e | o | o | archives securiti-
tion TO OOT- s m | zation data from
ABLES m | OTABLE to corre-
o | sponding OOT-
n | ABLE.
PUR | Archive Pro- | pprarc_bj | ARCHIVE Y | Y |Y | C| This process
ducers _100_01 | PRO- e | e | e | o | archives producer
DUCER s | s | s | m| datafrom PRO-
DATATO m | DUCERS table to
OTABLES o | OPRODUCERS
n | table.
PUR | Archive Pro- | pprarc_bj | ARCHIVE Y |Y | Y| C | This process
ducers _100_02 | PRO- e | e | e | o | archives producer
DUCER s | s | s | m| datafrom OPRO-
DATATO m | DUCERS table to
OOTABLES o | OOPRODUCERS
n | table.
PUR | Archive Pro- | ppx- ARCHIVE N |Y | N| C | This process
ducers Txns | arc_b- PRO- o0 | e | o | o | archives producer
j_100_01 | DUCER s m | transaction data
TXNS DATA m | from PRODUC-
TO o | ERS table to
OTABLES n | OPRODUCERS
table.
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PUR | Archive Pro- | ppx- ARCHIVE N |Y | N| C | This process
ducers Txns | arc_b- PRO- 0 | e | o | o | archives producer
j_100_02 | DUCER s m | transaction data
TXNS DATA m | from OPRODUC-
TO OOT- o | ERS table to
ABLES n | OOPRODUCERS
table.
PUR | Archive pstarc_b- | ARCHIVE N |Y | N | C | This process
Statements j_100_01 | ACCOUNT o | e | o | o | archives account
STATE- S m | statement and
MENT AND m | transaction data
TXNS DATA o | from TABLE to cor-
TO n | responding
OTABLES OTABLE.
PUR | Archive pstarc_b- | ARCHIVE N |Y | N | C | This process
Statements j_100_02 | ACCOUNT o | e | o | o | archives account
STATE- s m | statement and
MENT AND m | transaction data
TXNS DATA o | from OTABLE to
TO OOT- n | OOTABLE.
ABLES
PUR | Terminate ptuus- Terminate Y | Y |Y | C | This process termi-
User r_b- User e | e | e | o | nates user satisfy-
j_100_01 s | s | s | m| ingthe selection
m | criteria.
o}
n
PUR | Archive Txns | ptxarc_b- | ARCHIVE N |Y | N| C | This process
(ToO tables) | j_ 100 01 | TXNSDATA | o | e | o | o | archives data from
TO S m | TXNS table to
OTABLES m | OTXNS table.
o}
n
PUR | Archive Txns | ptxarc_b- | ARCHIVE N |Y | N | C | This process
(To OO j_100_02 | TXNS DATA | o | e | o | o | archives data from
tables) TO OOT- S m | OTXNS table to
ABLES m | OOTXNS table.
o]
n
PUR | Purge User pululg_b- | PurgeUser |Y | Y |Y | C | This process
Logins j_100_01 | Logins e | e | e | o | purges userlogin
s | s | s | m| datafrom the sys-
m | tem.
o}
n
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PUR | Archive Ven- | pvaarc_b | ARCHIVE N |Y | Y | C | This process
dor Assign- j_100_01 | VENDOR o | e | e | o | archives vendor
ments ASSIGN- s | s | m | assignment data

MENTS m | from TABLE to

DATATO o | OTABLE.

OTABLES " | The criteria for
archival is based
on following valida-
tion - Work Order
Status = Closed /
Completed /
Repossessed +
Days mentioned in
system parameter
‘PVA_ARCHIVE_-
DAYS'.

PUR | Archive Ven- | pvaarc_b | ARCHIVE N |Y |Y | C | This process
dor Assign- j_100_02 | VENDOR o | e | e | o | archives vendor
ments ASSIGN- s | s | m | assignment data

MENTS m | from OTABLE to

DATATO o | OOTABLE based

OOTABLES n | on the days men-
tioned in system
parameter
‘PVA_OAR-
CHIVE_DAYS'.

PUR | Archive Ven- | pviarc_b- | ARCHIVE N |Y |Y | C | This process

dor Invoices | j_100_01 | VENDOR o | e | e | o | archives vendor
INVOICES s | s | m| invoice data from
DATATO m | TABLEs to
OTABLES o | OTABLEs.

n The criteria for
archival is based
on following valida-
tion - Invoice Sta-
tus = ‘Close’ +
Days mentioned in
system parameter
‘PVI_ARCHIVE_-
DAYS'.
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PUR | Archive Ven- | pviarc_b- | ARCHIVE N |Y | Y | C | This process
dor Invoices | j 100 _02 | VENDOR o | e | e | o | archives vendor

INVOICES s | s | m| invoice data from
DATATO m | OTABLEs to OOT-
OOTABLES o0 | ABLEs based on

n | the days men-
tioned in system
parameter
‘PVI_OAR-
CHIVE_DAYS'.

PUR | Archive Ven- | pvearc_b | ARCHIVE N |Y |Y | C | This process
dors j_100_01 | VENDORS o | e |e | o | archives vendor
DATA TO s | s | m| invoice data from
OTABLES m | TABLEs to

o | OTABLEs.

n The criteria for
archival is based
on following valida-
tion - Vendor end
date is less than
system date - Days
mentioned in sys-
tem parameter
‘PVE_ARCHIVE_-
DAYS'.

PUR | Archive Ven- | pvearc_b | ARCHIVE N |Y |Y | C | This process
dors j_100_02 | VENDORS o | e | e | o | archives vendor
DATA TO s | s | m| invoice data from
OOTABLES m | OTABLEs to OOT-

0 | ABLEs based on

n | the days men-
tioned in system
parameter
‘PVE_OAR-
CHIVE_DAYS'.

QUE | Queue Cus- | qcsprc_b | CUS- N |Y |Y | C| This process cre-
tomer Ser- j_100_01 | TOMER o | e |e | o | atesthe customer
vice SERVICE s | s | m| service/collections

QUEUE m | queues
PROCESS- 0
ING n
SET- | QUEUES QCCPR | CRITERIA N|Y|Y This process facili-
QCS C _B- BASED tates to post crite-
J_100_0 | CONDI- ria based
1 TION POST- conditions on
ING Account.
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SET- | REAL TIME QCCPR | CRITERIA Y|Y This batch job pro-
QRT | QUEUES C_B- BASED cesses criteria
J_100_0 | CONDI- based condition
2 TION POST- posting queues
ING REAL marked as real
TIME PRO- time based on
CESSING refresh frequency
setup in the job
set.
RDB | RDB1 racd- Data Dump N |Y | Y | C | This process trans-
1 Accounts mp_b- Accounts o | e |e | o | fersthe account
j_100_01 s | s | m| data from (OLTP)
m | Regular tables to
o0 | Temporary T tables
n
RDB | RDB1 Appli- | rapd- LOAD Y | N | N | C | This process trans-
1 cations mp_b- APPLICA- e | o | o | o | fersthe applica-
j_100_01 | TION S m | tion data from
RELATED m | (OLTP) Regular
DATA INTO o | tables to Tempo-
T TABLES n | rary T tables
RDB | RDB1 Asset | ratd- LOAD N | Y | N | C | This process trans-
1 Tracking mp_b- ASSET o | e | o | o | fersthe account
j_100_01 | RELATED s m | asset data from
DATA INTO m | (OLTP) Regular
T TABLES o | tables to Tempo-
n | rary T tables
RDB | RDB1 Bank- | rbkd- LOAD N [N | Y | C| This process trans-
1 ruptcy mp_b- BANK- o | o | e | o | ferstheaccount
j_100_01 | RUPTCY s | m | bankruptcy data
DATATO T m | from (OLTP) Regu-
TABLES 0 | lar tables to Tem-
n | porary T tables
RDB RDB1 Call rcad- LOADCALL | N| N |Y | C | This process trans-
1 Activities mp_b- ACTIVITIES | o | o | e | o | fers the account
j_100_01 | DATA INTO s | m | call activity data
T TABLES m | from (OLTP) Regu-
o | lar tables to Tem-
n | porary T tables
RDB | RDB1 Defi- rchd- LOAD DEFI- | N | N | Y | C | This process trans-
1 ciency mp_b- CIENCY o | o | e | o | fersthe account
j_100_01 | DATA INTO s | m | deficiency data
T TABLES m | from (OLTP) Regu-
o | lar tables to Tem-
n | porary T tables
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RDB | RDB1 Con- rcod- LOADCON- | Y | Y | N | C | This process trans-
1 tracts mp_b- TRACT e | e | o | o | fersthe account
j_100_01 | DATAINTO |s |s m | contracts data from
T TABLES m | (OLTP) Regular
o | tables to Tempo-
n | rary T tables
RDB | RDB1 rfod- LOAD N [N | Y | C| This process trans-
1 Reposses- mp_b- REPO o | o |e | o | fersthe account
sions j_100_01 | FORECLO- s | m | bankruptcy data
SURE DATA m | from (OLTP) Regu-
INTOT o | lar tables to Tem-
TABLES n | porary T tables
RDB | RDB1 Pro- rprd- LOAD PRO- | N | Y | N | C | This process trans-
1 ducers mp_b- DUCER o|e |0 | o | fersthe producer
j_100_01 | AND ITS s m | and producer
TXNS DATA m | transactions data
INTOT o | from (OLTP) Regu-
TABLES n | lar tables to Tem-
porary T tables
RDB | RDB1 Setup | rstd- LOAD Y | Y | Y | C | This process trans-
1 mp_b- SETUP e | e | e | o | fersthe setup data
j_100_01 | RELATED s | s | s | m| from (OLTP) Regu-
DATA INTO m | lar tables to Tem-
T TABLES o | porary T tables
n
RDB | RDB1 Txns rtxd- LOAD TXN N |Y | N | C | This process trans-
1 mp_b- DATAINTO |o |e | o | o | fersthe account
j_100_01 | T TABLES s m | transactions data
m | from (OLTP) Regu-
o | lar tables to Tem-
n | porary T tables
RDB | RDB2 racac- Load N |Y | Y| C | This process trans-
2 Accounts c_b- Reporting o | e |e | o | fersthe account
j_100_01 | Tables s | s | m| datafrom T tables
Accounts m | to RDB tables
o]
n
RDB | RDB2 rac- Update N |Y |Y | C| This process
2 Accounts drv_b- Reporting o0 | e | e | o | updates the codes
(Derived j_100_01 | Tables s | s | m | with description for
Fields) Accounts m | account RDB
o | tables
n
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RDB | RDB2 Appli- | rapap- Load Y | N | N | C | This process trans-
2 cations p_b- Reporting e | o | o | o | fersthe applica-
j_100_01 | Tables Appli- | s m | tion data from T
cations m | tables to RDB
o | tables
n
RDB | RDB2 Appli- | rap- Update Y | N| N | C | This process
2 cations drv_b- Reporting e | 0 | o | o | updates the codes
(Derived j_100_01 | Tables Appli- | s m | with description for
Fields) cations m | application RDB
(Derived o | tables
Fields) n
RDB | RDB2 Asset | ratase_bj | Load N |Y | N| C | This process trans-
2 Tracking _100_01 | Reporting o | e |o | o | fersthe account
Tables Asset S m | asset tracking data
Tracking m | from T tables to
o | RDB tables
n
RDB | RDB2 Asset | ratdrv_b- | Update N |Y | N| C | This process
2 Tracking j_100_01 | Reporting 0 | e | o | o | updates the codes
(Derived Tables Asset S m | with description for
Fields) Tracking m | account asset
(Derived o | tracking RDB
Fields) n | tables
RDB | RDB2 Bank- | rbkab- Load N [N | Y | C| This process trans-
2 ruptcy d_b- Reporting o | o |e | o | fersthe account
j_100_01 | Tables s | m | bankruptcy data
Bankruptcy m | from T tables to
o | RDB tables
n
RDB | RDB2 Call rca- Load N | N | Y | C | This process trans-
2 Activities cac_b- Reporting o | o |e | o | fersthe account
j_100_01 | Tables Call s | m | call activities data
Activities m | from T tables to
o | RDB tables
n
RDB | RDB2 Defi- rchaof_bj | Load N | N | Y | C | This process trans-
2 ciency _100_01 | Reporting o | o | e | o | fersthe account
Tables Defi- s | m | deficiency data
ciency m | from T tables to
o | RDB tables
n
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RDB | RDB2 Con- rco- Load Y | Y | N | C | This process trans-
2 tracts con_b- Reporting e | e | o | o | fersthe account
j_100_01 | TablesCon- |s | s m | contract data from
tracts m | T tables to RDB
o | tables
n
RDB | RDB2 Con- rcodrv_bj | Update Y | Y| N | C | This process
2 tracts _100_01 | Reporting e | e | 0 | o | updates the codes
(Derived TablesCon- | s | s m | with description for
Fields) tracts m | account contract
(Derived o | RDB tables
Fields) n
RDB | RDB2 rfoafr_b- | Load N | N | Y | C| This process trans-
2 Reposses- j_100_01 | Reporting o | o |e | o | fersthe account
sions Tables s | m | repossession data
Reposses- m | from T tables to
sions o | RDB tables
n
RDB RDB2 Pro- rprdrv_b- | Update N |Y | N| C | This process
2 ducers j_100_01 | Reporting 0 | e | o | o | updates the codes
(Derived Tables Pro- S m | with description for
Fields) ducers m | producer and pro-
(Derived 0 | ducer transactions
Fields) n | RDB tables
RDB | RDB2 Pro- rprpro_b- | Load N |Y | N| C | This process trans-
2 ducers j_100_01 | Reporting o|e |0 | o | fersthe producer
Tables Pro- s m | and producer
ducers m | transactions data
o | from T tables to
n | RDB tables
RDB | RDB2 Setup | rststp_b- | Load Y | Y | Y| C | This process trans-
2 j_100_01 | Reporting e | e | e | o | fersthe setup data
Tables s |s |s | m|fromTtablesto
Setup m | RDB tables
o]
n
RDB RDB2 Txns rtxdrv_b- | Load N |Y | Y | C | This process trans-
2 j_100_01 | Reporting o | e | e | o | fersthe account
Tables Txns s | s | m | transaction data
m | from T tables to
o | RDB tables
n
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RDB | RDB2 Txns rixtxn_b- | Update N |Y | Y | C | This process

2 (Derived j_100_01 | Reporting 0 | e | e | o | updates the codes
Fields) Tables Txns s | s | m | with description for

(Derived m | account transac-
Fields) o | tions RDB tables
n
SEC | Pool Sum- ssm- POOL SUM- | N | Y | N | C | This process popu-
mary prc_b- MARY o|e |0 | o |latessummary
j_100_01 | TABLE s m | tables for all pools
POPULA- m
TION o]
n

SET- | OVERPAY- PFSTX- OVERPAY- N [Y | N | C | This process han-

OVR | MENT NOVR_B | MENT o | e |0 | o | dlestheoverpay-
REALLOCA- | J_100_0 | REALLOCA- S m | ments/overages
TIONS 1 TIONS m | existing on an

o | account
n
TPE Earning/ tam- AMORTIZA- | N | Y | N | C | This process cre-
Amortization | prc_b- TION o | e | o | o | atesthe month-
j_100_01 | TRANSAC- s m | end interest
TIONS m | accrual transac-
PROCESS- o | tions on month-
ING n | end.
TPE Earning/ tam- MONTH N |Y | N|L | This process cre-
Amortization | prc_b- END AMOR- | o | e | 0o | 0 | ates the month-
j_111_01 | TIZATION s a | end interest
TRANSAC- n | accrual transac-
TIONS tions on month-
end.

TPE Escrow Non | tenbmt_b | EscrowNon | N | Y | Y | C | This process posts
Monetary j_100_01 | Monetary O | e | e | 0| escrownon mone-
Transactions Batch Trans- s | s | m| tarytransactionsin

actions m | the background at
o | the specified time
n | interval.

TPE Escrow Anal- | tesanl_b- | Escrow N | Y | N | C | This process posts
ysis & Dis- j_100_01 | Analysis o|e | o | o | allapproved
bursements Posting S m | escrow analysis to

m | the account
o}
n
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TPE Escrow Anal- | tesanl_b- | Create N [Y | N | C | This process cre-
ysis & Dis- j_100_02 | batches for o|e |0 | o | atescompany
bursements Customer S m | branch wise

Refund m | batches for cus-
Requests o | tomer refund
n | requests.

TPE Escrow Anal- | tesanl_b- | Create N |Y | N | C | This process popu-
ysis & Dis- j_100 03 | Transaction | o | e | o | o | late customer
bursements of Customer s m | refund request in

Refund m | respective batch
Requests o0 | created above
n

TPE Escrow Anal- | tesanl_b- | Compute N | Y | N | C | This process popu-
ysis & Dis- j_100_04 | controltotals | 0 | e | o | o | lates control totals
bursements for cus- s m | for the bathes cre-

tomerrefund m | ated for customer
request o | refund requests.
batches n

TPE Escrow Anal- | tesanl_b- | Escrow N |Y | N|C | This process
ysis & Dis- j_100_05 | compliance o0 | e | o | o | checks escrow-
bursements checking S m | able account for

m | compliance
o}
n

TPE Escrow Anal- | tesds- Escrow dis- N | Y | N | C | This process posts
ysis & Dis- b_b- bursement O | e | o | o | processed escrow
bursements j_100_05 | posting & s m | disbursement and

requisition m | creates requisi-
creation o | tions.
n

TPE Non Mone- tnmb- NON MON- N | Y | Y | C | This process posts
tary Transac- | mt_b- ETARY o | e | e | 0o | non monetary
tions j_100_01 | TRANSAC- s | s | m| transactions in the

TIONS m | background at the
POSTING o | specified time
n | interval.
TPE Compensa- tpr- Compensa- N |[Y | N|L | This process cre-
tion com_b- tion o | e | o | o | atestransactionfor
j_111_01 s a | month-end pro-
n | ducer compensa-
tion
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TPE Statement tprps- Producer N |Y | N|L | This process cre-
g_b- Statement o | e | o | o | atesthe month-
i_111_01 s a | end interest
n | accrual transac-
tions on month-
end.
TPE Monetary txnacr_b- | INTEREST N | Y | N| C | This process posts
Transactions | j_100_01 | ACCRUAL o | e | o | o0 | anypayment
AND DELIN- S m | batches open in
QUENCY m | the system. This
PROCESS- 0 | process can be set
ING n | to run periodically.
TPE Monetary txnact_b- | ACCOUNT N |Y | N | C | This job activates
Transactions | j_100_01 | ACTIVA- o | e | o | o | newaccountsi.e.
TION s m | changes status
m | from PENDING to
o | ACTIVE.
n
TPE Monetary txnad- Advance N | Y | N|L | This process posts
Transactions | v_b- Posting o|e o |i | anyadvance
j_112_01 s n | batches openin
e | the system. This
process can be set
to run periodically.
TPE Monetary txnan- ANNIVER- N |Y | N| C | This process car-
Transactions | n_b- SARY PRO- | o | e | o | 0 | ries out the anni-
j_100_01 | CESSING s m | versary processing
m | for eligible
o | accounts
n
TPE Monetary txnomt_b | MONE- N | Y | N | C | This process posts
Transactions | j_100_01 | TARY 0 | e |0 | o | monetary transac-
TRANSAC- s m | tions in the back-
TIONS m | ground at the
POSTING o | specified time
n | interval.
TPE Monetary txnch- Chargeoff N |Y | N| C | This process
Transactions | g_b- Processing o | e | o | o | charges off eligi-
j_100_01 s m | ble or scheduled
m | for chargeoff
o | accounts.
n
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TPE Monetary txnch- Chargeoff N |[Y | N | C | On posting charge
Transactions | g_b- reversal o | e |o | o | offreversal trans-
j_100_03 s m | action, this pro-
m | cess moves the
0 | remaining expense
n | and fee from
charge off balance
to active balance.
TPE Monetary txncls_b- | VOID/PAID N |Y | N| C | This process
Transactions | j 100_01 | ACCOUNT o |e |0 | o | closes void and
CLOSE s m | paid off accounts.
PROCESS- m
ING o]
n
TPE Monetary txnddt_b- | BILLING/ N |Y | N| C | This process cre-
Transactions | j 100_01 | DUEDATES | o | e | o | o | ates/updates the
PROCESS- s m | due dates for the
ING m | accounts in the
o | system.
| In addition, this
process can also
do Asset Billing
using asset param-
eters defined for
‘Home’ collateral.
For more details,
refer to Asset Bill-
ing Rate section.
TPE Monetary txnfpd_b- | FIRSTPMT | N | Y | N | C | This process posts
Transactions | j_100_01 | DEDUC- o |e |0 | o | thefirst payment
TION PRO- s m | deduction pay-
CESSING m | ment to the eligi-
0 | ble accounts.
n
TPE Monetary txnfpr_b- | FIRSTPMT | N | Y | N | L | This process posts
Transactions | j_111_01 | REFUND o |e |0 | o | thefirst payment
PROCESS- s a | deduction pay-
ING n | ment to the eligi-
ble accounts.
TPE Monetary txnltc_b- | LATE N |Y | N| C | This process
Transactions | j_100_01 | CHARGE O | e | 0| o0 | assesses late
PROCESS- s m | charge depending
ING m | on the rules, for all
0 | accounts in the
n | system.
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TPE Monetary txnmt- MONTH N |Y | N | C | This process popu-
Transactions | d_b- END PRO- o | e | o | o | latesthe month
j_100_01 | CESSING s m | end balances and
m | carries over the
o | balances to next
n | month.
TPE Monetary txnp- Payment N |Y | N| C | This process does
Transactions | mt_b- Posting o | e | o | o | thedaily accrual
j_100_01 s m | and delinquency
m | processing.
o]
n
TPE Monetary txn- PROMO- N |Y | N| C | Thisprocess'ends'
Transactions | prm_b- TION END o | e | o | o | thepromotionon
j_100_01 | PROCESS- s m | the account.
ING m
o]
n
TPE Monetary txn- TLP PRO- N |Y | N | C | This process 'can-
Transactions | prm_b- MOTION o |e | o | o | cels'the promo-
j_100_03 | CANCEL s m | tion on the
PROCESS- m | account.
ING o}
n
TPE Monetary txnrat_b- | RATE N |Y | N| C | This process
Transactions | j 100_01 | CHANGE o0 | e | 0o | o | changes the prev-
PROCESS- s m | alent rate on an
ING m | account.
o}
n
TPE Monetary txn- SCHEDULE | N | Y | N | C | This process puts
Transactions | sch_b- FOR o | e | o | o | the'Schedule for
j_100_01 | CHARGED s m | Charge Off condi-
OFF PRO- m | tion on eligible
CESSING 0 | accounts.
n
TPE Monetary txntip_b- | TERMINA- N | Y | N | C | This process puts
Transactions | j 100_01 | TIONPRO- | o |e | o | o | the"Paid" status
CESSING S m | on eligible
m | accounts
o}
n
2-80 ORACLE




& 5| o €

Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73

c = 0| O| =

w Olwm|O|a

TPE Monetary txnytd_b- | YEAR END N |Y | N | C | This process popu-

Transactions | j 100 01 | PROCESS- | o | e | o | o | lates the year end
ING s m | balances and car-
m | ries over the bal-
0 | ances to next year.
n

TPE Usage TXNUS- | BillingBatch | N | Y | Y | C | This process is
Charge Pro- | G_B- job to pro- o0 | e |e | o | usedtoderive the
cessing J_100_0 | cess and s | s | m| billing amount to

1 post lease m | be charged for
usage/rental 0 | Lease Usage/
fees on n | Rental based
account asset for con-

sumed units calcu-
lated by the
applicable charge
matrix.

TPE MOCK BILL- | TXN- MOCKBILL- | Y | Y | Y | C | This process gen-
ING/DUE MDT_B- | ING/DUE e | e | e | o | erates the future
DATES J_100_0 | DATES s | s | s | m| dues/balances
PROCESS- 1 PROCESS- m | based on the
ING ING 0 | parameters

n | defined in the crite-
ria. This batch job
is a prerequisite
run for the mock
statements to get
generated.

TPE CAPITAL- TXNCPT | CAPITAL- Y | Y| Y| C| This processis
IZATION _BJ 100 | IZATION e | e | e | o | used to capitalize
PROCESS- _01 PROCESS- |s |s | s | m| the balance on all
ING ING m | qualified accounts

o | and is configured

n | to run after running
the billing batch
job.

TPE POST TXNEG- | POST Y This process is
MATURITY C B- MATURITY e used to pick-up
EVER J_121_0 | EVER S accounts match-
GREEN 1 GREEN ing the criteria for
TRANSAC- TRANSAC- evergreen
TION PRO- TION PRO- renewal, waits for
CESSING CESSING maturity date

based on grace
days and posts
Evergreen Lease
transaction.
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TPE CYCLE TXNCB- | CYCLE Y | Y| Y | C | This process facili-
BASED C B- BASED o | tates to calculate
COLLEC- J_100_0 | COLLEC- m | ‘Cycle based Col-
TION LATE 1 TION LATE m | lection Late Fee’ at
FEE PRO- FEE PRO- o | account level and
CESSING CESSING n | update the bal-
ances.
TPE CYCLE TXNC- CYCLE Y | Y| Y| C | This process facili-
BASED BL_B- BASED o | tates to calculate
LATE FEE J_100_0 | LATE FEE m | ‘Cycle Based Late
PROCESS- 1 PROCESS- m | Fee’ at account
ING ING o | level and update
n | the balances.
XPR | DEALER XPRP- DEALER N |Y |Y | C | This process
TRACK ST EW_ | TRACK 0 | dumps producer
PRO- 100_01 PRO- m | details maintained
DUCER DUCER m | in the system into
LOAD LOAD o | Dealer Track.

: System can either
use MDB flow by
generating out-
bound JMS mes-
sage if system
parameter ‘OUT-
BOUND_DL-
R_TRACK Q' is
set to ‘Y’ or use
existing flow by
making database
synchronous out-
bound calls to pro-
ducer data dump
web service.
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XPR | ROUTEONE | XPRP- ROUTE N |Y | Y| C | This process

2 PRO- ST _EW_ | ONE PRO- 0 | dumps producer
DUCER 100_01 DUCER m | details maintained
LOAD LOAD m | in the system into

o | ROUTEONE.

n System can either
use MDB flow by
generating out-
bound JMS mes-
sage if system
parameter ‘OUT-
BOUND_ROU-
TEONE_Q' is set
to 'Y’ or use exist-
ing flow by making
database synchro-
nous outbound
calls to producer
data dump web
service.

LTR CONDI- LORAC CONDI- Y | N | N | L | This process gen-
TIONAL O_B- TIONAL e | o | o | o | eratesthe adverse
ADVERSE J_100_0 | ADVERSE S a | action letter for rel-
ACTION 1 ACTION n | evant applications.
LETTER LETTER

GENERA-
TION

LTR ADVERSE LORAD- | ADVERSE Y | N| N | L | This process gen-
ACTION V_B- ACTION e | o | o | o | eratesthe adverse
LETTER J_100_0 | LETTER S a | action letter for rel-

1 GENERA- n | evant applications.
TION

RPT | ACCOUNT ROPAC- | ACCOUNT N|Y|N|C

LIST C EM_1 | LIST o|le|o|o
00_01 s m

m

o}

n

RPT | ADVANCE ROPAD- | ADVANCE N|Y | N|C
POSTING V_EM_1 | POSTING ole|o|o
LIST 00_01 LIST S m

m

o]

n
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RPT | ASSET ROPAT- | ASSET N|Y|N|C
TRACKING K EM_1 | TRACKING |o |e |0 |oO
DETAILS 00_01 DETAILS s m
m
o}
n
RPT | BANK- ROPBN BANK- NlY | N|C
RUPTCY K EM_1 | RUPTCY ole|o|o
ACCOUNT 00_01 ACCOUNT s m
LIST LIST m
o]
n
RPT | COLLEC- ROP- COLLEC- NlY | N|C
TORACTIV- | COL_EM | TORACTIV- |o |e |0 | O
ITY DETAILS | _100_01 | ITY s m
DETAILS m
o]
n
RPT | DEFI- ROP- DEFI- N|Y|N|C
CIENCY DEF_EM | CIENCY ole|o|o
ACCOUNT _100_01 | ACCOUNT s m
LIST LIST m
o}
n
RPT | DELIN- ROP- DELIN- NlIY | N|C
QUENT DLQ_EM | QUENT ole|o|o
ACCOUNT _100_01 | ACCOUNT s m
LIST LIST m
o]
n
RPT | FUNDING ROP- FUNDING NIY | N|C
CONTRACT | FUN_EM | CON- ole|o|o
LIST _100_01 | TRACT LIST s m
m
o
n
RPT | GL TXN ROP- GL TXN N|Y|N|C
DETAILS GLI_EM | DETAILS ole|o|o
LIST _100_01 | LIST s m
m
o}
n
2-84 ORACLE



& 5| o €
Ea Description ?:ktfh Description E :E '% § Comment
=) D 2| =73
c = 0| O| =
w Olwm|O|a
RPT | APPLICA- ROPOR | APPLICA- N|Y|N|C
TIONSLIST | G_CEM_1 | TIONSLIST |o |e |0 | O
00_01 s m
m
o}
n
RPT | PAYMENT ROP- PAYMENT NlY | N|C
ALLOCA- PAL EM | ALLOCA- ole|o|o
TION POST- | _100_01 | TION POST- s m
ING ING m
DETAILS| DETAILS]| o}
n
RPT | PAYMENT ROP- PAYMENT NlY | N|C
POSTING PMT_EM | POSTING ole|o|o
LIST _100_01 | LIST s m
m
o]
n
RPT | PAYABLE ROP- PAYABLE N|Y|N|C
REQUISI- PRQ_E REQUISI- ole|o|o
TION LIST M_100_0 | TION LIST s m
1 m
o}
n
RPT | REPOSSSE- | ROPRE REPOS- N|Y | N|C
SION/FORE- | P_LEM_1 | SSESION/ ole|o|o
CLOSURE 00_01 FORECLO- s m
ACCOUNT SURE m
LIST ACCOUNT o}
LIST n
RPT | SCHEDULE | ROP- SCHEDULE |[N|Y |N|C
TO CHAR- SCH_EM | TO CHAR- ole|o|o
GEOFF LIST | _100_01 | GEOFF s m
LIST m
o]
n
RPT | TERMINA- ROP- TERMINA- N|Y|N|C
TION IN TIP_EM_ | TION IN ole|o|o
PROGRESS | 100_01 PROG- s m
LIST RESS LIST m
o}
n
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RPT NON MON- ROPTN- | NONMON- [ N|Y [N |C
TETARY M_EM_1 | TETARY olel|o|o
TXN POST- 00_01] TXN POST- s m
ING LIST ING LIST m
o}
n
RPT MON- ROPTX- | MON- N|Y | N|C
TETARY N_EM_1 | TETARY o|le|o|o
TXN POST- 00_01 TXN POST- s m
ING LIST ING LIST m
o}
n
RPT BATCH JOB | CMN- BATCHJOB |[N|Y [N |C
SETUP BJB_EM | SETUP o|le|o|o
100 _01 s m
m
o]
n
RPT BATCH JOB | CMN- BATCHJOB [N|Y [N |C
LOG BJB_EM | LOG ole|o|o
_100_02 s m
m
o}
n
RPT NUMBER OUN- NUMBER NlY | N|C
OF CREDIT | ADE_EM | OFCREDIT (o |e |0 | O
APPLICA- _100_01 | APPLICA- s m
TIONS TIONS m
ENTERED ENTERED 0
BY USER BY USER n
RPT | CREDIT OUN- CREDIT NlY | N|C
APPLICA- ADE_EM | APPLICA- o|le|o|o
TIONS _100_02 | TIONS s m
IMAGES BY IMAGES BY m
STATUS STATUS o
n
RPT UNDER- OUNUN | UNDER- N|Y|N|C
WRITING D _EM_1 | WRITING olel|o|o
STATUS BY 11_1 STATUS BY s m
MONTH MONTH m
AND PRO- AND PRO- o}
DUCER DUCER n
(LOAN) (LOAN)
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RPT UNDER- OUNUN | UNDER- N|Y|N|C
WRITING D_EM_1 | WRITING o|le|o|oO
STATUS BY 11_12 STATUS BY S m
MONTH MONTH m
AND AND o]
UNDER- UNDER- n
WRITER WRITER
(LOAN) (LOAN)

RPT UNDER- OUNUN | UNDER- NlY | N|C
WRITING D EM_1 | WRITING ole|o|o
STATUS BY 11_13 STATUS BY s m
MONTH MONTH m
(LOAN) (LOAN) 0

n

RPT UNDER- OUNUN | UNDER- N|Y | N|C
WRITING D _EM_1 | WRITING ole|o|o
STATUS BY 11_14 STATUS BY s m
UNDER- UNDER- m
WRITER WRITER 0
(LOAN) (LOAN) n

RPT UNDER- OUNUN | UNDER- NIY | N|C
WRITING D_EM_1 | WRITING o|le|o|oO
STATUS BY 12_11 STATUS BY S m
MONTH MONTH m
AND PRO- AND PRO- o]
DUCER DUCER n
(LINE) (LINE)

RPT UNDER- OUNUN | UNDER- N|Y | N|C
WRITING D EM_1 | WRITING ole|o|o
STATUS BY 12_12 STATUS BY s m
MONTH MONTH m
AND AND 0
UNDER- UNDER- n
WRITER WRITER
(LINE) (LINE)

RPT UNDER- OUNUN | UNDER- NIY | N|C
WRITING D_EM_1 | WRITING ole|o|o
STATUS BY 12_13 STATUS BY s m
MONTH MONTH m
(LINE) (LINE) 0

n
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RPT UNDER- OUNUN | UNDER- N|Y|N|C
WRITING D_EM_1 | WRITING o|le|o|o
STATUS BY 12_14 STATUS BY S m
UNDER- UNDER- m
WRITER WRITER o]
(LINE) (LINE) n

RPT UNDER- OUNUN | UNDER- N|Y | N|C
WRITING D EM_1 | WRITING ole|o|o
STATUSBY |21 11 STATUS BY s m
MONTH MONTH m
AND PRO- AND PRO- o}
DUCER DUCER n
(LEASE) (LEASE)

RPT UNDER- OUNUN | UNDER- NlY | N|C
WRITING D_EM_1 | WRITING ole|o|o
STATUS BY | 21_12 STATUS BY s m
MONTH MONTH m
AND AND 0
UNDER- UNDER- n
WRITER WRITER
(LEASE) (LEASE)

RPT UNDER- OUNUN | UNDER- NIY | N|C
WRITING D_EM_1 | WRITING o|le|o|oO
STATUS BY | 21_13 STATUS BY S m
MONTH MONTH m
(LEASE) (LEASE) o]

n

RPT UNDER- OUNUN | UNDER- Y|N|N]J|L
WRITING D EM_1 | WRITING e|o|o|e
STATUS BY | 21 _14 STATUS BY | s a
UNDER- UNDER- s
WRITER WRITER e
(LOAN) (LOAN)

RPT | ACCOUNT OFNA- ACCOUNT Y|N|N|C
PAYABLE PY_EM_ | PAYABLE e|o|o|oO
(ORIGINA- 100_01 (ORIGINA- s m
TION) TION) m

o
n

RPT | ACCOUNT OFNA- ACCOUNT N|Y|N|C
PAYABLE PY_EM_ | PAYABLE o|le|o|oO
(SERVIC- 100_02 (SERVIC- S m
ING) ING) m

o]
n
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RPT | PRE-FUND- | OFNF- PRE-FUND- | Y [N | N |L
ING CON- ND_EM_ | ING CON- e|o|o|o
TRACTS 111_01 TRACTS s a

(LOAN) (LOAN) n

RPT | FUNDED OFNF- FUNDED Y| N|N]|I
CON- ND _EM_ | CON- e|o|o|o
TRACTS 111_02 TRACTS S a

(LOAN) (LOAN) n

RPT | PRE-FUND- | OFNF- PRE-FUND- | Y [N | N |L
ING CON- ND_EM_ | ING CON- e|o|o|oO
TRACTS 112_01 TRACTS S a

(LINE) (LINE) n

RPT | FUNDED OFNF- FUNDED Y| N|N|C
CON- ND_EM_ | CON- e|lo|o|o
TRACTS 112_02 TRACTS s m

(LINE) (LINE) m

o}

n

RPT | PRE-FUND- | OFNF- PRE-FUND- [ Y [N | N |C
ING CON- ND_EM_ | ING CON- elo|o|o
TRACTS 121_01 TRACTS s m
(LEASE) (LEASE) m

o}

n

RPT | FUNDED OFNF- FUNDED Y| N|[N|L
CON- ND_EM_ | CON- e|lo|o|o
TRACTS 121_02 TRACTS S a
(LEASE) (LEASE) n

RPT | ACCOUNT OCSAP- | ACCOUNT Y| N|N|L
PAYABLE P_EM_1 | PAYABLE elo|o|o

LOG BY 00_01 LOG BY s a
PRODUCER PRODUCER n

RPT | ACCOUNT OCSAPV | ACCOUNT Y| N|N|L
PAYABLE _EM_10 | PAYABLE e|o|o|oO

LOG BY 001 LOG BY s a
VENDOR VENDOR n

RPT | COLLAT- OCSAS- | COLLAT- Y|N|N|C
ERAL T EM_1 | ERAL elo|o|o
TRACKING 00_01 TRACKING | s m
LOG LOG m

o]

n
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RPT | GL POST- 0OCS- GL POST- Y| N|N|C
ING LOG GLI_EM ING LOG e|o|o|o
_100_01 S m
m
o}
n
RPT | PAYMENT OCSP- PAYMENT Y|N|N|C
POSTING MT_EM_ | POSTING elo|o|o
(DAILY 100_01 (DAILY s m
CASH) LOG CASH) LOG m
o]
n
RPT | PAYMENT OCSP- PAYMENT Y|N|N|C
POSTING MT_EM_ | POSTING elo|o|o
ERROR 100_02 ERROR s m
LOG LOG m
o]
n
RPT | ACCOUNT OCSAC- | ACCOUNT Y| N|N|L
LISTING C_EM_1 | LISTING elo|o|o
(LOAN) 11_01 (LOAN) s a
n
RPT | EXCESS OCSP- EXCESS Y|N|NJ|L
PAYMENT MT_EM_ | PAYMENT elo|o|o
(REFUND) 111_03 (REFUND) S a
LOG (LOAN) LOG n
(LOAN)
RPT | PAYMENT OCSP- PAYMENT Y| N|N|L
HISTORY MT_EM_ | HISTORY elo|o|o
(LOAN) 111_04 (LOAN) S a
n
RPT | PAYMENT OCSP- PAYMENT Y| N|N|L
ALLOCA- MT_EM_ | ALLOCA- elo|o|o
TIONS LOG | 111_05 TIONS LOG | s a
(LOAN) (LOAN) n
RPT | PAYMENT OCSP- PAYMENT Y| N|N|L
ALLOCA- MT_EM_ | ALLOCA- elo|o|o
TIONS LOG | 111_06 TIONS LOG | s a
BY GLPOST BY GL n
DT (LOAN) POST DT
(LOAN)
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c = 0| O| =

w Olwm|O|a

RPT PRO- OCSPS- | PRO- Y|N|NJ|L
DUCER M_EM_1 | DUCER e|o|o|oO
STATE- 11_01 STATE- S a
MENT MENT n
(LOAN) (LOAN)

RPT PRO- OCSPTX | PRO- Y|N|NJ|L
DUCER _EM_111 | DUCER e|o|o|oO
MONETARY | 01 MONE- S a
TXNS LOG TARY TXNS n
BY GLPOST LOG BY GL
DT (LOAN) POST DT

(LOAN)

RPT | SCHED- OCSS- SCHED- Y|N|NJ|L
ULED FOR CH_EM_ | ULED FOR elo|o|o
CHAR- 111_01 CHAR- S a
GEOFF GEOFF n
ACCOUNTS ACCOUNTS
LOG (LOAN) LOG

(LOAN)

RPT | AMOR- OCSTA AMOR- Y|N|N]J|L
TIZEDTXNS | M_EM_1 | TIZED e|o|o|oO
LOG BY GL 11_01 TXNS LOG S a
POST DT BY GL n
(LOAN) POST DT

(LOAN)

RPT | SCHED- OCSTER | SCHED- Y|N|NJ|L
ULED FOR _EM_111 | ULED FOR elo|o|o
TERMINA- _01 TERMINA- s a
TION TION n
ACCOUNTS ACCOUNTS
LOG (LOAN) LOG

(LOAN)

RPT MONETARY | OCSTX- | MONE- Y|N|N]J|L
TXNS LOG N EM 1 | TARYTXNS |e |o |0 |0
BY GLPOST | 11_01 LOGBYGL |s a
DT (LOAN) POST DT n

(LOAN)

RPT | ACCOUNT OCSAC- | ACCOUNT Y|N|NJ|L
LISTING C_EM_1 | LISTING e|o|o|oO
(LINE) 12_01 (LINE) S a

n

RPT | ADVANCE OCSAD- | ADVANCE Y|N|NJ|L
POSTING V_EM_1 | POSTING elo|o|o
LOG (LINE) 12_01 LOG (LINE) | s a

n
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RPT | ADVANCE OCSAD- | ADVANCE Y| N|N|L
POSTING V_EM_1 | POSTING elo|o|o
ERROR 12_02 ERROR s a
LOG (LINE) LOG (LINE) n
RPT | PAYMENT OCSP- PAYMENT Y|N|N]J|L
HISTORY MT_EM_ | HISTORY elo|o|o
(LINE) 112_04 (LINE) s a
n
RPT | PAYMENT OCSP- PAYMENT Y|N|N|C
ALLOCA- MT_EM_ | ALLOCA- elo|o|o
TIONS LOG | 112_05 TIONS LOG | s m
(LINE) (LINE) m
o]
n
RPT | PAYMENT OCSP- PAYMENT Y| N|N|C
ALLOCA- MT_EM_ | ALLOCA- elo|o|o
TIONS LOG | 112_06 TIONS LOG | s m
BY GLPOST BY GL m
DT (LINE) POST DT o}
(LINE) n
RPT | SCHED- OCSS- SCHED- Y| N|N|C
ULED FOR CH_EM_ | ULED FOR elo|o|o
CHAR- 112_01 CHAR- s m
GEOFF GEOFF m
ACCOUNTS ACCOUNTS o}
LOG (LINE) LOG (LINE) n
RPT | AMOR- OCSTA AMOR- Y|N|N|C
TIZEDTXNS | M_EM_1 | TIZED elo|o|o
LOG BY GL 12_01 TXNS LOG S m
POST DT BY GL m
(LINE) POST DT o
(LINE) n
RPT | SCHED- OCSTER | SCHED- Y|N|N|C
ULED FOR _EM_1 ULED FOR elo|o|o
TERMINA- 2_01 TERMINA- s m
TION TION m
ACCOUNTS ACCOUNTS o}
LOG (LINE) LOG (LINE) n
RPT | MONETARY | OCSTX- | MONE- Y|N|N|C
TXNS LOG N_EM_1 | TARYTXNS |e |o |0 | O
BY GLPOST | 12_01 LOGBYGL | s m
DT (LINE) POST DT m
(LINE) o}
n
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RPT | ACCOUNT OCSAC- | ACCOUNT Y| N|N|C
LISTING C_EM_1 | LISTING e|o|o|oO
(LEASE) 21_01 (LEASE) S m
m
o]
n
RPT PAYMENT OCSP- PAYMENT Y|N|N|C
HISTORY MT_EM_ | HISTORY elo|o|o
(LEASE) 121_04 (LEASE) s m
m
o]
n
RPT PAYMENT OCSP- PAYMENT Y|N|N|C
ALLOCA- MT_EM_ | ALLOCA- elo|o|o
TIONS LOG 121_05 TIONS LOG | s m
(LEASE) (LEASE) m
o
n
RPT PAYMENT OCSP- PAYMENT Y|N|N|C
ALLOCA- MT_EM_ | ALLOCA- e|o|o|oO
TIONS LOG 121_06 TIONS LOG | s m
BY GLPOST BY GL m
DT (LEASE) POST DT o]
(LEASE) n
RPT | SCHED- OCSS- SCHED- Y|N|N|C
ULED FOR CH_EM_ | ULED FOR elo|o|o
CHAR- 121_01 CHAR- s m
GEOFF GEOFF m
ACCOUNTS ACCOUNTS o}
LOG LOG n
(LEASE) (LEASE)
RPT | AMOR- OCSTA AMOR- Y|N|N|C
TIZEDTXNS | M_EM_1 | TIZED elo|o|o
LOG BY GL 21_01 TXNS LOG s m
POST DT BY GL m
(LEASE) POST DT 0
(LEASE) n
RPT | SCHED- OCSTER | SCHED- Y| N|N|C
ULED FOR _EM_12 | ULED FOR e|o|o|oO
TERMINA- 101 TERMINA- S m
TION TION m
ACCOUNTS ACCOUNTS o]
LOG LOG n
(LEASE) (LEASE)
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RPT MONETARY | OCSTX- | MONE- Y| N|N|C
TXNS LOG N_EM_1 | TARYTXNS |e |0 |0 | O
BY GLPOST | 21_01 LOGBYGL |s m
DT (LEASE) POST DT m
(LEASE) o]
n
RPT BANK- OCOBN | BANK- Y|N|N|C
RUPTCY K EM_1 | RUPTCY elo|o|o
LOG 00_01 LOG s m
m
o]
n
RPT | COLLEC- OCO- COLLEC- NI{N|Y | C
TORACTIV- | COL_EM | TORACTIV- |o |o |e |0
ITY _100_01 | ITY s | m
(DETAILED) (DETAILED) m
LOG LOG o]
n
RPT | COLLEC- OCO- COLLEC- N{N|Y | C
TOR PRO- COL_EM | TOR PRO- o|o|e|o
DUCTIVITY _100_02 | DUCTIVITY s |m
BY QUEUE BY QUEUE m
o]
n
RPT DELIN- OCO- DELIN- NI{N|Y |C
QUENCY COL_EM | QUENCY o|lol|e|o
ANALYSIS _100_03 | ANALYSIS s |m
BY PRO- BY PRO- m
DUCER DUCER o}
n
RPT DELIN- OCO- DELIN- NI{N|Y | C
QUENCY COL_EM | QUENCY o|lol|e|o
ANALYSIS _100_04 | ANALYSIS s |m
BY CREDIT BY CREDIT m
GRADE GRADE 0
n
RPT DELIN- OCO- DELIN- NIN|Y|C
QUENCY COL_EM | QUENCY o|lo|e|o
ANALYSIS _100_05 | ANALYSIS s |m
BY STATE BY STATE m
o]
n
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RPT | PAYMENT OCO- PAYMENT NIN|Y |C
PROMISE COL_EM | PROMISE o|lol|e|o
LOG _100_06 | LOG s |m
m
o}
n
RPT | COLLEC- OCO- COLLEC- N{N|Y | C
TORACTIV- | COL_EM | TORACTIV- o |o | e |0
ITY LOG _100_07 | ITYLOG s |m
m
o]
n
RPT | DEFI- OCODE- | DEFI- N{N|Y | C
CIENCY F EM_1 | CIENCY o|ol|e|o
LOG 00_01 LOG s |m
m
o]
n
RPT | DELIN- OCODL DELIN- NIN|Y|C
QUENCY Q_EM_1 | QUENCY o|lol|e|o
LOG 00_01 LOG s |m
m
o}
n
RPT | REPOSSES- | OCORE | REPOS- N{N|Y | C
SION/FORE- | P_LEM_1 | SESSION/ o|lol|e|o
CLOSURE 00_01 FORECLO- s |m
LOG SURE LOG m
o]
n
RPT | NON MONE- | OCOTN- | NONMON- |[N|N|Y |C
TARY TXNS | M_EM_1 | ETARY o|ol|e|o
LOG 00_01 TXNS LOG s |m
m
o
n
RPT | VENDOR OCOVIN | VENDOR NIN|Y|C
INVOICE _EM_10 | INVOICE o|lol|e|o
LOG 0_01 LOG s |m
m
o}
n
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RPT | VENDOR OCOVN | VENDOR NIN|Y|C
WORK A EM 1 | WORK o|lo|e|o
ORDER 00_01 ORDER s |m
LOG LOG m
o}
n
RPT | POOL OCSs- POOL N|Y | N|C
DELIN- SEC_EM | DELIN- ole|o|o
QUENCY _111_01 | QUENCY s m
SUMMARY SUMMARY m
(LOAN) (LOAN) o}
n
RPT | POOL OCS- POOL NlY | N|C
DEFAULTS SEC_EM | DEFAULTS ole|o|o
(NON LIQUI- | _111_02 | (NON LIQ- S m
DATED) UIDATED) m
(LOAN) (LOAN) o]
n
RPT | POOL PAY- 0OCSs- POOLPAY- [N|Y |N|C
OFFS SEC_EM | OFFS ole|o|o
(LOAN) _111_03 | (LOAN) s m
m
o}
n
RPT | POOL OCSs- POOL NlY | N|C
RECOVERY | SEC_EM | RECOV- ole|o|o
(LOAN) _111_04 | ERY (LOAN) s m
m
o}
n
RPT | POOL OCS- POOL NIY | N|C
DELIN- SEC_EM | DELIN- ole|o|o
QUENCY _111_05 | QUENCY s m
(LOAN) (LOAN) m
o
n
RPT | POOL 0OCSs- POOL N|Y|N|C
REPUR- SEC_EM | REPUR- ole|o|o
CHASED _111_06 | CHASED s m
ACCOUNTS ACCOUNTS m
(LOAN) (LOAN) o}
n
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RPT | POOL 0OCS- POOL N|Y|N|C
MONTHLY SEC_EM | MONTHLY olel|o|o
ACTIVITY _111_07 | ACTIVITY s m
(LOAN) (LOAN) m
o}
n
RPT | POOL LIQ- OCS- POOL LIQ- N|IY|N|C
UIDATED SEC_EM | UIDATED ole|o|o
CON- _111_08 | CON- S m
TRACTS TRACTS m
(LOAN) (LOAN) o}
n
RPT | POOLTXNS | OCS- POOLTXNS [N|Y [N |C
LOG BY GL SEC_EM | LOGBYGL |o|e |0 | O
POST DT _111_09 | POST DT S m
(LOAN) (LOAN) m
o]
n
SET- | Realtime QCSPR Real time N |Y |Y | C | This batch job pro-
QRT | Queues pro- | C_B- Queuespro- | 0 | e | e | O | cesses queues
cessing J_100_0 | cessing s | s | m| marked as real
2 m | time based on
o | refresh frequency
n | setup in the job
set.
TAM | MONTH TPR- MONTH N|IY|N|C
END COM- COM_B- | END COM- ole|o|o
PENSATION | J_100_0 | PENSA- S m
DISBURSE- | 1 TION m
MENT PRO- DISBURSE- o]
CESSING MENT PRO- n
CESSING
TAM | PRO- TPRPS- | PRO- N|IY|N|C
DUCER G _B- DUCER o|le|o|o
STATE- J_100_0 | STATE- S m
MENTS 1 MENTS m
o]
n
TAM | PRO- TPRSTA | PRO- N|Y|N|C
DUCER _BJ_100 | DUCER ole|o|o
STATUS _01 STATUS s m
CHANGE CHANGE m
o}
n
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TAM Depreciation | TAMDE- | DEPRECIA- | Y | T | Y | L | This process is
calculator P_B- TIONRATE |e | e | e | e | used to calculate
batch job J 121 0 | PROCESS- |s |s | s | a | the delta deprecia-

1 ING s | tion value of the
e | asset from previ-
ous to current
period (current
indicator is set as
‘Y’ by default).

TAM | Amortization | TAMIMP | IMPUTED Y | Y | Y| C| This process is
schedule _BJ_100 | INTEREST e | e | e | 0 | usedtogenerate
batch job _01 AMORTIZA- | s | s | s | m | Amortization

TION m | schedule based on
TRANSAC- o0 | imputed interest
TIONS n | rate for loan con-
PROCESS- tracts with Imputed
ING Interest.

TPE Escrow Anal- | TXNCH- | CHAR- N Y | N | C | This package con-
ysis & Dis- G_B- GEOFF 0 | e | o | o | tains procedures
bursements J 100 0 | PROCESS- s m | related to Batch

2 ING FOR m | Job for chargeoff
ACTIVE 0 | processing
ACCOUNTS n

ESC | ESCROW TESAN- | ESCROW N | Y | N| C | This package con-
ANALYSIS L _B- ANALYSIS 0 | e | o | o | tains procedures
POSTING J 100 0 | POSTING s m | related to Batch

1 m | Job for escrow
o | analysis process-
n | ing

ESC | CREATE TESAN- | CREATE N | Y | N | C | This package con-
BATCHES L_B- BATCHES o | e | o | o | tains procedures
FOR CUS- J _100_0 | FOR CUS- s m | related to Batch
TOMER 2 TOMER m | Job for escrow
REFUND REFUND 0 | analysis process-
REQUESTS REQUESTS n | ing

ESC | COMPUTE TESAN- | COMPUTE N|Y|N|C
CONTROLS | L_B- CON- ole|o|o
FOR CUS- J_100_0 | TROLSFOR s m
TOMER 4 CuUs- m
REFUND TOMER o}

REQUEST REFUND n
BATCHES REQUEST
BATCHES
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ESC | ESCROW TESAN- | ESCROW N|Y|N|C
COMPLI- L_B- COMPLI- o|le|o|oO
ANCE J_100_0 | ANCE S m
CHECKING 5 CHECKING m
o]
n
ESC | CREATE TESDS- | CREATE NlY | N|C
PAYABLE B _B- PAYABLE ole|o|o
REQUISI- J_100_0 | REQUISI- s m
TIONS 1 TIONS m
FROM FROM o]
APPROVED APPROVED n
DISBURSE- DISBURSE-
MENT MENT
REQUESTS REQUESTS
PUR | ARCHIVE PACARC | ARCHIVE NIY | N|C
ACCOUNT _BJ_100 | ACCOUNT ole|o|o
DATA TO _01 DATA TO s m
OTABLES OTABLES m
o
n
EVE BATCH EVBAC- | BATCH Y
EVENTS C_B- EVENTS e
FOR J_100_0 | FOR S
ACCOUNTS | 1 ACCOUNTS
EVE BATCH EVBAP- | BATCH Y
EVENTS P_B- EVENTS e
FOR APPLI- | J 100 0 | FORAPPLI- | s
CATIONS 1 CATIONS
EVE MAIN EVB- MAIN Y
BATCH JOB | PRC_B- | BATCHJOB e
FORBATCH | J 100 0 | FORBATCH s
EVENTS 1 EVENTS
PROCESS- PROCESS-
ING ING
ODD | BATCHJOB | CBUUT- | BATCHJOB | Y
2 TO GENER- | L_B- TO GENER- | e
ATE METRO | J_100_0 | ATEMETRO | s
2 DATA 2 2 DATA
ODD | BATCHJOB | CBUUT- | BATCHJOB |Y
2 FOR CRE- L_B- FOR CRE- e
ATING J_100_0 | ATING S
METRO 2 3 METRO 2
DATA FILE DATA FILE
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ODD | THIRD ACT- THIRD Y
2 PARTY ACH | PRC_B- | PARTY ACH e
PROCESS- J_100_0 | PROCESS- s
ING 1 ING
ODD | THIRD OBI- CREATE Y This process pulls
2 PARTY OUT- | PRC_B- | THIRD e the customer
PUT DATA J_100_0 | PARTY S account details
DUMP SER- | 1 CuUs- shared in input
VICING TOMER data files for pro-
FILE cessing.
ESC | JOBTO OED- JOBTO Y
GENERATE | PRC_B- | GENERATE e
ESCROW J_100_0 | ESCROW S
DISCLO- 1 DISCLO-
SURE SURE
STATEMENT STATE-
MENT
EDF | ADRFILE EDFADR | ADR FILE Y
_BJ_100 e
01 s
EDF IVR FILE EDFIVR | IVRFILE Y
_BJ_100 e
_01 s
TPE CONTRAC- TXN- CONTRAC- Y
TUAL PRO- PRM_B- | TUAL PRO- e
MOTION J_100_0 | MOTION S
CANCEL 4 CANCEL _
PROCESS- PROCESS- _
ING ING
TPE RATE TXN- RATE Y
CHANGE RAT_B- CHANGE e
PROCESS- J_100_0 | PROCESS- s
ING FOR 2 ING FOR
BACK- BACK-
DATED DATED
INDEXES INDEXES
RDB | LOAD RACD- LOAD Y
1 ACCOUNT MP_B- ACCOUNT e
RELATED J_100_0 | RELATED S
DATA INTO 1 DATA INTO
T TABLES T TABLES
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TPE EXPIRED TXNINS | EXPIRED Y
INSUR- _BJ_100 | INSUR- e
ANCE PRO- | _01 ANCE PRO- S
CESSING CESSING
ADT UPDATE ADT- UPDATE Y
ROWID IN PRC_B- | ROWID IN e
AUDIT J_100_0 | AUDIT S
TABLE (RUN | 1 TABLE
THIS JOB (RUN THIS
AFTER JOB AFTER
EXPORT- EXPORT-
IMPORT OF IMPORT OF
TABLES) TABLES)
RDB | LOAD RIND- LOAD Y
1 INSUR- MP_B- INSUR- e
ANCE DATA | J_100_0 | ANCE DATA s
TO T- 1 TO T-
TABLES TABLES
AGS | SALE LEAD | AGS- SALE LEAD | Y
AGING SAL_B- AGING e
J_100_0 S
1
BOD | PROCESS JOB- PROCESS Y
PARKED BOD _B- | PARKED e
TRANSAC- J_000_0 | TRANSAC- S
TIONS 2 TIONS
BOD | MARK SYS- | JOB- MARK SYS- Y
TEM FOR BOD _B- | TEM FOR e
BEGINING J_000_0 | BEGINING S
OF DAY 1 OF DAY
EOD | SET SYS- JOBEOD | SET SYS- Y
TEM MODE | BJ_000 | TEM MODE e
TO END-OF- | _01 TO END- S
DAY OF-DAY
ACR | DAILYTRIAL | TABAC- DAILY Y
BALANCE C _B- TRIAL BAL- e
DATA J_100_0 | ANCE DATA s
1 GENERA-
TION
LTR2 | RATE LCS- RATE Y
CHANGE RAT_B- CHANGE e
PRE-INTI- J_100_0 | PRE-INTI- s
MATION 1 MATION
LETTER LETTER
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BLK BULK BLK- BULK Y
UPLOAD PRP_B- UPLOAD e
FOR PRIC- J_100_0 | FOR PRIC- S
ING SETUP 1 ING SETUP
BLK BULK BLK- BULK c
UPLOAD GLS B- UPLOAD o}
FOR GL J 100 0 | FORGL m
ATTRI- 1 ATTRI- m
BUTES BUTES o]
n
BLK BULK BLK- BULK c
UPLOAD GLS B- UPLOAD 0
FOR GL J_100_ 0 | FORGL m
TRANSLA- 2 TRANSLA- m
TION TION DEFI- 0
NITION n
BLK BULK BLK- BULK c
UPLOAD GLS_B- UPLOAD o]
FOR GL J_100_0 | FORGL m
TRANSAC- 3 TRANSAC- m
TIONTYPES TION o]
TYPES n
DETAILS
BLK BULK BLK- BULK c
UPLOAD GLS B- UPLOAD 0
FOR GL J 100 0 | FORGL m
TRANSAC- 4 TRANSAC- m
TION LINKS TION LINKS 0
n
ODD | RATE OLSRAT | RATE Y
2 CHANGE _BJ_100 | CHANGE e
LETTER _01 LETTER S
FILE FILE CRE-
ATION
TPE EXPIRED TXN- EXPIRED Y
DRAW DRW_B- | DRAW e
PERIOD J_111_0 | PERIOD S
PROCESS- 1 PROCESS-
ING (STAGE ING (STAGE
FUNDED FUNDED
LOANS) LOANS)
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ODD | DEALER OPSSB- | DEALER c
2 SUBVEN- V_B- SUBVEN- o]
TION J_100_0 | TION m
STATE- 1 STATE- m
MENTS MENTS o]
GENERA- n
TION
TAM | SUBVEN- TPRSB- | SUBVEN- c
TION V_B- TION 0
RECEIV- J_100_0 | RECEIV- m
ABLE PRO- 1 ABLE PRO- m
CESSING CESSING o]
(PAY AS GO) (PAY AS n
GO)
ODD | PRO- OPCPR PRO- c
2 DUCER C_B- DUCER o]
CHECK J_100_0 | CHECK m
PRINT 1 PRINT m
GENERA- o]
TION n
BSR | BEHAV- BSR- BEHAV- y
IORAL PRC_B- | IORAL e
SCORING J_100_0 | SCORING S
1
AGE | TRANSAC- TXNAGE | TRANSAC- y
TION IN _BJ 100 | TIONIN e
WAITING _01 WAITING s
FOR FOR
APPROVAL APPROVAL
AGING AGING
PROCESS
ACR | PREPARE TXNA- PREPARE y
BATCH CR_B- BATCH e
DATA FOR J_100_0 | DATAFOR s
INTEREST 2 INTEREST
ACCRUAL ACCRUAL
AND DELIN- AND DELIN-
QUENCY QUENCY
PROCESS-
ING
PDC | POST PDCPR POST y
DATED C_B- DATED e
CHECKS J_100_0 | CHECKS S
1
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PDC | PENDING PDCPN PENDING y
PDC D_B- PDC PRO- e
J_100_0 | CESSING s
1
LTR2 | PDC LCSPD- | PDC y
RENEWAL C B- RENEWAL e
LETTER J 100 0 | LETTER s
1 GENERA-
TION
DOT | APPLICA- DOL- APPLICA- Y
TION DOCU- | PRC_B- | TION DOC- | e
MENT LOAD | J_ 000_0 | UMENT s
2 LOAD
ODD | ONE TIME OLSPD- | ONE TIME Y
2 ACH POST P_B- ACH POST e
DATED PAY- | J_100_0 | DATED s
MENT LET- 1 PAYMENT
TER LETTER
PROCESS-
ING
ODD | OUTPUT OST- MASTER Y This process is
2 DATADUMP | PRC_B- | CUS- e used to generate
SERVICING | J_100_0 | TOMER S consolidated
2 STATE- Account state-
MENT GEN- ments associated
ERATION for each Master
Account.
WFP | BILLING WTX- BILLING Y
BIL_B- PROCESS- e
J_132. 0 | ING S
1
WFP | DELIN- WTX- DELIN- Y
QUENCY DLQ_B- | QUENCY e
J_132_0 | PROCESS- s
1 ING
WFP | LATE WTX- LATE Y
CHARGE LTC B- CHARGE e
J 132 0 | ASSESS- S
1 MENT
WFP | STATEMENT | WTXPS- | STATE- Y
G _B- MENT GEN- e
J_132_0 | ERATION s
1
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WFP | RATE WTX- RATE Y
CHANGE RAT_B- CHANGE e
J_132_0 | PROCESS- S
1 ING
WFP | TERMINA- WTX- TERMINA- Y
TION TIP_B- TION PRO- e
J 132 0 | CESSING s
1
TPE PERIODIC TXNPM- | PERIODIC
MAIN- F_B- MAIN-
TAINENCE J_100_0 | TAINENCE
FEE 1 FEE PRO-
CESSING
WFP | UNIT WUP- UNIT c
UPLOAD PRC_B- | UPLOAD o]
J_132 0 m
1 m
o]
n
ODD | BATCH JOB | CBUUT- | BATCH JOB
2 FOR L_B- FOR
MONTHLY J_100_0 | MONTHLY
HANDSOFF | 4 HAND-
FILE FOR SOFF FILE
SIMAH FOR SIMAH
PUR | PURGE ALL | PTTPRC | PURGE ALL c
PTT TABLES | _BJ 100 | PTT o]
_01 TABLES m
o
n
TPE BATCH JOB | TXN- BATCH JOB y
FOR SET- MAC_B- | FOR SET- e
TING J_100_0 | TING S
MATURED 1 MATURED
ACCOUNT ACCOUNT
CONDITION CONDITION
TPE NON TXNRF- | NON c
REFUND GL | D_B- REFUND 0
J _100_0 | GL PRO- m
1 CESSING m
o]
n
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TPE PAYMENT TXNPA- PAYMENT y
ARRANGE- P_B- ARRANGE- e
MENT J_100_0 | MENT PRO- s
1 CESSING
TPE DELAY FEE | TXND- DELAY FEE y
LY B- PROCESS- e
J_ 100 0 | ING s
1
TPE STATE- TXNST- STATE- y
MENT PAST | M_B- MENT PAST e
MATURITY J 100 0 | MATURITY s
1 PROCESS-
ING
TPE BLACK VEVBB- | BLACK c
BOOK K _B- BOOK o
INTERFACE | J 100 0 | INTERFACE m
1 m
o
n
LBT BULK NSF TXNNS- | BULK NSF
PAYMENT F _B- PAYMENT
REVER- J 100 0 | REVER-
SALS 1 SALS
ACR | STOP TXNA- STOP y
INTEREST CR_B- INTEREST e
ACCRUAL J 100 0 | ACCRUAL s
3 PROCESS-
ING
QRT | CUSTOMER | QCSPR CUsS- y
SERVICE C B- TOMER e
REAL TIME J _100_0 | SERVICE s
QUEUE 2 REAL TIME
QUEUE
PROCESS-
ING
ODD | OUT- OCP- OuUT- y This process gen-
2 BOUND PRC_B- | BOUND e erates ‘Customer
CUSTOMER | J 100 0 | CUS- s Payment File
EXTRACTS 1 TOMER Extract’ file with
TO PAY- EXTRACTS individual account
MENT TO PAY- dues or consoli-
AGENCIES MENT dated dues at Mas-
AGENCIES ter account level in
column definitions.
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ODD | MASTER OMSPR | MASTER Y | Y| Y| C| This process gen-
2 ACCOUNT C B- ACCOUNT e | e | e | o | erates Asset bill-
CUSTOMER | J_100_0 | CUS- s |s |s | m|ing Mock
MOCK 1 TOMER m | Statements based
STATE- MOCK 0 | on preferences
MENT GEN- STATE- n | defined in Con-
ERATION MENT GEN- tract.
ERATION
IFP OFFLINE ICAPRC | OFFLINE y
CALL _BJ 100 | CALL e
ACTIVITY _01 ACTIVITY s
POSTING POSTING
ACR | RE-START TXNA- RE-START y
INTEREST CR_B- INTEREST e
ACCRUAL J_100_0 | ACCRUAL s
4
IFP UPLOAD ITUPRC | UPLOAD y
TRANSAC- _BJ_100 | TRANSAC- e
TIONS _01 TIONS s
IFP POST ITUPRC | POST y
UPLOADED | BJ 100 | UPLOADED e
TRANSAC- 02 TRANSAC- s
TIONS TIONS
IFP INPUT FILE ICE- CUR- Y |Y | Y| C | This process
PROCESS- PRC_B- | RENCY e | e | e | o | extracts currency
ING - CUR- J_100_0 | EXCHANGE | s | s | s | m| exchange rates
RENCY 1 RATE FILE m | from desired
EXCHANGE UPLOAD 0 | source at sched-
RATE FILE n | uled intervals.
UPLOAD
IFP INPUT FILE IDDPRC | INPUT Y This process
PROCESS- _BJ 000 | DATA e updates customer
ING - INPUT | 01 INSERTION s account informa-
DATA tion corresponding
INSERTION to the details
received from
external system.
Ex: Bankruptcy
details in External
Interface screen or
Cure Letter details
in Account Infor-
mation screen.
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IFP INPUT FILE IPIPRC_ | PIINFRO- Y | Y| Y| C| This process
PROCESS- BJ 100 _ | MATION 0 | uploads input file
ING 01 FILE m | with PII data into
UPLOAD m | the data masking
PROCESS- 0 | screen.
ING n
IFP INPUT FILE IUH- ASSET Y |Y | Y| C | This process
PROCESS- PRC_B- | USAGE 0 | uploads asset
ING J_100_0 | HISTORY m | usage details into
1 FILE m | the system.
UPLOAD (r)] Driven through
Setup > Data File
tab, when placed
in corresponding
folder and batch
job is run, system
processes the file
and loads in 'Exter-
nal Interfaces' tab.
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Engine Type

Description

Batch
Job

Description

Comment

T
U

INPUT FILE
PROCESS-
ING

ICP-
PRC_B-
J_100_0

CUS-
TOMER
PAYMENT
FILE
UPLOAD

<'| Origination

<'| Servicing

<'| Collection

5 03 39 0| Product

This process
uploads customer/
business based
payment details
and are displayed
in Payment Entry
screen with Multi
Account check box
selected.

The status of Pay-
ment batch is
updated based on
the value of sys-
tem parameter
PMT_BATCH_PO
STING (PAY-
MENT BATCH
POSTING PREF-
ERENCE).

If the value is set to
‘P’ (POSTED),
payment job
request is submit-
ted and paymentis
posted. On suc-
cessful posting,
the payment
record is available
in Payment Main-
tenance screen.

IFP

INPUT FILE
PROCESS-
ING

ISCPRC
_BJ_100
01

SECURITI-
ZATION
POOL FILE
UPLOAD

]

This process reads
the Securitization
upload file and
either attach or
detach the
accounts of the
Pool.

IFP

INPUT FILE
PROCESS-
ING

IAD-
PRC_B-
J_100_0

ACCOUNT
DUES FILE
UPLOAD

This process reads
the input file to
derive future pro-
rated due on a par-
ticular account. For
more information
refer to ‘Proration
of Future Account
Dues’ section in
Dashboard > Pro-
cess Files.
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Engine Type

Description

Batch
Job

Description

Comment

PUR

ARCHIVE
PURGE JOB
SET

PJR-
PAC_B-
J_100_0

PURGE
ACCOUNTS
DATA

=<'| Origination

<'| Servicing

<'| Collection
5 03 39 0| Product

This process
purges accounts
data in archival
tables based on
the days defined in
system parameter
PAC_PURGE_-
DAYS.

PUR

ARCHIVE
PURGE JOB
SET

PJRPA-
P B-
J_100_0

PURGE
APPLICA-
TION DATA

53 03300

This process
purges application
data in archival
tables based on
the days defined in
system parameter
PAC_PURGE_-
DAYS.

PUR

ARCHIVE
PURGE JOB
SET

PJRP-
GL_B-
J_100_0

PURGE GL
TXNS DATA

So3300

This process
purges general
ledger transaction
data in archival
tables based on
the days defined in
system parameter
PAC_PURGE_-
DAYS.

PUR

ARCHIVE
PURGE JOB
SET

PJRP-
PA_B-
J_100_0

PURGE
POOLS
DATA

3 03300

This process
purges pools and
its transactions
data in archival
tables based on
the days defined in
system parameter
PAC_PURGE_-
DAYS.

PUR

ARCHIVE
PURGE JOB
SET

PJRP-
PX_B-
J_100_0

PURGE
PRO-
DUCER
TXNS DATA

So3300

This process
purges producer
transaction data in
archival tables
based on the days
defined in system
parameter
PAC_PURGE_-
DAYS.
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PUR | ARCHIVE PJRPTX- | PURGE Y | Y| Y| C| This process
PURGE JOB | BJ 100 | TXNS DATA 0 | purges account
SET _01 m | transaction data in
m | archival tables
0 | based on the days
n | defined in system
parameter
PAC_PURGE_-
DAYS.
PUR | ARCHIVE PJRPVA | PURGE Y |Y | Y| C | This process
PURGE JOB | _BJ_100 | VENDOR 0 | purges vendor
SET _01 ASSIGN- m | assignment data in
MENTS m | archival tables
DATA o0 | based on the days
n | defined in system
parameter
PAC_PURGE_-
DAYS.
REV Revenue REVREC | DAILY REV- | Y | Y | Y | C | This process is
1 Recognition _BJ 100 | ENUEREC- | e | e | e | 0 | used to validate if
job set _01 OGNITION s | s | s | m| Account Revenue
PROCESS- m | Recognition Equity
ING o | is ‘greater than or
n | equal to’ Target

Revenue Recogni-
tion Equity and
update the Cur-
rent Qualification
Indicator.
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REV | Revenue REVREC | MONTH Y | Y | Y| C | This processis
2 Recognition _BJ 100 | ENDREVE- | e | e | e | 0 | used to validate
job set _02 NUE REC- s | s | s | m| the status of
OGNITION m | ‘Account Revenue
PROCESS- 0 | Recognition Quali-
ING n | fier indicator’ and
update the follow-
ing fields:
- Account Revenue
Recognition Quali-
fier Month End
indicator (after
month end pro-
cessing)
- Account Revenue
Recognition Quali-
fier Date
- Last Account
Revenue Recogni-
tion Qualifier Date
SET- | BATCH EVE- BATCH Y |Y | Y| C | This process is
EVE EVENTS PRC _B- | EVENTS e |e | e | o | usedfor BATCH
PROCESS- J 100 0 | PROCESS- |s |s |s | m| EVENTS PRO-
ING 1 ING m | CESSING for the
o | Entities Account/
n | Application/Assets.
SET- | EVENTS EVE- BATCH Y |Y | Y| C | This process is
EVE2 | PROCESS- PRC_B- | EVENTS e |e | e | o | usedfor BATCH
ING FOR J_ 100 0 | PROCESS- |s |s |s | m| EVENTS PRO-
CUSTOMER | 3 ING (CUS- m | CESSING for the
AND BUSI- TOMER o | Entities Customer/
NESS AND BUSI- n | Business/Vendors/
NESS ENTI- Producers.
TIES)

2.1

Collection Cycles

The Collection Cycles screen allows you to setup the collection workflow cycles.

To set up collection cycles

1. Click Setup > Setup > Administration > System > Collection Cycles link. The system
displays the Collection Cycles screen. The details are grouped into two:

e Status Cycle
e Current/Next Status
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e Status Change Responsibilities

ORACLE _ . a0 - o
Financial Services Lending and Leasing
i Close
T Collection Cycles 5 ma
» Origination i
Status Cycle
> Servicing o
View ~ Fomaty [ Freezz ! Detach Wrap o)
> Collections
Cycle Type
> WFP COL_BKRP_DISP_STATUS BANKRUPTCY
> Tools COL,DF'C,DISP,_F\ATUS DEFICIENCY
COL_REPO_FORC_DISP_STA . REPOSESSION
Setup
Setup
Administration A Current/Next Status FPadd | FZedit | Elview | o audit
Sy View v Fomat v Freeze i Detach
System Paramet @ o o = e Gﬁ
Lockups Current Code: Next Code
B £ NEWLY RECEIVED ACTIVE BEANKRUPTCY
User Defined Tat . . T
Auddit Tables NEWLY RECEIVED ASSIGNED TO ABS
i & NEWLY RECEIVED NEWLY RECEIVED
User Defined Def:
= PLAN CONFIRMED - AWAITING DISBURSEMENTS DISMISSAL NOTICE RECEIVED
Transaction Code
Data Files
Dedupe T
o Status Change Responsibilities dpadd | Fedt | Elview | o audt
View = Fomatv [ Freeze i Detach ¢l Wrap @
¥ . Responsibility Allowed Ind
iiALL Y

Vendars
Collection Cydles
Reporis
Error Messages
Translations
User
Organization
Comparies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queues
Frinters
Bark Detsils
Check Details
Standard Payees
Currencies
Zip Codes
Products

< >

In the Collection Cycles section, you can view the following details:

Field Do this:
Cycle The system displays the status cycle.
Type The system displays the type of status cycle.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

3. Inthe Current/Next Status section,perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field Do this:
Current Code Select the current code from the drop-down list.
Next Code Select the next code from the drop-down list.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. Inthe Status Change Responsibilities section,perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field Do this:
Responsibility Select the responsibility from the drop-down list.
Allowed Ind Check this box to allow a record.
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Perform any of the Basic Actions mentioned in Navigation chapter.

212 Reports

The Reports screen allows you to setup reports in the system.

To set up the Reports

1. Click Setup > Setup > Administration > System > Reports link. The system displays
the Report screen. The details are grouped into two:

e Reports
e Report Parameters

2. In the Reports section, perform any of the Basic Operations mentioned in Navigation

Financial Services Lending and Leasing
DashBoard Revortex
> Origination
> Servicing REPOLLS
View v Format v [f50 Freeze i Detach ] Wrap 5]
> Collections o
R Code Description
> Tools
Setup ACCESS_BY_RESPPONSIBILITY  ACCESS BY RESPPONSIBILITY
Setup ACCOUNT_WISE_PDC ACOOUNT WISE PDC LIST
Administration A ACC_LIST_LEASE ACOOUNTS AND LISTING - LEASE
System ACC_LIST_LINE ACCOUNTS. AND LISTING - LINE
System Paramete
Lookups
User Defined Tt Reports
Audit Tables
User Defined Def
Transaction Code —
Datz Files T
Dedupe Descgtion
Securitization * Package UNDEFINED
Events
5 { Report Parameters
Producer Cydes . 1 :
G View v Formatv [0 ze B Detach irap 5]
Collection Cycles &
Reports Parameter Description Parameter Type
Error Messages No data to display.

Translations
User
Organization
Companies
Access
Users
Credit Bureau
Correspondence
Genersl Ledger
Queues
Printers
Bank Details
Check Detsils
Standard Payess
Currencies
Zip Codes
Products
< >

v

Package

UNDEFINED
OUSRAC_EM_100_01
OCSPDC_EM_100_03

OCSACC_EM_121 01
OCSACC_EM_112 01

Paramster Sub Type

 Welcome, PRAKRRAQ + (]
[®) Close.
o add | 7 Ed = 7 Aud
]
Module System Defined  Enabled
Yes @ o N
~
ORIGINATION ¥
SERVICING ¥
s
COLLECTIONS ¥ e
COLLECTIONS ¥
[ saveand add || [ save and stay Saveand Retum | @ Retum
*Module [v]
= System Defined () Yes @) No
* Enabled []
dadd | Aedt v 7 A
Default Sort Enabled

A brief description of the fields is given below:

Field Do this:

Code

Specify the code of the report.

Description

Specify the description of the report.

Package

Specify the package .

Module

Select the code of the report from the drop-down list.

System
Defined Yes/
No

Select ‘Yes’, if you wish to maintain the Report as system defined
and ‘No’, if you do not want to maintain it as system defined.
System defined entries cannot be modified. If the entry is not
system defined, then it can be modified.

Enabled

Check this box to enable the report definition.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Report Parameters section,perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field Do this:

Parameter Specify the parameter code of the report.

Description Specify the description of the parameter.

Parameter Type Select the parameter type of the report from the drop-down list.

Parameter Sub Type Select the parameter sub type of the report from the drop-down
list.

Default Specify the default value for the report parameter (value to
initially populate, or used if no value is supplied) (optional).

Sort Specify the sort order for the lookup code. This determines the
order these report parameters are displayed or processed.

Enabled Check this box to enable the report definition.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.13 Error Messages

In the Error Messages Setup screen, you can translate or modify the text of error messages.
the system displays all messages as they appear to the system users in the Error Message
section’s Message field.

New messages created with the Error Messages screen can then be translated with the
Setup > Setup > Administration > System > Translation > Message Translation screen.

To set up the Error Messages Setup screen
1. Click Setup > Setup > Administration > System > Error Messages. The system
displays the Error Message screen.

2. Onthe Error Messages Setup screen’s Error Type section, use the Error Type field to
select the error type. These are the categories of error messages available for creating or
editing.

3. The error messages associated with the error type you selected appear in the Error
Message section.
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4. Inthe Error Messages section, perform any of the Basic Operations mentioned in
Navigation chapter.

Financial Services Lending and Leasing
Close
p— Error Messages x g
> Origination
S Error Message
rvicing
View » Formatw [ Freeze & Detach Il Wrap 5]
> Collections
Error Type
> WFP SERVER MESSAGE
1ENT ERROF )
= ok CLEENT ERROR
CLIENT MESSAGE
Setup CLIENT QUESTION v
S SERVER ERROR
Admiristration o
System
System Parametc Error Message dpadd | Pedt | 5 vew | o A
Lookups e View~ Format~ [ Fraczs B Detach 1 Wrap (o]
User Defined Tal
iRt Region Country Customer Engine Error Message System Defined  Enabled
o UNDEFINED UNDEFINED UNDEFINED UNDEFINED. Yes ® No N 1
Transaction Code svs sv5 515 ™ Transaction Locked, Transaction Posting Failed i
Datz Files svs svs svs ™~ ooz 0 === Transaction Posting Successful *=*== ¥
Delipa s¥s svs SYs ™ Transaction Posting will accur on Txn Dt ¥
Securitization 5
Invalid Account Number - ~ACC_NER~ , Transaction
Events RE =5 = B Posting Failed hd
Batch Jobs § s svs Srs ™ Transaction Posting Failed Yes ia
P"““d“m GRS svs svs s ™™ Transaction Locked, Transaction Posting Faled e v
Vendors
Collection Cycles svs 15 svs ™M =*=*= Transaction Posting Successful *+++* Yes v
Reports s¥s svs svs ™M Transaction Posting will occur on Txn Dt 5 Y
Error Messages - e = B, Inwalid Account Number - ~ACC_NBR~, Transaction g, v ) - v
Translations Posting Failed
User
Organization Error Message
;°”"’a"“*5 © seveand add || [ Seve and Stay || [ Save and Retum || (3 Retum
coess
. E D *Enabled []
—— Region  UNDEFINED Engine UNDEFINED Enable
Correspondence *Country UNDEFINED *Error Code | UNDEFINED * Error Message
Gelercl | faer = Customer # UNDEFINED * System Defined O Yes @) No
Queues
Printers
Bank Details
Chack Details
Standard Payees
Currencies
Zip Codes
Products
< >

A brief description of the fields is given below:

Field Do this:

Region Specify the region code.

Country Specify the country code.

Customer Specify the customer code.

Engine Specify the engine code.

Error Code Specify the error code.

System Defined Displays whether the record is system defined or not.

Enabled Check this box to enable the data error message.

Error Message Specify the error message.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.14 Translation

You can setup translation properties.

Navigating to Translation

1. Click Setup > Setup > Administration > System > Translation. The system displays
the Translation screen. On this screen you can,

e Setup Translation
e Translate Error Messages
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2.14.1 Setup Translation

In the Setup Translation tab, you can translate the contents of a predefined list of setup
description fields into a different language.

After you translate an entry in the Translation Data section, the system adds the new data to
the setup form.

To set up the Translation Setup

1. Click Setup > Setup > Administration > System > Translation > Setup Translation.

2. In the Language section, you can select the language for which you need to setup the
translation.

ORACLE'
Financial Services Lending and Leasing

% M) Close
» Origination A
= Source T
 Servicing e -
. Viewv Fomatv B} Freeze gfiDetach | &l Wrap W 5 ropulate A1
» Collections
Source Type
> WFP | ASSIGNMENTS
ASSET TYPES A
L AUDIT TABLES
Setup AUDIT TABLE COLUMNS v
i CALL ACTION TYPES
Administration A
System
System Paramet Translation Data A et View || & Audit
Lookups View v Formatv Eﬁ Freeze d‘ Detach | &l Wrap GF} ® Al () Translated () Untranslated (q'} Populate Details
User Defined Tak Key 1 Key 2 Key 3 Key 4 Key 5 Key 6 SysemDefired  Enabld Desc 1 Transli
':“d't;af’esd & 0DAYDELQ  UNDEFINED UNDEFINED UNDEFINED UNDEFINED UNDEFINED V=t Y 0 DAYS DELQAC.. 30 DAYS
ser Lefined Del A
SRR AGED_APP_QUELE  UNDEFINED UNDEFINED UNDEFINED UNDEFINED UNDEFINED Vs@n Y AGED APPLICATIO... AGED AF
Data Files AGED_CON_QUEUE UNDEFINED UNDEFINED UNDEFINED UNDEFINED UNDEFINED ves@no Y AGED CONTRACT. AGED X
Dedupe AITHA QUEUE  UNDEFINED UNDEFINED UNDEFINED UNDEFINED UNDEFINED Y@ Y APPLICATION ENT... ARPLICA
= 1 T T INED JNDEFT/ Yes'® No
ezl AK UNDEFINED UNDEFINED UNDEFINED UNDEFINED UNDEFINED Y HHH HHH
B
Eﬂims | | MPRROVEDAPR_. UNDEFINED UNDEFINED UNDEFINED UNDEFINED UNDEFINED Y@l Y AFPROVED [ CON... APPROV
PR 81 UNDEFINED UNDEFINED UNDEFINED UNDEFINED UNDEFINED Yes®No Y @1 @1
Vendors BKRP_CH_13 UNDEFINED UNDEFINED UNDEFINED UNDEFINED UNDEFINED Ys®pa Y BANKRUPTCY QUE... BANKRU
Collction Cydes BKRP CH 7 UNDEFINED UNDEFINED UNDEFINED UNDEFINED UNDEFINED ¥ BANKRUPTCY OLE... BANKRU
Ee””: o1 UNDEFINED UNDEFINED UNDEFINED UNDEFINED UNDEFINED t QUERY-CL QUERY
Tror Messages
b CONTRACT_QUEUE UNDEFINED UNDEFINED UNDEFINED UNDEFINED UNDEFINED i CONTRACT VERIF... CONTRA
k \_ENTRY_QU... 1 1 JNDEFINED 1l 1 ER Ep
fhak DATA_ENTRY QU... UNDEFINED UNDEFINED UNDEFINED UNDEFINED UNDEFINED ¥ DATA ENTRY APP.. DATAE
janizauon INCD 1l IND LEF] N Al i L
Organizat DEF UNDEFINED UNDEFINED UNDEFINED UNDEFINED UNDEFINED b DEFICIENCY QUE.. DEFICIE
Comparies DELQ DAYS 0 30 UNDEFINED UNDEFINED UNDEFINED UNDEFINED UNDEFINED ¥ DELINGUENCY Q... DELING
it
Ucce“ DELG DAYS 30+  UNDEFINED UNDEFINED UNDEFINED UNDEFINED UNDEFINED ¥ DELINGUENCY Q.. DELINGL
SErS )
Credit Bureau
Comespondence -
General Ledger Translation Data
Queuss {aRetim
Printers
Bank Details Key1 30-DAY DELQ System Defined () Yes @ No Desc 3
Check Details Key 2 UNDEFINED Erabled ¥ Translation 3
Standard Payees Key 3 UNDEFINED Desc 1 30 DAYS DELQ ACCOUNTS Desc 4
i d
”_””f”"h Key4 UNDEFINED Tranglation 1 30 DAYS DELQ ACCOUNTS Translation 4
At Key5 UNDEFINED e
il Key 6 UNDEFINED Translation 2 v
< >
Note

For more information, refer Language setup at the end of this chapter.

3. Inthe Source Type section, you can select the source (or location in the system) of the
item you want to translate.

4. Click Populate All in the Source Type section and the system loads the setup data
descriptions in the Translation section screen for the selected source type.
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If you have new entries and are unsure as to which setup items have been updated
since the last translation, click Populate All, the system loads the additional data for all
items with no impact to the previously translated data for any of the entries.

5. In the Translation Data section, Select:

e All-to view all the records (both translated and un-translated) in the Translation Data
section.

e Translated — to view all the translated records in the Translation Data section.
e Un Translated — to view all the un-translated records in the Translation Data section.

6. In the Translation Data section, perform any of the Basic Operations mentioned in
Navigation chapter.

Note

You cannot add a new record.

A brief description of the fields is given below:

Field Do this:

Key 1 Displays the first reference key value.

Key 2 Displays the second reference key value.

Key 3 Displays the third reference key value.

Key 4 Displays the fourth reference key value.

Key 5 Displays the fifth reference key value.

Key 6 Displays the sixth reference key value.

System Defined Select ‘Yes’, if you wish to maintain the data as system defined

and ‘No’, if you do not want to maintain it as system defined.

Enabled Check this box to indicate that the record is active.

Desc 1 Translation 1 | Specify the first translated description.

Desc 2 Translation 2 | Specify the second translated description.

Desc 3 Translation 3 | Specify the third translated description.

Desc 4 Translation 4 | Specify the fourth translated description.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

2.14.2 Message Translation Setup

In the Message Translation tab, you can translate the contents of a predefined list of error
messages into a different language.

After you translate an entry in the Error Message section, the system adds the new data to
the error message.
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To set up the Message Translation Setup

1. Click Setup > Setup > Administration > System > Translation > Message
Translation.

2. Inthe Language section, you can select the language for which the translation needs to
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Note

For more information, refer Language setup at the end of this chapter.

3. Inthe Error Type, you can select the type of error message you want to translate.

4. Click Populate All in the Error Type section and the system loads the error messages
in the Error Message section for the selected error type.

If you have new entries and are unsure as to which error messages have been updated
since the last translation, click Populate All, the system loads the additional data for all
items with no impact to the previously translated data for any of the entries.

5. Inthe Error Message section, select:

e All —to view all the records (both translated and un-translated) in the Error Message
section.

e Translated — to view all the translated records in the Error Message section.
e Untranslated — to view all the un-translated records in the Error Message section.

6. In the Error Message section, perform any of the Basic Operations mentioned in
Navigation chapter.

Note

You cannot add a new record.
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A brief description of the fields is given below:

Field Do this:

Region Displays the region code.

Country Displays the country code.

Customer Displays the customer code.

Engine Displays the engine name.

Error Code Displays the error code.

System Defined Check this box to indicate that the record is system defined.
Enabled Check this box to indicate that the record is active.
Message Specify the error message.

English Translation Specify the English translated description.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Language setup

On the Lookup master tab’s Lookup Types screen, you can add other languages to the
TRD_LANGUAGE_CD lookup type and perform translations for those languages.

However, translated data only appears in one language, which is defined by the User
Language parameter. This parameter can be defined in the system configuration file, typically
named DBKWEB.CFG, which defines the parameter as:

Parameter: otherparams=ORA_USER=<schema_name> USR_LANG=<native language>

Note

<native language> should match lookup codes in the TRD LANGUAGE_CD lookup type
on the Administration form’s Lookups screen.

The system supports the following pre-defined list of setup items for translation:

9.

© N o g~ 0w DN =

Asset Sub Types

Asset Types
Assignments

Audit Table Columns
Audit Tables

Call Action Result Types
Call Action Types
Checklist Action Types
Checklist Types

10. Commission Plans

1

1. Companies
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2.15

12. Company Branch Departments
13. Company Branches

14. Compensation Plans

15. Credit Bureau Score Reasons
16. Credit Models

17. Credit Scoring Parameters
18. Edits

19. Escrow Disburse Rules

20. Escrow Sub Types

21. Flex Table Attributes

22. Flex Tables

23. GL Transaction Types

24. GL Translators

25. Job Sets

26. Jobs

27. Lookup Codes

28. Lookup Types

29. Portfolio Companies

30. Portfolio Company Branches
31. Producers

32. Product Instruments

33. Product Insurances

34. Product Pricings

35. Products

36. Promotions

37. Spreads

38. Standard Correspondences
39. Standard Document Definitions
40. Standard Element Definitions
41. Standard Function Definitions
42. Transaction Codes

43. Error Messages

44. Org. Fees

Label Configuration

The Label Configuration screen facilitates for field label customizations to modify the default
field’s label which are provided as part of seed data during product installation / upgrade.
Using this screen, you can modify the field’s User Defined Label, update Tooltip, set Default
Value (if required), set display (Y/N) option and enable / disable the field. The changes done
here are populated to respective screen in the application.
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Note

— Label configuration is controlled by the value defined for system parameter
UIX_CUSTOM_LABEL_ENABLED_IND and indicates whether configurable option
is enabled or not.

— Also the 'Update' button in Label Configuration screen is enabled only if UIX_CUS-
TOM_LABEL_ENABLED_IND is seto Y.

Field in the Ul are categorized into two types:

Base fields - these are default fields in the Ul consisting of both mandatory and non-
mandatory fields.

User Defined Fields - these are additional fields provided in disabled status which can
be enabled and customized as required.

Note the following:

Configuring field details is only an optional functionality and has to be used sensitively.

Field customizations are to be done cautiously and is recommended to be performed by
someone who is well-versed with the product. For example, label change of a particular
field is to be done at both ‘Section’ and ‘Header’ block to avoid inconsistency.

Field customizations are to be performed at your sole discretion and OFSLL is not
responsible for any impact/damage/mismatch in the data being represented or resulting
out of this change.

The Label Configuration screen displays all the Base and User defined fields provided for the
below listed screens and its sub tabs. Apart from base fields, there are additional ‘User
Defined Fields’ provided with the below combination in disabled status.

10 free text fields - ‘User Defined Field Char’
30 numeric fields - ‘User Defined Field Num’
10 date fields - ‘User Defined Field Date’

List of screens enabled with the above User Defined Fields for configuration:

Producer Screen

Customer Service > Checklists > Checklist Types, Action - Regular sub tab, and Action
- Document sub tab.

Customer Service > Correspondence > Correspondences sub tab, Documents sub tab,
and Document Elements sub tab.

Customer Service > Letters

Customer Service > Collateral

Customer Service > Account Details

Servicing > Collateral Management > Collateral Details

Conversion Accounts > Account Boarding > Collateral and Account Details sub tab.
Origination > Underwriting > Bureau > Report Header sub tab and all 10 sub tabs

Note

The corresponding web services are also enhanced to include the User Defined Fields.
Refer to swagger web service release documentation available in OTN library (https://
docs.oracle.com/cd/F22291_01/webservice.htm).
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Ensure that the field(s) for which label changes are to be done is enabled in the Ul from
Access setup screen. For more information, refer to Field Access Definition section.

You can update the field properties for all the user defined fields. For Base -non mandatory
fields, you can set the display (Y/N) option, define as mandatory / non mandatory and enable
or disable the same in Ul.

The below table indicates the supported field update options based on field type.

Parameter

Base Field

User Defined Field

Comment

Label change

Allowed to modify

Allowed to modify

Data Type

Not allowed to modify
- Display only

Not allowed to modify
- Display only

Default data type
supported by the field

Default Value

Allowed to modify

Allowed to modify

No default value

Required

Not allowed to modify

Allowed to modify

Display (Yes/
No)

Allowed to modify for
non-mandatory fields

Allowed to modify for
non-mandatory fields

Cannot modify
mandatory Base field

The Label Configuration screen displays the field records based on specific combination of
‘Language’ and ‘Division’. By default the combination is set to ‘ALL’ and can further be filtered
by selecting required combination from respective drop-down list.

Note that the Label Configuration done for a specific division (for example US01) is displayed
to those users who are mapped to the same division (US01). Else, the default labels defined
for ‘ALL’ division is displayed.

After updating the required changes in Label Configuration screen, you need to logout and re-
login for changes to appear in respective Ul. This is basically to refresh session cache and
fetch the updated field information from database server. Though, there is ‘Update’ option,
clicking on the same only refreshes the cache and reloads the record.

To customize Label Configuration

1. Click Setup > Setup > Administration > System > Label Configuration.
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ObjectType FIELD *Tooltip Enter the User Defined Field Num 2 System Required
Object Name  UPRPCNVO Enabled @]
* Default Value 0

2. To filter the records in Label Configuration section, select the required combination of
‘Language’ and ‘Division’ from the drop-down list and click ‘Load’.
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3. Select the required record and click ‘Edit’. You can also perform any of the Basic
Operations mentioned in Navigation chapter.

While looking for a specific field to customize, you might notice multiple records with
similar data since one record is populated in section and other on header. Carefully
differentiate and select the required record for update.

A brief description of the fields is given below:

Field Do this:

Language View the language category of the field.

Division View the division category of the field.

Object Type View the type of object category of the field such as Tab / Field /
Button / Header / Sub header.

Object Name View the object name maintained in database.

Field Name View the field name maintained in database.

User Defined Label Specify the field label name to be updated in the Ul.

Tooltip Enter the tooltip indicating the type of value to be populated for
the field. The same is displayed on mouse over.

Default Value Specify the default value to be populated in UI.

Based on field type, the default value set to UNDEFINED for
varchar, 0 for Number, and system date for Date.

Required Check this box to mark the field as mandatory for input in Ul.

Display (Yes /No) Check this box to display the field in Ul. By default, the same
checked for Base - non mandatory fields.

Note: Option defined here takes precedence with the display (Y/
N) option selected in Setup > Administration > Access > Screen
> Field Access Configuration tab.

System Required ‘Y’ indicates the field is system required and other parameters
such as Required, Display, and Enabled options are disabled.

‘N’ indicates the field is user configurable.

Enabled Check this box to enable the field and apply the label
configuration changes on save.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. Click ‘Update’. System refreshes the cache automatically and fetches the updated field
details from database server to display in header section.

2.16 Seed Data

Seed data in general is referred to as any data delivered with the standard product installation
and is required to be present in the production environment for application to work properly.
Seed data basically consists of Table with its associated data that are uploaded into the
system through DAT files.
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2.16.1

Seed Data screen in Oracle Financial Services Lending and Leasing displays the seed data
details maintained in the system along with the updated seed data provided with the latest
release or patch installation.

Note that, when you upgrade OFSLL from an existing version to higher version,

e New seed data provided as part of that release is automatically updated into the system.

e Seed data which are modified from previous release to current release needs to be
manually accepted and updated into the system.

The modified seed data can have updates on base tables and/or its associated data and the
changes can either be updated or skipped depending on the need.

Navigating to Seed Data screen

1. Click Setup > Setup > Administration > System > Seed Data. The system displays the
Seed Data screen.

2. On this screen you can do the following:

e View the factory shipped seed data and update/skip the seed data differences between
existing and updated seed data in ‘Factory Data’ tab.

e View the customized (i.e. changed or configured) seed data as part of implementation
in ‘Current Data’ tab.

e View the differences between Factory data and Current data in ‘Comparison Data’ tab.
e Download all or only the required table specific seed data in “Download Data’ tab.

Factory Data

The Factory Data tab displays the list of both existing and updated seed data which are
provided though release/patch installation. In the Factory Data tab you can select and update
only the required seed data changes into the respective seed data tables. During update, you
can also skip the seed data changes for later updates (if required).

Accordingly, you can sort the view in Factory Data tab by selecting ‘Skipped’, ‘Update’ or ‘All
options to display the list of corresponding seed data.

In the ‘Patch # drop-down list, you can further sort the list to display ‘ALL’ the seed data or
only the additions or updates available as part of latest patch which has seed data changes.

To View Factory Data

Click Setup > Setup > Administration > System > Seed Data > Factory Data tab.
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2.16.1.1

The ‘Factory Data’ section displays the list of seed data with the following details:

Field View this:

Table Displays the seed data table name.

Type Displays the category of seed data as either System or
Combination Data.

Key Column Displays the unique identifier columns.

Key Column Type

Displays the unique identifier column data types.

Other Columns

Displays the non unique identifier column names.

Other Column Types

Displays the non unique identifier column data types.

Count

Displays the total count of updated records in the seed data
table.

The ‘Factory Data Details’ section displays the associated data of the selected seed data
table along with the following details:

Field

View this:

Key Column Data

Displays the unique identifier column names.

Other Column Data

Displays the non unique identifier column names.

Patch # Displays the patch number with which the seed data changes
are identified.
Status Displays the current status of seed data as one of the

following:
INSERT: This status indicates new seed data.

UPDATE: This status indicates if there are changes in the
record when compared to the seed data released in previous
patch.

POSTED: This status indicates that the seed data changes
are updated into the main tables and is subsequently updated
from previous status - SKIPPED OR UPDATE OR INSERT.

SKIPPED: This status indicates that the seed data is not
updated into the main tables.

DEPRECATED - This status indicates that the seed data is no
longer used.

In the ‘Factory Data’ tab, you can click (refresh) to fetch the latest details and click ‘View’
to display the detailed information of the selected record.

Update/Skip Seed Data

The ‘Update’ option in the Factory Data tab allows you to replace the existing seed data with
the current update. However, ensure to double check the details before performing ‘Update’
operation since the same can have significant impact on system behaviour.

To Update/Skip Data
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1. Inthe Factory Data’ tab, select ‘Update’. System displays those records which can be
updated to the existing seed data tables.

2. Inspect the required record in Factory Data section with the Factory Data Details in
subsequent section.

3. Select the required record to be updated by clicking on the adjacent check box. You can
also click ‘Select All’ to select all the records.

4. Do one of the following:

— Click ‘Update Data’. This action updates the existing seed data with the updated
seed data provided as part of the current patch release.

— Click ‘Skip Data’. This action skips the seed data changes received as a part of the
patch release. The skipped records can be viewed by selecting ‘Skipped’ option in
Factory Data tab. However, the same can further be updated into the system, by
selecting ‘Update Data’.

5. Click ‘Yes’ in confirmation dialog to confirm the setup data changes.

On successful update, system does the following:

e When individual records are selected and updated, the same is removed from Factory
Data Details section and the ‘Count’ column in Factory Data section is updated with the
remaining number of records.

e In case of Bulk update, the record is removed from Factory Data tab.

2.16.2 Current Data

The Current data tab displays the customized seed data which are changed or configured as
part of implementation. In the ‘Current Data’ tab, you can click (refresh) to fetch the latest
details and click ‘View’ to display the detailed information of the selected record.

Additionally you can click “Refresh Data’ to pull the seed data details from the production
system and update the current seed data tables.

To View Current Data

Click Setup > Setup > Administration > System > Seed Data > Current Data tab.
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2.16.3

The ‘Current Data’ section displays the following details:

Field

View this:

Table

Displays the current seed data table name.

Type

Displays the category of seed data as either System or
Combination Data.

Key Column

Displays the unique identifier columns.

Key Column Type

Displays the unique identifier column data types.

Other Columns

Displays the non unique identifier column names.

Other Column Types

Displays the non unique identifier column data types.

Count

Displays the total count of records in the seed data table.

Last Refreshed Dt

Displays the date and time when seed data for the selected
table was last updated in the system.

The subsequent ‘Current Data Details’ section displays the associated data of the selected

seed data table along with the following details:

Field

View this:

Key Column Data

Displays the unique identifier column names.

Other Column Data

Displays the non unique identifier column names.

Comparison Data

The ‘Comparison Data’ tab displays the differences between factory shipped seed data and
current customized seed data.

To View Comparison Data

Click Setup > Setup > Administration > System > Seed Data > Comparison Data tab.
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2.16.4

The ‘Comparison Data’ section displays the list of seed data records with the following details:

Field View this:
Table Displays the seed data table name to be inserted or updated.
Type Displays the category of seed data as either System or

Combination Data.

Key Column Displays the unique identifier columns.

Key Column Type Displays the unique identifier column data types.

Other Columns Displays the non unique identifier column names.

Other Column Types Displays the non unique identifier column data types.
Count Displays the total count of records in the seed data table.

The subsequent ‘Comparison Data Details’ section displays the associated data of the
selected seed data table along with the following details:

Field View this:

Key Column Data Displays the unique identifier column names.

Other Column Data Displays the non unique identifier column names.

Patch # Displays the patch release version with which the seed data
was inserted/updated.

In the ‘Comparison Data’ tab, you can click (refresh) to fetch the latest details and click
‘View’ to display the detailed information of the selected record.

Download Data

The Download Data tab allows you to download table specific seed data available in the
system in ‘.dat’ format. While migrating from one environment to other, you can use the
Download Data tab to download the existing seed data and perform a bulk upload of all/
required files.

Similar to other file download process, based on the value defined for the system parameter
‘CMN_FILE_PROCESS_TO_LOB’, the seed data download file can be accessed from the
Process Files interface (if value is ‘Y’) or Database Files system (if value is ‘N’). For more
information on handling Incoming/Outgoing process files, refer to ‘Dashboard’ section in User
Guides.
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To Download Data

1. Click Setup > Setup > Administration > System > Seed Data > Download Data tab.

ORACLE’ % Weicome, ApsrEkar ~  EIENNEE <
Financial Services Lending and Leasing -

@8 SeedData [ Close
(i) Information
= Request submitted. Reference Number ABSHEKARZ803065432:
Al L Factory Data || CurrentData | ComparisonData | Download Data
> Origination
> Servicing
»» Collections

Download Data

View v Formatv &y Freeze £ Detach Wrap @) [ submitFor Download
> WFP =
SE‘HI“ " Table Name Table Type
> Tools -
[l access crip EnTITIES COMBINATION_DATA
Setup g e
= ] ACCESS_GRID_ENTITY_DETALS COMBINATION_DATA
tup :
[ weno_access COMBINATION_DATA
Administration
iy LI access_erio_FuncTions COMBINATION_DATA
System Parameter [ appLICATION DEFALLTS PRODUCT_DATA
Lookups [ ASSET_ATIRIBUTE_TYPES PRODUCT_DATA
User Defined Tables [F]  ASSET MAKE_MODELS PRODUCT_DATA
Audit Tables [F]  asser_sus_Tpes PRODUCT_DATA

User Defined Defaults 1 ASSET_TYPES PRODUCT_DATA
Transaction Codes

[T ASSIGNMENT_CONDITIONS PRODUCT_DATA
Data Files = =

The Download Data section displays the list of tables maintained in the system with ‘Table
Name’ and ‘Table Type’. Click (refresh) to fetch the latest details.

2. Select the check box adjacent to the required table in the list. You can choose ‘Select All
check box to select all the tables with seed data maintained in the system.

3. Click ‘Submit For Download’ button. System displays an information message in the
header indicating that the request has been submitted along with a reference number.
The reference number is generated in format - useridDDMMHHMISS# followed by table
name with ‘.dat’ extension. For example, (USER1230603121517#lookups.dat)

4. (Optional) If ‘CMN_FILE_PROCESS_TO_LOPB’ is set to ‘Y’, navigate to DashBoard >
Process Files screen > Outgoing Process File tab to download the selected seed data file
which will be listed with the same reference number. The file can be downloaded to
Application server.

Data Masking

Data masking screen in Oracle Financial Services Lending and Leasing facilitates to mask
Personally Identifiable Information (PII) displayed in the application to safeguard the sensitive
and confidential information while protecting them from offenders.

As part of the product installation, standard set of identified fields (seed data) which is likely
to contain either organization / customer PI information are provided for data masking in
disabled status. Based on need, the required fields can be enabled and masked for specific
user responsibility in the Data Masking screen. Also if there are additional Pl fields identified
for masking, the same can be pooled into the system using input file processing method and
masked using Data Masking screen.

The data masking process involves the following steps:

e Identify and enable field(s) (seed data) to be masked

e Select user responsibility for whom the data has to be masked
e Execute batch job to create data redaction policy

e Compile the data redaction policy

e (Optional) Process user identified Pll data for masking
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The following table indicates the standard pre-defined fields (seed data) identified in
respective screens/tabs which can be readily masked using the Data Masking screen.

Tab Name Field Names
Origination
Applicant First Name, MI, Last Name, Family Name, Birth Dt, Nationality,

National ID, Visa #, Passport #, License #, Marital status, Mother's
maiden name, Passport number, Gender, Language, Dependents,
Ethnicity, Disability, Email, Race, and Education.

Applicant > FATCA

Birth Place, Birth Country, and Permanent US Resident Status.

Applicant > Power

Holder Name, Address, Country, Nationality, and Telephone

of Attorney Number.

Applicant Active Military Duty, Military Effective Date, Duty Order Number,
and Active Military duty Release date.

Addresses Country, Postal Address Type, Address #, Street Pre, Street
Name, Street Type, Street Post, Apt #, Address 1, Address 2,
Address 3, Zip, Zip Extn, City, State, and Phone.

Telecoms Phone and Extn

Employments

Employer, Country, Address #, Address 1, Address 2, Zip, Zip
Extn, City, State, Phone, Extn, Income Amt - Stated, Income Amt -
Actual, Salary - Stated, Salary - Actual, and Title.

Applicant >
Financials

Type, Source, Account #, and Currency.

Existing Accounts

Account # and Title.

Servicing

Customer

Name, Birth Dt, Nationality, National ID, Visa #, Passport #,
License #, Marital status, Mother's maiden name, Passport #,
Language, Disability, Email, and Education.

Customer > FATCA

Birth Place, Birth Country, and Permanent US Resident Status.

Customer > Power

Holder Name, Address, Country, Nationality, and Telephone

of Attorney Number.

Customer Active Military Duty, Military Effective Date, Duty Order Number,
and Active Military duty Release date.

Addresses Country, Postal Address Type, Address #, Street Pre, Street

Name, Street Type, Street Post, Apt #, Address 1, Address 2,
Address 3, Zip, Zip Extn, City, State, Phone, and Address.

Employments

Employer, Country, Address #, Address 1, Address 2, Zip, Zip
Extn, City, State, Phone, Extn, and Title.

Assets tab

Assets

Identification #, Lien Status, Lien Event Date, Second Lien Holder,
Comments, Lien Release Entity, and Entity Name.
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Masking Format

Oracle Financial Services Lending and Leasing supports only complete masking (not partial)
of both factory shipped and user identified Pll data. On masking, the masked data is

presented in same structural format to facilitate internal validations. The below table indicates
the default values used for masking fields based on data type:

Data Type Masking Value
NUMBER 9

VARCHAR X

DATE 31/12/9999

Phone number For Ul represented format - 000-000-0009
(Masked with O’s and last digit as 9) and for
generic, masked as 9999999999

Email XXXXX.XXX@<domain>.com

Note

Itis recommended to avoid modifying masked data for user(s) with masked responsibility.
However, while editing masked data (if permitted) requires to input full data replacing the
masked characters. For example, editing a masked SSN (xxx.xx.xxxx) requires to specify

all nine digits of SSN and not just the last four digits.

2171 Setup Data Masking

1. Click Setup > Administration > System > Data Masking.

2. Define the parameters available in ‘Data Masking Details’ and ‘User Access Details’ tabs.

2.17.1.1 Data Masking Details

On clicking Data Masking link, the Data Masking Details tab is displayed by default and allows

you to enable the required fields for masking.

ORACLE
Financial Services Lending and Leasing

, PRITAM ¥ Accessiblity g Sign Out o

Data Masking
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Data Masking Details

View « Format » @ Freeze ;:j‘ Detach o Wrap EE}
Table Name Field Name
ACCOUNTS ACC_ACH_BANK_NAME
ACCOUNTS ACC_ACH_BANE_MAME_CUR
ACCOUMNTS ACC_PHP_DRAWER_CITY
» ACCOUNTS ACC_PRIMARY_CUS_LANGUAGE_CD
ACCOUNTS ACC_TITLE
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1. In the Data Masking Details section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields are given below:

Field Do this:

Table Name View the table name which contains the selected field details.

Field Name View the selected field name.

Enabled Check this box to enable masking of the selected field.

System Defined View the type of seed data maintained in the system. Y’
indicates factory shipped seed data and ‘N’ indicates user
defined seed data.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

2.17.1.2 User Access Details

The User Access Details tab facilitates to define the user responsibility to whom the Pl data
should be masked. By default, all the selected PII data in Data Masking Details tab appears
as masked for one or more user(s) selected in this tab.

1. Click Setup > Administration > System > Data Masking > User Access Details.

ORACLE # \Welcome, PRITAM ¥ Accessbiity 4G Sign Qut =
Financial Services Lending and Leasing

Data Masking [3€] Close

Data Masking Detalls User Access Details

User Access Details o add || 7 Edit =] view o Audit
View v Formatv [ Freeze  ofi Detach Wirap oh)
Responsibility Masked
UNDERWRITER 14
L PAYMENTS SUPERVISOR. &

User Access Details
E Save and Stay E Save and Return <‘;; Return

* Responsibility  PAYMENTS SUPERVISOR [=]
* Masked [¥]

2. Inthe User Access Details section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields are given below:

Field Do this:
Responsibility Select the user responsibility from the drop-down list.
Masked Check this box to enable masking for the selected user.

Note: Defining a user and not selecting the masked check box
will only create the record and masking rules are not applied.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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Create data redaction policy

Once the data masking details are defined and stored in the database, you need to create a
data redaction policy which facilitates for field level masking while displaying the details to the
respective user. A data redaction policy file contains the policies on the columns enabled in
the Data Masking Details screen.

To create data redaction policy

Click Setup > Administration > System > Batch Jobs and execute the following batch job
(in single thread mode only):

Set Code | Description Job Code

SET-RED | POLICY CREATION FOR PERSONAL | REDPRC_BJ_100_01
IDENTIFIABLE INFORMATION DATA

This batch job can either be scheduled for regular run or executed on-demand and facilitates
to generate data redaction policy picking only the enabled data masking field information from
database. On every run, the batch job drops and re-creates new set of policies in the file
based on the details updated in Data Masking Details screen.

The generated policy is either written into CLOB or sql file depending on the following option:

e if the value of system parameter ‘CMN_FILE_PROCESS _TO_LOB’is setto ‘Y’, the
policy file is generated in CLOB and can be accessed by navigating to DashBoard >
Process Files screen. For more information on handling Incoming/Outgoing process
files, refer to ‘Dashboard’ section in User Guides.

e Ifthe value of system parameter ‘CMN_FILE_PROCESS_TO_LOB’ is ‘N’, the policy is
generated as an sql file and stored in the repository path as defined in the system
parameter - CMN_SERVER_ HOME. For example, /scratch/OFSLL/<release>/sq|l.

Further, the policy file needs to be manually compiled into database schema to apply the
masking rules for respective fields for that particular user. Either a system administrator or any
other user having administration privileges needs to compile the policies in the database.

Note

For every change in the data masking details such as masking additional fields or unmask-
ing / disabling masked fields, a new policy is to be created by executing the batch job.

Masking User defined data

Apart from factory shipped seed data, additional user identified PIl data can be masked by
uploading an input file with field details and processing it in Data Masking screen using input
file processing method.

1. On identifying the fields, create an input file (in text file format) with table name, column
name, and enabled indicator (Y/N) for each field level record. If enabled indicator is ‘N’,
the record is not processed for data masking.

For example, BUSINESS_APPL_DETAILS,BSD_LEGAL_NAME,N

2. Place the input file to the path as defined in system parameter IPI_DIRECTORY. For
example, $OFSLL_HOME/input/ipi
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3. Navigate to Setup > Administration > System > Batch Jobs screen and execute the
following batch job:

Set Code

Description

Job Code

SET-IFP

PI INFROMATION FILE UPLOAD PROCESSING

IPIPRC_BJ_100_01

On execution, the batch job picks the file from the location, processes it and loads the seed
data into Data Masking screen. By default, all the user identified PIl data from input file is
categorized separately in Data Masking screen by assigning the value of ‘System Defined’

property as ‘N’.

Once the data is available in Data Masking screen, enable the required fields, assign user
responsibility and run the processing batch job - redprc_bj_100_01 to generate a redaction

policy. For more details, refer Create data redaction policy section.

Note

In addition, an xml sample file with PII fields data is provided in the installation bundle

(docs folder). The same is generated through Application Data Model (ADM) and can be
imported to view the details of Pll masked fields. However to do so, you need to have Or-
acle Cloud 13c installed.

Webhook

In the Webhook screen, you can register third-party applications to which you can notify the
changes that are done in OFSLL by triggering Webhook request as an event action.

In this type of integration, the server which is OFSLL propagates the information to the
dependant third-party applications (client) when a specific type of change has happened in
OFSLL. For example, when customer details are updated in OFSLL. For detailed information,
refer to Appendix - Webhooks chapter.

In the Webhook screen, you can maintain Webhook definition details and associate Event

Details.
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2.18.1 Webhook Definition

In a Webhook definition, you can create a Channel with authentication mode as BASIC and/
or OAUTH2.0, provide test and service url and generate secret key.

To setup Webhook Definition

1. Select Setup > Administration > System > Webhook.

2. In the Webhook section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields are given below:

Field Do this:

Channel Specify the channel name of interfaced third-party application for
identification. The same will be added into weblogic Key Store.

Client Secret Key The client secret key is auto generated by the system on clicking
‘Generate’ button after defining the details. If already generated,
the same can be used to regenerate.

Service URL Specify the context path of third-party application’s Webhook
Service URL used for communication where POST request is to
be provided. You can define multiple service end-point URLs for
the same channel.

Test Service URL Specify the GET web service Webhook URL of third-party
application to check service availability.

Click ‘Test’ button to generate sample test call. The status, either
success or error of the test call is displayed on the screen as
SERVICE URL TEST SUCCESFUL/FAILED. Refer step 4 below
for more information.

Enabled Check this box to enable the Webhook definition.

Authentication mode | Select the authentication mode of third-party application from the
drop-down list. The list is displayed based on lookup code
WHK_AUTH_MODE_CD. System supports the following modes:

BASIC - On selecting this option, you need to define User Name
and Password to authenticate.

OAUTH2.0 - On selecting this option, you need to define
additional enabled fields such as Grant Type, Client Id, Client
Secret, Identity Domain, Token and Header Key.

User Name If Authentication mode is selected as BASIC, specify the Basic
Authentication User Name.

If Authentication mode is selected as OAUTH2.0 and Grant Type
as ‘Resource Owner Password’, specify the third-party OAUTH
2.0 Resource Owner User Name.

Password If Authentication mode is selected as BASIC, specify the Basic
Authentication User Password.

If Authentication mode is selected as OAUTH2.0 and Grant Type
as ‘Resource Owner Password’, specify the third-party OAUTH
2.0 Resource Owner User Password.
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Field

Do this:

Bureau

Select the Credit Bureau from the drop-down list. This is required
if the Credit Bureau report format is to be processed externally as
defined in Setup > Administration > User > Credit Bureau screen.

The list is populated with credit bureau details maintained in
CRB_SOURCE_CD lookup. This field is enabled only during
ADD process and is Read-Only during EDIT.

Ensure that the selected Bureau is not already selected for the
enabled record. Else, system displays an error indicating ‘Record
already exist with same bureau’ and need to disable the existing
record and enable the new record with the new Bureau.

Note: The ‘Event Details’ section is not displayed if the Credit
Bureau report format is to be processed externally.

Verified

This check box is auto selected on verifying the channel data by
clicking ‘TEST button and if the test server connection is
successful.

The following additional fields are enabled for OAUTH2.0 type of Authentication mode:

Token URL Specify the third-party OAUTH 2.0 token generation URL.

Grant Type Select the OAUTH 2.0 grant type from the drop-down list. The list
is populated based on lookup code WHK_GRANT_TYPE_CD.

Client Id Specify the identification name of third-party OAUTH 2.0 client.

Client Secret Specify the secret code of third-party OAUTH 2.0 client.

Identity Domain Specify the domain name of the third-party OAUTH 2.0 client.

Token Header Key Specify the token header key of third-party OAUTH 2.0 client.

3. Perfo
4. Click

rm any of the Basic Actions mentioned in Navigation chapter.

‘Test’ button verifies the configuration details of third-party application.

Th external system generates base 64 X-Hmac header using HMAC SHA 256 and
propagate this as part of response header to OFSLL.

Channel name is used in HMAC digest as given below. This will be passed to the
external interface using HTTP Header Key ‘ChannelName’. This value will be in
base 64 encoded format.

System will validate this response and update the Verified indicator. Only HTTP
status code 200 is considered as success.

Format: "OFSLL": Base64 Encoded [HMAC SHA 256 of ["Http Method Types":"Base64

Enc
For
Clie

oded Channel Name": "Service URL"] with Client Secret Key]
example:
nt Secret Key

ZXIKMGVYQWIPaUpLVjFRaUxDSmhiR2NpT2IKSVV6VXhNaUo5LmV5SnpkVOlp
T2IKWFJVSKIUMDIMSWI3aVEwaEJUazVGVENJINKIPVIWRVZTVGtGTVNVNVVS
VkpHUVVORKxVOUJWVIJJTWpBaUxDSnBjM01pT2IKUFJsTk1URjIYUIVKSVQw
OUxJaXdpWIhod0lgb3hOVFUXTmpnMU1qSXpMQOpwWYhRaU9gRTFOVFUyTO
RRNU1qTjkuemxMb0lzdWduek1FRnhyblexYXJIeXNMSFIiSmVQdOR5SUxvdDdU
aXZDMEFVUKtEbm5WcDJpWmRIT 1 pJald5aHNfSWxNaG11V1dWZUFOYmZRUnI
1X2¢c=
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Cipher Text for HMAC SHA 256

GET:RVhURVJOQUxJTIRFUkZBQOUtTOFVVEgyMA==:application/json:https://
Hostname:Port/webhook _oauthqa/service/api/resources/webhook/test

Generated Sample ‘X-Hmac’ header
OFSLL:F/jj07ghgM3g5z91EHU/rdxYbad266SRnXsBRoUxgUc=

Clicking ‘Generate’ button OFSLL generates Client Secret Key. This key is used in
generation of X-HMAC header that is sent to the third-party channel to validate origination
of the request.

System generated ‘X-HMAC’ header uses base 64 encoded HMAC SHA 256 algorithm.
This algorithm uses below logic:

Format: "OFSLL": Base64 Encoded [HMAC SHA 256 of ["Http Method Types":"Base64
Encoded Payload":" Http Content Types": "Service URL"] with Client Secret Key]

For example.

Client Secret Key
TOZTTEXfQjJCX1RFU1RfQOXxJRUSUONdIbGNVbWUX

Cipher Text for HMAC SHA 256

POST:ewoglCAgIlJlcXVIc3RUeXBlljoglk9VVEJPVUSEIgp9:application/json:http://
Hostname:Port/webhook/service/api/resources/webhook/basic

Generated Sample ‘X-Hmac’ header
OFSLL:g6xCpZrnudfB8owvYEi2+Aac4cIM3b/XFVTVrChdQKA=

2.18.2 Event Details

The Event Details section acts as a single point of entry to define and update required
Webhook Events in the system. In Event Details, you can define service end points of third-
party application which accepts the communicated changes. Multiple end points can be
defined to a single channel for each Event Criteria. These details are displayed as Webhook
Event Action in Setup > Administration > System > Events screen.

To define Event Details

1.
2.

Select Setup > Administration > System > Webhook.
Select the required definition in Webhook section.

In the Event Details section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields are given below:

Field Do this:

Event Select the event code from the drop-down list. The list is

populated based on the enabled event codes maintained in
Events setup screen.

Event Criteria Select the event criteria from the drop-down list. The list is

populated based on the enabled event criteria maintained for the
selected event in Events setup screen.

Service End Point Specify the third-party application end point URL which is

propagated to Event Definition as an Event Action Parameter.

Event Message Specify the event message which is propagated to Event

Definition as an Event Action Parameter.
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Field Do this:

Enabled Select this check box to enable the event details in the system.

4. Click “ﬁ" button and add the event details to the list.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

2.18.3 Monitoring Webhook Events

You can verify the status of all Webhook Event Actions on the JMS Queues screen of the
System Monitor screen.

To monitor Webhook events

1. On the Oracle Financial Services Lending and Leasing home screen, click Dashboard >
Dashboard > System Monitor > JMS Queues.

The Messages tab displays the ‘Status’ for all outbound Webhook events processed to
third-party applications and their request in ‘Response Message Details’ section.

For more details, refer to Dashboard > System Monitor section in any of the User Guides.
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3. Administration User

In the Administration > User, you can record setup data that define your organization
structure and its users. Information in this link is more “data” related, whereas the information
stored on the System drop-down link functions more like switches that control system
behavior.

Navigating to Administration User

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User.

The User drop-down link records the following data:
e Organization
e Companies
e Access
e Users
e Credit Bureau
e Correspondence
e Queues
e Printers
e Intelligent Segmentation
e Currencies
e ZipCodes
e Payment Hierarchy

Organization

The Organization screen records the operational hierarchy of your business in terms of
people. It groups the human resources of your business in three categories: organization,
division, and department. The system uses this data to control access of users to
accounts.(The Companies screen allows you to setup the location of these accounts.)

Note

You can have only one active organization, so use the Organization field to define your
organization at its highest level.

Divisions are groups within your organization that will have access to the same accounts.
Larger organizations often define their divisions by region. Smaller organizations may define
division as branch offices or even departments, and might only have one division defined.
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Departments are smaller units within a division. They expand on who is in the corresponding
Division field. The system uses this sub screen, for example, when setting up the Services
screen on the Utility form. At least one department must be defined for each division.

I—Qrganization —‘ '
I—.. Division A —l | I— Divisioln .B —I

' Deptl Dept2 Dept 3 Deptl Dept2 . Dept 3
{PEOPLE)

As an example of an organization setup, Oracle Corp. might be defined as:
Organization: O-00010racle Corp.ORA

Division: OD-001Central RegionC01

Department. ODD-010riginationORG

Department. ODD-02FundingFUN

Department. ODD-03ServicingSER

Division: OD-002Eastern RegionE01

Department. ODD-11ServicingSER

Department. ODD-12CollectionCOL

™ ]

I—Central Region (C01) —I Eastern Region (E0L)
Crigination Funding Servicing Servicing .Collcctions
(ORG) {FUN) (SERV) (SER) (coL)

Note

The Short Name field on the Organization screen allows you to create the ID that Oracle
Financial Services Lending and Leasing will use when referring to the organization, divi-
sion, and department throughout the system.

To setup the Organization screen
1. Click Setup > Setup > Administration > User > Organization.
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2. In the Organization Definition section, there can be only one active entry, so use this
screen to define your organization at its highest level. Perform any of the Basic
Operations mentioned in Navigation chapter.

ORACLE’
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A brief description of the fields is given below:

Field: Do this:

Organization Specify the organization ID (the ID is the unique identifier used
internally by Oracle Financial Services Lending and Leasing to
represent your organization).

Note: Do not edit this field.

Organization Name Specify the organization name.

Short Name Specify the short name for the organization.

Note: This ID represents this organization throughout the sys-
tem.

Enabled Check this box to enable the organization.

Note: Only one enabled organization is currently allowed by
Oracle Financial Services Lending and Leasing.

Country Select the country where the organization is located from the
drop-down list.

City Specify the city where the organization is located.

State Select the state where the organization is located from the
drop-down list.

Address Line 1 Specify the address line 1 for the organization.

Address Line 2 Specify the address line 2 for the organization.
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Field: Do this:

Zip Select the zip code of the location where the organization is
located from the drop-down list.

Extn Specify the extension of the selected zip code.

Phone 1 Specify the primary phone number for the organization.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the alternate phone number for the organization .

Extn 2 Specify the phone extension for the alternate phone number, if
specified.

Fax 1 Specify the primary fax number for the organization.

Fax 2 Specify the alternate fax number for the organization.

Perform any of the Basic Actions mentioned in Navigation chapter.

In the Division Definition section, you can setup the information for the groups within
your organization that will have access to the same accounts. Perform any of the Basic
Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Division

Specify the division ID. The ID is the unique identifier used inter-
nally by the system to represent the division within the organiza-
tion.

Note: Once specified, do not edit this field.

Division Name

Specify the division name.

Short Name Specify the short name for the division.
Note: This ID represents this division throughout the system
(required).

Enabled Check this box to enable the division.

Country Select the country where the division is located from the drop-
down list.

City Specify the city where the division is located.

State Select the state where the division is located from the drop-down

list.

Address Line 1

Specify the address line 1 for the division.

Address Line 2
(unlabeled)

Specify the address line 2 for the division.

Zip

Select the zip code of the location where the division is located
from the drop-down list.
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Field: Do this:

Extn Specify the extension of the selected zip code.

Phone 1 Specify the primary phone number for the division.
Extn 1 Specify the extension for the primary phone number.
Phone 2 Specify the alternate phone number for the division.
Extn 2 Specify the extension for the alternate phone number .
Fax 1 Specify the primary fax number for the division.

Fax 2 Specify the alternate fax number for the division.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Click Setup > Setup > Administration > User > Organization > Department
Definition.

7. On the Department Definition section, perform any of the Basic Operations mentioned
in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Department Specify the department ID.

Note: The ID is the unique identifier used internally by the sys-
tem to represent the department within the division.

Department Name Specify the department name.

Short Name Specify the short name for the department.

Note: This is the ID that appears throughout the system to repre-
sent this department.

Enabled Check this box to enable the department.

Country Select the country where the department is located from the
drop-down list.

City Specify the city where the department is located.

State Select the state where the department is located from the drop-
down list.

Address Line 1 Specify the address line 1 for the department.

Address Line 2 Specify the address line 2 for the department.

Zip Select the zip code where the department is located from the

drop-down list.

Extn Specify the zip extension where the department is located.
Phone 1 Specify the primary phone number for the department.
Extn 1 Specify the phone extension for the primary phone number.
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3.2

Field: Do this:

Phone 2 Specify the alternate phone number for the department.
Extn 2 Specify the phone extension for the alternate phone number.
Fax 1 Specify the primary fax number for the department.

Fax 2 Specify the alternate fax number for the department.

8. Perform any of the Basic Actions mentioned in Navigation chapter.
9. Click Setup > Setup > Administration > User > Organization > Display Format.

10. On the Display Format section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Format Type Select the type of format from the drop-down list.

Format Sub Type | Select the sub type of the format from the drop-down list. The format
sub type will be displayed based on the format type selected.

Format Specify or select the format based on the format type and format sub
type selected. For Date and Time Zone format, select the required
option from the drop-down list.

Format Mask Specify the format mask.

Format Filler Specify the format filler.

Special Data Specify the special data, if any.

Enabled Check this box to enable the display format.

11. Perform any of the Basic Actions mentioned in Navigation chapter.

Companies

The Companies screen records the hierarchical structure of your portfolio companies and
their branches. Just as Oracle Financial Services Lending and Leasing uses the Organization
screen to determine the location of people, it uses the information on the Companies screen
to determine the location of accounts. In completing the Companies screen, there can be
more than one company, and each company can have more than one branch.

Accounting is performed at the company level. Accountscan be sorted down to the branch
level. For this reason, branches are set up to reflect different business practices. You would
set up different branches if, for example:

e The General Ledger (GL) differs between branches
e The branches work with different accounts
e There is a difference between branches in terms of the tasks they perform

As an example of the companies setup, Oracle Corp. might have the following companies and
branches defined as:
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Company: C-0001TrustOne Financial CorpTOFC
Branch: CB-01TOFC - HeadquartersHQ

Branch: CB-02Kennedy Plaza KP

Company: C-0002Credtyme Credit CorpCCC
Branch: CB-11CCC - HeadquartersHQ

Branch: CB-12CCC - MissoulaMT

Eractym= Cioait
RS

ESETHoadataers SCO i molin
ahay PATE 2SN, RAT (AT

— The system does not limit the number of companies or associated branches with
the company you can enter.

— The Short Name field on the Companies screen allows you to create the ID that the
system will use while referring to the company and branch.

KEY CONCEPT: Note the difference between the Company screen and the Organization
screen:

e On the Organization screen, Oracle Financial Services Lending and Leasing users
belong to an organization and division.

e Onthe Companies screen, credit accounts belong to a company and branch.

As you can see in the following Access screen section, the information on the Organization
and Companies screens define the operational hierarchy of your companies in terms of which
Oracle Financial Services Lending and Leasing users will have access to which accounts
To setup the Companies

1. Click Setup > Setup > Administration > User > Companies. The Companies screen
defines entities within your organization that originate and/or service Loans.
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2. In the Company Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.

ORACLE’

Financial Services Lending and Leasing
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A brief description of the fields is given below:

Field: Do this:

Company Specify the portfolio company ID. (This ID is the unique identifier
used internally by the system to represent the company).

Name Specify the name of the portfolio company (required).

Short Name Specify the short name for the portfolio company (ID displayed to
represent the company).

Currency Select the currency of the portfolio company from the drop-down
list. The system displays the default value as ‘US DOLLAR'.

Enabled Check this box to enable the portfolio company.

Country Select the country where the portfolio company is located from the

drop-down list. The system displays the default value as ‘UNITED
STATES'.

Address Line 1

Specify the address line 1 for the portfolio company.

Address Line 2

Specify the address line 2 for the portfolio company.

Zip Select the zip code of the location where the portfolio company is
located from the drop-down list.

Extn Specify the extension of the zip code where the portfolio company is
located.

City Specify the city where the portfolio company is located.

State Select the state where the portfolio company is located from the

drop-down list.
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Field:

Do this:

Company Time
Zone

Select the time zone in which the company operates using the drop-
down list. This time zone is considered if system is setup to process
GL at Company level. For more information, refer to ‘Appendix -
Configuration at Company Level’ chapter.

Remittance Address section

Country Select the remittance address country from the drop-down list. The
system displays the default value as ‘UNITED STATES'.

Remittance Specify the remittance address line 1, if it is different from the com-

Address 1 pany address. This address is included as the remittance address
on statements.

Remittance Specify the remittance address line 2.

Address 2

Zip Select the zip code of the remittance address line 1 from the drop-
down list.

Extn Specify the extension of the remittance address zip code.

City Specify the remittance address city.

State Select the remittance address state from the drop-down list.

Phone 1 Specify the primary phone number for the portfolio company.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the alternate phone number for the portfolio company.

Extn 2 Specify the phone extension for the alternate phone number.

Fax 1 Specify the primary fax number for the portfolio company.

Fax 2 Specify the alternate fax number for the portfolio company.

Tax ID # Specify the tax identification number for the portfolio company.

TCC Specify the transmitter control code for the portfolio company (1098
Electronic Filing).

Contact Specify the contact information about the portfolio company.

Coupon Order
Code

If you are using coupons, Specify the coupon order code to be used
by a third party printing the coupons for billing statements.

HMDA

Select the HMDA agency (Home Mortgage Disclosure Act reporting
agency for the company).

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. On the Branch Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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3.3

A brief description of the fields is given below:

Field: Do this:

Branch Specify the portfolio branch ID. (This ID is the unique identifier used
internally by the system to represent the branch within your company).

Name Specify the name of the portfolio branch (required).

Short Name Specify the short name for the portfolio branch (ID displayed to repre-
sent the branch) (required).

Enabled Check this box to enable the portfolio branch.

Sub Unit Select the Sub Unit from the drop-down list.
Sub Unit refers the entity which is the source of funds for the credit
application/Account.
System associates the selected sub unit with the particular company/
branch combination and displays by default when the same is selected
during an application/Account creation.

Country Select the country from the drop-down list. The system displays the
default value as ‘UNITED STATES'.

City Specify the city where the portfolio branch is located.

State Select the state from the drop-down list.

Address Line 1

Specify the address line 1 for the portfolio branch.

Address Line 2

Specify the address line 2 for the portfolio branch.

Zip Select the zip code of the location where the portfolio branch is located.

Zip Extn Specify the extension of the zip code, where the portfolio branch is
located.

Phone 1 Specify the primary phone number for the portfolio branch.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the alternate phone number for the portfolio branch.

Extn 2 Specify the phone extension for the alternate phone number.

Fax 1 Specify the primary fax number for the portfolio branch.

Fax 2 Specify the alternate fax number for the portfolio branch.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Access

Using the organizations, divisions, companies, and branches created on the Organization and
Companies screens, you can control the access privileges of accounts. On the Access
screen, you define which organization/division (users) can gain access to which company/
branch (accounts) locations.
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3.3.1

Normally, for each division within an organization, you would define a record with Company
value of ALL and a Branch value of ALL, then select the Allowed box. You then define other
records for the same Organization and Division for other Company and Branch combinations
with the Allowed box cleared to restrict access.
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To setup the Access

1. Click Setup > Setup > Administration > User > Access. The system displays the
Access screen. In this screen, you can control the access privileges of the user for the

following categories:

e Data
e Screen
e Reports

e Correspondence
e Webservice

Data

The Data screen allows you to restrict access to different data.

To setup the Data

1. Click Setup > Setup > Administration > User > Access > Data.
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2. Inthe Access Grid section, perform any of the Basic Operations mentioned in Navigation

chapter.
ORACLE
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A brief description of the fields is given below:

Field: Do this:

Organization Select the organization for which you are defining access privileges
from the drop-down list.

Division Select the division within the organization for which you are defining
Access privileges from the drop-down list.

Company Select the portfolio company to which you are defining access privi-
leges for the organization and division specified from the drop-down
list.

Branch Select the portfolio branch of the company to which you are defining
access privileges for the organization and division specified from the
drop-down list.

Allowed Check this box to provide access to the data pertaining to the com-
pany and branch, for the organization and division specified.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
3.3.2 Screen
In the screen, you can control the access to the following:

1. Menu — Control access at the application menu level. For example, for Setup menu you
can provide access only to an Administrator.
2. Screens — Control access to the screens available in the application.

3. Buttons — Control access based on the stage.
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For example, Add and Edit buttons can be disabled once an application is funded.

If you want to restrict updating the Applicant details, then edit button has to be disabled
for the stage.

4. Fields - Control access to base and user defined fields.

The screen allows you to restrict access to different screens and fields using the following
tabs:

e Security Access Definition
e Field Access Definition

3.3.2.1 Security Access Definition

To set the Screen Security
1. Click Setup > Setup > Administration > User > Access > Screen.

2. In the Security Super Group section, you can view the details of the super group you
want to work with.
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3. Inthe Security Access Definition section, perform any of the Basic Operations
mentioned in Navigation chapter.

Note

You can not add a new record

A brief description of the fields is given below:

Field: Do this:

Access Code The system displays the selected access code.
Description Modify the description of the access code.

Type The system displays the type of security access definition.

System Defined | If ‘Yes’ is selected, the security access definition entry is system
defined.

If ‘No’ is selected, the security access definition entry is manually
defined.
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Field: Do this:

Enabled Check this box to enable the security access definition entry is
enabled.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. Inthe Security User Access Details section, perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Access Type Select the access type of the user who will have access to this
screen from the drop-down list.

Active Value Select the active value of the user who will have access to this
screen from the drop-down list.

Allowed Select “Yes'’ to allow access to this screen or ‘No’ to deny access to
this screen.

System Select ‘Yes', if the screen user access definition entry is system

Defined defined.
Select ‘No’, if the screen user access definition entry is manually
defined.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

3.3.2.2 Field Access Definition

The Field Access Definition tab facilitates for field customization in the User Interface (Ul)
screen. In this tab, you can do the following:

e Enable User Defined Fields (UDFs) to be displayed in respective Ul which are provided
as part of product installation/upgrade

e Allow or restrict user access to base non-mandatory fields and UDFs maintained in the
system
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e Regroup base fields to another section in Ul
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Note the following:

e The Field Access Definition tab displays User defined Fields maintained in the system
for which you can specifically define access permissions based on user responsibility.

e The base mandatory fields are loaded automatically and Access Responsibility is set to
ALL by default during product installation/upgrade. The same cannot be modified and
hence are not displayed in this tab.

e Field access and customizations are to be performed at your sole discretion and OFSLL

is not responsible for any impact/damage/mismatch in the data being represented or
resulting out of this change.

e Field labels can further be customized in Administration > System > Label Configuration

screen.

Before defining field access, refer to the table below which indicates the possible
combinations of a particular field being displayed and allowed to edit in Ul.

View Type | Access Result

VIEW NO NON VIEWABLE

VIEW YES VIEWABLE AND EDITABLE
LOCK NO READONLY

LOCK YES VIEWABLE AND EDITABLE

To add/enable new User Defined Fields

1. Inthe ‘Field Access Definition’ section, click ‘Add’ and populate the following details:

Field: Do this:

Language Select the language of the user(s) who will have access to this field
from the drop-down list.

Division Select the division or group within the organization to which the user
belongs from the drop-down list.
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Field: Do this:

Object Name Select the Object Name from the drop-down list. You can use the
search option to query based on specific name. The list is populated
based on the combination of Language and Division selected above.

Field Name Select the field to be updated from the drop-down list. The list is dis-
played based on the object selected.

Access Type Select the access type as one of the following from the drop-down
list.

View - to display and make the field editable.
Lock - to only display the field.

Note: Option defined here takes precedence with the display (Y/N)
option selected in Setup > Administration > System > Label Configu-
ration tab.

System Defined | Select ‘Yes’, if the field access definition is system defined.

Select ‘No’, if the field access definition is manually defined.

Enabled Check this box to enable the field access definition.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

3. Click ‘Update’. System refreshes the cache and automatically updates the Field Access
Details from database to display in header section.

After updating the required changes in screen, you need to logout and re-login for changes to
be effective. This is basically to refresh session cache and update Field Access information
from database server. Though, there is ‘Update’ option, clicking on the same only refreshes
the cache and reloads the record.

To enable/disable Base fields
1. Inthe ‘Field Access Definition’ section, click ‘Edit’ and populate the following details::

Field: Do this:

Access Code View the access code defined for the field.

Description View the access code description. You can modify the details if
required.

Type By default, system displays the name of the group inside which the

field is displayed in Ul. To move the field to a different group, select
the required type from the drop-down list.

System Defined | Select ‘Yes’, if the screen field access definition is system defined.

Select ‘No’, if the screen field access definition is manually defined.

Enabled Check this box to enable the field access definition.

3.3.2.3 Security User Access Definition Details

The ‘Security User Access Definition Details’ sub tab is available only for base - non
mandatory fields and user defined fields. In the ‘Security User Access Definition Details’ sub
tab you can defined field access and set restrictions to specific user responsibility.
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3.3.3

1. In the ‘Security User Access Definition Details’ section, perform any of the Basic
Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field:

Do this:

Access Type

Select RESPONSIBILTY as the access type from the drop-down list
since access to field is based on responsibility by default. This field is
disabled during edit.

Active Value

drop-down list.

Select the user role who needs to have access to this field from the

Allowed

field.

Select ‘Yes’ to allow access to this field or ‘No’ to deny access to this

System
Defined

Select ‘Yes', if the field user access definition is system defined.

Select ‘No’, if the field user access definition is manually defined.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Reports

In the Reports screen you can control access to generate certain reports.

To set up Reports

1. Click Setup > Setup > Administration > User > Access > Reports.

2. In the Reports section, you can view the following information:

ORACLE’
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DashBoard
> Origination
> Servicing
> Collections
> WFP
> Tools
Setup
Setup
Administration
System
System Paramets
Lookups
User Defined Tat
Audit Tables
User Defined Def
Transaction Cods
Data Files
Dedupe
Securitization
Events
Batch Jobs l
Producer Cycles
Vendars
Collection Cydles
Reports
Error Messages
Translations
User
Organization
Companies
Access
users
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bark Details
Check Details
Standard Payees
Currencies
Zip Codes
Products
< >

A

Access x.

Data | Screen | Reports | Correspondence | Transaction

Reports

View~ Fomaty [Ep Freeze  Hfi Detach Wrap o)

Code Module Description

LOAN_BOARDING_RPT SERVICING LOAN BOARDING REPORT

NEW_LN_UPLD_EDTS SERVICING NEW LOAN UPLOAD - EDITS

ACCOUNT_WISE_PDC SERVICING ACCOUNT WISE PDC LIST

A IST_LEASE COLLECTIONS ACCOUNTS AND LISTING - LEASE

ST_LINE COLLECTIONS ~ ACCOUNTS AND LISTING - LINE

C_LIST_LOAN COLLECTIONS ACCOUNTS AND LISTING - LOAN

ACC_PAYABLE_ORIGINATION ORIGINATION ACCOUNT PAYABLE(ORIGINATION)

ACC_PAYABLE_SERVICING SERVICING ACCOUNT PAYABLE(SERVICING)

ACC_PAY_LOG_CUSTOMER SERVICING ACCOUNTS PAYABLE LOG BY CUSTOMER

ACC PAY LOG PRODUCER SERVICING ACCOUNTS PAYABLE LOG BY PRODUCER

Reports User Access Definition

View~ Formatv  [Ep Fresze i Detach Wrap (5]
Access Type Access Value
Reports User Access Definition
=
&
wied O Yes® No

[ os=

Enabled
¥
Y ~
%
i
o
i
i
&
¥ v
=

Hadd | Sede | [Hw A Aud

Alowed System Defined
Yes ® No Yes ¢ No

[ save and add || [ save and Stay

= System Defined () Yes®

& save and Retum || 3 Retum

No
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A brief description of the fields is given below:

Field View this:
Code Displays the code of the report.
Module Displays the code of the report from the drop-down list.

Description Displays the description of the report.

Enabled Displays whether the report definition is enabled or not.

3. Inthe Reports User Access Definition section, you can set the access rights for the
report selected in the Reports section. Perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Access Type Select the access grid function type from the drop-down list.
Access Value Select the access function grid value from the drop-down list.
Allowed Select ‘Yes’ to allow access or ‘N0’ to restrict access to the entry

based on the access type and value.

System Defined | Select ‘Yes', if the report user access definition entry is system
Yes/No defined.

Select ‘No’, If the report user access definition entry is manually
defined.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

3.3.4 Correspondence

The Correspondence screen allows you to restrict access to different correspondence
commands on the Letters menu, thus restricting your ability to generate certain
correspondence.

If you do not have the responsibility to create a type of correspondence, the corresponding
command on the Letters menu is unavailable (dimmed).

To setup the Correspondence
1. Click Setup > Setup > Administration > User > Access > Correspondence.
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2. Inthe Correspondence Codes section, perform any of the Basic Operations mentioned
in Navigation chapter.

ORACLE Py ———
Financial Services Lending and Leasing ekt .
DashBoard AoEss x [ dos=
» Origination Data  Screen  Reports  Correspondence  Tramsaction
> Servicing
* Collections Correspondence Codes | [El view | & Audit
iy Vieww Fomatv [ freeze gfiDetach | ofl Wrap [E]
T Code Description Enabled
CBK_01 01 BANKRUPTCY SET :
Setup €Co_01 01 COLLECTION SET ¥
Setup €Cs_01 01 CUSTOMER SERVICE SET Y
Administration ~ CDF_01 01 DEFICIENCY SET Y.
Sk CFN_01 01 FUNDING SET ¥
;vs;rsrtem Paramete CRF_01 01 REPO/FORECLOSURE SET 6k
Lookups CUN_D1 01 UNDERWRITING SET Y
User Defined Tat.
Audit Tables Correspondence Codes
User Defined Def &2 Retum
Transaction Code
Data Files Code CBK_01
Dedupe it
Securitization nabled ¥
Events
:i‘fh‘j”bs . ' correspondence User Access Definition apadd || Aedt | [Hview || o Audit
V;;::r o View » Formaty [ Freeze [ Detach Wirap (o]
Collaction Cycles Access Type Access Value Allowed System Defined
Reports RESPONSIBILITY ALL ® Yes Mo Yes ® No
Error Messages
Translations
User
‘Organization
‘Companies
Credit Bureau
‘Correspondence
General Ledger
Queues
Printers
Bank Details
Check Details
Smnda@ fayaes
o,
Products
< i >
A brief description of the fields is given below:
Field: Do this:
Code The system displays the correspondence code name you want to work
with.
Description The system displays the description for the correspondence code (dis-
play only).
Enabled Check this box to enable the selected correspondence code entry.

3. Inthe Correspondence User Access Definition section, perform any of the Basic
Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Access Type Select the access grid function type from the drop-down list.
Access Value Select the access function grid value from the drop-down list.
Allowed Select ‘Yes’ to allow access or ‘N0’ to restrict access to the entry

based on the access type and value.

System Defined | Select “Yes/, if the correspondence user access definition entry is
Yes/No system defined.

Select ‘No’, If the correspondence user access definition entry is
manually defined.
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3.3.5

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Webservice

The Webservice screen in Access setup allows you to configure access to the available
RESTful webservices in the system. The associated seed data for all the RESTful

webservices are loaded during product installation and process of installing the same is
detailed in the Installation guide.

As an administrator/superuser, you can Enable/Disable Web Service access to users based
on their responsibility and ensure that only authorized user have access to specific type of

data in the system. Following list indicates some of the available RESTful webservices in the
system and the complete list is made available in swagger JSON file shared in OTN library.

Generic Post Transaction Service

Call Activity Service

Scheduler Service

Account Search Service
Account Boarding Service
Payment Posting Service
Account Detail Service
Calculator Service

Application Search Service
Get Scenario Analysis Service
Post Scenario Analysis Service
Lookup Service

Dialer Integration Service
Application GET Service
Application Entry service
Application Update Service
Application Status Change
Application Checklist
Application ACH GET Service
Application ACH POST Service

Application Comment GET Service

Application Comment POST Service

Application Document GET Service

Application Document POST Service

Account Comment GET Service

Account Comment POST Service

Account Document GET Service

Account Document POST Service

Process File Upload Service
Process File Download Service
Process File List Service
Product Service

Asset Service
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e Asset Sub-Type Service

e Scheduler Force ReSubmit
e Remarketing GET Service
e Remarketing POST Service
e Invoice GET Service

e Invoice POST Service

To setup the Webservice access

Click Setup > Setup > Administration > User > Access > Webservice. The screen

consists of the following tabs:
e Security Super Group
e Security Access Definition
e Security User Access Definition Details

e Security Access Definition Details (This sub tab is available only for ‘SERVICING AND
COLLECTION’ Super Group
ORACLE'
Financial Services Lending and Leasing
Access x [ Close
Dota | Sween | Reports | Corespondence | Trensaction  Webservice E
Security Super Group Eliew || 2 Audt
View v Formatw [ Freeze i Detach lirap [50]
Super Group
SERVICING AND COLLECTION -
SETUP
WHOLESALE FLOOR PLANNING -
Security Access Definition Z Edtt || [ vew || o audt
View v Format~ B Freeze i Detach ®
Access Code Descrption Type SystemDefined  Enabled
FLL.CUSTOMERPREFERENCERESOURCE. GET FETCHPREFERENCE ACCESS TO GET CUSTOMER PREFERENCE SERVICE WEB SERVICES Yes_ifio ¥ =M
§| AUt ERESOURCE.FOST.Fi 3 ACCESSTO POST CLSTOMER PREFERENCE SERVICE WEB SERVICES 9 Yes ) No ¥
FLL DIALERINTEGRATIONRESOURCE POST. PUSHCUSTOMERACCOUNT  ACCESS TO DIALER INTEGRATICN SERVICE WEB SERVICES Y
FLL.GENERICPCSTTRANSACTIONRESOURCE POST.GENERICPOSTIXN  ACCESS TO GENERIC POST TXN SERVICE V/EB SERVICES Y
FLL ACEOUNTCOMMENTRESOURCE. GET. GETCOMMENTS ACCESS TO GET ACCOUNT COMVENTS SERVICE WEB SERVICES e o ¥ =
Security User Access Definition Details Fpadd || Aedit || [Fuew || o audt
View v Formatv B Freeze i Detach o)
AccessType Access Vahue Alowed System Defined
RESPONSIBLLTY AL Yes@ No Yes Mo
RESPONSIBLLTY coLLEcToR es@ No
RESPONSIBLTY SUPERUSER 9 Yes ) No ves
Security Access Definition Details qpadd || ZEdit | [Fvew | P audt
Vew~ Formatr [ Freeze i Detach [50]
AccessType Access Value Alowed? YesiNo SystemDefined Yeso

2. The ‘Security Super Group’ section, contains the following super group categories for

selection:
¢ COMMOM
e INTERFACES
e ORIGINATION

SERVICING and COLLECTIONS
SETUP
WHOLESALE FLOOR PLANNING

Select the required Super Group and the associated data in sub tabs are categorized
accordingly.

In the ‘Security Access Definition’ section, you can view the following field details and edit
only the ‘Description’ and ‘Enabled’ status of selected Security Access Definition.

Field: Do this:

Access Code The system displays the webservice access code.
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Field: Do this:

Description The system displays the description of the associated webser-
vice access code and can be edited for required changes.

Type The system displays the type of security access definition.

System Defined If selected as ‘Yes’, the security access definition entry is system
defined. If selected as ‘No’, the security access definition entry is
manually defined.

Enabled Check this box to enable the selected webservice access code.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Inthe Security User Access Details section, perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields are given below:

Field: Do this:

Access Type Select ‘Responsibility’ (default) as the access type from the drop-
down list. For this access type to be available in the drop-down list,
ensure that the Lookup Type ‘ACCESS_GRID_TYPE_CD’ is main-
tained in the system.

Access Value This field is ‘Read-only’ for ‘System Defined’ Security Access Defini-
tions which are loaded as part of seed data during installation.

For non-system defined Security Access Definitions, select the
access value which is the user responsibility who needs to have
access to this webservice from the drop-down list.

For user responsibilities to be populated in the drop-down list, ensure
that the Lookup Type ‘RESPONSIBILITY_CD’ is maintained in the
system.

Allowed Select “Yes’ to allow user access to this webservice or ‘No’ to deny
access. By default, No’ is selected.

System Select ‘Yes', if the webservice user access definition entry is system
Defined defined.

Select ‘No’, if the webservice user access definition entry is manually
defined.

7. Perform any of the Basic Actions mentioned in Navigation chapter.

Security Access Definition Details

If you have selected the Security Super Group as ‘SERVICING and COLLECTIONS’, there is
an additional sub section ‘Security Access Definition Details’ enabled. This sub tab facilitates
you to further restrict and control access to specific type of data within the accessible RESTful
web services. The restriction can be defined based on specific ‘Account Condition’ or
‘Account Status’.

For example, out of all the account types maintained in the system you can restrict data

access to only delinquent account(s) to a particular user responsibility by selecting Access
Type as ‘Account Condition’ and Access Value as ‘Delinquent’,

3-22 ORACLE



Controlling web service data access to permitted user(s)

For any user to access web service data, you need to define atleast one positive (allowed)
definition defined in 'Security Access Definition Details' section. Else, webserivce data is not
displayed for that particular user even if that user responsibility has permissions to access
web service.

OFSLL supports multiple user conditions on an Account and system requires to have atleast
one account condition defined as ‘Allowed’ in setup to display the data. In case, even if any
one of the account condition is defined as ‘Not Allowed’ in setup, then system does not allow
to access the data.

During the following scenarios, data is either displayed/not displayed in Webservice screen:

Scenario Data displayed

No condition is available on the account and also no | Data is displayed since
condition defined in setup there is no restriction.

Condition is available on the account but not defined | Data is not displayed
in setup since restriction is applied

Multiple conditions are available on the account and Data is displayed
one condition is defined in setup as ‘Allowed’

Multiple conditions are available on the account and Data is not displayed
one condition is defined in setup as ‘Not Allowed’

Whenever user with specific responsibility tries to access the restricted data, following type of
error messages are displayed:

e ForPOST/PUT service, system displays error as ‘Access denied’ with HTTP Error Code
401.

e For GET service with single account record, system displays error message as ‘No data
found’ with http error code 400.

e For GET service with multiple account records, of which some have access restriction
and other don’t, then system displays only the unrestricted records and does not display
the restricted records. In such a case, error message is not displayed.

Note

When multiple user access definitions are defined in the system, while processing the data
access request to a web service OFSLL first validates for any access restrictions on the
user responsibility. If not, then validates the same against 'ALL' responsibility before dis-
playing the data in Webservice screen.

For example, if data access restriction is defined for ALL and SUPERUSER responsibilities.
when logged in with SUPERUSER responsibility, the data restriction of SUPERUSER is
applied. In case, if the user logs in with any other responsibility other than SUPERUSER, then
restriction defined for ‘ALL’ is applied.

To define Security Access Definition Details
1. Click Setup > Setup > Administration > User > Access > Webservice tab.

2. Select the module in Security Super section as ‘SERVICING and COLLECTIONS’.

3. Select the user responsibility in ‘Security User Access Definition Details’ section.
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4. Inthe Security Access Definition Details section, perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields are given below:

Field Do this:

Access Type | Select the access function type (as either ACCOUNT CONDITION OR
ACCOUNT STATUS) that is being used to control the user access from
the drop-down list.

Access Select the access value from the drop-down list. The list is sorted based
Value on the Access Type selected. Also, based on a lookup associated with
the Access Type multiple entries for each access type can be created as
long as each has a different access value.

Allowed? Select ‘Yes’ if the access is allowed and ‘No’ if the access is not allowed.
Yes/No This indicates whether the selected combination of Access Type and
Access Value is allowed to access the data.

System Select ‘Yes’, if you wish to maintain access type as system defined and
Defined Yes/ | ‘No’, if you do not want to maintain it as system defined. However, sys-
No tem defined entries cannot be modified.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

3.4 Users

The Users screen allows you to create and set up an user. In the User Definition section, you
can assign a user an identification name and password to log on to the system. You can also
assign the organization, division, and department where each user is located. Additional fields
allow you to record information for contacting the user. You can also define the time frame
within which a user has access to the system to ensure compliance to the company’s
schedule. This is a very useful feature to prevent logins during scheduled maintenance.

The Responsibility field records the job function of the user and defines the level of access
that user has within the system; in particular:

e What menu items does the user have access to?

e What transactions can the user perform on the Maintenance screen on the Customer
Service screen?

Note

The system’s SUPERUSER responsibility grants access to the entire system. Give careful
consideration to the number and type of users who receive this responsibility.

To set up the Users screen

1. Click Setup > Setup > Administration > User > Users. The system displays the Users
screen.
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2.

In the User Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.

ORACLE’
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A brief description of the fields is given below:

Field:

Do this:

User

Specify the user ID.

Note: This field is a unique indicator and cannot be updated,
edited, or deleted once saved.

Organization

Select the organization to which the user belongs, from the drop-
down list.

Division

Select the division to which the user belongs, from the drop-down
list.

Department

Select the department to which the user belongs, from the drop-
down list.

Start Dt

Specify the start date for the user. You can also select from the
adjoining calender icon.

End Dt

Specify the end date for the user. You can also select from the
adjoining calender icon.

System Defined

Select ‘Yes/, if the entry is system defined. System defined entries
cannot be modified.

Select ‘No/, if the entry is not system defined and it can be modified.

Enabled

Check this box to enable the user.

First Name

Specify the first name of the user.

MI

Specify the middle initial of the user.

Last Name

Specify the last name of the user.
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Field:

Do this:

Responsibility

Select the responsibility for the user from the drop-down list.

Note: The users mapped to the role ‘Responsibility’ can only view
the screens.

Review Request

Select the supervisor responsibility who can also review and

Supervisor respond to review requests from the drop-down list.
The list displays the corresponding Review Request Supervisors
who are either one or more levels higher from the above selected
user ‘Responsibility’ as maintained in ‘RESPONSIBILITY_CD’
lookup code.

Phone 1 Specify the user’s primary phone number.

Extn 1 Specify the phone extension for the primary phone number.

Phone 2 Specify the user’s alternate phone number.

Extn 2 Specify the phone extension for the alternate phone number.

Fax 1 Specify the user’s primary fax number.

Fax 2 Specify the user’s alternate fax number.

Replacement
User

Select the user ID of the replacement user from the drop-down list.

Dt

Specify the date from when the replacement is effective. You can
also select from the adjoining calender icon.

Note: These two fields allow you to create a replacement user for
the current user. This is particularly useful when a new employee
assumes the duties of a former. By completing the Replacement
User and Replacement Dt field, the system recognizes the replace-
ment user as the current user on the effective date. For more infor-
mation, refer the section, ‘Replacement Users’.

Type

Select the user type from the drop-down list.

Reference #

Specify the reference number for the user from the drop-down list.

Email

Specify user’s email address.

Default language

Select the default language from the drop-down list.

Time Zone

Select the required Time Zone from the drop-down list, The speci-
fied time zone would be applicable at company level.

Time Zone Level

Select the time zone level (Organization, Company or User) that
would apply by default, when specific time zone is not specified at
Company and User level.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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3.41

3.4.2

Replacement users

By completing the Replacement User and Dt fields on the Users screen, you can replace an
existing user with a new user. The system assigns all responsibilities of the original user to
the new user as of the date of the replacement.

The Replacement User and Dt fields allow you to designate a replacement for the current

user in the User ID field. When you complete the Replacement User and Dt fields, save your
entry, and then enable the record, the system replaces the original user. The system changes
the End Dt field to the date when the original user was replaced (the same date in the Dt field).

The system assigns the queues of the original user to only those replacement users who have
the same user responsibilities (or Super User responsibility) as set in the system.

The system updates the following when replacing users:

1. Assigns all applications in the replaced user’s underwriting queue with the status NEW to
the replacement user’s queue.

2. Assigns all applications in the replaced user’s funding queue with a status other than
FUNDED to the replacement user’s queue. The system currently stores the collector
name in the back end tables, which are updated with the replacement users ID in the case
of the replacement of any user.

3. Also updates the Producer Management screen with the replacement user in the
Underwriter and Collector fields. The system assigns all applications routed to the
original user to the replacement user. This also includes any future applications for the
replaced user.

4. The system automatically updates the Collector ID field in all accounts to the
replacement user and routes all accounts assigned to the original user to the replacement
user.

Note

The system will not update the replacement user ID for accounts that are closed.

5. Onthe queue setup of Customer Service screen’s Responsibilities sub screen, the record
for the original user will be disabled and a new record will be created for the replacement
user. If the replacement user already exists in the setup, The system will not create a new
record. It updates the user ID and routes all accounts that were assigned to the original
user, based on the account condition, to the replacement user.

Application and Oracle Identity Manager Synchronization

Oracle Identity Manager is for user administration. Oracle Financial Services Lending and
Leasing has been developed in such a way that it can be implemented with or without Oracle
Identity Manager. In case OID has been employed, the user definition is done in OID and then
synchronized to the Oracle Financial Services Lending and Leasing Users table using a utility
JAR called OID Synchronization JAR. In OID, users are defined across various groups
belonging to a realm which is nothing but the directory structure in OID. A user can be
configured to belong to multiple groups in a realm. Every time the user tries to login to Oracle
Financial Services Lending and Leasing or OBIEE, the system validates the login ID and the
password with OID and provides access to those applications.
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3.5

3.5.1

Credit Bureau

In the system, an important part of the origination process is pulling a credit report from a
credit bureau and scoring that information against a user-defined risk model. These credit
reports can be pulled both automatically and manually.

After you enter an application, the system compares its contents against pre-screen criteria.
If the application passes a pre-screen edits check, the system advances the status of the
application and automatically pulls a credit report.

You can manually request a credit report for an applicant or any other party included on the
application, such as co-signers and spouses by selecting the bureau from which you want to
pull the report. If more than one report type is defined for the selected bureau, then you can
indicate the type of report you want to pull.

The following are few additional Credit Bureau Setup details:

e The credit bureau from which the report is pulled is determined by the applicant’s zip
code. The credit bureau interface searches the information in the Credit Bureau Zip
Matrix tab and matches the applicant’s zip code to determine the bureau(s) from which
to request a report.

e The number of credit reports automatically pulled per applicant is controlled through the
credit request parameter CRB_. MAX BUREAU_PULL. If this parameter is setto 1, a
credit bureau request will be made for the Bureau credit bureau from the zip code
matrix. Likewise, if this parameter is set to 2, a credit bureau request will be made for
the Bureau1 and the Bureau2 credit bureaus from the zip code matrix.

e The system automatically pulls credit reports for only the primary applicant and the
primary applicant's spouse (for joint applications) unless the
CRB_ALL APL BUREAU PULL credit request parameter is set to Y. However, if the
parameter is setto Y, the system pulls credit reports for all of the applicants on the Loan,
regardless of their relationship to the primary borrower.

e Passwords, default report formats, and other required information from the credit
bureaus are set up in the Report Formats screen.

Member codes and passwords when switching credit bureau access methods (moving from
dial-up to Net Connect). The member codes and passwords are not dependent on the
connection method used to access the bureau.

Frame relay access is from the database server to the Experian host though a TCP/IP socket
connection. The connection is outbound only and it is to a specific port (699 or 700) on the
Experian host.

The credit bureau service will be accessing Experian Net Connect service through HTTP to
the ECALS URL supplied by Experian as well as by the HTTPS to the URL returned as a
response to the ECALS URL inquiry (the credit request URL). This access is from the
database server access.

Credit Bureau

The setup for Credit Bureau spans across the following links:
e Reporting
Navigating to Credit Bureau

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Credit Bureau.
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3.5.1.1 Reporting

The system reports to the credit bureau agencies in the Metro 2 format with the payment and
account status information of each account holder. The Credit Bureau Reporting screen
contains the program identifier to be reported to the bureaus.

To setup the Reporting
1. Click Setup > Setup > Administration > User > Credit Bureau > Reporting.

2. Inthe Credit Bureau Reporting section, perform any of the Basic Operations mentioned
in Navigation chapter.

ORACLE - .
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A brief description of the fields is given below:

Field Do this:

Company Select the portfolio company from the drop-down list.

Bureau Select the bureau from the drop-down list.

Program Identifier Specify the program identifier. The customer receives this from
the bureau and uses it to identify itself to that bureau. You will

need to update this information.

Enabled Check this box to enable the program.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.5.2 Special Metro Il Code reporting

The system allows you to report the following special Metro 1l segments to the credit bureau
output file:

e Consumer Information Indicator Code (CIIC)
e Compliance Condition Code (CCCD)
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e Special Comment Code (SPCC).

The system users will need to use call Action/Results and Reason fields on the Call Activities
sub screen of the Customer Service form (Lending > Customer Service > Customer Service
(2) master tab > Account Details tab > Call Activities sub tab) to place specific account
conditions where these Metro Il segments are to be reported. The specific segment reported
for a given condition will be based on the account condition and call activity reason codes.

Note

It is the responsibility of the Administrator or individual user to setup Special Metro Il Code
reporting functionality.

When users open one of the following conditions:

Code Description

CIIC CONSUMER INFORMATION INDICATOR CODE (METRO?2 - FCRA)

CCCD COMPLIANCE CONDITION CODE (METRO2)

SPCC SPECIAL COMMENT CODE (METRO2)

The system recognizes the condition, processes the selected Metro Il reporting call activity
reason code, and generates the Metro Il reporting segment in the Metro Il reporting output file.

Note

— You are responsible for selecting the correct Metro Il reporting segment reason
code to be reported. If you do not select a Metro Il reporting segment reason code,
the system will not generate information to Metro Il output file. If you select an
incorrect Metro Il reporting segment reason code, the system will report the
selected Metro Il reporting segment. the system does not validate the contents of
the Reason field with the contents of the Condition field.

— To end the reported Special Metro Il Special Code, close the open Special Metro I
Condition (no reason code needed). The system recognizes the closing of the open
Special Metro Il Condition and will not create a Metro |l reporting segment in the
output file.

— The CBU_FILE FREQUENCY (METRO 2 FILE FREQUENCY) Company system pa-
rameter determines if output file is generated and created daily or output file is writ-
ten with daily data and output monthly.

To setup Metro Il Code reporting

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Queues > Call Action Results to open and close the
following system defined condition codes:

Action Code | Description

CIIC CONSUMER INFORMATION INDICATOR CODE (METRO?2 - FCRA)
CCCD COMPLIANCE CONDITION CODE (METRO2)
SPCC SPECIAL COMMENT CODE (METRO2)
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When setup is completed, you can open and close Special Metro Il code conditions.

Note

Opening and closing Special Metro 1l Code reporting is a manual process.

The CBU_FILE _FREQUENCY (METRO 2 FILE FREQUENCY) Company system parameter
determines, if output file is generated and created daily or output file is written with daily data
and output monthly.

Oracle Wallet Manager setup

The Experian Net Connect, Equifax Internet System to System, and CSC interfaces within the
the system credit bureau service use functionality provided by the Oracle Wallet feature. Use
the Oracle Wallet Manager on the database server to create and export a wallet for use by
the credit bureau service.

Note

All of the above mentioned interfaces use the same Oracle wallet. If a wallet already exists
and is in use by one of the credit bureau interfaces, there is no need to create another wal-
let. Due to differing certificate requirements, there may be a need to import additional trust-
ed certificates into the wallet, but there will not be a need to create a new one. The credit
bureau parameter ORA_WALLET PATH contains the location of the Oracle Wallet used
by the credit bureau service.

To create and export a wallet suitable for use by the credit bureau

Refer to the Oracle documentation for more detailed instructions on how to use the Oracle
Wallet Manager to create and manage a wallet:

1. If a wallet does not already exist, create one somewhere on the database server. The
location must be readable and writable by the Oracle user. Make a note of the full path
where the wallet is stored (for example, /etc/ORACLE/WALLETS/oracle or
C:\oracle\WALLETS).

e For Transunion credit bureau, a separate wallet file is needed under transunion folder
inside the main wallet path (for example: /etc/ORACLE/WALLETS/oracle/transunion or
C:\oracle\WALLETS\transunion).

2. The wallet needs to contain the public key for the certificate authority that issued the
server certificate for each HTTPS web site that will be connected to by the credit bureau
interface. At the time of this document, those sites are:

https://ssl.experian.com Experian

https://transport5.ec.equifax.com Equifax

https://www.emortgage.Equifax.com CSC

This list may change. Use the URL provided to you by the credit bureau when they set up your
service. To get the proper Experian HTTPS URL, enter the ECALS URL that was provided by
Experian into a web browser. The response returned to the browser is the HTTPS URL that
will be used to communicate with Experian.
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3.5.5

1. Import the necessary certificate authority’s certificate files into the Oracle wallet that was
created in Step 1. See the appendix of this chapter for detailed instructions of how to
download and install a trusted certificate.

2. Test the wallet by connecting to each web site with a simple command issued from
SQLPlus.

SQL> select utl http.request('https://ssl.experian.com', NULL,
'file:/etc/ORACLE/WALLETS/oracle', 'password') from dual;

Replace the URL in the above command with each HTTPS URL given to you for use by
the credit bureaus. Also replace the wallet path with the path to your wallet and your
wallet password. The output from the command is not important, what is important is
that it runs without displaying an Oracle error. If there is an Oracle error, then something
is wrong with the contents of the wallet, the path to the wallet, and/or the wallet
password.

3. When the wallet contains all of the required trusted certificates, export the wallet to a text
file. On the Operations menu of the Oracle Wallet Manager, choose Export All Trusted
Certificates. The text file MUST be located in the same directory as the wallet and the
filename MUST be default.txt. Anytime a change is made to the trusted certificates in the
wallet, the wallet must be re-exported to the same text file.

4. Inthe Setup > Setup > Credit Bureau > Parameters set the ORA WALLET PATH and
ORA WALLET PASSWORD parameters.

Oracle JVM Security setup

The Experian Net Connect interface within the credit bureau service requires the use of the
Oracle Java Virtual Machine (JVM) that is resident in the Oracle database. Furthermore,
specific permissions must be granted to the Java classes used by the credit bureau service.
These permissions have been added to the set_java_perms.sql script that is part of the
distribution. This script (as well as many other useful SQL scripts) is available from the Oracle
Financial Services Software technical support Oracle Financial Services Lending and Leasing
patches web site.

The set_java_perms.sql script needs to run as the SYS user (or a user with SYS privileges).
The script will prompt for SYS user id and password. Be prepared to provide it when
prompted. Also, the script will select the value of the ORA_ WALLET PATH parameter from
the credit bureau parameters table. Make sure that it has been updated with the proper wallet
path before running the set_java_perms.sql script (although the script can be safely run again
if necessary).

Credit Bureau Service operation

The basic operation of the credit bureau service has not changed. Once setup, there is no
operational difference between accessing the credit bureaus via dial-up, frame relay, or the
Internet.

Importing a trusted certificate into an Oracle Wallet

The HTTPS servers used by Experian, Equifax, and CSC for their Internet based credit report
services (as well as all HTTPS servers) contain a site certificate signed by a trusted Certificate
Authority (CA). The CA is an entity that guarantees the identity of the HTTPS server. If the
client trusts the CA, and the CA says that the HTTPS server is who they say they are, then
the client inherently trusts the HTTPS server. Normally, a client tool such as Microsoft Internet
Explorer has a large store of trusted CA certificates which makes secure communication
between a client and a trusted HTTPS server relatively seamless and uneventful.
Unfortunately, the store of CA certificates in the default Oracle wallet is rather small and it is
likely that it will not contain the certificate of the CA that is certifying one or more of the credit
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bureau web sites. This means that the CA certificate must be imported into the wallet. To do
this, the certificates must first be exported from a browser and then imported into the Oracle
wallet using the Oracle Wallet Manager.

Using Microsoft Internet Explorer to Export a Certificate

1. Use Microsoft Internet Explorer and connect to one of the HTTPS URLs referenced in the
Oracle Wallet Manager Setup section of this document.

If the web site asks for a user id and password, cancel the dialog box and remain on the
top-level HTTPS screen.

2. Once connected, from the browser’s File menu, choose Properties.
Click the Certificates button.

4. Click the Certification Path tab. The bottom-most certificate is the one generated by the
host itself. The one or more certificates above the bottom-most one are of greater
importance to this task. The screen shot below displays a web site with two CAs (an
intermediate, and a primary). Whether it is an intermediate CA or a primary one, the steps
are the same for saving the certificate as a text file.

Certificate

General | Details ~ Certification Path l

— Cettification path

1 |
Wiew Certificate. .. l

Certificate status:
This certificate is OK.

5. Click the first certificate above the bottom-most certificate (it may be the only certificate
above the bottom-most certificate).

6. Click the View Certificate button.

7. Click the Details tab.

8. Click the Copy to File button.

9. Click the Next button.

10. Choose the Base 64 encoded format.

11. Click the Next button.

12. Enter a filename and location for the file.

13. Click the Next button.

14. Click the Finish button.

15. Repeat steps 5 through 14 for the next certificate in the certification path, if any.

3-33 ORACLE



3.5.6

Importing the Certificates into an Oracle Wallet

1.

Copy the certificates exported and saved during the process described above onto the
database server (not the iAS server).

As the Oracle user (or Administrator on Windows), start the Oracle Wallet Manager.

Open the wallet that will be used by the credit bureau service. Create a new wallet if one
does not already exist.

View the list of Trusted Certificates in the wallet.

Check the list of certificates against the list of certificates that are in use on the HTTPS
servers used by the credit bureaus (and that were exported and saved during the export
process described above).

Click the Trusted Certificates heading in the left list box of the Oracle Wallet Manager.

\Wallet Dperations Help

g Wallet Carlficates KeySize  Expire Date
Lgce'“f‘““ﬁm“m 3| Class | Public Primary Certfication Authorlty 1024 January7, 2020
MERERRE 3 Class 2 Public Primary Certfication authory 1024 January7, 2004
3 Class 1 Publ 3 Class 3 Public Primary Cerfication Authority 1024 January 7, 2004
7 Class 2 Publi 73, Secure Servr Certifization Authority 1000 January7, 2010
-3, Class 3 Public 73 GTE CyberTrust Root 1024 February 23, 2006
= Secure Sarver (8= GTE CyberTrust Glabal Root 1024 Augusti3, 2018
7R OTE CyberTru 53 Enrustner Secure Server Ceniication Auorly 1024 May 25, 2019
R GTE CyberTrus =5 EntrusLnet Certification Authorlty (2048) 2048 December 24,2019
-—?‘Enlrustnet Sec S 52 Entrustnet Secure Server Certfication Authorly 1024 Febnan 4, 2020
=3 Enfrustnet CeJ 3 Clags 3 Public Primary Cerfication Authority 1024 August1,2028
3 Entustngt Sec| | 3 wevelision comiCPS Incorp by Rel LIABILIT,. 1024 October 24, 2011
-3 Class 3 Public
—'ﬁm.verisign.cl

7. Use Microsoft Internet Explorer to view the certificate details for the HTTPS web sites

(File > Properties > Certificates > Certification Path > View Certificate > General)
that will be contacted by the credit bureau service. Look through the list of certificates
shown in the right panel of the Oracle Wallet Manager and look for a match between the
Issued To and Valid To dates shown in the Internet Explorer View Certificate screen.
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The screen shot below shows a certificate that is already in the wallet’s list of trusted
certificates (see the last entry for the www.verisign.com/CPS certificate).

Certificate

General | Detale  Certification Path I

— Certificahon path

Yerizign Class 3 Public Prinary Cé
srizign. com/CFS [ncorp.by Fef. LIABILITY LTD [c]97 W

q |
Wiew Certificate... |

Certificate status:
This certificate is Ok

8. Onthe Operations menu, choose Import Trusted Certificate and follow the prompts for
locating and loading the files that were copied onto the database server in step 1 for any
certificate not already stored in the wallet.

9. On the Wallet menu, choose Save when finished loading certificates.

3.5.7 De-duping Credit Bureau data

Oracle Financial Services Lending and Leasing allows you to remove duplicate (“de-dupe”)
liabilities data from the credit bureau information.

De-duping logic

The de-duping logic is based on a number of parameters that the system compares among
tradelines (only) to determine if they are duplicates. The following fields are used to
determine if two tradelines are duplicates:

Field: Description:

Account # The account number of the consumer with the lender for the particular
account.

Open Date The date the account was opened.

Member Code | The subscriber code of the lender with the respective credit bureau.

Note: Since member codes for the same lender differ across bureaus,
this field is used only for tradelines reported by the same bureau. Since
reports obtained from CSC can have tradelines from different bureaus,
this field is only for reports pulled from the credit bureaus.

All available bureau reports pulled later than DEDUP_CRB_EXPIRATION DAY days old will
be used.
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The following system parameters will be set up to provide switches to allow the functionality
to be turned on and off:

Parameter Description Valid Setup
Values value
JOINT_DEQUP_SPOUSE_LIABILITIES | De-deup the tradelines with spouss YoM v
JOINT_DEDUP_ALLAPL_LIABILITIES De-deup the tradelines with spouse | ', b W
and secondary applicant=s(=z).
DECUP_CRE_EXPIRATION _DAYS Credit report expiration days Mumber ag

Whenever two (or more) items are identified as duplicates, Oracle Financial Services Lending
and Leasing uses the following hierarchy to pick one of the items as the “correct” one:
1. Last Reported Date: The row that has been reported most recently is used.

2. Owner: In case of a tie on the last reported date, one of the tradelines is picked in the
descending order of priority depending on who the tradeline belongs to: Primary, Spouse,
then Secondary.

Debt Ratio combination

Oracle Financial Services Lending and Leasing uses the system parameter

DBR _JOINT INC DEBT WITH_SPOUSE to decide whether to combine debt ratios of the
spouse with the primary applicant. The DBR JOINT INC DEBT WITH COAPP parameter
decides whether to do the same on a non-spousal joint application.

When this indicator is checked, all liabilities in the Liability section on the Summary sub screen
of the Applicant (2) master tab with the Include box selected will be used in the debt ratio
calculation.

The following system parameter will be set up to provide switches to allow the functionality to
be turned on and off:

De-duping process

The de-duping logic will be integrated into the system decision-making process in the
following manner:

Initial credit pulls on new applications

e Ifthe JOINT DEDUP _SPOUSE LIABILITIES/ JOINT DEDUP ALLAPL LIABILITIES
system parameters are set to Y, uses the de-duping logic described above to uncheck
the duplicate liabilities in the spouse's/co-applicant’s liabilities.

e Ifthe DBR_JOINT INC DEBT WITH SPOUSE/
DBR _JOINT INC DEBT WITH ALLAPL parameters are setto Y, the system includes
the liabilities of the spouse/ co-applicant while calculating the debt ratio of the primary
applicant.

e The system will use all available credit reports at the time.

Subsequent credit pulls (manual)

e Toremove duplicate liabilities from the calculation, choose the Dedup Liabilities button
on the Underwriting form (Applicants master tab > Summary sub screen > Liability
section). (Potential record locking situations force the action to remain manual versus
the system automatically doing it).

e Ifthe Populate Debt and Include Debt boxes are selected in the Applicant/Customer
Detail section on the Bureau master tab on the Underwriting form for the credit
request and the JOINT DEDUP_SPOUSE LIABILITIES/

JOINT DEDUP_ALLAPL_LIABILITIES system parameters are setto Y, the system will
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use the de-duping logic described above to uncheck the duplicate liabilities in the
spouse's/co-applicant's liabilities.

e Ifthe DBR_JOINT INC DEBT WITH SPOUSE/
DBR JOINT INC DEBT WITH COAPL parameters are settoY, the system will include
the liabilities of the spouse/ co-applicant while calculating the debt ratio of the primary
applicant.

e The system will use all available credit reports at the time of the request that have been
requested within the number of days specified in the DEDUP_CRB_EXPIRATION DAYS
parameter.

Restrictions

The de-duping logic will be limited based upon the discussion above. If the system cannot
identify two tradelines as duplicates based upon the logic mentioned above, the individual
tradelines will be retained. In such circumstances, both tradelines will be used in the debt ratio
calculation and it will be the user’s responsibility to disregard one of them by clearing the
Include check box.

Correspondence

The Correspondence screen enables you to setup the system’s correspondence.

The system provides two types of correspondence: predefined and ad hoc. The following
chart provides a quick summary of both:

TYPE OF CORRESFONDENCE AD HOC [ PREDEFINED
Created automatically

Created manually

Generated for accounts

Generated for applications

Set up with the Correspondence link

H =

bt
b
s
h
X

Set up with the Letters link on the Product link

This chapter explains how to setup ad hoc correspondence with the Correspondence form.

The Correspondence screens provide a cost-effective and easy to use method to build
custom documents that draw information from the system’s database without additional
programming. You can choose what to include in a letter, create a template, and then use this
template to produce a letter.

The core of the Correspondence module is the document element -- the information stored in
the database merged into the correspondence. The system has document elements defined
for commonly used data elements in correspondence, such as account numbers, account
balances, customer addresses, telephone numbers, and due dates.

Correspondence consists of a document file with text of your choice and the document
elements from the system’s database.

You can create a correspondence set that consists of one or more documents. If a
correspondence set consists of more than one document, such as the account details letter
and a payment overdue letter, it prints both documents every time the system generates
correspondence for a customer.

The Correspondence module creates the following standard ad hoc correspondence:

e Microsoft Word (RTF)
e Adobe Acrobat (PDF/XFDF)
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3.6.1.1

Note

In this document and in the system, the term BANKERS SYSTEM is synonymous with
Adobe Acrobat.

Correspondence

The Correspondence screen contains the following sub screens:
e System Functions
e Elements
e E-Form Elements
e Documents
e Correspondence

Navigating to Correspondence

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Correspondence.

System Functions

The System Functions screen enables you to view the predefined functions for the
appropriate Loan product in the system. These are attributes from the database.

Functions define how the system retrieves data to include in correspondence. The data is
retrieved as elements which are either specific database columns or calculated values.
Elements are recorded on the Elements screen.

To view the predefined system functions
1. Click Setup > Setup > Correspondence > Loan > System Functions.

2. In the Function Definition section, you can view the following information.

ORACLE’ 2 Welcome, PRAKRRAO = (]
Financial Services Lending and Leasing

— Comespondance x Boese

> Origination Gommon || Loan | Line || Lease

* Servicing System Functions | Flements || E-Form Elements || Documents || Correspondence

> Collections

> WEP Function Definition

> Teols View ~ Format~ B Freeze B Detach dl wrap )

Setup Function Name. Description Function Type Source Program

GET_ACC_111_DTLS Get ACC Details (Loan CE) COR_ELM_PROC CGNACC_EL_111_01
P

Get Account Repayment Schedule Details COR_ELM_PROC CGNACP_EL_111_01
Get Account Rate Schedule Details COR_ELM_PROC CGNACR_FL_111 0

Setup
Administration £
System
System Parameter
Lookups
User Defined Tables
Audit Tables
User Defined Default
Transaction Codes
Datz Files
Dedupe
Securitization

ek Function Parameters
Batch Jobs 1

Prisdce e View~ Format~ [} Freeze i Detach Al Wirap 2]
Vendors Position Parameter Description

Collection Cycles 1iv L0 ACC id Account 1D

Regorts 2 iv_name_ar Parameter Name

3 i_value_ar Parameter value

Get APP Payment Change Schedule Details COR_ELM_PROC
Get APP Rey Schedule Details COR_ELM_PROC
et APP De n CE) COR_ELM_PROC
Get Application Decisians (Loan Close Ended) COR_ELM_PROC
Get Application CON Details (Loan CE) COR_ELM_PROC
Get APP Rate Schedule Details COR_ELM_PROC
Get Account Payment Change Schedule Details COR_ELM_PROC
Get CON Details (Loan CE) COR ELM PROC CGNCON EL 111

Error Messages
Translations
User

Organization

Companies

Access

Users

Credit Bureau

Correspondence

General Ledger

Queues

Printers

EBank Details

Check Details

Standard Payees

Currencies

Zip Codes
Products

< >
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A brief description of the fields is given below:

Field: View this:

Function Name Displays the function name.
Description Displays the function description.
Function Type Displays the function type.
Source Program Displays the source program.

3. Inthe Functions Parameters section, you can view the following information.

A brief description of the fields is given below::

Field: View this:

Position Displays the parameter position.

Parameter Displays the function parameter.
Description Displays the function parameter description.

3.6.1.2 Elements

The Elements screen displays the predefined document elements retrieved from the
database when the correspondence is generated.

In the Element Definitions section, you can update or edit only the Description field.

To view the Elements

1. Click Setup > Setup > Administration > User > Correspondence > Loan > Elements
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2. On the Element Definitions screen, perform any of the Basic Operations mentioned in
Navigation chapter. You cannot add a new record.

ORACLE"

Financial Services Lending and Leasing

&, PRAKRRAQ v

. ©

DashBoard
> Origination
> Servicing
> Collections
> WEFP
> Tools
Setup

Setup

Admiristration

System
Lookups
Audit Tables
Data Files
Dedupe

Securitization
—

Vendors

Collection Cycles

Reports

Error Messages

Translations

User

Organization

Companies

Access

Users

Credit Bureau

Correspondence

General Ledger

Queues

Printers

Bank Details

Check Details

Standard Payees

Currencies

Zip Codes
Products

< >

System Parameter

User Defined Tables

User Defined Default
Transaction Codes

Correspondence x

Common || Loan | Line | Leass

System Functions | Elements | E-Form Elements | Documents | Comespondence

Elements
View~ Formatv [ Frezze  Ef Detach
Leveld Type Element Name
ACC ACC_ACCRUAL_DT_L
A ACC
ACC
ACC
Acc ACC_ACH_BANK_NAME_111
ACC ACC_ACH_BANK_ROUTING_NBR_111
ACC ACC_ACH_FEE_IND_111
ACC ACC_ACH_PMT_AMT_111
ACC ACC_ACH_PMT. 1
ACC
ACC
ACC
ACC
AcC
‘4 ACC
ACC
ACC
ACC
ACC
ACC,
<
Elements

w

Element Type Description
ACCOUNT ACCRUAL DT LAST
ACCOUNT ACCRUAL DT START
ACCOUNT ACH ACCOUNT NER
ACCOUNT ACH ACCOUNT TYPE CD
ACOOUNT ACH BANK NAME
ACCOUNT ACH BANK ROUTING NBR
ACCOUNT ACH FEE INDICATOR
ACCOUNT ACH PMT AMT

ACCOUNT ACH PMT DAY

ACOOUNT AGH PMT FREQ CD
ACCOUNT ACH START DT
ACOOUNT ANNIVERSARY NO TERM
ACCOUNT APR

ACCOUNT BALLOON AMT CURRENT
ACCOUNT CHGOFF NEXT FOLLGWUP DT
ACCOUNT COMP AMT EARNED
ACCOUNT COMP AMT PD

ACOOUNT COMP AMT WRITEQFF
ACCOUNT COMP FACTOR

ACOOHINT COMP TNT AMT FARNED.

R T T RV NN R R R R R NPT

* Description  ACCOUNT ACCRUAL DT LAST
ta Type DATE

ource Function GET_ACC_111_DTLS

[®) Close
F et | [E|view || <7 aud
Data Type
DATE
DATE A

VARCHARZ

NUMBER
NUMBER
VARCHARZ
DATE
NUMBER
NUMEER
NUMBER
DATE
NUMBER
NUMBER
NUMBER
NUMBER
MUMBFR

B seve and stay || B save and Retum

Enabled ¥

Default Value

A brief description of the fields is given below:

Field:

Do this:

LevelO Type

Displays the element LevelO type.

Element Name

Displays the element name.

Element Type

Displays the element type.

Description

Specify the element description.

Data Type

Displays the element data type.

Source Function

Displays the element function.

Enabled

Displays if the element is enabled or not.

Default Value

Displays the default value.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

E-Form Elements

The E-forms Elements screen defines elements included when the system generates online
correspondence with a browser. The E-forms screen is set up only for PDF elements using

the XFDF format. These definitions translate the external element required by the vendor to
a systems correspondence element.
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For example,

Type Details

Vendor Element AlIBorrowers.FullNameStreetCityStateZip

(Contains names of all borrowers with address of
primary customer)

The system’s Elements PRIM_APL NAME
SPOUSE_APL_NAME
PRIM_APA_ADDRESSI
PRIM_APA_ADDRESS2
PRIM_APA_ADDRESS3

Translation: PRIM_APL NAME ||','|| SPOUSE APL NAME|""||
PRIM_APA_ADDRESSI ||';'|[PRIM_APA_ AD-
DRESS2 || ;' || PRIM_APA_ ADDRESS3

To setup the E-forms Elements
1. Click Setup > Setup > Administration > User > Correspondence > Loan > E-Form
Elements

2. In the E-form Elements Definitions section, perform any of the Basic Operations
mentioned in Navigation chapter.

ORACLE 3" SRAKRRAQ ~ [=)
Financial Services Lending and Leasing
Close:
R Correspondence » [Efs
> Origination Common Loam Line Lease
Servicen System Functions || Elements | E-Form Elements || Documents || Comespondence
> Collections
7 WEP E-Form Elements Foadd | At | Evew | o adit
> Tools View - Format- [Ep Freeze B Detach ) wrap 50}
Setup Leveld Type Source Code Element Name Destription Data Type Code  Translation Enabled
N
Setup
Administration o) £ 2
System
System Parameter E-Form Elements.
Lookups [ save and add | [ Save and Stay | [ Save and Retum || (3 Retum

User Defined Tables
* Levelo Type [v] = Description = Enabled []
. d * Data Type v

Source Code [v] e [v]

* Element Name * Translation

Dedupe
Securitization

Evants

Batch Jobs 1
Producer Gydes

Vendors

Collection Cydles

Reports

Error Messages
Translations

Organization
Companies
Access

Users

Credit Buresu
Correspondence
General Ledger
Queues

Printers

Bank Details
Check Details

A brief description of the fields is given below:

Field: Do this:
Level0 Type Select the element Level0 type from the drop-down list.
Source Code Select the element e-form source code from the drop-down list.
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Field: Do this:

Element Name Specify the element name (the name used in the external form).

Description Specify the element description.

Data Type Code Select the element data type code from the drop-down list.

Select the translation for the e-form element (SQL statement frag-
ment defining the element data), from the drop-down list.

Translation

Enabled Check this box to enable the e-form element.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
3.6.1.4 Documents
The Documents screen enables you to set up the various documents and the data fields that

the system compiles together when creating a correspondence. The system provides two
different document formats: Word or XFDF: XML-based form.

Note

Oracle Financial Services Software assumes that the user is familiar with Word and the
Merge Document command. If the user is creating e-form documents with XFDF, then
Oracle Financial Services Software assumes that person is familiar with Adobe forms.

To setup documents to be compiled in correspondence
1. Click Setup > Setup > Administration > User > Correspondence > Loan >
Documents.

In the Document Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

2.

; PRAKRRAO ~ <

ORACLE’
Financial Services Lending and Leasing

3 Close

DashBoard o gipndenct x

» Origination Common  Loan Line Leass
> Servicing
»» Collections
> WEP
> Tools
Setup
Setup
Administration
System
System Parameter
Lockups
User Definad Tables
Audit Tables

System Functions || Elements | E-Form Elements | Documents | Comespondencs

Documents Definition dkadd || 7 Edit | View | <7 Audit
Format~ | Ep Freere

Description

View + B % Gen. Data File

Code

o Detach <l wrap

File Name Levelo Type E-Form Source Product Source Enabled

‘ORACLE: BI PUBLISHE?
ORACLE: BI PUBLISHE?

ALL
AL

APPLICATION
ACCOUNT

OFSLL
OFSLL

SAMPLE_LOAN_APP SAMPLE LOAN APPLICATIONS
SAMPLE XMAS_LTR SAMPLE XMAS BEST WISHES TO CUST...

sample_loan_app
sample_xmas_r

Documents Definition

Hsaveandadd | H ssveandstay | [ saveand Retum | 3 Retum

User Definad Default
Transaction Codes
Data Files

Dedupe

Jobs
Producer Cycles
Vendors
Collection Cycles
Reports
Error Messages
Translations

User
Organization
Comparies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queues
Printers
Bank Detsils
Check Details
Standard Payees
Currencies
Zip Codes
Products
< >

* Code
* Description

* File Name

Document Elements
Viewv Fomaty [
Seq Type
No data to display.

Document Templates
View~ Fomat~ | B
File Name Froduct
No data to display.

* Level0 Type ACCOUNT
* E-Form Source OFSLL

= Product ALL

@

Description

Freeze  Efi Detach Wrap
Element Name

&}

Froducer State

& Detach
Customer State

Fresze ¢ Wrap

Data Type

App/Acc 5t

Farmat Mask

New Template

e ORACLE: BI PUBLISHER

[v]

ok add

A Edit | [Elview | o audit

Default Value Enabled

Enabled
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A brief description of the fields is given below:

Field: Do this:

Code Specify the document code to define the name for the new docu-
ment.

Description Specify the document description for the new document. This entry

appears in the Correspondence section on the Request screen,
when you generate an ad hoc correspondence.

File Name Specify the document file name for the resulting file (Word or XFDF
document).

Ensure that the name specified here is same as the BIP Template
name since system refers to this file name for generating the corre-
spondence.

LevelO Type Select the levelO type from the drop-down list.

E-form Source Select the element e-form source from the drop-down list.

Product Select the document product from the drop-down list.
Source Select the document source type from the drop-down list.
Enabled Check this box to enable the document definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Document Elements section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Seq Specify the sequence number to order the document elements.
Type Select element type from the following from the drop-down list. This

list provides the following options:

System-defined — If you select, the value is supplied by the system
and cannot be changed in the Correspondence Request screen.

Constant.

User Defined Element — If you select, you can choose the value
and change it in the Correspondence Request screen.

User Defined Constant — If you choose, you can choose the value,
but you cannot change it in the Correspondence Request screen.

Translated Element — If a document contains an e-form element
and you do not select this option, then the value will not be trans-
lated.

Element Name Select the element name from the drop-down list.
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Field: Do this:

Description Specify element description.
Notes:

1. Check that the element name does not have blank spaces or
special characters, such as the forward slash “/” or backward slash
li\”.

2. If the element is system-defined, then the system will automati-
cally complete this field.

Data Type Select the element data type from the drop-down list.
Format Mask Select the element format mask from the drop-down list.
Default Value Specify the element default value.

Enabled Check this box to include the element in the document.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Inthe Document Template section, you can set the information about the template which
is attached to the correspondence documents. The template thus saved is similar to the
template functionality available in MS word. Perform any of the Basic Operations
mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

File Name Specify the file name to define the name for the new template.

Product Select the product for which the template is valid, from the drop-
down list.

Customer State | Select the customer state for which the product is valid, from the
drop-down list.

Producer State | Select the Producer state for which the product is valid, from the
drop-down list.

App/Acc St Select the Applicant/Account state for which the product is valid,
from the drop-down list.

New Template Check this box to load the template as a new template.

Loaded Check this box to indicate that the template is loaded.
Enabled Check this box to enable the template.
Note

You can define multiple templates for each document and the template file name (BIP tem-
plate) is picked based on following criteria — Product and Producer / Account / Customer
State.

7. Perform any of the Basic Actions mentioned in Navigation chapter.
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The Document Elements sub screen records the system’s application or account information
that appears in the ad hoc correspondence
To generate a data file for a document

1. In the Document Definition section of Setup > Setup > Administration > User >
Correspondence > Loan > Documents, select the record for which you want to
generate a data file.

2. Click Gen. Data File button.
The system displays a new screen with the following options:

r '

Opening CODEL %

You have chosen to open:

L CoDE1

which is 3 Adoke Acrocbat Document
from: hitps://10.184.132.155:7013

What should Firefox do with this file?

@ Openwith | Adobe Acrobat (default) -

") Save File

[ Do this automatically for files like this from now on.

0K Cancel

L. A

e Open with — Select to view the data file in the format you want. The adjacent drop-down
list provides a list of formats compatible with the system. The system downloads the file
and displays it.

e Save File — Select to save the data file on your system.

3. Check the box Do this automatically for files like this from now on to apply selected
properties for the files which are similar to the current one.

3.6.1.5 Correspondence

The Correspondence screen enables you to define who will receive the documents you
created on the Document Definition screen by creating correspondence sets. Each document
must belong to a set, and a set can have more than one document.

To set up a correspondence set

1. Click Setup > Setup > Administration > User > Correspondence > Loan >
Correspondence. The correspondence setup is classified into two:

e Documents
e Functions
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2. In the Correspondence section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE

Financial Services Lending and Leasing

2 Welcome, DEMOSUPR » g Signout O

DashBoard
> Origination
> Servicing
> Collections
> WFP
> Tools
Setup

Setup

System
System Parameter
Lookups
User Defined Tables
Audit Tables
User Defined Defaults
Transation Codes
Data Files
Dedupe
Securitization
Events
Batch Jobs
Producer Cycles
Vendors
Collection Cydles
Reports
Error Messages
Translations
User
Organization
Comparies
Access
Users
Credit Bureau
Correspondence
General Ledger
Queuss
Printers
Bark Details
Check Details
Standard Payess
Currencies
Zip Codes
Products

Admiristration ~

Asset Types v

Documents | Functions

Correspondence (36 Close
Commen || Loan | Line | Lease
System Functions | Elemerts | E-Form Elements | Documents | Correspondence
Correspondence 4 add | Ed = # Audit
View v Formatv  [Ep Freeze i Detach Wrap )]
Code Description Print: Schedule Level Group Company Branch
DOC_PREP DOCUMENT PREPARATION TEST ONLINE APPLICATION 01 FUNDING SET AL ALL ~
LN_CE_RISC_CON_1 NOTE AND SECURITY AGREEMENT 1 ONLINE APPLICATION 01 FUNDING SET AL AL
LN_CE_ XMAS LTR 1 XMAS BEST WISHES TO CUSTOMERS ONLINE ACCOUNT 01 CUSTOMER SERVICE SET  ALL AL ~
SAMPLE_CORR SAMPLE CORRESPONDENCE ONLINE ACCOUNT 01 BANKRUPTCY SET AL AL
< >
Correspondence
[ saveandadd | Bl saveand stay | [ save and Retum | Ga Retum
* Level ACCOUNT [v] *Branch ALL [+]
*Group ~] = Product ALL [v]
= Print Schedule [v] *Company |ALL ~] *Enabled [

Documents qpadd | 7 Ede S| wiew || < Audit
View » Formatw (B Freeze i Detach & virap (50}
Documents Recipient Include

No data to display.

A brief description of the fields is given below:

Field:

Do this:

Code

Specify the correspondence code.

Description

Specify the correspondence description (required).

Print Schedule

Select the correspondence output schedule type from the drop-
down list.

Level

Select the correspondence level type from the drop-down list.

Group

Select correspondence group from the drop-down list.

Company

Select the correspondence company from the drop-down list.

Branch

Select the correspondence branch from the drop-down list.

Product

Select the correspondence product from the drop-down list.

Enabled

Check this box to enable the correspondence.

Perform any of the Basic Actions mentioned in Navigation chapter.

Click Setup > Setup > Administration > User > Correspondence > Loan >

Correspondence > Documents.

chapter.
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A brief description of the fields is given below:

Field: Do this:

Document Select the correspondence document from the drop-down list.
Recipients Select the recipients for the document from the drop-down list.
Enabled Check this box to enable the recipient selected.

6. Perform any of the Basic Actions mentioned in Navigation chapter.
7. Click Setup > Setup > Correspondence > Loan > Correspondence > Functions.

8. Inthe Functions sub screen, you can define the functions that should be executed before
or after correspondence is generated. Perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Function Select the correspondence functions from the drop-down list.
Execute Select when to execute the correspondence function from the
When? drop-down list.

9. Perform any of the Basic Actions mentioned in Navigation chapter.

3.6.2 Creating Correspondence

1. To create a correspondence add a record in the document definition block. For example:
SAMPLE_LOAN_APP

2. In the Document Elements section, add the elements required in the correspondence.
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3. Click on Gen.Data File to generate PDF file of the report.

£ SAMPLE_LOAN_APP (1).pdf - Adobe Reader EaRE=x]

File Edit View Window Help

RN N = =] Lla|le@®[=]|HB| e 2|

Tools Sign Commen

ORACLE’
Financial Services Lending and Leasing

<?xml version="1.0" encoding="UTF-8" 7>

<xs:schema xmins:xs="http://www.w3.0org/2001/XMLSchema" version="1.0">
<xs:element name="SAMPLE_LOAN_APP">

<xs:element name="PRIM_APL_BIRTH_DT" type="xs:string"/>
<xs:element name="PRIM_APL_NAME" type="xs:string"/>
<xs:element name="APP_REQ_ADV_AMT_100" type="xs:string"/>
<xs:element name="APP_APPROX_CASH_PRC_111" type="xs:string"/>
<xs:element name="ASE_APP_DESC_100" type="xs:string"/>
<xs:element name="PRIM_APL_SSN" type="xs:string"/>

<xs:element name="APA_ADDRESS1" type="xs:string"/>
<xs:element name="APA_ADDRESS2" type="xs:string"/>
<xs:element name="APA_ADDRESS3" type="xs:string"/>
<xs:element name="APE_NAME" type="xs:string"/>

<xs:element name="APA_PHONE" type="xs:string"/>

<xs:element name="APE_ADDRESS1" type="xs:string"/>
<xs:element name="APE_ADDRESS2" type="xs:string"/>
<xs:element name="APE_ADDRESS3" type="xs:string"/>
<xs:element name="APE_PHONE" type="xs:string"/>

<xs:element name="APL_EMAIL_ADDRESS1" type="xs:string"/>
<xs:element name="APL_NO_OF_DEPENDENTS" type="xs:string"/>
<xs:element name="APE_ACTUAL_MTHLY_AMT" type="xs:string"/>
<xs:element name="APP_PRO_NAME" type="xs:string"/>
</xs:element>

</xs:schema>

4. Copy and save the content in the pdf file as an xml file. The saved xml file should have
the same name as entered in the Code column of Document Definition section. For

Example: SAMPLE_LOAN_APP.xml.
5. Open MS Word.

Note

Oracle Financial Services Software assumes that BIP Desktop Tool is installed and the

user is familiar with the BIP Report Tool.

6. In Bl Publisher Tab in MS Word, click on Sample XML and import the saved xml file. For

Example: SAMPLE_LOAN_APP.xml.
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7. Create the template by inserting required elements tag.

Pagelayout  References  Mailings  Review  View

— e P )

|B| L U ~abe x, X' Aav|%~

Requested Loan Amount
Dealer

Approx Value of Asset
Description of Asset
Name of Applicant

Date of Birth

SSN

Name & Address of Employer

Employer Phone
Monthly Salary (Gross)
Number of dependants

Residence Address

Address Phone

E-mail

Page:1of1 | Words: 100 | &

8. The template created in MS Word should be saved with .rtf extension. For Example:

SAMPLE_LOAN_APP.rtf

BI Publisher

AsBCel AwBbC AaBb( AaBbC AaBh( aspbcer | A4

TNormal | T No Spaci.. Headingl — Heading 2 Title Subtitle 75:;”"“
es

BANK
LOAN APPLICATION FOR PURCHASE OF ASSET

APP_REQ_ADV_AMT_100
APP_PRO_NAME
APP_APPROX_CASH_PRC_111
ASE_APP_DESC_100
PRIM_APL_NAME
PRIM_APL_BIRTH_DT
PRIM_APL_SSN

APE_NAME

APE_ADDRESS1
APE_ADDRESS2
APE_ADDRESS3

APE_PHONE
APE_ACTUAL_MTHLY_AMT
APL_NO_OF DEPENDENTS
APA_ADDRESS1
APA_ADDRESS2
APA_ADDRESS3

APA_PHONE

APL_EMAIL_ADDRESS1

Note

The .xml and .rtf file should be saved with the same name as entered in the ‘Code’ col-
umn of Document Definition section.

9. Upload the rif template in the BIP and create the data model with SQL query as “select
CDO_XML_DOCUMENT from correspondence_docs where cdo_id = :docld”.

10. After the data model creation, launch the correspondence screen and click
Correspondence tab.

11. You can setup a correspondence with the created doc.

3.6.3 Generating Correspondence

1. Togenerate a correspondence open the application for which the correspondence should
be generated.

2. Click Correspondence tab. In the Correspondence section, click on Add.
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3. Selectthe created Correspondence. Click Save and Add to save and add a new record.
Click to Save and Return save and return to main screen. Click Return to return to main

screen without modifications.

‘ORACLE p— o
Financial Services Lending and Leasing
it Clase
 DashBoard fmitn v Mo
Origination Search/Task  Underwriting: 0000001050 Reviews Requsts (Pending: )
Origination
Siles Lead Application: 0000001050 GURLEY JENNIFER / TODD St | Blvien | o auit
Simple Applicaion Enty -
A‘:D:)‘;U::‘Et:t:" i Views Fomatv [ [[Frece ffoctah  JWamp @) OwrideOK v Wamingok v
Lok Prc
E::;';;”""“ |3 App# Sub Uit Status Egg;"“”’"m“ Producer Hame: ;zammgtus{nmer E;g}:ﬁ:{fnn Contact Sales Agent Branch Pror
Applicaion Retrieval 04J06/2015 0000001050 UNDEFINED NEW - REVIEW REQUIRED  REVIEW PRAO0002: PORSCHEINDL. .. ¥ ¥ DEMOSALES  USHQ ]
Scenario Analysis )
Applicaton Docunents
Tnage aintenance
Reports
Producers summary | Applicant  Business | Request  Dedsion Bureau | Collteral | Comments Tracking | Document  Verification | Correspondence | Tools
Vendors
Correspondence  Letters
Correspondence padd | Elvew | o Audt
Views Fomatv B [Fewe Pt v @ |
10 Cortespondence Date
0 02032016
4001 SAVPLE LDAN APPLICATION 1222015
Correspondence
[ saveandads | [ smeand stay | [ soveandRetum | CaRetun
* Correspondence v Date 02/09/2016
Documents
» Seniicing Views Fomaty B [[Frece Hoead  Jum @
> Collections Document Id Document Redpiert EfomSoce  SoureType Scleced  Generated
o data to display.
> WFP
> Tools
> Setup Document Elements Evew || & auit y
e . lmE . o

4. Click Generate to generate the selected correspondence and View Correspondence to
view the Correspondence in PDF format.

APPLICATION FOR PURCHASE OF ASSET

LOAN APPLICATION

Requested Loan Amount
Dealer

Approx Value of Asset
Description of Asset
Name of Applicant

Date of Birth

SSN

Name & Address of Employer

Employer Phone
Monthly Salary (Gross)
Number of dependants

Residence Address

Address Phone

E-mail

Signature of the Applicant
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BANK
FOR PURCHASE OF ASSET

20000.00

.00

2005 TOYOTA CAMRY
ANDREW WATT
07/15/1975
HKAXXKX2147

58, EAST 19TH STREET

HOLTSVILLE NY 00544
o

552230.00

o

34, WEST 69TH STN BCHN

NEW YORK MA 01730 US
o

ANDREW.WATT@XYZ.COM

| declare that the information given in the application is true to the best of my knowledge and belief
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Queues

When processing an account, various users might work on the accounts to complete different
tasks.

The account processing workflow facilitates the movement of the account from one person to
another with queues. Queues create a work section of accounts waiting for a particular and
common task to be performed. The system’s powerful queuing module automates this
otherwise manual process.

In the Queues setup screen, you can setup and manage workflow and work assignments on
a daily basis to ensure that the appropriate queues are available for users at all times.

Any time an account’s status is changed, the system checks whether the account is in the
right queue.

The system will sort queues based on an account’s status and condition. A condition is the
state of an account at a particular time, such as a delinquent, which determines the action a
user needs to take.

Queues in the system are distinguished to two types of queues:

1. Origination Queues

2. Customer Service Queues.

Customer service queues

In the Customer Service screen, queues create a work list of accounts waiting for a particular
and common task to be performed, such as collecting on a delinquency. The system’s
powerful queuing module automates this otherwise manual process. The Queue Setup form
allows you to manage workflow and work assignments and ensure that all accounts are in the
queues of the appropriate users at all times.

Customer Service queues distribute and route accounts that require some particular action to
be performed to specific users or departments. The system sorts customer service queues
based on an account’s status and condition.

Accounts become available for queue assignment when an account receives a condition.
Conditions can be applied automatically by the system or manually by users. For example,
during nightly processing, the system recognizes an account as delinquent and automatically
assigns it a condition of DELQ (“Delinquent”). The users can manually change an account’s
condition using combination of Action and Result field entries on the Servicing > Servicing
> Customer Service > Customer Service > Customer Service > Call Activities.

These Action and Result field entry combinations are set up on Setup > Setup >
Administration > User > Queues > Call Actions Results.

The system associates an account with one or more queues based on multiple parameters,
including user-defined criteria and the follow-up date. For example, customer service queues
might be configured so accounts are parsed to users according to:

e Due date changes
e Deferment requests
e Title and insurance follow-up dates

Collections queues are included in the Customer Service queue. These queues focus on:
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e General collections
e Bankruptcy

e Foreclosure

e Repossession

e Deficiency

Customer Service queues can be built online or in a nightly batch job. Within each queue, the
order of the accounts can be sorted based on user-defined criteria.

Note

— Although, the system allows you to define your own selection criteria in creating
queues, the system’s performance depends on how the selection criterion is
defined. The application highly recommends that you get approval from your
database administrator before using any queue selection criteria. Also, avoid using
user-defined tables and columns in the selection criteria.

— You can use these same methods for creating and closing queues in the case of
repossession, foreclosure and deficiency.

The Call Actions Results screen allows you to define the contents of the Action and Result
fields on the Customer Service screen’s Add Call Activities section. The system uses this
information to allow users to manually change the condition of an account, and thus assign or
remove the account to a queue.

Depending on how you set up call action result codes on the Call Actions screen, conditions
and queues are created or closed. You can also restrict the use of certain call activities based
on responsibility.

The lookup type ACC_CONDITION_CD defines which account conditions can be created. The
application’s queuing engine determines, if queues need to be created based on the
information in the Lookups sub screen for this lookup type.

The following table displays the possible combinations of condition and queue.

CONDITION
QUELE Den Close WA
Onen YES 0 NG
Close WS VES YES
hA YES 0 NC

1. Condition: Open, Queue: Open

e In this state, both the account condition and queue are created or opened at the same
time.

e The system’s transaction-processing engine automatically creates DELQ, TIP,
SCHGOFF conditions and queues; therefore, you need not setup any call action result
with these conditions.

e CHGOFF is an account status, so no queues are created. To follow-up on charged-off
accounts, create DEFICIENCY condition with this option.

e BKRP (Bankruptcy), REPO (Repossession), FORC (Foreclosure) account conditions
and queues can be opened with this option. Also, account level indicators (for reporting
purpose) are set.
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Note

— An account is moved to the condition, when a Call activity is posted; however, the
Queue is moved only when you click Update queue manually or in the EOD batch.

— Accounts are automatically moved based on the system parameter set up.

2. Condition: Open, Queue: NA
e In this state, only the account condition is created or opened.
e This option should be used only if queuing is not necessary on this account condition.

3. Condition: NA, Queue: Close
e In this state, the queue associated to the account condition is closed.

e This option should only be used if an existing queue on this account condition should be
closed. For example, for accounts with bankruptcy condition, delinquency follow-up is
not necessary. In such case, DELQ queue can be closed while the condition is still open.

e DELQ, TIP, SCHGOFF queues can be closed by using this option.

4. Condition: Close, Queue: Close
e In this state, both the account condition and queue are closed.

e The system’s transaction-processing engine automatically closes DELQ, TIP,
SCHGOFF conditions and queues; therefore, don’t setup any call action result with these
conditions.

e BKRP (Bankruptcy), REPO (Repossession), FORC (Foreclosure) account conditions
and queues can be closed with this option. Also, account level indicators (for reporting
purposes) are set.

Note

Condition will be removed from the Summary conditions section.

Navigating to Queues screen

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Queues.

2. The system displays the Queue Setup screen. You can setup queues related to:
e Customer Service
e Call Action Results

3.71 Criteria Based Condition

OFSLL supports various conditions on an Account with the ability for users to open and close
required account conditions. A condition can either be posted ‘automatically’ by the system
(like updating DELQ delinquency condition on account) or ‘manually’ through a transaction or
call activity.

The Criteria Based Condition screen facilitates to automate the manual process of opening or
closing conditions on account by defining criteria which helps to categorize specific accounts
and post conditions on to those accounts in bulk.

For example,

e You can define specific conditions to Send Letters, Post Transaction and so on if
Account Maturity date is less than 90 days from current system date.
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You can post a condition to allow Extension transactions on an account if 50% of
financed amount is received.

When there is a natural calamity, you can post a condition to allow Extension
transactions on Accounts belonging to that particular zip code.

However, note that the following conditions are controlled only by the system and cannot be
defined to process automatically.

DELINQUENT

SCHEDULE FOR CHARGEOFF
PAYOFF/TERMINATION IN PROGRESS
NON ACCRUAL

BANKRUPTCY

DEFICIENCY

REPOSSESSION

FORECLOSURE

In the Criteria Based Condition screen, you can setup Criteria Definitions and define Actions
to Open or Close a condition on account. This in-turn is processed during the execution of
automated batch job QCCPRC_BJ_100_01 (CRITERIA BASED CONDITION POSTING) in
SET-QCS batch job set and while executing the batch job QCCPRC_BJ_100_02 in
SET_QRT batch job set.

At account level once the condition is opened/closed, system posts a comment with the
Criteria definition details.

|

SETUP ]—)[ SETUP ACTION H BATCH JOB ]—{ ACCOUNT ACTION ]

3.7.1.1 Criteria Definition

In this section, you can define Criteria definition which can perform specific action on the
Accounts.
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To Setup Criteria Definition

1. Click Setup > Administration > User > Queues > Criteria Based Condition tab.

ORACLE’
Financial Services Lending and Leasing

# Welcome ABSHEKAR ~ o

Queues [3€) Close

Origination ~ Criteria Based Condition  Customer Service  Call Action Results ~ Activity Tracking  User Groups

Criteria Definition Add |/ Edit View Audit
Viewv Formatv [ Freeze [ Detach Wrap W Checkcriteria

Name Description Start Dt End Dt Seq Company Branch Enabled
ANKS_LINKED_CRITERIA ANKS_LINKED_CRITERIA 06/01/2019 12/31/2020 0 IND INDB N ~
ANKS_02 LINKED_02 06/01/2019 06/30/2020 0ALL ALL N

TSTO1 TST_UDF 12/01/2018 06/30/2020 o0 AL ALL N

DSDS SDSDS oA AL N
TEST_MAC_CONDITION CONDITION BASED ON COMPANY 01/01/2019 01/01/2020 0 AUSO1 AL Y

TEST1S TEST 09/01/2019 10/27/2019 0ALL ALL N

TST_02 TST USER DEFINED FIELDS 12/03/2018 07/28/2020 1AL ALL Y

TEST I TEST I 01/01/2000 01/01/2020 1AL AL N v

Criteria Definition

» [ saveand stay | [ Save and Retun | (3 Return
Name ANKS_LINKED_CRITERIA End Dt 12/31/2020 £ *Seq 0
* Description  ANKS_LINKED_CRITERIA| * Company IND v * Enabled
Start Dt 06/01/2019 & *Branch INDB v

Criteria Details  Conditions

Criteria e Add |/ Edit View Audit
View v Formatv [ Freeze Eff Detach Wrap 5]
Comparison Logical
Seq ( Parameter G Criteria Value ) Operator  Enadled
) ACCOUNT LINKED ACCOUNT NUMBER EQUAL 20190500011841 R Y
2 PPRODUCT CODE LIKE %L % Y

2. In the Criteria Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Name Specify an unique Criteria definition code.
Description Specify the description of the criteria.

Start Dt Select the start date from when the Criteria is to be

considered for execution using the adjoining calendar.

End Dt Select the end date till when the Criteria is to be considered
for execution using the adjoining calendar.

Company Select the company from the drop-down list.
Branch Select the branch drop-down list.
Seq Specify the sequence for criteria execution. When there are

multiple conditions to be posted on account, the same is
processed based on the sequence defined here.

However, there cannot be more than one enabled Criteria
with same sequence and this condition is auto validated by
the system.

Enabled Check this box to enable the Criteria Definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.7.1.2 Criteria Details

The Criteria Details section helps you to define the account selection criteria.
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1. Click the Setup > Setup > Administration > User > Queues > Criteria Based
Condition tab.

2. Select the required Criteria definition.

3. Inthe Criteria section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list.
Comparison Operator Select comparison operator from the drop-down list.
Criteria Value Specify criteria value.

) Specify right bracket.

Logical Expression Specify logical operator from the drop-down list.
Enabled Check this box to enable the selection criteria.

4. Perform any of the Basic Actions mentioned in Navigation chapter.
3.7.1.3 Conditions

The Condition section determines whether the Condition in the selected Criteria Definition is
to be opened or closed on the matching accounts.

1. Click the Setup > Setup > Administration > User > Queues > Criteria Based
Condition tab.
2. Select the required Criteria definition, define Criteria and click Conditions tab.

In the Condition section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Condition Select the Condition from the drop-down list. This list is
populated based on lookup code ACC_CONDITION_CD
which consists of all the matching conditions associated with
the selected Criteria Definition.

Note that, some of the conditions like Delinquency,
Scheduled for Charge-Off and so on (listed above) are
automatically opened/closed by system and is not available
in this list for selection.

Action Select the action as Open / Close by clicking on the adjacent
radio button.

Enabled Check this box to enable the Condition.
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3.7.2

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Customer Service Tab

The Customer Service section allows you to set up the customer service queues. The screen
includes a Hard Assigned box. When selected, the system assigns an equal amount of
accounts to each individual user working on a that queue. Also, an account that is hard
assigned will remain assigned to the individual who opens that account until that person is no

longer working that queue

Customer Service command buttons

The Customer Service screen contains following three command buttons:

Command

button: Function:

Update Queue | Queues can be updated whenever selection criteria has been updated.
They may also be updated manually, if the nightly batch fails.

accounts in this queue.

selected by updating the queue and re-assigned.

Un-Assigned Depends on location of the cursor when you choose this button.
Customer Service - “Un-assigns” all accounts in this queue.

Responsibilities and Users > Responsibilities - “Un-assigns” all

Responsibilities and Users > User - “Un-assigns” all accounts
assigned to the specific user. Unassigned accounts may now be

to enable a queue with invalid selection criteria.

Check Criteria Reviews the selection criteria for errors. The system will not allow you

To set up the Customer Service queues

1. On the Queue Setup screen, click Setup > Setup > Administration > User > Queues >
Customer Service. Queues are further filtered based on the following criteria:

e Selection Criteria

° Sort

e Responsibilities and Users
e Data node assignments

e Group Assignment
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2.

In the Queue Definition section, perform any of the Basic Operations mentioned in

Navigation chapter.
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A brief description of the fields is given below:

Field:

Do this:

Queue Name

Specify queue name.

Queue Desc

Specify queue description.

Account Condition

Select account condition from the drop-down list.

Priority Specify the priority.
Company Select the company from the drop-down list.
Branch Select the branch from the drop-down list.

Hard Assigned

Check this box to assign an equal amount of accounts to each
individual user working on a that queue. Also, an account that is
hard assigned remains assigned to the individual who opens that
account until that person is longer working that queue.

Group Follow-up Ind

Check this box to enable the bank to indicate whether the
accounts belonging to the same customer have to be followed-up
in groups.

Near Real-Time

Check this box to select the queues for the near real time refresh.
You can specify the time interval and frequency to run this queue.
When a batch is run, it picks only customer service queues
marked as “Real Time” queues for re-assignment.

Dialer Extract

Check this box to indicate if the accounts satisfying the selection
criteria should be extracted from the batch process or not. If the
user is hard-assigned, then user gets identified by the dialer
system as ‘Permission to call” user. The extract will also have
data pertaining to customer time zone and privacy opt out
indicator.

Enabled

Check this box to activate the queue.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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Click the Setup > Setup > Administration > User > Queues > Customer Service >
Selection Criteria.

In the Selection Criteria section, you can define the account selection criteria with the
following fields. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Seq Specify sequence numbers.

(

Specify left bracket.

Parameter Select the parameter from the drop-down list.
Comparison Operator Select comparison operator from the drop-down list.
Criteria Value Specify criteria value.

)

Specify right bracket.

Logical Expression Specify logical operator from the drop-down list.
Enabled Check this box to enable the selection criteria.
6. Perform any of the Basic Actions mentioned in Navigation chapter.
7. Click the Setup > Setup > Administration > User > Queues > Customer Service >
Sort.
8. Inthe Sort section, you can define the order to sort the account selection criteria with the

following fields. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Seq Specify sequence number.

AssAgpCode | Select sort field from the drop-down list.

Order Select sort order from the drop-down list.

9.

10.

11.

Perform any of the Basic Actions mentioned in Navigation chapter.

Click Setup > Setup > Administration > User > Queues > Customer Service >
Responsibilities and Users.

In the Responsibilities section, you can define the responsibilities that are authorized to
work on the queue. Perform any of the Basic Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Responsibility Select the responsibility from the drop-down list.
Enabled Check this box to enable the responsibility.

12. Perform any of the Basic Actions mentioned in Navigation chapter.
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13. In the Users section, you can define the users who are authorized to work on the queue.
Also, you can hard assign the queues to the user. Perform any of the Basic Operations
mentioned in Navigation chapter.

Note

The system allows the work queue list to be sorted by user-defined criteria.

A brief description of the fields is given below:

Field: Do this:
Name Select user name from the drop-down list.
# Assigned Specify number of accounts assigned.

Hard Assigned

Feature).

Check this box to hard assign. (For more information, see the
following section in this chapter, Using the Hard Assigned

Enabled

Check this box to enable.

14. Perform any of the Basic Actions mentioned in Navigation chapter.

15. Click Setup > Setup > Administration > User > Queues > Customer Service > Data
Node Assignments. You can enable the administrator to configure the User interface
nodes that should be made available for the applications that are being processed in that
particular origination queue.

16. In the Data Node Assignments section, perform any of the Basic Operations mentioned
in Navigation chapter.

A brief description of the fields is given below::

Field: Do this:
Node Specify the node.
Enabled Check this box to enable the record.

17. Perform any of the Basic Actions mentioned in Navigation chapter.

18. Click Load Queue Nodes on the Node Assignments sub screen to display the respective
Ul nodes in the origination module.

19. Click Setup > Administration > User > Queues > Origination > Group Assignment.
In the Group Assignment sub tab, you can add user groups to Customer Servicing Queue

and also if required, you can un-assign users from the user group.

Note

Modification of user details (adding or disabling users) within a user group which is added
to Group Assignment will implicitly be updated in Responsibilities and Users tab also.

20. In the User Group section, Click Add. You can also perform any of the Basic Operations
mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Group Name Select the user group name from the drop-down list. The list
displays the pre-defined user groups available in the system.

Enabled Check this box to enable the user group.

21. Perform any of the Basic Actions mentioned in Navigation chapter.

22. (Optional) Click 'Un-Assigned' button to un-assign all the users of the group in the queue.

Note the following:

e Ifthe queue is 'Hard Assigned', then it implies that all users in the user group(s) attached
to that queue are not 'Hard Assigned'. Hence all those Users should have to be explicitly
marked as hard assigned in the queue added through user group.

e User added directly to the queue should be disabled manually. For common users
present at Queue and User Group, you need to manually maintain the data in sync.

e Following table indicates various combinations for enabling and disabling Users and
User Group(s) from Queue and User group(s).

Added | Added
Entity | in in User | Enabling and Disabling options
Queue | Groups

User Yes No User should be disabled /enabled only in that particular
Queue.
No Yes User should be disabled / enabled in all the Queues where

the user group is attached.

User Yes No User group should be disabled /enabled only in that
Group particular Queue.
No Yes User group should be disabled / enabled in all the Queues

where the user group is attached.

Group Follow-up

The system enables lending institution to conduct “one time only” follow-up activity on the
Customer Service screen, if the customer has multiple accounts in various conditions or in
various queues. This avoids unnecessary confusions that arise when more than one user is
performing collection tasks on multiple accounts belonging to the same customer.

You can follow-up on multiple accounts in the same condition at the same time using the
group follow-up functionality. The system locks the accounts in the low priority queues and
displays the same in the high priority queues. You can perform the follow-up activity on all the
accounts when the account in the high priority queue becomes due for follow-up.

For example,

Suppose a customer holds three accounts, one that’s 30 days delinquent and in the

0 30 DAYS DEL queue, one that's 60 days delinquent and in the 30 60 DAYS DEL queue
and one that’s 90 days delinquent and in the 90+ DAYS DEL.

a) If each of the queues Group Followup Ind is unchecked on the Customer Service screen,
then no group follow-up will be performed.
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b) If each of the queues Group Followup Ind is checked on the Customer Service screen,
while updating the follow-up date for the low priority days queue, then the system will use the
90 days follow-up date

c) If the Group Followup Ind is checked on Customer Service screen forthe 0 30 DAYS DEL
and 30 60 DAYS DEL queues and note the 90+ DAYS DEL queue, and the customer has
accounts in each of the queue, then the system will use the follow-up date of 60 days for the
low priority account.

Using the Hard Assigned feature

The system’s “Hard Assigned” queues feature allows companies to evenly distribute accounts
between users. The following example explains how it works:

Let's say there are 40 unassigned accounts in a queue. Three users are assigned to the
queue, Hard Assigned is checked for two.

When you select Update Queue on the Customer Service screen (or Oracle Financial
Services Lending and Leasing processes the CUSTOMER SERVICE QUEUE PROCESSING
nightly batch) each of the two Hard Assigned users receives 20 accounts, while the one that
isn’t marked as Hard Assigned receives zero.

If users already have accounts assigned to them, the system attempts to balance the
workload when assigning new accounts. For example, let’s say there are three users in a
queue. The first has 15 accounts, the second has ten and the third has five. If there are ten
new accounts, the system would give the third user the first 5 accounts, thus bringing that
user's total to ten. The system splits the next five between the second and third, bringing their
totals to 13 and 12, respectively.

Note

The system randomly assigns these accounts.

To set up a user as Hard Assigned feature

1. Click Setup > Setup > Administration > User > Queues > Customer Service >
Responsibilities and Users.

2. In the Responsibilities section, select the level responsibility of the users you want to
hard assign in the queue.

3. Inthe Users section, check the Hard Assigned check box for each user you want to hard
assign.

4. On Setup > Setup > Administration > User > Queues > Customer Service, click
Update Queue to distribute the applications in the queue to the hard assigned users.

The system displays an Information section with the message as “Queue creation
submitted in background”.

5. Choose OK beneath the Error Message section box containing the words NO ERROR.

The system distributes and hard assigns the accounts in the queue to the selected users
in the Users section.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

To remove a user
1. Inthe Responsibilities section, select the responsibility of the user you want to remove.

2. In the Users section, select the user you want to work with.
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e Ifyou don’t want that user to be hard assigned any longer, uncheck the Hard Assigned
check box.

e If you don’t want that user to be assigned to that queue any longer, uncheck the
Enabled check box.

3. The system updates the number of accounts assigned to a user only after:
e Running the nightly batch job
e Clicking the Update Queue button.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Queue Activity

The queue Activity sub tab allows you to add specific activities which are defined in Queues
> Activity Tracking tab for the selected queue in ‘Queue Definition’ section. These activities
can be tracked for updates in Customer Service > Queue Assignment tab.

1. Inthe Queue Activity Definition section, Click ‘Add’. You can also perform any of the Basic
Operations mentioned in Navigation chapter. A brief description of the fields is given

below:

Field: Do this:

Activity Code Select the Activity Code from the drop-down list. The list
displays only those activities which are Enabled in Queues >
Activity Tracking tab.
In case the same ‘Activity’ is disabled in Queues > Activity
Tracking tab after adding it here, the same needs to be
manually disabled.

Enabled Check this box to enable the selected activity.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Call Action Results tab

1. Click Setup > Setup > Administration > User > Queues > Call Action Results. The
screen contains two sections:

e Call Actions
e Call Results

2. Inthe Call Actions section, perform any of the Basic Operations mentioned in Navigation
chapter.
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You can either define new Call Action details or specify a new action code in the New
Action field and click Create Copy to create a copy of selected call action with details.
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A brief description of the fields is given below:

Field: Do this:

Action Code | Specify the action type code.

Description Specify the description for the call action type.
Call Type Select the call type from the drop-down list.
Enabled Check this box to enable the call action.

Perform any of the Basic Actions mentioned in Navigation chapter.

4. In the Call Results section, you can define call action result codes and corresponding
descriptions. Perform any of the Basic Operations mentioned in Navigation chapter.

5. A brief description of the fields is given below:

A brief description of the fields is given below:

Advance Unit

Field: Do this:

Result Code Specify the result type code for the specified call action type.
Description Specify the description for the result type.

Report Type Select the report type for the result type, from the drop-down list.
Right Person Check this box to indicate that result type is a right person contact.
Contact

Follow-up Select the unit for advancing the follow-up date/time from the drop-

down list.

Value

Specify the value for the follow-up advance unit.

Enabled

Check this box to enable the result.

6. Perform any of the Basic Actions mentioned in Navigation chapter.
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Queues are further filtered based on the following criteria:

e Conditions
e Responsibilities

The Conditions section determines whether the selected action/result will cause the listed
conditions to be opened or closed. It also determines whether the queue will be opened or
closed.

7. Inthe Conditions section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:

Condition Select the account condition to be open/close for the action from the
drop-down list.

Condition Select ‘Open’ to open the listed condition, ‘Close’ to open the listed
condition, or ‘NA’, if the condition is not applicable.

Queue Select ‘Open’ to open the listed Queue, ‘Close’ to open the Queue, or
‘NA, if the Queue is not applicable.

Enabled Check this box to enable the account condition.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

9. Inthe Responsibilities section, define the responsibilities that are authorized to use the
call action result combination.Perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Responsibility Select the responsibility that can perform the action result from the
drop-down list.

Allowed Select 'Yes' if access is allowed.

Enabled Check this box to enable the responsibility.

10. Perform any of the Basic Actions mentioned in Navigation chapter.

Activity Tracking

The Activity Tracking tab in Queues screen allows you to define 36 different activities at any
given time. You can define unique Action and Result for each activity and also set the activity
expiry duration beyond which new actions can be defined for the same activity.
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3.7.5

The Activity defined in this tab is used in User > Queues > Customer Service > Queue Activity
tab to define activities for selected ‘Queue Definition” which in-turn is used in Customer
Service > Queue Assignments tab to track the updates from call activity results.

ORrRACLE & Viekcome, ABSHEKAR ~ 1g Signout
Financial Services Lending and Leasing
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1. In the Activity Definition section, Click ‘Add’. You can also perform any of the Basic
Operations mentioned in Navigation chapter. A brief description of the fields is given

below:

Field: Do this:

Activity Code Select the activity code from the drop-down list. The list
displays pre-defined activity codes which are enabled as part
of ‘QUEUE_ACTIVITY_TYPE_CD’ lookup code maintained in
the system.

Description View the description of activity code.

Action Select the Action for the activity from the drop-down list. The
list displays all the customer service call actions available in
the system.

Result Select the appropriate Result for the action from the drop-down
list. The list is sorted with results based on the action selected.

Activity Expiry Specify the number of days after which the activity has to

Days expire (i.e. status set ‘N’). An activity code in ‘N’ status can be
used to associate new action for tracking.

Enabled Check this box to enable the activity.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

User Groups Tab

The User Groups tab in Queues is a centralized repository which allows you to define user
groups, add and remove users from user groups.
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The User Groups tab consists of User Group Definition section listing the defined User
Groups and User section below listing the associated users of the selected User Group.
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To define a User Group

1.

On the Oracle Financial Services Lending and Leasing home screen, click Setup >

Administration > User > Queues > User Groups.

In the User Groups section, Click Add. You can also perform any of the Basic Operations

mentioned in Navigation chapter.
A brief description of the fields is given below:

Field:

Do this:

Name

Specify user group name.

Description

Specify an appropriate user group description. The same is
used while referring this User Group on other screens.

Responsibility

Select the responsibility of the user group from the drop-down
list. You can later add only those ‘Users’ who have the selected
responsibility into the user group.

Enabled

Check this box to enable the user group.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

To add Users to User Group

1.

On the Oracle Financial Services Lending and Leasing home screen, click Setup >

Administration > User > Queues > User Groups.

In the User Groups section, select the required User Group.

In the Users section, Click Add. You can also perform any of the Basic Operations

mentioned in Navigation chapter.
A brief description of the fields is given below:

Field:

Do this:

Name

Select the user from the drop-down list, The list displays the
available users based on the responsibility defined for the user

group.

Enabled

Check this box to enable the user.

3-67 ORACLE



3.8

4. Perform any of the Basic Actions mentioned in Navigation chapter.
Printers

The Printers screen allows you to set up an unlimited number of network printers and fax
devices to be used with the system server. The system uses the information on this screen
while selecting a printer, when the printing process involves a batch job or uses a job
scheduler. Examples include printing reports and correspondence.

The printers and fax devices can be set up at each organization, division, or department to
promote efficient printing of documents, and reports. The system uses this information during
product setup and on the Letters screen in the Batch Printer field.

Special printer names

The following printer names are predefined and have specific functions within the system:

Name Description

UNDEFINED Indicates that the document to be printed is to be previewed in your
browser instead of actually printing the document.

ARCHIVE Instead of sending an item to the printer, the system generates a
PDF document and saves it in the archive directory on your server.

EMAIL For Loan origination correspondences that can be faxed, the system
e-mails the document as a PDF attachment to the consumer for
direct Loans or to the producer in the case of in-direct Loans.

FAX For Loans origination correspondences that can be faxed, the sys-
tem generates a PDF document and will send to the fax server
defined in System Parameters.

Additionally, you may set up composite entries in the Printer Name field to perform two or
more functions at the same time. This can be done by defining a printer name with the
following format:

PRINTER NAME = <PRINTER NAME1> + <PRINTER NAME2>

For example, if a printer named JET4050 was previously defined, as were the special printer
names listed above, then the following additional printers could be defined:

Name Description

JET4050+ARCHIVE Prints the document with the jet4050 printer and archives the
document.

FAX+ARCHIVE Faxes and archives the document.

EMAIL+ARCHIVE+]J | E-mails, archives, and prints the document with the jet4050
ET4050 printer.

To set up the Printers

1. Click Setup > Setup > Administration > User > Printers. The system displays the
Printers screen
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2. In the Printers section, perform any of the Basic Operations mentioned in Navigation

chapter.
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A brief desc

ription of the fields is given below:

Field:

Do this:

Printer Name

be: \\servername\jet4050

Specify the printer name. The name of the printer as defined by the
server. For a UNIX server, the name might be JET4050, while to
access the same printer from a Windows server the name would

Description

Specify the description for the printer.

selected.

Organization Select the organization to which the printer belongs, from the drop-
down list.
Division Select the division to which the printer belongs, from the drop-

down list. The division will be displayed based on the organization
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3.9

3.9.1

Field: Do this:

Department Select the department to which the printer belongs, from the drop-
down list. The department will be displayed based on the division
selected.

IMPORTANT: When you select a printer to use, the system
searches for a best match using the following attributes:

1 Organization
2 Division
3 Department

Hence, Oracle recommends creating a version of each edit, where
ALL is the value in these fields.

It is also recommended that, you define a default printer for an
Organization, Division and Department.

Default Check this box to set the printer as a default printer.

Enabled Check this box to enable the printer and that the printer is active.
Note: Never disable the UNDEFINED printer.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Intelligent Segmentation

OFSLL is equipped to leverage the Machine Learning (ML) feature of Oracle Database to
suggest and create Customer Servicing Queues by analysing the current system data. Using
this functionality, system automatically identifies the possible Queue/Segmentation for
Account data using the Machine Learning Algorithm thereby creating an Intelligent
Segmentation.

This helps to automate the manual process of queue creation which is otherwise done by
identifying different segments of Accounts and assigning day to day Customer Service
Activities. Further queue processing workflow continues as detailed in ‘Queues’ section.

Machine Learning for Queue Creation

The Intelligent Segmentation screen in OFSLL is based on the Oracle JavaScript Extension
Toolkit (Oracle JET) framework. This facilitates to identify different clusters of data and create
queues.

In order to access the Intelligent Segmentation screen from the User Interface menu link, you
need to enable the system parameter FLL_SET JET INTELLIGENTSEG_URL (JET
INTELLIGENT SEGMENTATION URL). For more details on installing and deploying this
feature in OFSLL, refer to Installation Manual.

In this screen, you do the following:

Identify Create View Create

Conditions Clusters Hierarchy Queue

e Identify Cluster of Data for a given Account Condition.
e View hierarchy of cluster and list of accounts falling into different levels of cluster.
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e Create a queue by selecting Cluster

3.9.2 Machine Learning Data visualization

The data generated by the system is represented in the following view formats.

3.9.2.1 Cluster view

ORACLE # Welcome, ABSHEKAR v 1g Sign out &
Financial Services Lending and Leasing

Intelligent Segmentation x (3] Close:
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Segment  Insights
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3.9.2.2 Segment View
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# Cluster-10(28) Cluster-12(31
Cluster-5(32) Cluster-933)  Cluster-11(56)
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3.9.2.3 Insights View

ORACLE’
Financial Services Lending and Leasing

# Welcome, ABSHEKAR v 1g signout &

Intelligent Segmentation x
" * "
Company Branch Account Conditions

ALL v ALL v DELINQUENT

Clusters ~ Segment Insights

Cluste 612 Clusterd: 13
Record Counts 31 Record Count 31

(3] Close

3.9.2.4 Selection Criteria Attributes

Clicking on any of the data segment system displays dynamic record details (Attribute Name

and Attribute Value) along with the option to create queue.

Records of Cluster - 7

ATTRIBUTE_NAME
ACC_COLLATERAL_TYPE_CD
ACC_DLQ_CATEGORY
ACC_DLQ_DAYS
ACC_DUE_TOTAL_AMT

ACC_OUTSTANDING_TOTAL_AMT

ATTRIBUTE_VALUE

HOME

180

211.857 to 392.714

0to 296121

-10985 to 62604.5

3-72

ORACLE



3.9.3 View Machine Learning Generated Queue

To view ML based queue

1. Click Setup > Setup > Administration > User > Intelligent Segmentation. The
following screen is displayed:

orAcLE

Financial Services Lending and Leasing

A

Intelligent Segmentation x \E‘ Close

Company * Branch * Account Conditions *

select v select select v Submit

No data to display

2. Select the following option:
Field: Do this:
Company Select the company from the drop-down list. The list is populated

only with those Company Definitions to which you have been pro-
visioned access.

Branch Select the branch within the company from the drop-down list. This
may be ALL or a specific branch. This must be ALL, if you have
selected ‘ALL’ in the Company field.

Account Condi- | Select the required account conditions. There are various Account
tions Conditions which are either posted ‘automatically’ by the system
(like updating DELQ delinquency condition on account) or ‘manu-
ally’ through a transaction or call activity.

3. Click ‘Submit’. System generates different data segments based on above selected
combination using a background job process. By default, the data is represented in
clusters and can be viewed on other view formats as detailed in ‘Machine Learning Data
visualization’ section.

3.9.4 Create ML Based Queue

On generating the data segments in the Intelligent Segmentation screen, you can further drill
down to each cluster and view details with different selection criteria. However, the details of
each record is based on the data maintained in the system.
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3.10.1

Button

Action

Create

Clicking on this option creates a Queue in OFSLL and the selection
criteria of the Queue is populated with the Cluster Attributes. The
queue sequence is based on Queue name/Description and is dis-
played as a confirmation message in the format ‘Queue ML <Account
Condition > <Date YYYYMMDD > <Time HHMMSS> created success-
fully’.

@ Queue Created Successfully X

Queue ML_DELO_20201209_011239 created successfully

The newly created queue is available in Setup > Administration > User
> Queues screen.

Note that following with ML generated Queues:

e All Queues are created in ‘Disabled’ status with Selection Criteria ‘Enabled’.
e Periority is defaulted to 0.

e Company/Branch is defaulted to selected combination.

e Hard Assigned/Group Follow-up/Near Real-Time/Dialler actions are marked as

disabled.

Currencies

The Currencies link allows you to set up currency details.

Navigating to currencies

1. Click Setup > Setup > Administration > User > Currencies. The system displays the
Currencies screen. In this screen, you can set up:

e Currency Definition

e Currency Pair Definition

Currency Definition

The Currency Definition screen allows you to set up currency details.

To set up the currency definition information

1. Click Setup > Setup > Administration > User > Currencies > Currency. The system
opens the Currency Definition tab by default.
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2. In the Currency section, perform any of the Basic Operations mentioned in Navigation
chapter.

ORACLE'
Financial Services Lending and Leasing

% Welcome, PRAKRRAD = o

i Close
e Currendies e

> Origination Currency | Currency Pair
> Servicing
> Gollactions Currency Fadd | Ledt | B vew | o2 Audit
- WEP View » Fomat~ By Freeze it Detach 1l wrap 5]
o ral Currency Currency Name Country Enabled
ools

Setup INR INDIAN RUPEE INDIA

EUR EURO IRELAND
A Py JAPANESE YEN JAPAN

OMR AL SAUDI ARABIA
usp US DOLLAR UNITED STATES

Translations
User
Organization
Companies
Access
Users Currency
Credit Bureau saveandadd || [ save and stay || [ seve and Retumn || G Retum
Correspondence
Generel Ledger * Currency - * Enabled [
Queues
Printers Currency Name
Bank Details * Country [v]
Chack Details
Standard Payees 1
Currencies
Zip Codes
Products
Asset Types
Index Rates
Currency Exchange
Scoring Parameters
Products
Pricings
Contract
Edits
Cydles
Scoring Models
Fees
Origination Fees
Compensation
‘Commission
Insurance
Checklists.
Stipulations
Spreads
Statement Messages
Letters

A brief description of the fields is given below:

Field: Do this:

Currency Select the currency you want to define, from the drop-down list.

Currency Name The system displays the currency name based on the currency
selected.

Country Select the country for which the currency is defined, from the drop-
down list.

Enabled Check this box to enable the currency entry.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.10.2 Currency Pair link

The Currency Pair Definition link allows you to set up currency pair details.

To set up the currency pair definition information:

1. Click Setup > Setup > Administration > User > Currencies > Currency Pair. The
system displays the Currency Pair Definition screen
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2. Inthe Currency Pair Definition section, perform any of the Basic Operations mentioned
in Navigation chapter.

ORACLE ) ) 1 2. Welcome, PRAKGRAO = =]
Financial Services Lending and Leasing
DashBoard Cmmeader x g
» Origination Currency  Currency Pair
> Servicing
> Collections Currency Pair Fadd | A Edt | [Eview | oF audit
- WEP View » Formatv [Ep Fresee i Detach I Wrap W
> Tools Cumency Cumency Pair Code Thiough Curency  T1T0Ush CUTEncy  ggpieq
Setup | o
s EUROD RIAL OMANI N ¥
e o EURD YEN N ¥
i EURO US DOLLAR N ¥
Organization e i % #
Zoi o] YEN US DOLLAR N id
AeES RIAL OMANI EURO Y US DOLLAR Y
“55: RIAL OMANI YEN ¥ US DOLLAR Y
Credt Bureau : : -
Comsspancence 2 s 5 .
General Ledger s N o
Quauss RIAL OMANI N ¥
fraizn EURO N EURO N
Bank Details INDIANRUPEE  VEN N 3
Check Details
i"‘”d""j Payees 4 Currency Pair
;;":;: [ save and 2dd || [l Save and Stay || [ save and Retumn || <2 Retum
Products
Asset Types * Currency [v] Through Currency Code [v]
';:f_a:nzi‘imga *Cumrency Pair Code ~] = Erabled []
Scoring Parameters * Through Currency [
Products
Pricings
Contract
Edits
Cydes
Scoring Models
Fess
Origination Fees
Compensation
Commission
Insurance
Checklists
Stipulations
Spreads
Statement Messages
Leftars b
A brief description of the fields is given below:
Field: View this:
Currency Code Select the currency code from the drop-down list.

Currency Pair Code Select the currency pair code from the drop-down list.

Through Currency Check this box to set the selected currency as a through cur-
rency.
Through Currency Select the through currency code from the drop-down list.

Code

Enabled Check this box to enable the currency pair entry.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

3.11 Zip Codes

The Zip Codes screen allows you to set up zip code details.

To set up the zip codes information

1. Click Setup > Setup > Administration > User > ZipCodes. The system displays the Zip
Codes screen
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2. Inthe Zip Codes section, perform any of the Basic Operations mentioned in Navigation

chapter.

ORACLE’

Financial Services Lending and Leasing

DashBoard
> Origination
> Servicing
> Collections
> WFP
> Teols
Setup
Setup
Administration
System
System Parameter
Loakups
User Defined Tables
audit Tables
User Defined Default
Transaction Codes
Data Files
Dedupe
Securitization

Collection Cycles
Reports
Ertor Messages

Translations
User

Organization

Companies

Access

Users.

Credit Bureau

Correspondence

General Ledger

Queues

Printers

Bank Details

Chack Details

Standard Payess

Currencies

Zip Codes
Products

< >

A brief description of the fields is given below:

UNITED STATES  PUERTO RICO
UNITED STATES  PUERTO RICO
UNITED STATES  PUERTO RICO
UNITED STATES  PUERTO RICO
UNITED STATES  PUERTO RICO
UNITED STATES ~ PUERTO RICO
UNITED STATES  PUERTO RICO
UNITED STATES  PUERTO RICO
UNITED STATES ~ PUERTO RICO
UNITED STATES  PUERTO RICO
UNITED STATES  PUERTO RICO
UNITED STATES  PUERTO RICO
UNITED STATES  PUERTO RICO
UNITED STATES ~ PUERTO RICO
UNITED STATES  PUERTO RICO
UNITED STATES  PUERTO RICO
PUERTO RICO
PUERTO RICO
US VIRGIN ISLANDS
US VIRGIN ISLANDS
US VIRGIN ISLANDS
US VIRGIN ISLANDS

Zip Codes

*Country UNITED STATES

Zip Codes 3
Zip Codes
View~ Formatv [} Frezze [ Detach
Country State

*Zip

=iy

COAMO

LAS PIEDRAS.
LoTZA

LUQUILLO
CULEBRA
JUNCOS
GURAEO

COTO LAUREL
PONCE
COMERIO
COROZAL
GUAYAMA
GUAYAMA

LA PLATA
HUMACAO
HUMACAO
BARRANQUITAS
JUANA DIAZ
CHARLOTTE AMA
CHARLOTTE AMAL
ST THOMAS
CHARLOTTE AMA
CH AMAL

[ saveand add | [ SaveandStay | [ Seve and Retun | (3 Retum

* ZipStatecd

County

COAMO A
LAS PIEDRAS

LOIZA

LUQUILLO

CULEBRA

JuNCos

GURABO

PONCE

PONCE

COMERIO

COROZAL

GUAYAMA

GUAYAMA

ATBONITO

HUMACAQ

HUMACAO
BARRANQUITAS

JUANA DIAZ
SAINT THOMAS
SAINT THOMAS
SAINT THOMAS
SAINT THOMAS
SAT MAS

Field:

View this:

Country

Select the country from the drop-down list.

State

Select the state from the drop-down list.

Zip Code

Specify the zip code (required).

City

Specify the city.

County

Specify the county.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Payment Hierarchy

The Payment Hierarchy screen facilitates to define hierarchy definition along with payment
appropriation, excess payment handling, account selection criteria and sort order. These
details are required by the system to allocate payments to the matching accounts of a
customer, when customer based payments are being processed in ‘Payment Entry’ screen.
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Below is an illustration on how payment hierarchy is used to post customer based payments.

Y

< Payment Hierarchy Setup
-+

P t T, ti
ayn.-q.en;,..._r_.an—sfc on Customer

Ul f Service Call)

Fy
v
¥

>
id Master Account
>

Spreads
{Funds appropriation sequence by
balance type i.e. Charges, Interest,
Principle and =o on}

{Generic Payment Upl

Payment Batch ‘

Any Payment transaction generated in the system either from Ul / Web Service Call or through
a Payment Batch (Generic Payment Upload) can be directly posted to an Account or at
Customer level.

e Ifpaymentis posted directly to an Account, the funds are allocated based on the defined
spread with funds appropriation sequence of balance type i.e. Charges, Interest,
Principle and so on.

o If paymentis posted at Customer level having two accounts and if the payment amount
is less than the due, then appropriation sequence is required. Else, one of the account
can have a short fall with payment allocation.

In such case, the Payment Hierarchy determines the sequence of payment as to which
account is to be appropriated first and which is to be appropriate next. This is based on 'order
by clause' and ‘appropriation sequence’ defined.

Also the Balance Type determines the distribution type as one of the following:

e Equally to all the accounts
e Prorated by Due amount (i.e. highest due or lowest due first)
e Prorated by Outstanding Amount.

Once the account is narrowed down and payment amount is decided, then based on spread
the payment is appropriated. This gives additional flexibility for defining payment modes at the
master account level.

If Payment Hierarchy is not defined while funding an application or needs correction, the same
can be done by posting ‘MASTER ACCOUNT PAYMENT HIERARCHY MAINTENANCFE’
non-monetary transaction in Servicing > Maintenance > Transaction Batch Information
section. At Customer level, Payment hierarchy can be updated by posting CUSTOMER
MAINTENANCE transaction.

Payment Appropriation Methods

While creating Hierarchy definition in the Payment Hierarchy screen, you can use any of the
following payment appropriation methods available in Hierarchy Type field. On selecting the
specific Hierarchy definition at Application or Account level, the defined method is used to
allocate payments to corresponding accounts.
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However in all the methods, the payment criteria is also used for identifying the due accounts
and careful consideration is required while defining the same.

Method Description
EQUAL To allocate payment equally to all the accounts picked.
AMOUNT

This is traditional method of payment allocation in which the total
payment amount received is divided and adjusted equally to all cus-
tomer linked accounts.

DUE AMOUNT To allocate payment based on the ratio of amount due on all
RATIO accounts.

In this method, the due accounts are identified based on the defined
selection criteria and the payment appropriation is done on the ratio
of amount due on each account using the below formula.
Amount Due ~ Payment Amount
Total Due Amount

Following is an illustration on payment allocation:

Amount Due Outstanding Amount
Master Account 30 200
Associated Account 1 50 250
Associated Account 2 100 400

Due Amount Ratio |Outstanding Amount Ratio |Equal Amount
Payment Amount 590 590 590
Master Account 515 521.18 530
Associated Account 1 525 526.47 530
Associated Account 2 550 542.35 530

OUTSTANDING To allocate payment based on the ratio of total outstanding due on
BALANCE RATIO | all accounts.

Similar to above, even in this method the due accounts are identified
based on the defined selection criteria and the payment appropria-

tion is done on the ratio of outstanding amount due on each account
using the below formula.

Outstanding Balance + Payment Amount
Total Qutstanding Balance

This method can be selected if the received payment amount is
equal to total outstanding due on all linked accounts indicated in
Customer Service > Transaction History > Balances screen.

ACCOUNT COL- | To allocate payment based on hierarchy order.

UMN BASED In this method, the due accounts are identified based on the defined

selection criteria and the payment appropriation is done as per the
sequence of due accounts defined either in ascending/descending
order.

During payment appropriation, system allocates the payment amount only up to the total of
resulted accounts and remaining amount (if any) are processed based on the excess payment
method value.
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3.12.2

While onboarding accounts through web services, system considers the value of system
parameter PMT_HIERARCHY_CODE to default the payment allocation in Customer/
Business Details screen after account activation.

Also while onboarding if the Payment Hierarchy is not passed as part of the request
(Applicant/Application), then system parameter value is considered.

Excess Payment Appropriation

During or after payment appropriation, there can be a residual amount pending for allocation.
For example, $0.01 remains when $100 is equally paid to 3 accounts. In such case the
residual amount is transferred to last account in the hierarchy sequence. However, note that
system performs this residual payment allocation only once.

In other case where there in an excess payment received which is more than account dues,
the same can be processed for payment allocation using any of the following ‘Excess
Handling Method’ while defining the Hierarchy Definition.

Method Description

SUSPENSE To post the excess amount as suspense on Customer or Master
account.

HIERARCHY To allocate the excess payment based on any of the Hierarchy Defi-

BASED nitions maintained in the system.

Based on the selection, system re-allocates the excess amount to corresponding accounts.
To set up payment hierarchy
1. Click Setup > Setup > Administration > User > Payment Hierarchy.

2. In the Hierarchy Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’ # Welcome ABSHEKAR ~ o
Financial Services Lending and Leasing
&
Payment Hierarchy 3] Close
Hierarchy Definition P Add | 2 Edit | ] view | o Audit
View v Format v [E52 Freeze [ Detach wap @
Name Description Hierarchy Type Excess Handling Method ~ Excess Hierarchy Name Enabled
TEST_PH1 TEST_PH1 ACCOUNT COLUMN BASED HIERARCHY BASED PH1 Y ~
PAYMENT3 PAYMENT3 DUE AMOUNT RATIO SUSPENSE Y
PAH_TEST2 PAH_TEST2_DESC EQUAL AMOUNT HIERARCHY BASED TEST_PH2 Y
OUTSTANDING BALANCE OUTSTANDING BALANCE OUTSTANDING BALANCE RATIO HIERARCHY BASED PAYMENT_COLUMNBASED Y
M_PH2 M_PH2 OUTSTANDING BALANCE RATIO SUSPENSE Y v
i & >
Account Selection Criteria  Hierarchy Order
Account Selection Criteria P Add | ZEdit | [ View | o Audit
View v Format~ [ Freeze Eff Detach Wrap @) o Check Criteria
Comparison —_— Logical
Seq ( Parameter Operator Criteria Value ) Operator Enabled
0 DELINQUENT DAYS LESS THAN OR EQ... 0 7

A brief description of the fields is given below:

Field: View this:

Name Specify an unique name for the hierarchy definition.

Description Specify the description for the hierarchy definition.
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Field: View this:
Hierarchy Select one of the following type of payment allocation method from the
Type drop-down list. The list is populated based on the PMT_HIERARCHY _-
TYPE_CD lookup.
- EQUAL AMOUNT
- DUE AMOUNT RATIO
- OUTSTANDING BALANCE RATIO
- ACCOUNT COLUMN BASED
For more information on the above methods, refer to ‘Payment Appropri-
ation Methods’ section.
You can define multiple Hierarchy definitions with same Hierarchy type.
Excess Han- | Select one of the following type of excess payment allocation method to
dling Method | be used with payment hierarchy definition from the drop-down list. The
list is populated based on PMT_HIERARCHY_EXCESS_METHOD_CD
lookup.
- SUSPENSE
- HIERARCHY BASED
For more information on the above methods, refer to ‘Excess Payment
Appropriation’ section.
Excess Hier- | This field is enabled and is mandatory if the Excess Handling Method is
archy Name | selected as ‘Hierarchy Based'.
Select the Hierarchy Definition from the drop-down list. This list is popu-
lated with all the pre-defined and enabled hierarchy definitions main-
tained in the system.
For more information on the above methods, refer to ‘Excess Payment
Appropriation’ section.
Enabled By default this check box is enabled for new hierarchy definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Account Selection Criteria

This sub tab facilitates to define the account selection criteria that is used to identify due
account for payment allocation. Atleast one valid account selection criteria is required for all
the Hierarchy Types.

1. Inthe Account Selection Criteria section, perform any of the Basic Operations mentioned
in Navigation chapter. A brief description of the fields is given below:

Field: Do this:

Seq Specify sequence numbers.

( Specify left bracket.

Parameter Select the parameter from the drop-down list. The list is

populated based on the values maintained in CUSTOMER
PAYMENT HIERARCHY ORDER PARAMETERS user
defined table.
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Field:

Do this:

Comparison Operator

Select comparison operator from the drop-down list.

Criteria Value

Specify criteria value.

)

Specify right bracket.

Logical Expression

Select logical operator from the drop-down list.

Enabled

Check this box to enable the selection criteria.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

3. You can click ‘Check Criteria’ for system to validate the query and display the results.

Hierarchy Order

This sub tab facilitates you to define hierarchy order that is used to sort the due account for
payment allocation. This sub tab is enabled only for ACCOUNT COLUMN BASED’ Hierarchy

type.

1. In the Hierarchy Order section, perform any of the Basic Operations mentioned in
Navigation chapter. A brief description of the fields is given below:

Field: Do this:
Seq Specify sequence number.
Sort Field Select sort field from the drop-down list. The list is populated

based on values maintained in CUSTOMER PAYMENT
HIERARCHY ORDER PARAMETERS user defined table.

Order Select sort order as either Ascending or Descending from the
drop-down list.

2. Perform any of the Basic Actions mentioned in Navigation chapter.
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4. Product

Under the Setup master tab’s drop-down link bar, the product Setup link opens screens that
enable you to configure the basic business guidelines necessary to support one or more
products in the system. This includes defining the types of collateral your company supports,
creating lending instruments, and determining what is included in credit bureau reporting.
Setting up the Products screens requires a thorough understanding of the current rules of
your business and must be completed before you can use Oracle Financial Services Lending
and Leasing. The Products drop-down link opens screens to record data of all the products
supported by the system and contains the following links:

Navigating to Products

In the Setup > Setup > Products link enables you to setup the options related to following
closed ended products your company offers:

e Asset Types

e Regulatory Rates

e Scoring Parameters
e Contract

e Fees

e Asset Billing Rate

e Checklists

e Statement Messages
e Letters

e Subvention

This chapter explains how to setup the screens associated with each one.

Asset Types

In Assets types you can setup the asset types that can serve as an application or account’s
collateral.

The information on the Assets screen is used by the system to automatically display the
appropriate collateral screen (Vehicle, Home, or Other) on the Application Entry screen.

The system recognizes the following four types of collateral:

Collateral Type Description
Home collateral Homes, manufactured housing, or any real estate collateral.
Vehicle collateral All vehicle types, such as cars, trucks, and motorcycles.

Household goods All other collateral types not defined as home, vehicle, or
and other collateral | unsecured; for example, household items such as water heaters,
televisions, and vacuums.

Unsecured All unsecured lending instruments. (This collateral type makes
collateral the collateral tabs on the system forms unavailable.)

The Asset Sub Type section allows you to further categorize an asset; for example, the asset
type VEHICLE might be categorized as CAR, TRUCK, or VAN.
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The Attributes/Addons and Makes and Models sub screens continue to further detail the asset
both in description and value. For example, a VEHICLE asset might include addons such as
LEATHER SEATS and CRUISE CONTROL.

Note

Neither asset types nor asset sub types can be deleted. As they may have been used in
the past, the display and processing of that data is still dependent on the existing setup.

To set up the Asset Types

You can either define new Asset Type or specify a new name in the New Asset Type field
and click Create Copy to create a copy of selected asset with details.

1. Click Setup > Setup > Products > Asset Types.

2. Inthe Asset Type section, perform any of the Basic Operations mentioned in Navigation

chapter.

ORACLE

Financial Services Lending and Leasing

Asset Types 3. [ <
Asset Type dApadd || Pedt | [Fuew | of Audt
View v Format v B Freeze i Detach i wrap @ New AssetType Create Copy
Asset Type Description Collateral Type Company Branch Enabled
BUs BUs VEHICLE COLLATERAL AL AL v
BUs_TEST BUS_TEST VEHICLE COLLATERAL AL AL ¥
car R VEHICLE COLLATERAL AL AL v
CAR_CP CAR_CP VEHICLE COLLATERAL ALL ALL N
CAR_CPZ CAR_CP2 VEHICLE COLLATERAL ALL ALL N il
Asset Sub Type o | i
View v Format~ B Freeze g Detach ®
Asset Sub Type Description Asset Property Type Enabled
MINL BUS MINI BUS INDERMINATE ¥
»
Asset Sub Type
[ save ane dstay | [ SaveandRewm || GaRetumn
Asset Sub Type MINI BUS * Enabled [¥]
* iption  MINL BUS
et Property Type | INDERMINATE [=]
Attributes / Addons  Makes and Models  Usage/Rental Details  Usage Charge Matrix  Rental Charge Matrix
Asset Attributes + S Edi %
View ~ Format~ | B eze [l Detach rap ®
Attribute/Addon Description Default Value Enabled
No data to display.

A brief description of the fields is given below:

Field: Do this:
Asset Type Specify the asset type.
Description Specify the description for the asset. (This is the asset type which will

appear throughout the system).

Collateral Type

Select the collateral type (the general category that the asset type
falls within) from the drop-down list.

Note: There is no need to define an asset for UNSECURED
COLLATERAL, as by definition there is no asset on such account.

Company

Select the portfolio company to which the asset type belongs, from
the drop-down list. These are the companies within your organization
that can make Loans using this asset type. This may be ALL or a
specific company.
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Field: Do this:

Branch Select the portfolio branch to which the asset type belongs, from the
drop-down list. This is the branch within the selected company that

can make Loans using this asset type. This may be ALL or a specific
branch. This must be ALL if in the Company field you selected ALL.

IMPORTANT: By selecting which asset type to use, the system
searches for a best match using the following attributes:

1 Company
2 Branch

Hence, the system recommends creating one version of each asset
type where ALL is the value in these fields.

Enabled Check this box to enable the asset type and indicate that the asset
type is currently in use.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Asset Sub Type section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:
Asset Sub Type Specify the asset sub type.
Description Specify the description for the asset subtype

Asset Property Type | Select the type of property from the drop-down list.

Enabled Check this box to enable the asset sub type.

5. Perform any of the Basic Actions mentioned in Navigation chapter.
6. Click Setup > Setup > Products > Assets > Attributes/Addons.

7. In the Attributes/Addons section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Attribute/Addon Displays the asset attribute or addon name for the selected asset).

Description Select the description for the asset attribute/addon from the drop-
down list.

Default Specify the default text to be copied or displayed when the asset
attributes and addons fields are completed on an application for
this asset.

Value Specify the default monetary value to be copied or displayed when
the asset attributes and addons fields are completed on an
application for this asset.
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Field: Do this:

Enabled Check this box to enable the asset attribute/Addon and indicate

that it is available for this type of asset.

8. Perform any of the Basic Actions mentioned in Navigation chapter.
9. Click the Setup > Setup > Products > Assets > Makes and Models.

10. In the Makes and Models section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Make Specify asset make.
Model Specify asset model.
Style Specify asset style type.

Model Year Specify asset model year.

Enabled Check this box to enable the asset make and model and indicate that it
is included on fields for this asset type.

11. Perform any of the Basic Actions mentioned in Navigation chapter.

Usage/Rental Details

The Usage / Rental Details sub tab allows you to define Usage/Rental definition details to
categorize the incoming asset usage/rental data based on different parameters. The details
maintained here are populated in Origination screen for billing calculation and can also be
modified based on requirement.

For more information on how OFSLL handles Usage based leasing, refer to Appendix - Usage
Based Leasing chapter and for Rental based leasing, refer to ‘Rental Agreement’ section in
Lease Origination User Guide.

1. In the ‘Usage/Rental Details’ section, perform any of the Basic Operations mentioned in
Navigation chapter.
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2. A brief description of the fields is given below:

Field: Do this:

Agreement Select the agreement type as one of the following from the drop-down

Type list. The selected Agreement Type defines the criteria for pricing
selection during billing calculation.
- USAGE
- RENTAL

- USAGE RENTAL

Note: Based on the above selected option, the other fields are either
enabled or disabled for selection as indicated below:

For Usage Agreement Type, the following fields are editable:

e Calc Method
e Usage Cycle
e Min Usage
e Max Usage
e Discount %
e Usage Rollover / Advance
e Usage Term Calc Method
For Rental Agreement Type, the following fields are editable:
e Discount %
e Discount Amount
e Security Deposit
For Usage Rental Agreement Type, the following fields are editable:
e Usage Cycle
e Max Usage
e Discount %
e Discount Amount
e Security Deposit

Calc Method | Select the calculation method as one of the following from the drop-
down list.

- TIERED (billing is based on the defined Usage/Rental Charge Matrix)

- NON-TIERED (system automatically chooses the applicable slab
based on the final usage value)

Usage Cycle | Select the frequency of billing the asset usage from the drop-down list.
This field is disabled for RENTAL agreement type.

Min Usage Specify the minimum usage value of the allowed range. This field is
disabled for RENTAL agreement type.

Max Usage Specify the maximum usage value of the allowed range. This field is
disabled for RENTAL agreement type.

Discount % Specify the percentage of discount exempted from final billing.
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Field: Do this:

Usage Select the type of asset usage calculation as one of the following:
Rollover /

Advance - ROLLOVER (remaining usage balance is carried forward to next cycle)

- NO-ROLLOVER (remaining usage balance is not carried forward)

- ROLLOVER AND ADVANCE (remaining usage balance is carried
forward to next cycle + total usage limit for current cycle can be utilized
upfront)

- ADVANCE (total usage limit for current cycle can be utilized upfront)

Note: This field is disabled for RENTAL and USAGE RENTAL
agreement type and ‘NO-ROLLOVER’ option is applicable by default.

Reset Specify the reset frequency of the billing cycle. This field is disabled for
Frequency RENTAL and USAGE RENTAL agreement types and is available for
ROLLOVER, ADVANCE and ROLLOVER AND ADVANCE methods of
asset usage billing.

Usage Term | Select the type of asset usage term for billing calculation as one of the
Calc Method | following from the drop-down list:

- ACTUAL - here the current details updated/received is treated as the
final record for usage term calculation.

- AVERAGE - here system takes the average of usage details received
in previous cycles for usage term calculation.

The calculation method selected here is populated to ‘Elastic Term Calc
Method’ field in Origination/Servicing Collateral screen. This field is
disabled for RENTAL and USAGE RENTAL agreement type.

Discount If you are defining Usage/Rental Details for RENTAL or USAGE

Amount RENTAL type of agreements, specify the discount amount allowed
upfront from the final billing. This field is disabled for USAGE agreement
type.

Security If you are defining Usage/Rental Details for RENTAL or USAGE

Deposit RENTAL type of agreements, specify the security deposit amount paid

upfront for the term. This field is disabled for USAGE agreement type.

Excess Rent | If you have selected the Agreement Type as USAGE RENTAL, select
Collection one of the following type of Charge Matrix to be used to derive the
Method Excess Rent Collection Method from the drop-down list.

- USING USAGE MATRIX
- USING RENTAL MATRIX

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.1.2 Usage Charge Matrix

The Usage Charge Matrix sub tab allows you to define and maintain different chargeable
slabs based on the combination of Billing Cycle and Charge Type. The details maintained
here are used for billing calculation based on a particular asset usage.

For more information on how OFSLL handles Usage based leasing, refer to Appendix - Usage

Based Leasing chapter and for Rental based leasing, refer to ‘Rental Agreement’ section in
Lease Origination User Guide.

4-6 ORACLE



41.3

1. Inthe ‘Usage Charge Matrix’ section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Billing Cycle | Select the frequency of the billing cycle for the asset from the drop-down
list.

Units From Specify the minimum number of units from which the current usage
charge matrix is applicable.

Charge Per Specify the amount to be charged for every unit.
Unit

Charge Type | Select the Charge Type as one of the following from the drop-down list.
The list is displayed based on CHARGE_TYPE_CD lookup.

- BASE (Units considered as base and chargeable at base rate)

- EXCESS CYCLE (Units beyond base units and chargeable considering
excess cycle)

- EXCESS LIFE (Units exceeding the total contracted units and
chargeable considering excess life cycle)

Excess life is not applicable for Rental agreement type.

Enabled Check this box to enable the charge matrix for usage calculation.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Rental Charge Matrix

The Rental Charge Matrix sub tab allows you to define and maintain different chargeable
slabs based on the combination of Billing Cycle, Rental Duration, Charge Per Cycle and
Charge Type. The details maintained here are used for billing calculation based on a
particular asset usage.

For more information on how OFSLL handles Usage based leasing, refer to Appendix - Usage
Based Leasing chapter and for Rental based leasing, refer to ‘Rental Agreement’ section in
Lease Origination User Guide.

1. In the ‘Rental Charge Matrix’ section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Billing Cycle | Select the frequency of the billing cycle for the asset from the drop-down

list.
Rental Specify the minimum duration for which the rental charge is applicable.
Duration
From

Charge Per Specify the amount to be charged for every rental cycle.
Cycle
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4.2

Field:

Do this:

Charge Type

Select the Charge Type as one of the following from the drop-down list.
The list is displayed based on CHARGE_TYPE_CD lookup.

- BASE (Chargeable units exceeding from base units allowed)
- EXCESS CYCLE (Chargeable units exceeding from billing cycle units)
- EXCESS LIFE (Chargeable units exceeding the total contract term)

Excess life is not applicable for Rental / Usage, Rental agreement types.

Enabled

Check this box to enable the charge matrix for usage calculation.

2. Perform any of the Basic Actions mentioned in Navigation chapter.

Regulatory Rates

Regulatory rate is the interest rate offered while funding a loan contract which may or may not
vary from the contract rate (market rate). The regulatory rates tab allows you to maintain
various regulatory rate definitions with specific interest rates and criteria which are used in
Origination > Contract screen while defining a loan contract with imputed interest. For more
information, refer to ‘Imputed Interest’ section in Loan Origination User guide.

To set up Regulatory Rates

1. Click Setup > Setup > Products > Regulatory Rates.

2. In the ‘Regulatory Rates Definition’ section, perform any of the Basic Operations
mentioned in Navigation chapter.

ORACLE’

Financial Services Lending and Leasing

& Welcome, ABSHEKAR ~ g signout &

Regulatory Rates

Regulatory Rates Definition

Regulatory Rates Definition

Name IMP-TTRZ
* Desaription IMP-ITR2
*Start Dt 11/29/2000
End Dt 12/31/4000
*Enabled [7]
*Rate 8.0000

view v Format v & Freeze i Detach
Name Description Start Dt
IMP-ITR2 IMP-TTR2 11/23/2000
IMP1ITR2 IMP1ITR2 11/25/2000
«

Requlatory Rates

End Dt Enabled Rate
12/31/4000 E 8,0000
12/31/4000 Y 6.0000

%
%

oduct ALL

* AssetClass ALL

MONTHLY

Branch
AL
AL

Biling Cyde
MONTHLY
MONTHLY

=
=
=
[=]
[

* Asset Model ALL [=]

*Curency AL =]

*State ALL [=

3. A brief description of the fields is given below:

Field:

Do this:

Regulatory section

Name Specify an unique name for the regulatory rate definition. This field
is not editable once you save the record.

Description Specify a description for the regulatory rate definition.

Start Dt Select the start date from when the regulatory rate definition is

effective using the adjoining calendar.
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Field: Do this:

End Dt Select the end date up to when the regulatory rate definition is
effective using the adjoining calendar.

Enabled Check this box to enable the regulatory rate definition.

Rate Specify the regulatory interest rate to be used for calculation. The

rate specified here is populated to Origination > Contract screen
while defining loan contract with imputed interest.

Selection Criteria section

Company

Select the company for the instrument from the drop-down list.
This may be ALL or a specific company.

Branch

Select the branch within the company for the instrument from the
drop-down list. This may be ALL or a specific branch. This must
be ALL, if you have selected ‘ALL’ in the Company field.

Billing Cycle

Select the billing cycle frequency for the instrument as one of the
following from the drop-down list.

o MONTHLY (Default)
o WEEKLY

o BIWEEKLY

o QUARTERLY

o SEMI ANNUAL

o ANNUAL

Product

Select the product for the instrument from the drop-down list. This
may be ALL or a specific product defined in the system.

Asset Class

Select the asset class for the instrument from the drop-down list.
This may be ALL or a specific asset class. The list is populated
based on Class setup defined in the system.

Asset Type

Select asset type for the instrument from the drop-down list. This
may be ALL or a specific asset type. The list is populated based
on Asset Types setup defined in the system.

Sub Type

Select the asset sub type for the instrument from the drop-down
list. This may be ALL or a specific asset sub type. The list is
populated based on Asset Types setup defined in the system.

Asset Make

Specify the asset make from the drop-down list. If ALL was
selected for either Asset Type or Asset Sub Type, then ALL will be
the only available option for selection.

Asset Model

Specify the asset model from the drop-down list. If ALL was
selected for either Asset Type or Asset Sub Type, then ALL will be
the only available option for selection.

State

Select the state for the instrument from the drop-down list. This
may be ALL or a specific state.

Currency

Select the currency for the instrument from the drop-down list.
This may be ALL or a specific currency.
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4.3

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Scoring Parameters

With the Scoring Parameters, you can define the scoring parameters of a company’s credit
scorecard and behavioral scoring.

Pricing scores apply to applications and are based on information recorded during origination,
behavioral scoring applies to accounts and is based on account history attributes and per-
formed on a monthly basis.

Behavioral scoring

Behavioral scoring examines the repayment trends during the life of the account and provides
a current analysis of the customer. This logical and systematic method identifies which
accounts are more likely to perform favorably versus accounts where poorer performance is
probable. This is useful when determining which other Lines of credit/loan products a
customer may qualify for.

This information appears on the Customer Service form in the Account Details screen’s
Activities section.

To set up the Scoring Parameters
You can either define new Scoring Parameters or specify a new name in the New

Parameter field and click Create Copy to create a copy of selected parameter with details.
1. Click Setup > Setup > Products > Scoring Parameters.

2. Inthe Parameters section, perform any of the Basic Operations mentioned in Navigation
chapter.

opacie 5

Financial Services Lending and Leasing

Close
» DashBoard Scoring Parameters . o

7 Origination 7

gl Parameters dpadd | it | 5 view | of Audt

7 Sevicing

9 Vienv Fomate B Feee i Detach Wap Q) NewParamete % Create Copy Show Expression

> Collections Farameter Descrption Data Type ScorngType  Enabled

S WEP BEHAVIORALSC... BEHAVIORALSCORE HUMEER BEHAVIORALSCO... Y
FICOSCORE  FICO SCORE HUMEER CREDIT SCORING Y

7 Tools 1 1 HUMEER CREDITSCORING K

Setup TET TEST CHARACTR  CREDITSCORING N

setup

Adniristation Paramieters

System [ saveandstay | [ soveand Retum | Cagetum
User

Products Porameter BEHAVIORAL SCORE *Scoting Type. BEHAVIORAL SCORING v
Aeset Types * Destription BEHAVIORAL SCORE * Enabled @

*Data Type. NUMBER v

Index Rates
Curency Exchange
Scoring Parameters
Products

Fridngs

Cortract

Edis

Cyeles

1 Formula Expression
Bpression

Scorng Hodels g I >
Formula Definition padd | it | 2 vien | o At

Origination Fees Views Fomatv Ep || Freere flDetach wap @)

S seq Vaiable Costant Ve Phematisl ) Enabed
Comnission Operator

Insurance 1 ACC_DLO DAYS ]
Checists

Stipulations

Spreats

Statement Nessages

Letters

Fees

Promotions
Subvention
Escrow
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A brief description of the fields is given below:

Field: Do this:

Parameter Specify the name of the scoring parameter. The system
recommends entering a name that in some way reflects how the
parameter is used; for example, use FICO_SCORE instead of
PARAMETER 1.

Description Specify a description of the parameter. Again, Specify a name that
reflects how the parameter is used; for example, use FICO SCORE
and WEIGHTED FICO SCORE instead of FICO SCORE NUMBER 1
and FICO SCORE NUMBER 2.

Data Type Select the data type of the scoring parameter being defined from the
drop-down list. This determines how the system handles the values.
(While DATE and CHARACTER are available data types, generally
only NUMBER should be used when defining a scoring parameter.

Scoring Type Select the scoring type from the drop-down list: CREDIT SCORING
or BEHAVIORAL SCORING.

Enabled Check this box to enable and indicate that the scoring parameter is
available.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

The Formula Definition section allows you to define a mathematical expression of the
scoring parameter you want to define. The expression may consist of one or more sequenced
entries. All arithmetic rules apply to the formula definition. If errors exist in the formula
definition, the system displays an error message in this section when you choose Show
Expression.

4. In the Formula Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Seq Specify the sequence number (the order in which the formula definition
variable will be assembled and evaluated).

( Specify a left bracket, if you need to group part of your formula definition.

Variable Select the variable from a validated field based on the user-defined table
SCR_CRED_SUMMARY: SCORING PARAMETERS, from the drop-down
list.

Constant Specify the constant value (optional).

Value

You can specify varchar values which includes Numbers, Alphabets/
letters, special character/symbols.

Mathematical | Select the math operator to be used on the adjacent formula definition
Operator rows, from the drop-down list.

) Specify a right bracket, if you are grouping part of your formula definition.
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4.4

Field: Do this:

Enabled Check this box to enable the formula and indicate that it is included when
building a definition for the scoring parameter.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

6. Inthe Parameters section, click Show Expression.

The mathematical expression appears in the Formula Expression section (in sequential order)
in the Expression field.

Products

The Product screen defines the closed ended products your organization offers. This screen
is enhanced to support Islamic along with the conventional.

A product is based on the following attributes:

e The collateral type and sub type
e The billing cycle
e Whether the amount is paid directly or indirectly to the customer

The Product Definition section records details about the product such as the description, start
and end dates, collateral type and sub type, credit bureau reporting attributes, billing cycle,
index and rate calculation attributes.

System supports ‘Biennial’ (once every 2 years) and Triennial (once every 3 years) type of
billing cycles. Based on the following lookups, the billing cycle ‘frequency’ can be defined:

e BILL_CYCLE_CD

e LOAN_BILL_CYCLE_CD - For Loan accounts, the Biennial and Triennial billing cycles
are applicable only for ‘Standard’ Product Category and for both Advance and Arrears
type of Rent Collection Methods - Advance (if First Payment Date is equal to Contract
Date) and Arrears (if First Payment Date is greater than Contract Date). However, these
billing cycles are allowed for Balloon Methods N and N+1 and ‘not allowed’ for Flexible
repayment > Skip Months.

The Product Itemization section is used to define itemized entries for a product. This
information is used on the Itemization sub screens of the Application Entry and Application
screens.

The Rate Adjustments section is used to define the frequency of rate change allowed during
interest rate calculations.

To set up the Product

You can either define new Product details or specify a new product code in the New Product
field and click Create Copy to create a copy of selected product with details.

1. On the Oracle Financial Services Lending and Leasing home screen, Setup > Setup >
Administration > User > Products > Products > Loan.
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2. In the Product Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

oRacLe

Financial Services Lending and Leasing

Products x (3] Close
Loan Line Lease
Loan Product % add |/ Edit View Audit
View v Format v [ Freeze [ Detach Wrap @ NewProduct Create Copy
Product Description Start Dt End Dt Direct Flexible Repayment g'a‘;;?o’;fm“"‘ After c“":i‘t"’“e’ Credit  game Billng O
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AUTO_LOAN AUTO_LOAN 12/17/1997 12/31/4000 Y N Y N N
BARAK_LOAN BARAK AUTO LOAN 12/17/1997 12/31/4000 Y Y Y Y N
DARAHOME-LN  ARA HOME LOAN (FR) 12/17/1997 12/31/4000 Y N Y N N
ISTISNA-HOME-LN  ISTISNA HOME LOAN (FR) 12/17/1997 12/31/4000 b2 N Y N N
LOAN AUS AAUS LOAN VEHICLE (FR) 12/17/1997 12/31/4000 N Y Y N N
LOAN-CHAT LOAN CHATTEL (FR) 12/17/1997 12/31/4000 Y N Y N N -
>
>
Loan Product
[ save and stay. || [ save and Return || GaRetum
Product LOAN-UN * Customer Credit Limit * Credit Bureau Account Type | UNSECURED v
* Description | LOAN UNSECURED (VR) * Same Billng Cycle *Billing Cycle | MONTHLY v
* Start Dt 02/03/2020 (& * Enabled Check to enable/disable Skip Credit Bureau Reporting  Category | STANDARD =
*End Dt | 12/31/4000 | B * Skip Credit Bureau Reporting M Index Rounding | NO ROUNDING TO INDEX RATE ¥
* Dif * Collateral Typ UNSECURED COLLATERAL v
Direct ¥ olateral fype Reschedule Method | CHANGE PAYMENT v
* Fle * Collateral Sub Type UNSECURED 2l
Flexible Repayment oleteral sub Type Reschedule Value |10.0000
* Close Account After Paid-Off ¥ * Credit Bureau Portfolio Type INSTALLMENT v
Product Itemizations ~ Rale Adjustments
Product Itemizations H Add || Z Edit View 7 Audit
View v Format v [ Freeze [ Detach Wrap (5]
Itemization Disc Rate Sort Sign Enabled v

words, how you want to differentiate the products). For example,
products can be differentiated according to asset. The product code, or
name, is unique.

Description Specify the description of the product. (This is the product description as
it appears throughout the system).

Start Dt Specify the start date for the product. You can even select the date from
the adjoining Calendar icon.

End Dt Specify the end date for the product. You can even select the date from
the adjoining Calendar icon.

Direct Check this box, if you need the product to be originated directly to
customer. (In this case, the compliance state is the state listed in the
customer’s current mailing address.) If unchecked, the product is an
indirect lending product; that is, payment is made to the producer. (In this
case, the compliance state is the state listed in the producer’s address.)

Flexible Check this box to allow flexible repayment for the Product. When you
Repayment check this check box, the Flexible Repayment Allowed box of
Repayment Options section available under Funding tab > Contract sub
tab > Replacement sub tab of Funding screen.

Note: On the Repayment sub screen of Contract link on Funding screen,
you may only enter the desired repayment schedule type in the
Repayment section’s Type field if the Flexible Repayment Allowed is
selected.
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Field:

Do this:

Close Check this box to allow the account to be closed once the account is

Account paid off i.e. system closes the account after the number of days specified

After Paid- in the system parameter has elapsed. This option is selected by default.

Off If not selected, system ignores the system parameter and does not close
the account even if the account is paid off i.e. system keeps the
accounts active so that the equity can be traded with other accounts. For
information on accounts trading, refer to ‘Appendix - Trading of
Accounts’ chapter.
Note: If the business practice of a financial institution is ‘not’ to close the
accounts then this Indicator need to be unchecked. Mainly in the
Vacation Ownership where a Timeshare Loan can be traded anytime
even if the account is paid-off, this feature is used.

Customer Check this box to enable ‘Customer Credit Limit’ tab in Origination

Credit Limit module. Using the ‘Customer Credit Limit’ tab, an underwriter can define
a specific credit limit for the customer while funding the first application
and based on that credit limit, subsequent applications can be funded.
For more information, refer to ‘Customer Credit Limit’ details in User
Guide.

Same Billing | Check this box to set the same billing cycle (supported only billing cycles

Cycle Monthly and Weekly) for all the future applications funded for an existing
customer.

Enabled Check this box to activate the product.
Note: You can check this box only when Rate adjustment schedule is
maintained, i.e., All the products should be variable rate products.

Skip Credit Check this box to skip credit bureau reporting of all Accounts funded with

Bureau this product type - i.e. on funding an application, that particular account

Reporting is enabled with this parameter and is excluded when the metro Il batch
job is run for credit bureau reporting.
This option can also be enabled/disabled at individual account level in
Servicing by posting ‘Skip Credit Bureau Reporting Maintenance’ non-
monetary transaction.
However note that existing behaviour of ‘Stop Bureau Account’ condition
would still be applicable.

Collateral Select the collateral type for the product, from the drop-down list. This

Type field identifies what type of collateral is associated with the and assists
the system in identifying the correct screen(s) to display.

Collateral Select the collateral sub type for the product, from the drop-down list.

Sub Type

Credit Select the credit bureau portfolio type for the product, from the drop-

Bureau down list.

Portfolio

Type*
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Field: Do this:

Credit Select the account type for the product, from the drop-down list.
ig;iiﬁt *Note: The Credit Bureau Portfolio Type and Credit Bureau Account
Type* Type fields determine how the portfolio is reported back to the credit

bureaus.

Billing Cycle | Select the billing cycle for the product, from the drop-down list.if

Category Select the category as Standard for the conventional product and Islamic
for the Islamic product, from the drop-down list. This serves to group
products for reporting purposes.

Index Select the index rate rounding factor for the product, from the drop-down
Rounding list.

Note: For more information, refer Appendix C: Rounding Amounts and
Rate Attributes.

Reschedule Select the rate change reschedule method for the variable rate product,
Method from the drop-down list. Select CHANGE PAYMENT, if you want to
automatically recalculate the repayment amounts on the interest rate
change. Select UNDEFINED (the default value), if you do not want to
take any action on interest rate change.

Reschedule Specify the value in percent (%) to decide the repayment change. For
Value example, if you enter 10, then the periodic repayment amount will
change only if the newly computed repayment amount is higher by 10%
of the previous repayment amount. Specify 0 if you want to change
repayment amounts with every index rate change.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

The 'Reschedule Method' and 'Reschedule Value' fields allows you to define and control
the changes in loan payment amount for Variable and Fixed rate loans during originating,
funding, and servicing. For more information, refer Variable and Fixed Interest Rate.

441 Product Itemizations

1. Click Setup > Setup > Administration > User > Products > Products > Loan >
Product Itemizations.

2. Inthe Product Itemization sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Itemization Select the itemization type for the product selected in product
definition section, from the drop-down list.

Discount Rate Specify the discount rate.

Sort Specify the sort order.
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Field: Do this:

Sign Select +ve for a positive number and -ve for a negative number.

Note: The +ve and -ve buttons determine whether the values will
increase or decrease the itemization total for the product based on
the selected product. Together the contents of the Product
Itemization sub screen, positive and negative, add up to the
amount.

Enabled Check this box to indicate that this product itemization is currently
available.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

442 Rate Adjustments

1. Click Setup > Setup > Administration > User > Products > Products > Loan > Rate
Adjustments.

2. On the Rate Adjustments subtab, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Seq Specify the sequence number of the rate change adjustments.
Consider 1 as the initial (first) rate change adjustment frequency. All
subsequent frequencies will be considered for rate change
adjustments according to their sequence number.

Adjustment Select the frequency value for adjustments, from the drop-down list.
Frequency Currently, the following values are available in the system:

RATE CHANGE OCCURS EVERY X YEARS
RATE CHANGE OCCURS EVERY X MONTHS
RATE CHANGE OCCURS EVERY X DAYS

RATE CHANGE OCCURS EVERY BILLING DATE
RATE CHANGE OCCURS EVERY DUE DATE
RATE CHANGE OCCURS AT MATURITY

Period Specify the period associated to adjustment frequency. For
example, if you select the adjustment frequency as RATE CHANGE
OCCURS EVERY X YEARS and enter 5, the rate change occurs
every five years.

# of Adjustments | Enter the number of adjustments associated with the adjustment
frequency. For example, in above example, if you enter the value as
2, then rate payment adjustment occurs on the product every five
years and will happens 2 times before switching to the next
adjustment frequency.

Enabled Check this box to indicate that this rate adjustment is currently
available.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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4.5

Contract

The Contract screen allows you to define the instruments used within your system. A
instrument is a contract used by a financial organization with specific rules tied to it. When
processing an application, an instrument associated with the application informs the system
of the type of contract being used for the approved loan. This ensures that all parameters tied
to the instrument are setup for the account as it is booked - without requiring you to do it.

Instruments can be setup at different levels:
e Company
e Branch
e Product
e Application state
e Currency

The following groups of parameters are setup at the instrument level (Each has its own
section on the Contract screen):

e Selection Criteria
e Accrual

e Rebate

e Imputed Interest
e Capitalization

e Scheduled Dues
e Billing

e Delinquency

e Payment Caps

e Extension

e Advance Details
e Rate Cap And Adjustments

Items defined in the contract are “locked in” when you choose Select Instrument on the
Funding form’s Contract link.

The Contract screen’s Instrument and Description fields allow you to enter the financial
instrument’s name and description, for example; INS-LOAN: VEHICLE.

System supports ‘Biennial’ (once every 2 years) and Triennial (once every 3 years) type of
billing cycles. Based on the following lookups, the billing cycle ‘frequency’ can be defined:

e BILL_CYCLE_CD

e LOAN BILL_CYCLE_CD - For Loan accounts, the Biennial and Triennial billing cycles
are applicable only for ‘Standard’ Product Category and for both Advance and Arrears
type of Rent Collection Methods - Advance (if First Payment Date is equal to Contract
Date) and Arrears (if First Payment Date is greater than Contract Date). However, these
billing cycles are allowed for Balloon Methods N and N+1 and ‘not allowed’ for Flexible
repayment > Skip Months.

To set up the Contract

You can either define new Contract Definition details or specify a new name in the New
Instrument field and click Create Copy to create a copy of selected contract with details.
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1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > Products > Contract > Loan

2. On the Contract Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Field:

Do this:

Instruments secti

on

Instrument

Specify the code identifying the instrument.

Description

Specify the description of the instrument being defined.

Start Dt

Specify the start date for the instrument. You can even select the
date from the adjoining Calendar icon.

End Dt

Specify the end date for the instrument. You can even select the
date from the adjoining Calendar icon

Enabled

If you check this box, the system will consider this contract definition
when selecting a instrument for an application.

Note: Once the field is enabled load balances button in balances
sub tab will be disabled

Selection Criteria

section

Company

Select the company for the instrument from the drop-down list. This
may be ALL or a specific company.

Branch

Select the branch within the company for the instrument from the
drop-down list. This may be ALL or a specific branch. This must be
ALL, if you have selected ‘ALL’ in the Company field.

Billing Cycle

Select the billing cycle selected from the drop-down list.

Product

Select the product for the instrument from the drop-down list. This
may be ALL or a specific product.
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Field:

Do this:

State Select the state in which the instrument is used from the drop-down
list. This may be ALL or a specific state.

Currency Select the currency for the instrument from the drop-down list.
IMPORTANT: By selecting which type to use, the system searches
for a best match using the following attributes:

1. Billing Cycle

2. Start Date

3. Company

4. Branch

5. Product

6. State

Hence, Oracle Financial Services Software recommends creating
one version of each type, where ALL is the value in these fields.

Pricing Select the pricing in which the instrument is used from the drop-

down list. This may be ALL or a specific pricing.

Accrual section

Rent Accrual
Method

Select the accrual method used to calculate interest accrual for this
instrument from the drop-down list.

Base Method

Select the base method used to calculate interest accrual for this
instrument from the drop-down list.

Start Dt Basis

Select to define the start date from when the interest accrual is to be
calculated for this instrument from the drop-down list.

Note:

If you select the Effective Date, then the interest is calculated from
the Contract date.

If you select the Payment Date, then the interest is calculated based
on (first payment date minus one billing cycle).

Start Days

Specify the number of days for which the interest accrual is to be
calculated.

Time Counting

Select the time counting method used to calculate interest accrual

Method for this instrument from the drop-down list.
Installment Select the payment installment method from the drop-down list.
Method

Note: the system supports an amortized repayment schedule with
the final payment potentially differing from the regular payment
amount in the other billing cycles. You may choose:

Whether the equal installments for each billing cycle includes any
minute final payment differences (EQUAL PAYMENTS)

_Or-

If the final payment amount may be slightly different (FINAL
PAYMENT DIFFERS).

ORACLE



Field: Do this:

Int Amortization Select the interest amortization frequency from the drop-down list.
Freq

Imputed Interest

This section allows you to enable/disable the imputed interest calculation options in
Origination > Contract screen. These options are required while funding a loan
application with imputed interest for system to calculate ‘Imputed Interest Amortization
Schedule’. For more information, refer to ‘Imputed Interest’ section in Loan Origination
User guide.

Check this box to enable imputed interest related fields in

Imputed Interest Origination >Contract screen. By default, this option is un-checked.

Capitalization section

This section allows you to define capitalization parameters which helps to capitalize the
corresponding account balances to the principal balance of the account based on
specific frequency. For example, you can capitalize the accumulated Interest or Late
Fees to principal balance of the account.

You can either capitalize all the balances based on same frequency or define different
frequency for each type of balance. Balance capitalization is processed during the
execution of batch job TXNCPT_BJ_100_01 (CAPITALIZATION PROCESSING) which
is executed after running the billing batch job.

Note: Capitalization parameters can also be updated by posting ‘CAPITALIZATION
MAINTENANCE’ monetary transaction.

Check this box to enable capitalization parameters for the contract.
By default, this option is un-checked.

The option is available only for the following product types:

Capitalize - Interest Bearing Loans and Mortgage Loans
- Interest Rate Method Lease
- Average daily balance Method Line of Credit
Select the required capitalization frequency from the drop-down list.
The list contains the following types of frequency to either capitalize
all the balances based on same frequency or define different
frequency for each type of balance.
- Based on specific intervals such as Monthly, Quarterly, Annual and
SO on.

Frequency - Based on contract Billing Frequency, Billing Date, or Due date.

- Specifically on every Month End.
-Or-

- Based on Balance Frequency to define different capitalization
frequency for each balance. This can further be defined in Balances
sub tab.
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Field:

Do this:

Capitalization
Start Basis

Select the capitalization start date from the drop-down list as either
Contract Date or First Payment Date to calculate the capitalization
frequency accordingly.

However, this field is not enabled for Billing date or Due Date type of
capitalization frequency.

Grace Days

Specify the grace days allowed in the frequency (minimum 0,
maximum 31) before capitalizing the balances to account. This is
also the deciding factor for executing the capitalization batch job
which is based on Capitalization Frequency + Grace Days.

However, note that Grace Days are not accounted for Month End
type of capitalization frequency and is ignored even if specified.

Cap Tolerance
Amt

Specify the capitalization tolerance amount which is the minimum
amount to qualify for capitalization. Any amount less than this is not
considered for capitalization of balances.

This helps to avoid capitalization of nominal or decimal amounts.

Note: There is no specific accounting maintained for non-capitalized
decimals with reference to setup.

Rebate section

Pre Compute

Check this box to indicate that this is a precomputed loan.

Rebate Method

Select the rebate calculation method from the drop-down list.

Rebate Term
Method

Select the rebate term method from the drop-down list.

Rebate Min Fin

Select the rebate minimum finance charge calculation method from

Chg Mthd the drop-down list.

Min Finance Specify the minimum finance charge value.
Charge

Acquisition Specify the acquisition charge amount.
Charge Amt

Scheduled Dues section

Due Day Min Specify the minimum value allowed for the due day for this
instrument.

Due Day Max Specify the maximum value allowed for the due day for this
instrument.
Note: If billing cycle is selected as weekly, then Due Day Max field
value cannot be greater than 7.

Max Due Day Specify the maximum number of due day changes allowed within a

Change / Year given year for this instrument.

Max Due Day Specify the maximum number of due day changes allowed over the

Change / Life life of a product funded with this instrument.
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Field:

Do this:

Max Due Day
Change Days

Specify the maximum number of days a due date can be moved.

Pmt Tolerance
Amt*

Specify the payment tolerance amount. This is the threshold amount
that must be achieved before a due amount is considered PAID or
DELINQUENT. If (Payment Received + Pmt Tolerance: $Value) >=
Standard Monthly Payment, the Due Date will be considered as
satisfied in terms of delinquency. The amount unpaid is still owed.

Pmt Tolerance%*

Specify the payment tolerance percentage. This is the threshold
percentage that must be achieved before a due amount is
considered PAID or DELINQUENT. If Payment Received >=
(Standard Monthly Payment * Pmt Tolerance% / 100), the due date
will be considered satisfied in terms of delinquency. The amount
unpaid is still owed.

The system uses the greater of these two values.

Promise
Tolerance Amt*

Specify the promise tolerance amount. This is the threshold amount
that must be achieved before a due amount is considered KEPT or
BROKEN. If (Payment Received + Promise Tolerance: $Value) >=
Promise Amount, the Due Date will be considered KEPT (satisfied).

Promise
Tolerance %*

Specify the promise tolerance percentage. This is the threshold
percentage that must be achieved before a due amount is
considered KEPT or BROKEN. If Payment Received >= (Promised
Amt * Promise Tolerance%), the due date will be considered KEPT
(satisfied).

The system uses the greater of these two values.

Billing section

Prebill Days

Specify the prebill days. This is the number of days, before the first
payment due, that accounts funded with this instrument will be billed
for the first payment. Thereafter, the accounts will be billed on the
same day every month. If an account has a first payment date of 10/
25/2003 and Pre Bill Days is 21, then the account will bill on 10/04/
2003, and then bill on the 4th of every month.

Billing Type

Select the billing type for accounts funded using this instrument from
the drop-down list.

Billing Method

Select the billing method for accounts funded using this instrument
from the drop-down list.

Balloon Method

Select the balloon payment method for accounts funded using this
instrument from the drop-down list.

Multiple Billing
Asset Rate

Check this box to indicate if multiple asset rates are applicable for
one billing period.

System considers billing period from current due date to the next
due date. Multiple rates are fetched only when rate end date (rate
start date + rate frequency) ends one or more cycle(s) before the
next due date i.e. current rate record does not cover the entire billing
period.
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Field:

Do this:

Delinquency sect

ion

Late Charge

Specify the number of grace days allowed for the payment of a due

Grace Days date before a late charge is assessed on the account.
Stop Accrual Specify the number of days a contract can be in delinquent state,
Days after which the interest accrual must stop for an account.

A Batch Job is run daily to select accounts in delinquent status for a
pre-defined number of days and post ‘No Accrual transaction’ for
such accounts on current date. When the account recovers from
Delinquency, the system will then post a ‘Start Accrual Transaction’
on the date the account is recovered from delinquency.

Delq Grace Days

Specify the number of grace days allowed for the payment of a due
date before an account is considered delinquent. This affects DELQ
Queues, the system reporting, and the generation of collection
letters.

Time Bar Years

Specify the total number of years allowed to contact the customer
starting from the first payment date and beyond which the account is
considered delinquent. You can specify any value between 0-999.

Cure Letter Gen
Days

Specify the number of delinquency days to initiate cure letter gener-
ation.

Cure Letter Valid
Days

Specify the number of days during which the issued cure letter is
valid. Usually financial institutions will start the collection activities
after the lapse of cure letter validity date.

Delq Category
Method

Select the delinquency category method to determine how the
system populates delinquency counters on the Customer Service
form.

Note: This value does not affect credit bureau reporting.

Accrual Post
Maturity

Check this box to indicate that this is the post maturity default rate.

Extensions allow you to extend the maturity of the contract by one or
more terms by allowing the customer to skip one or more payments.
The skipped terms are added to the end of the contract.
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Field: Do this:

Cycle Based Fees - This section allows to define the parameters for calculating cycle
based fees at individual account level. Using the below parameters, system derives the
Cycle Base Fees and updates the account balances on processing the following batch
jobs - TXNCBC_BJ_100_01 (CYCLE BASED COLLECTION LATE FEE PROCESSING)
and TXNCBL_BJ_100_01 (CYCLE BASED LATE FEE PROCESSING). For more
information, refer to ‘Fee Consolidation Maintenance’ section in Appendix chapter.

System calculates the below type of fee in combination of associated and master
account and is assessed only when total due crosses ‘Threshold’ amount (that is defined
in Setup > Products > Contract > Fees tab and Setup > Products > Fees screen):

Fee Late Charge (FLC)

e Percentage of sum of payment due

e Percentage of sum of standard payment

e Percentage of sum of billed amount
Cycle Based Collection Late Fee

e Flat amount

e Percentage of sum of payment due

e Percentage of sum of standard payment

e Percentage of sum of billed amount

e Percentage of payment due

e Percentage of standard payment

e Percentage of billed amount

e Percentage of total due amount

e Percentage of sum of total due amount

Cycle Based Late Fee

e Flat amount

e Percentage of sum of total due amount
e Percentage of sum of payment due

e Percentage of sum of standard payment
e Percentage of sum of billed amount

e Percentage of total due amount

e Percentage of payment due

e Percentage of standard payment

e Percentage of billed amount

Cycle Based Check this box to enable cycle based collection late fee assessment
Collection Late on the account.
Fee

If selected, the balance type CYCLE BASED COLLECTION LATE
FEE is made available in the Balances tab which further allows to

define how system should derive the balances when an account is
booked and funded.

If unchecked (default), system does not display the ‘Cycle based
Collection Late Fee’ balance in Contract >Balances tab on clicking
‘Load Balances’ button.
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Field:

Do this:

Cycle Based
Late Fee

Check this box to enable cycle based late fee assessment on the
account.

If selected, the balance type CYCLE BASED LATE FEE is made
available in the Balances tab which further allows to define how
system should derive the balances when an account is booked and
funded.

If unchecked (default), system does not display the ‘Cycle Based
Late Fee’ balance in Contract >Balances tab on clicking ‘Load
Balances’ button.

Cycle Based
Collection Late
Fee Grace Days

Specify the number of grace days allowed before cycle based
collection late fee is assessed on the account. This field is enabled
only if the Cycle Based Collection Late Fee option is checked above.

Cycle Based
Late Fee Grace
Days

Specify the number of grace days allowed before cycle based late
fee is assessed on the account. This field is enabled only if the Cycle
Based Late Fee option is checked above.

Fee Consolidation - If Cycle Based Late Fee is assessed based on above parameters,
this section allows to enable/disable the option to consolidate the late fee at Master

Account level.

Late Charge at
Master Account

Check this box to allow system to consolidate the late charge
assessment at master account level.

Cycle Based
Collection Late
Fee at Master

Check this box to allow system to consolidate the cycle based
collection late fee assessment at master account level.

Ensure that, the option ‘Cycle Based Collection Late Fee’ is also

Account checked for fee consolidation at Master Account level.

Cycle Based Check this box to allow system to consolidate cycle based late fee
Late Fee at assessment at master account level.

Master Account

Ensure that, the option ‘Cycle Based Late Fee’ is also checked for
fee consolidation at Master Account level.

Extension section

Max Extn Period
/ Year

Specify the maximum number of terms that the contract may be
extended, within a given rolling calendar year.

Max Extn Period
/ Life

Specify the maximum number of terms that the contract may be
extended, within the life of the loan.

Max # Extn / Specify the maximum number of extensions that may be granted
Year within a given rolling calendar year.

Max # of Extn / Specify the maximum number of extensions that may be granted
Life within the life of the loan.

Minimum # Specify the minimum number of payments that must be made before
Payments extension.

Extension Gap in
Months

Specify the gap between previous extension provided in the account
and current one as specific number of months.
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Field:

Do this:

Advance Details section

Multi Check this box, if this contract allows disbursement of funds to

Disbursements customers through multiple advances or draws up to the approved

Allowed amount within a specified “draw period.” If you select the Multiple
Disbursements Permitted box, complete the Advance Details section
on the Contract section. (For more information, see the Stages
Funding section in this chapter.)

Min Initial Specify the minimum initial advance amount allowed. This is the

Advance smallest possible initial advance that can be disbursed to the
borrower after funding.

Max Initial Specify the maximum initial advance amount allowed. This is the

Advance largest possible initial advance that can be disbursed to the borrower

after funding.

Late Charge
Allowed

Check this box to allow disbursement period late charge.

Min Advance

Specify the minimum advance amount. This is the smallest advance
amount that a borrower may subsequently request after the initial
advance.

Max Advance

Specify the maximum advance amount. This is the largest advance
amount that a borrower may subsequently request after the initial
advance.

Billing Allowed Check this box to allow stage funding with draw period billing.
Draw Period Select the method for billing during the draw period from the drop-
Billing Method down list.

Reschedule Ind

Select this check box to indicate that the rescheduling is allowed at
the draw period.

Rate Cap & Adjustments section

Max Rate Inc /
Year

Specify the maximum rate increase allowed in a year.

Max Rate Inc /
Life

Specify the maximum rate increase allowed in the life of the loan.

Max Rate Dec /
Year

Specify the maximum rate decrease allowed in a year.

Max Rate Dec /
Life

Specify the maximum rate decrease allowed during the life of the
loan.

Max # Adjust / Specify the maximum number of rate changes allowed in a year.
Year

Max # Adjust / Specify the maximum number of rate changes allowed during the life
Life of the loan.
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Field: Do this:

Min Int Rate Specify the minimum rate.
(Floor)

Max Int Rate Specify the maximum rate.
(Ceiling)

Payment Caps section

Max Pmt Inc / Specify the maximum payment increase allowed in a year.

Year

Max Pmt Inc / Specify the maximum payment increase allowed in the life of the
Life loan.

Statement section

This section allows to define the preferences for Mock Statement generation at Master
Account level. Generating a Mock Statement helps to mock the asset billing process with
a future date and to get an upfront statement indicating future dues of Master and
Associated Accounts. In ‘Vacation Ownership’ industry, such statements are required to
forecast future dues based on current ‘Timeshare’ holdings.

The selected preference here are propagated to Application > Contract screen when the
instrument is loaded.

Select this check box to indicate if the account is to be include in
Mock statement Generation.

Mock Statement _ . _

Req Note: Based on this selection, others fields related to Mock
Statement below are enabled and becomes mandatory for providing
details.

Select the start month of Mock Statements period from the drop-
down list.

Mock Start Note: During the ‘Mock Statement Next Run Date’ validation if next

Month run date is less than Contract Date or GL Date, system moves the

‘Mock Start Month’ to same month of next year. For more
information, refer to ‘Mock Statement Maintenance’ in Appendix -
Non Monetary transactions sections.

Mock Statement | Select the total number of billings (between 1-12) that are to be
Cycles generated post Mock Statement Start Date.

Mock Pre Specify the number of Pre bill days for Mock Statements generation.
Statement Days

Stmt Preference | Select the account statement preference mode as either Email or
Mode PHYSICAL from the drop-down list.

The selected preference will be propagated to Application > Contract
screen when the instrument is loaded.

Other section

1st Pmt Check this box to indicate that the first payment for fixed rate loans
Deduction using this instrument may be deducted from the producer's
Allowed proceeds.
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Field:

Do this:

1st Pmt Refund
Allowed

Check this box to indicate that refunding first payment deductions to
the producer is allowed.

1st Pmt
Deduction Days

Specify the first payment deduction days. If the first payment for
fixed rate loans using this instrument is less than this number of
days from funding, the first payment will be deducted from the
producer’s proceeds if 1st Pmt Deduction.

1st Pmt Refund
Days

Specify the first payment refund days. If the first payment for fixed
rate loans using this instrument is received within this number of
days from the first payment date, the first payment deduction will be
refunded to the producer if 1st Pmt Refund.

Refund Allowed

Check this box to indicate that refunding of customer over payments
are allowed.

Refund
Tolerance Amt

Specify the refund tolerance amount. If the amount owed to the
customer is greater than the refund tolerance, the over payment
amount will be refunded if Refund Allowed box is selected.

Anniversary

Specify the anniversary term that define the anniversary period. This

Period is based on billing cycle, so normally for MONTHLY the value is 12
and for WEEKLY the value is 52.
Write Off Specify the write off tolerance amount. If the remaining outstanding

Tolerance Amt

receivables for accounts funded using this instrument is less or
equal to the write off tolerance amount, the remaining balance on
the account will be waived.

Pre Pmt Penalty

Check this box, if there is a prepayment penalty charged for
accounts funded using this instrument.

% of Term for

Specify percentage of term for prepayment penalty. If the (remaining

Penalty terms / total terms) expressed as a percentage exceeds this amount,
a prepayment penalty will be assessed if the Pre-Pmt Penalty box
was selected.

Recourse Check this box if recourse is allowed. This indicates whether the

unpaid balance may be collected from the producer if the consumer
fails to perform on the loan.

Max Recourse%

Specify the maximum percentage of the outstanding receivables that
may be collected from the producer if the Recourse Allowed box was
selected.

Pay Off Fee
Allowed

Check this box to allow for a payoff quote fee to be assessed to the
account attached to this contract.

Note: This will require you to set up a payoff fee at the contract
(Fees sub screen) or state (Fee screen) level. For more information,
see the following Contract screen (Loan)’s Fees sub screen or Fee
screen (Loan) sections in this chapter.

Escrow Allowed

Check this box, if this contract can do escrow of tax and insurances.
(For more information, see the Escrow Setup Form chapter.)

Repmt Currency

Select the designated repayment currency for this contract from the
drop-down list.
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Field: Do this:

PDC Security Check this box to indicate that post dated checks are the method of
Check repayment for this contract.

Default Pmt Select the default payment spread to be used when receiving
Spread payments for this account if one is not explicitly chosen, from the

drop-down list.

Calendar Method | Select the required calendar method for this contract from the drop-
down list. The calendar method "Hijri" should be selected, if the
product category is selected as Standard in the Products screen. For
"Islamic" product category, the calendar method can be either
Gregorian or Hijri.

ACH Fee Ind Check this box to indicate that direct debit fee is included.

Note: The ACH Fee/Direct Debit Fee balance will be displayed in
Balances sub tab only when this checkbox is selected.

Track Down Select this check box for system to validate if ‘Down Payment
Payment Balance’ is loaded. This helps to record the Down Payment balance
Balance Agreed and Paid by the customer.

If selected, system validates if Down Payment Balance is loaded in
the contract setup. However, system does not validate Down
Payment Balance if unchecked. This check box is available only for
Loan and Lease contracts.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Extension of Terms

The system facilitates extension of terms, provided the following conditions are satisfied:

e Specified number or more payments made in the account

e Gap between the previous and current extension provided in the account must be a
specific number of months that could be specified

If the above conditions are not satisfied, then the system displays an appropriate error
message.

A new transaction Force Extension will be available. This transaction will be posted when you
want the system to bypass the extension validations defined at the contract level.

When a backdated transaction with TXN Date exists before the transaction date of extension,
all the transactions are reversed and posted again. If extension transaction is posted again,
then the validation rules are not validated again.

Staged Funding

Staged funding for closed-end loans allows you to disburse funds to customers through
multiple advances or draws up to the approved amount within a specified “draw period.”
To create a multiple disbursement contract for a transaction

1. In the Contract Definition section, click Add and complete the fields following the
instructions above, making sure to complete the following steps:

e Inthe Advance Details section, select the Multiple Disbursement Permitted check box.
When you select a contract instrument that permits staged funding (multiple
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disbursements) on the Funding screen, the system copies the information for that
instrument from the Setup Module screen’s Contract screen to the Funding screen’s
Contract screen.

Note

You cannot clear the Multi Disbursement Allowed box in the Advance section on the Con-
tract screen.

e Complete the fields in the Advance Details section to define the limits for initial and
subsequent advances for staged funding.

Note

This information appears in the Advance section of the Funding screen’s Contract link.

N

If you choose, set the following APPLICATION CONTRACT EDITS as an ERROR or
WARNING on the Setup Module screen’s Edits screen.

Note

For more information, see the Edits link (Edits screen) section in this chapter.

1. REQUIRED: ADV DRAW END DATE
2. XVL: ADV DRAW END DT MUST BE AFTER CONTRACT DT
3. XVL: ADV DRAW END DT MUST BE LESS THAN FIRST PMT DT - PREBILL DAYS

These edits appear on the Funding screen’s Verification screen.

Repayment scheduling for staged funding

When funding a loan, the system computes repayment schedules from the contract date,
irrespective of whether funds have been disbursed or not. The system uses the approved
amount (amount financed) for computing repayment schedules on the contract date.

As the might have been disbursed through multiple draws, or the draws have been less than
the approved amount, or the amount may have been repaid in some amount before the draw
end date, you may need to change the payment amount. In such cases, you can manually
change the payment in the system by posting the monetary transaction CHANGE PAYMENT
AMOUNT on the Customer Service screen’s Maintenance link.

Disbursements for staged funding

The approved amount for staged funding can be disbursed with the Funding screen or at a
later time using the Advances screen. If the first disbursement is requested during funding,
you may enter it on the Itemization sub screen of the Funding screen’s Contract screen.

If the entire approved amount is not disbursed during initial funding, it can be disbursed using
the Advances screen’s Advance Entry screen.

If the initial amount on the Advance Entry screen is not within the minimum or maximum limits
(as entered in the Advance Details section on the Setup Module screen’s Contract screen),
the system displays any of the following error or warning messages in the Advances section’s
Error Reason field:

e ADVANCE AMOUNT IS LESS THAN THE INITIAL ADVANCE AMOUNT MINIMUM
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4.5.1

_or'_
e ADVANCE AMOUNT IS MORE THAN THE INITIAL ADVANCE AMOUNT MAXIMUM

The Advance Entry screen also allows you to enter subsequent funding / disbursements. If
subsequent advances are not within the predetermined minimum or maximum amounts, the
system displays any of the following warning or error messages in the Advances section’s
Error Reason field:

e ADVANCE AMOUNT IS LESS THAN THE ALLOWED SUBSEQUENT ADVANCE
AMOUNT

_O r-

e ADVANCE AMOUNT IS MORE THAN THE ALLOWED SUBSEQUENT ADVANCE
AMOUNT

Additional messages in the Error Field regarding Staged Funding

If you attempt to post an advance after the draw end date, then the system displays the
message in the Advances section’s Error Reason field as, "ADVANCE DT IS AFTER DRAW
PERIOD END DATE".

If you attempt to post an advance above the approved amounts, including tolerance, the
system displays the message in the Advances section’s Error Reason field as "ADVANCE
AMOUNT IS MORE THAN THE TOTAL APPROVED AMOUNT INCLUDING TOLERANCE".

Since this is not a revolving loan, if any repayment is made against the approved amount
principal balance, the system will not adjust the disbursed amount allowing for subsequent
additional staged funding or advances.

Note

There is no change to the payoff quote functionality in the system. The system uses the
actual amount of the advance(s) and any interest accrued since the date of the last pay-
ment or credit in the PAYOFF QUOTE VALID UPTO DATE value when the payoff quote is
requested before the draw end date.

Balances

The Balances sub screen lists the balances that will be established when an account is
booked and funded.

CAUTION: Please contact your Implementation Manager for changes to this section.

To set up the Balances

1. Click Setup > Setup > Administration > User > Products > Contract > Loan >
Balances.

2. On the Balances sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Balance Type Displays the balance type.
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Field: Do this:

Chargeoff Method Select the charge off method to determine how the outstanding
amount of this balance type will be handled from the drop-down
list, if the account becomes uncollectable and the product is
charged off.

Writeoff Method Select the write off method to determine how the outstanding
amount of this balance type will be handled from the drop-down
list, if the account is within the write off tolerance of being PAID.

Reschedule Method | Select the reschedule method to determine how the outstanding
amount of this balance type will be handled from the drop-down
list, if the account is rescheduled.

Sort Specify the sort order of how account balances will appear on the
Customer Service form’s Balance screen.

Billed Check this box to indicate that outstanding amounts for this
balance type are considered a part of the billed amount. This also
determines whether payments applied to this balance type are
considered when satisfying outstanding amounts due.

Accrued Check this box to indicate that outstanding amounts for this
balance type will be included when interest is accrued against the
account.

Non Performing Check this box to indicate that “non-performing” is used as an

Rollover intermediary status on your general ledger prior to charge off and

want to create balances for non-performing accounts for this
balance type.

Note: (The Non-Performing Rollover box applies only to Balance
Types of ADVANCE/PRINCIPAL and INTEREST. For all other
Balance Types, this box would be cleared).

Non Performing Select the balance type you want to rollover from drop-down list,

Balance Type if you select the Non-Performing Rollover box (Advance/
Principal).

Enabled Check this box to indicate that this balance type will be created

when the account is booked and funded

This section is applicable if the capitalization frequency is selected as Balance
Frequency for the contract and allows you to define capitalization parameters for a
specific type of account balance such as ‘Interest’.

Note: The value of parameters defined in this section supersedes the values defined in
header section.

Check this box to enable capitalization parameters for the

Canitall selected balance type. By default, this option is un-checked.
apitalize
P Note: The option is disabled for ‘Advance / Principal’ type of Loan

or Line contracts and for Lease Receivables.
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4.5.2

Field: Do this:

Select the capitalization frequency from the drop-down list.
Frequency can be selected using any of the following options:

- Based on specific intervals such as Monthly, Quarterly, Annual
Frequency and so on.

- Based on contract Billing Frequency, Billing Date, Due date.

- Specifically on every Month End.

Specify the grace days allowed in the frequency (minimum 0,
maximum 31) before capitalizing the balances to account. This is
also the deciding factor for executing the capitalization batch job
Grace Days which is based on Capitalization Frequency + Grace Days.

However, note that Grace Days are not accounted for Month End
type of capitalization frequency and is ignored even if specified.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
The system loads the currently defined balances for accounts.

If your organization maintains additional balances, contact your Implementation
Manager for information regarding those balances.

Amortized Balances

With the Amortize Balances sub screen, you can select one or more balances to be amortized

over the life of the loan. You can also define the amortization method.

To set up the Amortization Balances

1. Click Setup > Setup > Administration > User > Products > Contract > Loan >
Amortized Balances.

2. In the Amortization Balances section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Amortize Balance Type Select the amortize transaction type from the drop-down
list.

Amortization Method Select the amortization method used to calculate the net

amortization amount from the drop-down list.

Cost/Fee method Select the amortization cost/fee method.

Sort Specify the sort sequence to define the order of the
amortize balances.

Enabled Check this box to enable the amortize balance to be created
when the account is booked and funded.

3. Perform any of the Basic Actions mentioned in Navigation chapter.
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453 Itemizations

On the Itemizations sub screen, you can define the itemized components for each type of
contract, indicate if it is required, and determine whether it has a positive or negative bearing
on the contract itemization math. You can establish the following groups of itemization

transactions:

Advance Total amount of the product that is not a part of financed fees; in other
words, the total amount the customer requested to be advanced.

Financed Fees rolled into the principal balance of the product. Financed fees are

Fees also considered to be a part of the finance charge.

Pre-Paid Fees that are paid by the consumer prior to the funding of the loan.

Fees These fees are not rolled into the balance of the product but are
considered as part of the finance charge and are included in the
calculation of the APR.

Producer Fees that are paid to or by the producer of the loan; for example, a fee
that is being charged to the producer. These transactions will affect
proceeds.

Escrow Allows you to connect the actual escrow itemization with the escrow type
and the funding transaction.

To set up the Itemizations
1. Click Setup > Setup > Administration > User > Products > Contract > Loan >
Itemizations.

2. On the ltemization sub screen select the option button to indicate the type of itemization
you are working with: Advance, Financed Fees, Pre-Paid Fees, Producer, or Escrow.

3. On the ltemization sub screen, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Itemization Select the itemization from the drop-down list.
Disbursement Select the disbursement type from the drop-down list.
Type

Transaction Select the funding transaction type from the drop-down list.

Itemization Type | Select the itemization type from the drop-down list.
Notes:

1. On selecting the "Prefunding Txns" as itemization type, it
indicates that this particular itemization expects a payment from the
customer prior to funding.

2. The itemization type "Prefunding Txns" is available only for loans.

Sort Specify the sort order to define the order of the itemization
transactions.
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4.5.4

Field: Do this:

Sign If the itemized transaction increases the group balance, click +ve.
-Or-
If the itemized transaction decreases the group balance, click -ve.

Enabled Check this box to enable the itemization and indicate that this
itemization transaction will be created when the account is booked
and funded.

Amortize Select the amortize balance affected by this itemization transaction

Balance from the drop-down list. Note: Advance itemizations do not affect
amortize balances.

Refund Select the refund calculation method from the drop-down list

Calculation

Method

Taxable Check this box, if the itemization type is taxable. However, note that
the taxable option defined in Setup > Administration > System >
Sale Tax screen will supersede with this preference.

Seller Pmt Check this box to enable seller payment

Escrow Select the escrow from the drop-down list.

Itemization Select the itemization formula description from the drop-down list.

Formula

Refund Check this box to enable Refund calculation Method.

Calculation

Method

Escrow If this is an escrow account, check this box to indicate that an

Required escrow is required during the application process (though at that

time the user can choose Opt Out to decline.)

Discount. Rate

Specify the discount rate for the itemization.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Fees

Any fees that are defined in the contract are set up on the Fees sub screen. The system
currently supports the following contract fees:

e Late charges

e Non sufficient funds

e Extensions

e Prepayment penalties

e Delay Fee
e ACH Fee

The Fees sub screen allows you to define those fees whose value and method of calculation
are set at the time of the loan. As these amounts cannot be changed after the product is
booked and funded, you should only set up fees here that will not change over the life of the
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loan. Individual contract fee types may be defined multiple times in order to create graduated
fees.

Note

Certain fees, like late fees, can be set up at contract, as well as state level. In such cases,
the contract fee, if present, is used first.

To set up the Fees
1. Click Setup > Setup > Administration > User > Products > Contract > Loan > Fees.

2. Inthe Fees section, perform any of the Basic Operations mentioned in Navigation

chapter.

A brief description of the fields is given below:

Field:

Do this:

Type

Select the fee type from the drop-down list.

Txn Amt From

Specify the lowest transaction amount or balance amount against
which this contract fee definition may be applied.

Amount
Financed From

Specify the minimum value of amount financed on the contract.

Note: This is the 'Contracted loan amount' during origination and
would always be the 'Amount Financed' on contract even if principal
addition is done through a transaction in servicing.

Method Select the method of calculating the fee to be assessed from the drop-
down list.
Frequency Select the frequency of calculating the fee to be assessed from the

drop-down list.

Threshold Amt

This field is enabled only if the Contract Fee type is either CYCLE
BASED COLLECTION LATE FEE or CYCLE BASED LATE FEE.

Specify the threshold amount which is less than or equal to minimum
fee amount to be assessed. Based on this amount, system calculates
and posts the Cycle Based Collection Late Fee or Cycle Based Late

Fee based on the account.

If calculated fee amount is less than threshold amount, fee is posted
with transaction amount = 0.

If calculated fee amount is greater or equal to threshold amount, fee is
posted based on existing min amt and max amt comparing logic.

Min Amt Specify the minimum fee amount to be assessed.

Max Amt Specify the maximum fee amount to be assessed. If you selected
FLAT in the Method field, then this field is not used and is normally
populated as $0.00.

Percent Specify the fee percentage of the outstanding transaction amount to
be assessed as a fee. This amount will be adjusted to fall within the
Min Amount and the Max Amount.

Enabled Check this box to create the selected contract fee when the account is

booked and funded.
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3. Perform any of the Basic Actions mentioned in Navigation chapter.

Behavioral Score Models

ORACLE
Financial Services Lending and Leasing
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> DastBeard Scoring Models
 Origination Loan | Line| | Lease
7 Senicing Credit Score Models  Behaviorl Seore Hodels
 Collections
 WEP Score Models Padd | et | Elvew | o audit
> Tools View~ Fomatv [ Freeze EfiDetach ¢ Wrap @) teew Credit Model % Create Copy
Setup Hodel Description Start Ot End Ot W Score Company Branch Product Carrency At
setup 02/1sf2016, 12/31/4000 0 ]
Adninistration LoAN LOAN SCORING HODEL (FICO SCORE) 11/11/1992 12/31/4000 1000 ALL AL AL ALL it
»
AT Score Models
Index Rates [ saveandadd | [ save and stay || B save andRetum | Gapetum
Currency Exchange
Scoring Parameters * Model Result * Currency AL ¥
Products * Desciption * MaxScore 0 Bl S
Prcings . B Selection Criteria easons
Contract Stk a * Company AL * Auto Decision %
Edits q End 0t 12314000 By il
Cydles Enabled 5
Scoring Hodels Bruduet (AL
Fees
Origination Fees
Compensation
Commission
Tnsurance
Checkists
stipuations
Spreats
Statement Hessages Parameters | Grades
Letters
Promotions
i Parameters i | JEit | Evien | o auit
Subvention
Escrin Views Fomatv [ Freeze Pfivetach  dwep @
WP Parameter Max Ve ABverse Action Weighted Value Enabled
Index Rates e e
o o data to display
Pricings
Contracts o Tl 7 - i
Balances Range Definition Add | JEdt | B View || o Audit
Transactions Vieww Fomat~ Freeze T Detach ] wrap 0]
Spreads Value From Value From Percent / Value Enabled o

You can either define new Behavioral Score Model details or specify a new name in the New
Behavioral Model field and click Create Copy to create a copy of selected score model with
details.

1. Click Setup > Setup > Administration > User > Products > Scoring Models > Loan >
Behavioral Score Models.
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2.

In the Score Models section, perform any of the Basic Operations mentioned in

Navigation chapter.

ORACLE'

Financial Services Lending and Leasing
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i Close
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Setup Hodel Description stat 0t End Dt Enabled Hax Score Compary Branch Product Curency
152016 123174000 N 0
Setup LOAN 85 TESTES 12122015 12314000 N 0AL AL AL AL
Adninistation AN S SCRORING HODEL 12162015 12314000 N 100 ALL AL AL AL
> Sstem LOAN SH5 LoAN 12/162015 12314000 N 0AL AL LOANVEHICLE (FR) ALL
> User
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Currency Exchange
Scoring Parameters * Hodel . *Branch ALL v
Selection Criteria
Froducts ) * Description *Product AL v
Pricings o
Coistt *Start D 02/152016 O * Max Score 0 *Currency ALL ¥
i tmdot iy B * Company AL '
Cycles * Enabled
Scaring Models
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Origination Fees
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Coramisin Parameter VaxValue Enabled
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A brief description of the fields is given below:

Field:

Do this:

Model

Specify the code for the scoring model.

Result section

Max Score

Specify the maximum score allowed. (This is normally the sum of the
Max Value fields within the scoring parameters.).

Selection Criteria

section

Company

Select the company for the scoring model, from the drop-down list.
This may be ALL or a specific company.

Branch

Select branch within the company for the scoring model, from the
drop-down list. (This may be ALL or a specific branch. However, if
you have selected ‘ALL" in Company field, then you must select ‘ALL
for this field).

Product

Select the product for the scoring model, from the drop-down list.
This may be ALL or a specific product.

Currency

Select the currency for the scoring model, from the drop-down list.
This may be ALL or a specific currency.

Bureau Score
Reasons

Check this box if bureau score reason is applicable.

Auto Decision

Check this box if auto decision is applicable.
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Field:

Do this:

Description Specify a description of the scoring model.

Start Dt Specify the start date for the scoring model. You can even select the
date from the adjoining Calendar icon.

End Dt Specify the end date for the scoring model. You can even select the
date from the adjoining Calendar icon.

Enabled Check this box to enable the scoring model.

Result section

Max Score

Specify the maximum score allowed. (This is normally the sum of the
Max Value fields within the scoring parameters.).

Selection Criteria section

Select the company for the scoring model, from the drop-down list.

Company This may be ALL or a specific company.

Branch Select branch within the company for the scoring model, from the
drop-down list. (This may be ALL or a specific branch. However, if
you have selected ‘ALL" in Company field, then you must select ‘ALL
for this field).

Product Select the product for the scoring model, from the drop-down list.
This may be ALL or a specific product.

Currency Select the currency for the scoring model, from the drop-down list.

This may be ALL or a specific currency.

Bureau Score
Reasons

Check this box if bureau score reason is applicable.

Auto Decision

Check this box if auto decision is applicable.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Click ‘Create Copy’ button on the Score Models screen to create copy of the selected
record with details.

The Parameters section records the parameters used to determine the score calculated by

the scoring model. You can define multiple parameters and adverse action reason associated
with each parameter in a scoring model. Each scoring parameter can have maximum values
set. The score range is based upon the information in the Range Definition section on the

Parameters sub tab.

The system calculates a final score by adding the score for each parameter in the scoring
model. A parameter weighted value is used to find the four adverse action reasons, if bureau
reasons are not used.

Note

— A character parameter range definition should contain the exact value of the
parameter.
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— Each scoring parameter should have range definitions defined that encompass all
of the values that might result.

5. Inthe Parameters section, perform any of the Basic Operations mentioned in Navigation
chapter.

A brief description of the fields is given below:

Field: Do this:
Parameter Select the parameter from the field, from the drop-down list.
Max Value Specify the maximum value allowed for the selected parameter.

Adverse Action | Select the adverse action reason.
Reason

Weighted Value | Specify the weighted value.

Enabled Check this box to enable the parameter.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. The Range Definition section allows you to translate the calculated value for a scoring
parameter into the value to be used, depending on the returned value of the parameter.

8. In the Range Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Value From Specify the lowest calculated value to apply the specific translation. The
ceiling of the range definition is based on the range definition with the
next highest Value From or the Max Value of the scoring parameter
(whichever is less).

Value From Select the following options to determine how values for a scoring
parameters are translated:

% Max Value — If selected, then the calculated values within the range
definition receives a value based on a percentage of the Max Value of the
scoring parameter.

% Param — If selected, then the calculated values within the range
definition receives a value based on a percentage of the calculated value
of the scoring parameter.

Value — If selected, then the calculated values with in the range definition
receives a specific value.

Percent / Specify the percent or value to be used in the translation of the calculated
Value value of the scoring parameter.
Enabled Check this box to consider this range definition while translating values

for this scoring parameter.

9. Perform any of the Basic Actions mentioned in Navigation chapter.
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4.6

Fees

The Fee screen allows you to define fees that may be automatically assessed by the system.
The Fee Definition section records fees not defined within the Contract screen’s Fees sub
screen.

The following fee types are currently supported for automatic assessment:

e Late charge

o NSF

e Extension

e Advance

e Over Credit Limit

e Membership

e Prepayment penalty
e Phone Pay

e Payoff Quote

e Periodic Maintenance
e Rental Fee

e ACH Fee

e Delay Fee

e Other Fee and Tax

Fees can be calculated as either a flat amount or a percentage of payment due based on fee
type.

You can specify minimums and maximums for fee amounts in the Min Amt and Max Amt
fields. Different fee rules can be setup at the company/branch level.

When Fees are assessed, the system determines the best match using all enabled fee
definitions that meet the following criteria:

e Exactly match the fee type being assessed.
e Have an effective date that is greater than or equal to the start date.

e Have a Txn Amt From that is greater than or equal to the outstanding amount related to
the fee assessment.

e Match either the value or ALL for all other criteria (Exact matches for each field are
given a higher weight than matches to ALL.)

The returned rows are then given a descending rank based on the weighted values and the
hierarchical position of the following criteria:

Company

Branch

Product

Application state

Transaction amount

Start date

End date

© N o g s~ 0w DN =

Currency
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On the ranked rows, the first row is returned as the best match.

Note

Certain fees, like late fees, can be set up at contract, as well as state level. In such cases,
the contract fee, if present, is used first. Only if the contract fee is not present in the state
fee used.

To set up the Fee

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Fees > Loan

2. In the Fee Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

ORACLE’
Financial Services Lending and Leasing

# Welcome ABSHEKAR ~ ]

Feesx (3 Close
Loan Line Lease
Fee Definition + Add |/ Edit View Audit
View v Format v [ Freeze i Detach Wrap o)

Fee Rule Fee Type Start Dt End Dt Enabled Calc Method Threshold Amt Min Amt Max Amt Percent Company Bran
CBOLF CYCLE BASED COL... 01/01/2000 12/31/4000 B FLAT AMOUNT 15.00 20.00 100.00 0.0000 INOL ALL
CBLF CYCLE BASED LAT.... 01/01/2000 12/31/4000 v FLAT AMOUNT 15.00 20.00 100.00 0.0000 INOL ALL
FEE LATE CHARGE  FEE LATE CHARGE  01/01/2000 12/31/4000 N FLAT AMOUNT 0.00 0.00 1,500.00 2.0000 ALL
FEE_NSF FEE NSF 01/01/2000 12/31/4000 N FLAT AMOUNT 0.00 0.00 1,000.00 2.0000 ALL
FNSF FEE NSF 11/02/1990 12/31/4000 N FLAT AMOUNT 0.00 0.00 10.00 0.0000 ALL
FEE FEE USAGE 01/01/2000 12/31/4000 N FLAT AMOUNT 0.00 0.00 100.00 0.0000 AL ~

Fee Definition

] B saveand sty | [ Save and Return | Ga Retun

Fee Rule CBCLF * Max Amt  100.00 * Channel AL
* Fee Type  CYCLE BASED COLLECTION LATE FI v

*start Dt 01/01/2000
*EndDt 12/31/4000 (B
* Enabled Selection Criteria
* Calc Method FLAT AMOUNT ns

* Percent 0.00 * Product AL

<1< ¢

* LF Assessment Allowed Days 999999 *State AL
* Currency ALL
*Txn Amt From 0.00
* Company  INO1 v Amount Financed From 0.00
*Threshold Amt 15.00

*Branch ALL >
*Min Amt 20.00

A brief description of the fields is given below:

Field: Do this:

Fee Rule Specify the fee rule used to identify the particular fee definition.

Fee Type Select the fee type from the drop-down list. The system computes
these drop-down values from the TXN_TYPE_CD Lookup, with FEE
as the sub type.

Start Dt Specify the start date. You can even select the date from the
adjoining Calendar icon.

End Dt Specify the end date. You can even select the date from the
adjoining Calendar icon.

Enabled Check this box to enable the fee.
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Field: Do this:

Calc Method | Select one of the following method of calculating the fee, from the
drop-down list.

If ‘Flat Amount' is selected, then minimum fee will be charged.

If ‘Percentage’ is selected, then the amount charged will be based
on percentage defined subject to minimum and maximum amount
(i.e. "Txn Amt From").

Threshold This field is enabled only if the Contract Fee type is either CYCLE
Amt BASED COLLECTION LATE FEE or CYCLE BASED LATE FEE.

Specify the threshold amount which is less than or equal to minimum
fee amount to be assessed. Based on this amount, system
calculates and posts the Cycle Based Collection Late Fee or Cycle
Based Late Fee based on the account.

If calculated fee amount is less than threshold amount, fee is posted
with transaction amount = 0.

If calculated fee amount is greater or equal to threshold amount, fee
is posted based on existing min amt and max amt comparing logic.

Min Amt Specify the minimum amount for the fee.

Max Amt Specify the maximum amount for the fee. If you selected FLAT
AMOUNT in the Calc Method field, then this field is not used and is
normally populated as $0.00.

Percent Specify the percentage value of the outstanding transaction amount
to be assessed as a fee. This amount will be adjusted to fall within
the Min Amount and the Max Amount.

Selection Criteria section

Company Select the portfolio company from the drop-down list. This may be
ALL or a specific company.

Branch Select the portfolio branch from the drop-down list. This may be ALL
or a specific branch. (This must be ALL, if you have selected ‘ALL’ in
the Company field).

Channel Select the channel from the drop-down list, This can be ALL or a
specific channel.

Product Select the product from the drop-down list. This may be ALL or a
specific product. The available values come from a validated field
based on the selected Billing Cycle setup and the Product setup.

State Select the state for this fee, from the drop-down list. This may be
ALL or a specific state.

Currency Select the currency for this fee, from the drop-down list. This may be
ALL or a specific currency.
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Field: Do this:

Txn Amt Specify the transaction or balance amount. The fee is calculated
From using the specifications of this record only if the transaction amount
is greater than the value specified in this field (and less than this
field in another record for the same fee).

IMPORTANT.:

When you select the fee to use, the system searches for a best
match using the following attributes:

1 Company

2 Branch

3 Product

4 State

5 Amount (Txn Amt From)

6 Effective/start date (Start Dt)

Hence, Oracle Financial Services Software recommends creating a
version of each fee, where ALL is the value in the these fields.

It is also recommended that you define a default printer for an
Organization, Division and Department.

Amount Specify the minimum value of amount financed on the contract.
Financed

From Note: This is the 'Contracted loan amount' during origination and

would always be the 'Amount Financed' on contract even if principal
addition is done through a transaction in servicing.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.7 Asset Billing Rate

In Asset Billing Rate screen you can setup the various parameters associated with ‘Home’
collateral which serves as the input for ‘Asset Billing’ batch job to process and post the dues
on to respective accounts in the system.

The chapter consists of following sections:

e Asset Billing Rate Definition

e Asset Billing Rate Details

e Asset billing Calculations

e Asset Billing Rate Setup - File upload
e Asset Billing Batch Job

4.71 Asset Billing Rate Definition

In the Asset Billing Rate Definition tab you can create and maintain ‘Timeshare’ specific Home
collateral and account details of an account which are used as a selection criteria.
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To set up Asset Billing Rate Definition

1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Asset Billing Rate.

opacLe

Financial Services Lending and Leasing

i

Asset Billing Rate [3€] Close
Asset Billing Rate Definition P Add | ZEdt | [5] View | o Audit
View v Format~ [ Freeze EAfi Detach Wrap (o]
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SG_RATE SG RATE Y SGOL SGHQ ALL ALL AL ALL ALL
SG_FLAT_AMOUNT  SG FLAT AMOUNT Y SGO1 SGHQ AL ALL AL AL ALL
ITR2_UDX_TESTL.. ITR2_UDX_TESTL.. Y SGOL SGHQ ISTISNA HOME LO... ALL AL ALL ALL v
> < >
Asset Billing Rate Details P Add | ZEdt | [F] View | o Audit
View v Format~ [ Freeze 4 Detach Wrap o)
Start Date Transaction Calc Method Flat Amt Rate Frequency % of Calc Amt Min Amt Max Amt Base Points
No data to display.
< >

2. In the Asset Billing Rate Definition section, perform any of the Basic Operations
mentioned in Navigation chapter. A brief description of fields are given below:

In this field: Do this:

Name Enter a uniqgue name for Asset Billing Rate definition. This
field is not editable after saving the record or during EDIT.

Description Enter the description for Asset Billing Rate definition.

Enabled Check this box to enable the record.

Selection Criteria

Company Select the portfolio company from the drop-down list. This list
is populated based on Enabled Company definitions main-
tained in the system.

Branch Select the portfolio branch from the drop-down list.

Product Select the type of product associated with the collateral from
the drop-down list.

State Select the state to which the account operates from the drop-
down list.

Channel Select the channel from the drop-down list.

Asset Type Select asset type from the drop-down list. The list is popu-

lated based on assets setup.

Asset Sub Type Select the asset sub type from the drop-down list.
Club Name Select the Club Name from the drop-down list.
Phase Number Select the Phase Number from the drop-down list.
Site of Inventory Select the Site of Inventory from the drop-down list.
Building Select the Building from the drop-down list.
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In this field: Do this:

Unit Select the Unit from the drop-down list.

Week Select the Week from the drop-down list.

Room/Unit Type Select the Room/Unit Type from the drop-down list.
Usage Type Select the Usage Type from the drop-down list.

Resort Identifier Select the Resort Identifier from the drop-down list.

Min Points Specify the minimum points for the asset billing definition.
Max Points Specify the maximum points for the asset billing definition.
Association Id Select the Association Id from the drop-down list.

Club Indicator Check this box to indicate Club Indicator.

Plus Membership Check this box to indicate Plus Membership Type.

Type

PR Marking Check this box to indicate PR Marking.

Signature Grand Check this box to indicate Signature Grand Father.
Father

Additional Attributes - This section consists of additional 15 configurable fields as
indicated below

5 check boxes - Membership 1-5 Opt

5 drop-down lists - Other Attribute 1-5

5 Calendar fields - Other Attribute 5-10

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.7.2 Asset Billing Rate Details

In the Asset Billing Details sub tab, you can define Transactions, their Calculation Method,
and other parameters which are posted by Billing Batch Job.

Note that once a record is created in this section, the same is available in Read-Only mode
and you can only Enable or Disable the record in Edit mode.

To set up Asset Billing Rate Details
1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Asset Billing Rate.

2. Inthe Asset Billing Rate Details section, perform any of the Basic Operations mentioned
in Navigation chapter. A brief description of fields are given below:

In this field: Do this:

Start Date Select the date of asset billing from adjoining calendar.
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In this field:

Do this:

Transaction

Select the transaction from the drop-down list.

This list is populated with transactions where the Transaction
code = FOTH%.

Calc Method

Select one of the following calculation method from drop-
down list.

- Flat Amt

- Rate

- Flat Amt + Rate
- Tiered Rate

- Slab Formula

For more information on above calculation methods, refer to
‘Asset billing Calculations’ section.

Flat Amt

Specify the flat amount or fixed amount to be charged during
asset billing calculation.

This field is available if the Calc Method is Flat Amt, Flat Amt
+ Rate, and Slab based Formula.

Rate

Specify the rate for asset billing calculation. This field is avail-
able if the Calc Method is Rate and Flat Amt + Rate.

Frequency

Select the frequency of asset billing calculation from the
drop-down list. The list is populated based on frequency
maintained in lookup code.

% of Calc Amt

Specify the percentage of amount for calculation. By default,
this is set to 100.

Base Points

Specify the base points for asset billing calculation. By
default this is set to 1 since a value is required system does
not allow to enter ‘0’.

This field is available if the Calc Method is Rate, Flat Amt +
Rate, Tiered Rate, and Slab Formula.

Slab Points

Specify the slab points for asset billing calculation. This field
is available if the Calc Method is Slab Formula.

% Increase

Specify the percentage increase in each slab for asset billing
calculation. This field is available if the Calc Method is Slab
Formula.

Min Amt

Specify the base minimum amount to be configured for the
resulted transaction amount.

If the resulted Transaction Calculation Amount is less than
the Min Amt defined here, system posts the transaction with
Min Amt.

Max Amt

Specify the maximum amount to be configured for the
resulted transaction amount.
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4.7.3

4.7.31

In this field: Do this:

Billing Year Specify the year in which the Rate is applicable.

The Billing Year is stamped in billing amount transaction
description only for FOTH% transactions.

Enabled Check this box to enable the Asset Billing Rate.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Tiered Rate Details sub tab

The Tiered Rate Details sub tab you can define ‘points’ specific tiers with different rates. This
sub tab is enabled only if the transaction calculation method is selected as ‘Tiered Rate’ in
Asset Billing Rate Details section. For calculation details, refer to ‘Tiered Rate Calculation’
section.

To set up Tiered Rate Details
1. On the Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Asset Billing Rate.

2. Inthe Tiered Rate Details section, perform any of the Basic Operations mentioned in
Navigation chapter. A brief description of fields are given below:

In this field: Do this:

From Points Specify the points from where the respective rate is applica-
ble.

Rate Specify the rate for defined points range.

Enabled Check this box to enable Tiered Rate detail

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Asset billing Calculations

This section explains the following calculation methods based on which the Asset Billing is
processed in the system:

e Flat Amount Calculation

e Rate Calculation

e Flat Amt + Rate Calculation
e Tiered Rate Calculation

e Slab Formula Calculation

Flat Amount Calculation

In ‘Flat Amount’ calculation, system calculates the Transaction Amount using below formula:

Frequency Billing Cycle | Transaction Amount Calculation

Annual Monthly (Flat Amt/12)

Monthly Annual (Flat Amt*12)
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4.7.3.2

4.7.3.3

4734

Frequency Billing Cycle | Transaction Amount Calculation
Annual Quarterly (Flat Amt/4)
Quarterly Annual (Flat Amt*4)
Annual Semi Annual (Flat Amt/2)
Semi Annual | Annual (Flat Amt*2)
Annual Annual (Flat Amt /1)

Consider the above calculation as reference for other combinations of Rate Frequency and

Billing cycle.

Rate Calculation

In ‘Rate’ calculation, system calculates the Transaction Amount using below formula:

Frequency Billing Cycle | Transaction Amount Calculation

Annual Monthly (Rate/12)*(Billing Points at collateral / Base Points)
Monthly Annual (Rate*12)*(Billing Points at collateral / Base Points)
Annual Quarterly (Rate/4)*(Billing Points at collateral / Base Points)
Quarterly Annual (Rate*4)*(Billing Points at collateral / Base Points)
Annual Semi Annual (Rate/2)*(Billing Points at collateral / Base Points)
Semi Annual | Annual (Rate*2)*(Billing Points at collateral / Base Points)
Annual Annual (Rate/1)*(Billing Points at collateral / Base Points)

Consider the above calculation as reference for other combinations of Rate Frequency and
Billing cycle.

Flat Amt + Rate Calculation

In ‘Flat Amt + Rate’ calculation, system calculates the Transaction Amount using below
formula.

Transaction Amount = Flat Amt + Rate * (Billing Points at Collateral/Base Points)

Note

The Rate and Flat amount are adjusted based on Frequency and Billing Cycle.

Tiered Rate Calculation

In ‘Tiered Rate’ calculation, system selects the ‘Asset Billing Rate Details’ using the Billing
Points at Asset and other asset parameters and calculates the transaction amount by deriving
the rate from Tiered Rate table.
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4.7.3.5

4.7.4

Transaction Amount = (Tiered Rate) * (Tiered Points / Base Points)

For example, if an Asset has 1.5 million points and the range is maintained as - for first million
points rate=0.66 with Base Points =1000 and for remaining points rate=0.60 with Base Points
= 1000, the Transaction Amount = 1million * (0.66/1000) + 0.5 million * (0.6/1000) = 660 + 300
= 960.

Note the following:

o If the range for specific points are not maintained correctly, the same is considered as
‘0’ rate and in-turn the Transaction Amount derived also becomes ‘0’

For example, if Billing Points are 8000 but if range maintained points is from 10000 with
Rate = 0.55 and Base Points = 1, the transaction amount results as (0*(8000/1) =0).

e Rate is adjusted based on Frequency and Billing Cycle as mention in ‘Rate’ Method.

Slab Formula Calculation

In ‘Slab Formula’ calculation, system calculates the Transaction Amount using below formula.

Transaction Amount = [Flat Amt] + Ceil[\{Billing Points - Base Points)/Slab
Points}*\{%Increase / 100)*Flat Amt}]]

The resultant amount will always be rounded-up.

For example,

Transaction Amount = [491.32+[{(61000-5000)/2500}*{(30.4/100)*491.32}]]
= [491.32+ [Round-up {22.4}*{149.36}]]

= [491.32+3435.28]

Transaction Amount = 3926.6

Note

The Rate and Flat amount are adjusted based on Frequency and Billing Cycle.

Asset Billing Rate Setup - File upload

The data in Asset Billing Rate screen can also be created and updated from an external file
through SET-IFP input file upload process. While doing so, ensure that the file format of
Header and Details record are maintained in required order and the input file is placed in
upload area.

During the scheduled batch job run, the asset billing batch job picks-up the data in input file
and loads on to the system to create Asset Billing Rate setup records.

However, before processing the details, system performs the following validations:

e If Name of the record is unique and duplicate record is not being updated.

e For Tiered Rate, the details are added only if the Calc Method = Tiered Rate. If not,
system displays an error indicating ‘Tiered Rate Details are not required for <Calc
Method>’ and the record is added in bad file.

e For update to existing record details, only Enable/Disable option is supported. If there
is @ mismatch in the name of the record, batch job errors out with message ‘Record not
found’ and the record is added in bad file.

e For new records, all the fields are mandatory and default values are applicable.
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e Values provided in fields which are of lookup type are validated with lookup code. In
case of mismatch, batch job errors out with message ‘Lookup value not matching’ and
the record is added in bad file.

e Negative values is not added for number fields.
e Base Point's field does not contain negative, ‘0’, or decimal values.

4.7.5 Asset Billing Batch Job

The billing batch job TXNDDT_BJ_100_01 (BILLING/DUE DATES PROCESSING) facilitates
to process the asset billing dues on account for ‘Home’ collateral and posts the corresponding
transactions.

Listed below is the sequence of processing steps:

1. Billing batch job picks-up the Vacation Ownership (VO) parameters from Servicing >
Account > Collateral (Home) > Vacation Ownership tab.

e The required accounts for Asset billing batch job processing is selected based on the
type of account selected in ‘Due Amt Account Type’ field. l.e. in “Vacation Ownership
Details’ section if the ‘Billing’ option is checked and the Due Amt Account Type is
selected as Current or Linked or Master Account, then the billing batch job posts the
transactions based on Asset Billing Rate setup in Current account or Linked Account of
current Account or Master Account of current Account respectively.

e In addition, system includes the asset billing points of Linked Account/Associated
Account only if the status of those accounts are in any of the status defined in lookup
code ‘ACC_STATUS_BILLING_CD’ (ACCOUNT STATUS FOR ASSET BILLING
CODES). Account statuses which are not maintained in the lookup code are excluded
for asset billing calculation. However, If no statuses are maintained in the lookup, then
system will consider all statuses for consolidation.

— Ifbilling flag is checked and Due Amt Account Type = Current Account, billing batch
job posts the transactions based on Asset Billing Rate setup in ‘Current’ account.

— Ifbilling flag is checked and Due Amt Account Type = Linked Account, billing batch
job post the transactions based on Asset Billing Rate setup in ‘Linked Account of
current Account’.

— If billing flag is checked and Due Amt Account Type = Master Account, billing batch
job post the transactions based on Asset Billing Rate setup in ‘Master Account of
current Account’.

Before the due calculation, batch job validates VO parameters with the following:

e If the selected Usage Type sub code is ‘FULL’, system considers Full points for rate
derivation and ‘Billing points’ is considered for Transaction Amount calculation.

e If the selected Usage Type sub code is ‘HALF’, system considers ‘Billing Points’ for
Transaction Amount calculation but rate is derived using full points.

e If the ‘First Year Proration’ check box is selected, then the rate is derived using full
points and the Transaction Amount is calculated based on prorated points (not on full
points).

e The prorated points are calculated based on Asset ‘Usage Start Date’.

— Ifthe usage start date year is equal to first due year, then system prorates the points
as indicated in example below:

If First Due Date = 01/01/2018, Usage Start Date = 01/10/2018,
Prorated Points = Billing Points * (13-1)/12= Billing Points *1

If First Due Date = 01/01/2018, Usage Start Date = 03/10/2018

Prorated Points = Billing Points * (13-3)/12= Billing Points*10/12
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Note: Number ‘13’ here is used as constant.

— If the usage start date year is before the due date year, system considers the full
points for calculating the Transaction Amount and no proration is required here.

Batch job looks of best matching Asset Rate details and Asset Billing definition in Setup.

Batch job checks for status (Y/N) of ‘Multiple Billing Asset Rate’ indicator at Account
Details > Contract > Billing level to decide if multiple asset rates are applicable for one
billing period or not.

If ‘N’, system picks the latest rate which is less than or equal to DUE DATE. In this case
only one best match record is fetched to derive Transaction Amount and no multiple
asset rates are applicable for one billing period.

If Y’, system fetches multiple rates only when rate End Date (i.e. rate start date + rate
frequency) ends with one or more cycle(s) before the next due date. This implies that
current rate record does not cover the entire billing period.

However, if ‘Multiple Billing Asset Rate’ is setto Y but there is no ‘Rate’ available for Due
period beyond the Rate End date, system applies the same rate that is picked for Due
Period which is Less than or Equal to Due End Date.

Batch job posts the matched transactions at account level based on calculation method.

The following Asset Billing Rate Details are stamped on the transaction posted:

— Asset Id (Assets)

— Asset Rate Id (Asset Billing Rate Definition)

— Asset Rate Details Id (Asset Billing Rate Details)
— Rate Start Date (Asset Billing Rate Details)

— Rate Frequency (Asset Billing Rate Details)

— Calculation Method (Asset Billing Rate Details)
— Rate (Asset Billing Rate Details)

— In case of Tiered Rate, Effective Rate is stamped
— Base Points (Asset Billing Rate Details)

— Slab Points (Asset Billing Rate Details)

— % Increase (Asset Billing Rate Details)

— Billing Year (Asset Billing Rate Details)

On posting the transactions, following validations and outcome are handled:

If the respective balance for transaction is missing, batch job fails with an error message
indicating ‘Account #: Transaction posting failed Balance not available’ in Batch >
Request Results block and does not process the account due amount calculation.

—  This can be rectified by posting ‘Add balance to Account’ non-monetary
transaction. For more information, refer to Appendix - Non-Monetary transactions
section in Servicing User Guides.

If the transaction posting failed due to an issue in Access grid configuration or Product
configuration at transaction codes, batch job displays error indicating ‘Account #:
Transaction posting failed <Reason>’ and does not process the account due amount
calculation.

If the Resulted transaction amount is less than Min Amount defined, batch job considers
the Min amount and posts the transaction.

If the Resulted transaction amount is greater than Max Amount defined, batch job
considers the Max amount and posts the transaction.
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4.8

Checklists

A checklist is an optional set of steps to follow when completing a task in the system, such as
the underwriting and funding processes.

Checklists can be used as guidelines to help ensure that the system users follow your
business’s standard operating procedures and enter all required data. Some checklists are
optional, but others such as those related to application decisions or contract verification, may
be required depending on the edit sets defined in your system. The Checklists screen allows
you to specify the contents of the checklist.

You can define additional checklists for your organization. You can set up multiple checklists
for a single type of checklist. These checklists can be differentiated by:

e Company

e Branch

e Product

e Account state

To set up the Checklists

You can either define new Checklist Type Definition details or specify a new code in the New
Checklist field and click Create Copy to create a copy of selected checklist type definition
with details.

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Checklists > Loan.

2. In the Checklist Type Definition section, perform any of the Basic Operations mentioned
in Navigation chapter.
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3. A brief description of the fields is given below:

Field:

Do this:

Checklist Code

Specify the checklist code that identifies checklist being defined.

Description

Specify the description for the checklist.

Checklist Type

Select the checklist type from the drop-down list, to define where the
specific checklist will be available in the system.

Company Select the portfolio company associated with the checklist from the
drop-down list. This may be ALL or a specific company.

Branch Select the portfolio branch associated with the checklist from the
drop-down list. This may be ALL or a specific branch. This must be
ALL if in the Company field you selected ALL).

Channel Select the channel from the drop-down list, This can be ALL or a
specific channel.

Product Select the product associated with the checklist from the drop-down
list. This may be ALL or a specific product. The available values
come from a validated list based on the selected Billing Cycle setup
and the Product setup.

State Select the state associated with the checklist type from the drop-down
list. This may be ALL or a specific state.

IMPORTANT: By selecting which edits type to use, the system
searches for a best match using the following attributes:

1 Company

2 Branch

3 Product

4 State

Hence, Oracle Financial Services Software recommends creating one
version of each checklist type where ALL is the value in these fields.

Currency Select the currency associated with the checklist from the drop-down
list. This may be ALL or a specific currency.

Enabled Check this box to enable the checklist.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

Checklist actions are steps (a set of one or more tasks) related to the checklist you are
creating. They are loaded on the Checklist Action Definition section.

5. In the Checklist Action Definition - Regular section, perform any of the Basic Operations
mentioned in Navigation chapter

A brief description of the fields is given below:

Field: Do this:
Action Code | Specify the action code for the checklist.
Description Specify the description for the action type.
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Field: Do this:

Sort Specify the sort order to define the placement of the action type on the
Checklist sub screen.

Enabled Check this box to include this action in the checklist.

6. Perform any of the Basic Actions mentioned in Navigation chapter.

7. In the Checklist Action Definition - Document section, perform any of the Basic
Operations mentioned in Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Action Code | Specify the action code for the checklist.

Description Specify the description for the action type.

Document Select the document type from the drop-down list.

Type

Document Select the document sub type from the drop-down list.

Sub Type

Document Check this box to indicate that the document is mandatory.

Mandatory

Sort Specify the sort order to define the placement of the action type on the

Checklist sub screen.

Enabled Check this box to include this action in the checklist.

8. Perform any of the Basic Actions mentioned in Navigation chapter.

Statement Messages

The Messages screen allows you to set up messages that appear on account statements sent
to customers. You can set up statement messages for different products. When the system

generates a statement for an account, all statement messages matching the selection criteria
are included in the statement file for that account.

The system inserts the message in the Text field into the statement file produced during the
nightly batch job for the appropriate consumers.

A record of an account’s statement history, including the messages included in the statement,
appears on the Statement’s screen on the Customer Service screen.

To set up the Messages

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Statement Messages > Loan.
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2. In the Statem

ent Messages section, perform any of the Basic Operations mentioned in

Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Seq Specify the sort sequence of how the statement message should be
printed.

Code Specify the message code identifying the statement message.

Start Dt Specify the first date the statement message is available. You can
even select the date from the adjoining Calendar icon.

End Dt Specify the last date the statement message is available. You can
even select the date from the adjoining Calendar icon.

Enabled Check this box to enable the message.

Result section

Text

Specify the text of the statement message.

Selection Crite

ria section

Company Select the company for the statement message from the drop-down
list. This may be ALL or a specific company.

Branch Select the branch within the company for the statement message from
the drop-down list. This may be ALL or a specific branch. This must be
ALL if in the Company field you selected ALL.

Product Select the product for which this statement message will be used from

the drop-down list. This may be ALL or a specific product.
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Field: Do this:

Currency Select the currency for the statement message from the drop-down
list. This may be ALL or a specific currency.

Producer Select the producer for the statement message from the drop-down
list. This may be ALL or a specific producer. The available values
come from a validated field based on the Pro Group and Pro Type.
IMPORTANT: By selecting which message to use, the system
searches for a best match using the following attributes:

1. Company

2. Branch

3. Product

4. Producer

5. Currency

Hence, Oracle Financial Services Software recommends creating one

version of each edit type where ALL is the value in these fields.
Letters

The Letters screen allows you to define letters that the system automatically generates when
the application or the account for a products meets certain conditions, or “trigger events.”
Each letter has its own trigger event. For example, you can configure the system to
automatically send a welcome letter when an application becomes an account or send a
collection letters when an account becomes delinquent.

The system supports the following types of letters:

Type of letter:

Definition:

Action letter

ACCOUNT Generated when account is to receive a billing statement (this time is
STATEMENT defined in contract setup). Letter is sent to customer.
ADVERSE Generated in nightly batch jobs for applications that were declined.

This letter is sent to the consumer to indicate the reasons why the
application was declined.

CONDITIONAL Generated in nightly batch jobs for applications that were
ADVERSE
ACTION declined. This letter is sent to the consumer to indicate the reasons
LETTER why the application was declined. This letter also indicates steps that
the consumer may take to gain approval of the application.
COLLECTION Generated when an account becomes delinquent. This is the first
LETTER 1 dunning letter sent to the customer.
COLLECTION Generated when an account remains in delinquency for an extended
LETTER 2 period. This is the second dunning letter sent to the customer.
COLLECTION Generated when an account remains in delinquency for an extended
LETTER 3 period, even after having received previous notices. This is the final

dunning letter sent to the customer.
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Type of letter: Definition:

CONTRACT Generated when an application is APPROVED: FUNDED or
FUNDING fax/ CONDITIONED: FUNDED. This letter is sent to the producer.
email

DECISION FAX/ Generated when an application is APPROVED, CONDITIONED, or
EMAIL REJECTED. This letter is sent to the consumer or producer,
depending on whether the product is a direct or in-direct loan.

PAID IN FULL Generated in nightly batch jobs when the account pays off. This letter
LETTER is sent to the customer.

PAYOFF Generated when a payoff quote is created for an account. This letter
QUOTE is sent to the customer.

LETTER

WELCOME Generated when an application is APPROVED: FUNDED. This letter
LETTER is sent to the consumer.

STATEMENT PAST MATURITY Generated when an accounts are
matured but unpaid.

This letter is sent to the account holders as a reminder to make their
payments.

When the system generates letters, it searches the Letters screen for letter definitions that
meet the following criteria:

e Definition is enabled.
e Definition is an exact match of the letter code being generated.
e Definition is a match of either the application/account value or ALL for all other criteria.

Exact matches for each field are given a higher weight than matches to ALL.

The returned rows are then given a descending rank based on the weighted values and the
hierarchical position of these fields:

Company

Branch

Product

State

o D=

Currency

On the ranked rows, the first row is returned as the best match.

To set up the Letters

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Administration > User > Products > Letters > Loan.

4-58 ORACLE



2. In the Letter Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:
Field: Do this:
Letter Code Specify the code for the letter.
File Name Specify the file name of the Oracle report used to generate the letter.

The file should be named <File Name>.rep on your server.

Letter Type Select the type of letter you want to generate from the drop-down list.

Channel Select the application source (channel) for the letter from the drop-down
list. This may be ALL or a specific channel.

Enabled Check this box to enable this letter definition.

Result section

Batch Printer | Select the batch printer being used to generate the letter from the drop-
down list.

Batch User Select the user who will submit this letter from the drop-down list. This
will normally be set to BATCH.

Selection Criteria section

Company Select the portfolio company for which this letter will be used from the
drop-down list. This may be ALL or a specific company.

Branch Select the portfolio branch for which this letter will be used from the
drop-down list. This may be ALL or a specific branch. This must be ALL
if in the Company field you selected ALL).
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Field: Do this:

Product Select the product for which this letter will be used from the drop-down
list. This may be ALL or a specific product.

State Select the state for which this letter will be used from the drop-down list.
This may be ALL or a specific state.

Currency Select the currency for which this letter will be used from the drop-down
list. This may be ALL or a specific currency.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Subvention

The Subvention Setup screen’s loan Subvention tab allows you to set up Loan subvention
plans for producers (groups or individuals). Multiple producers may contribute to one
subvention plan or a plan can be set for a specific producer.

Subvention Types

Subvention can be offered in many forms for vehicle loans. The most common format is the
rate subvention for vehicle loans. Rate subvention involves sharing the finance charge
(interest) by the participant (most frequently with the manufacturer). The finance company
sets its buy rate (the minimum cost to the company to extend the loans to a customer). If the
customer rate is less than this buy rate, then the amount is equivalent to the interest amount
for the difference (the buy rate minus the customer rate) is paid by the participant as the
subvention amount.

Currently Oracle Financial Services Lending and Leasing supports the following subvention
types:
Loan subvention types:

e Rate

e Cash bonus
e Buydown

Subvention plans can be defined for one participant (for example, a manufacturer or a
particular dealer) or group of participants (such as a dealer association). One subvention plan
could have multiple sub plans and multiple participants could participate to each sub plan.

Example

Subvention plan:

e “Summer Special Event”
Subvention sub-plans for above plan:
e 1.9% for 36 months

- or -

o 2.99% for 48 months
- or -

e 3.99% for 60 months
- Or -

e $1500.00 cash bonus
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Multiple participants may participate in each sub plan. For example, for the 1.9% rate, 1%
might be shared by the manufacturer and 0.9% might be shared by the dealer. Similarly, for
the $1,500 cash bonus, $1,000 might be shared by the manufacturer and $500 by the dealer.
Or, the complete $1,500 might be covered by the manufacturer.

Collection of subvention amounts can be set for each participant in the subvention plan with
the Collection Method.

Oracle Financial Services Lending and Leasing supports following collection methods:

Type Details

UPFRONT The entire subvention amount is collected at the booking of the Loan
from the producer proceed.

UPFRONT The entire subvention amount is collected at the time of the subven-

STATEMENT tion statement.

PAY AS U GO The subvention amount is billed to the producer when the customer
pays the Loan payment. The producer is due for the amount at each
statement.

Subvention Refund

There are times when a Loan is either paid-off early or gets charged off and the finance
company refunds the unearned subvention amount back to the producer. The refund is
available only when the subvention amount is collected from the producer proceeds
(UPFRONT) or the whole amount is billed in the first statement (UPFRONT STATEMENT).

You can set up the system to allow refunds only for a certain period and not beyond that. The
period can be set differently for charge offs and paid offs and can be based on two methods:
1. Days

2. Term

The system provides the following methods for refund amount calculation:
1. Earned

2. Percentage

The earned method is used to refund the unearned portion of the collected subvention
amount. The percentage method is used to refund a certain percentage of the subvention
amount collected.

Loan Subvention Plans

The Loan Subvention Plans screen allows you to set up subventions for Loans.

To set up the Loan Subvention Plans screen.

1. On the Oracle Financial Services Lending and Leasing home screen, Click Setup >
Setup > Products > Subvention > Loan.

2. The system displays the Loan Subvention screen. The details are grouped into three.
e Plan Definition
e Sub Plan Definition

e Plan Details.
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3. In the Plan Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Code Specify the subvention plan code.

Description Specify the subvention plan description.

Company Select the company name from the drop-down list.

Branch Select the branch name from the drop-down list.

State Select the state from the drop-down list.

Start Date Specify the start date for the subvention plan (required). You can select
the date even from the adjoining Calendar icon.

End Date Specify the end date for the subvention plan. You can select the date
even from the adjoining Calendar icon.

Enabled Check this box to activate the record.

Selection Criteria

Billing Cycle Select billing cycle from the drop-down list.
Product Select the product from the drop-down list.
Asset Class Select the asset class from the drop-down list.
Asset Type Select the asset type from the drop-down list.
Asset Sub Select asset sub type from the drop-down list.
Type

Asset Make Select asset make from the drop-down list.
Asset Model Select the asset model from the drop-down list
Asset Age Specify the asset age.

4. Perform any of the Basic Actions mentioned in Navigation chapter.

5. In the Sub Plan Definition section, perform any of the Basic Operations mentioned in
Navigation chapter.

A brief description of the fields is given below:

Field: Do this:

Code Specify the subvention sub plan code.

Description Specify the subvention sub plan description (required).
State Select the state from the drop-down list.

Pro Group Select the producer group from the drop-down list.

4-62

ORACLE



Field: Do this:

Pro Type Select the producer type from the drop-down list.
Producer Select the producer from the drop-down list.
Enabled Check this box to activate the record.

AmtFrom Specify the amount.

Subvention Select the subvention type from the drop-down list.
Type

Grade Select the grade from the drop-down list.

Term Specify the term.

Asset Class Select the asset class from the drop-down list.
Asset Type Select the asset type from the drop-down list.
Sub Type Select asset sub type from the drop-down list
AssetMake Select asset make from the drop-down list.
AssetModel Select the asset model from the drop-down list
Age Specify asset age.

6. Perform any of the Basic Actions mentioned in Navigation chapter.
7.

chapter.

A brief description of the fields is given below:

In the Plan Details section, perform any of the Basic Operations mentioned in Navigation

Field:

Do this:

Participant

Select the participant from the drop-down list.

Collection Method

drop-down list.

Select the collection method for the subvention plan from the

Transaction Select the transaction code from the drop-down list.
Rate Specify the subvention rate.
Enabled Check this box to activate the record.

Calculation section:
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Field: Do this:

Method Select the subvention calculation method from the drop-down
list. The list displays the following values:

- SPREAD DEFAULT

- SPREAD DEFAULT - (minus) PRESENT VALUE
- FLAT AMOUNT

- % OF AMT FINANCED

- % OF AMT FINANCED + FLAT AMOUNT

Override Check this box to allow overriding the rate at the time of under-
writing / funding.

Max Amt Specify the maximum subvention amount.
% Amt Financed Specify the percentage of amount financed to derive the Subven-
tion Amount.

For example: If Amount Financed = 100$, and % of Amt
Financed = 5%, then the Subvention Amount = 100 * 0.05 = 5%

Flat Amt Specify the flat amount.
Factor Specify the subvention factor.
Spread Max Specify the maximum subvention spread value.

Refund section:

Paid Off Method Select the method from the drop-down list, if the account is paid-
off early.

Paid Off Basis Select the basis from the drop-down list, if the account is paid-off
early.

Paid Off Period Specify the number of terms in which the subvention can be

refunded to the producer, if the account is paid-off early.

Paid Off Percent Specify the refund percentage, if the account is paid-off.
Charge Off Calc Select the calculation method from the drop-down list, if the
Method account is charged-off.

Charge Off Basis Select the charge off basis from the drop-down list.

Charge Off Period Select the charge off period from the drop-down list.

Charge Off Percent | Select the charge off percent from the drop-down list.

Amortization section:

Balance Type Select the amortize balance type from the drop-down list.
Method Select the amortize method from the drop-down list.
Frequency Select the amortize frequency from the drop-down list.
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Field: Do this:

Cost / Fee Select the cost / fee from the drop-down list.

Perform any of the Basic Actions mentioned in Navigation chapter.
Escrow

Oracle Financial Services Lending and Leasing provides tax and insurance escrow for loans.
The Escrow screen contains subsection that allow you to set up these features.

This chapter explains the Escrow screen and how to set up escrow in the system.
Escrow

The Escrow Definition screen allows you to review or set up escrow definitions for taxes and
insurance and note whether or not cushion is allowed.
Navigating to Escrow

1. Onthe Oracle Financial Services Lending and Leasing home screen, click Setup > Setup
> Products > Escrow. The Escrow details can be setup across three subsections:

e Escrow
e Shortage/Cushion Rules
e Disbursement Rules

Escrow

To setup Escrow
1. Click Setup > Setup > Products > Escrow > Escrow.

2. In the Escrow Definitions section, perform any of the Basic Operations mentioned in
Navigation chapter.
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A brief description of the fields is given below:

Field: Do this:

Escrow Specify the escrow code. This is protected against update and
cannot be changed after initial set up.

Description Specify the escrow description.

Escrow Type

drop-down list.

Select the escrow type, usually INSURANCES or TAXES from the

Cushion Allowed

should be retained.

Check this box if the escrow you are defining allows for cushion.

Note: Cushion rules are used to determine how much cushion

Incl 1098

Check this box to include in 1098 reporting.

Enabled

Check this box to enable the escrow definition.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4.12.1.2 Shortage/Cushion Rules

In Shortage/Cushion Rules, you can review and set up escrow analysis shortage/cushion
rules. Shortage/cushion rules determine how much cushion you are allowed on a particular
escrow line and if there is a predicted shortage, how to eliminate it by increasing payment.

To setup Shortage/Cushion Rules

1. Click Setup > Setup > Products > Escrow > Shortage/Cushion Rules.

2. In the Rules section, perform any of the Basic Operations mentioned in Navigation

chapter.
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A brief description of the fields is given below:

Field: Do this:

Rule Specify the rule code. This is protected against update and cannot be
changed after initial set up.

Description Specify the rule description.

Start Dt Specify the start date for this rule. You can even select the date from the
adjoining Calendar icon.

End Dt Specify end date for this rule. You can even select the date from the
adjoining Calendar icon.

Enabled Check this box to enable the rule.

Parameters section

Shortage Select the shortage threshold, either an amount or number of install-
Threshold ments, from the drop-down list.

Shortage Specify shortage threshold value.

Value

Shortage Specify shortage spread increase percent.

Spread

Increase%

Term Specify shortage spread term.

Max Term Specify the maximum amount of shortage spread terms.
Surplus Amt | Specify surplus threshold amount for this rule.
Company Select the company for this rule from the drop-down list.
Branch Select the branch for this rule from the drop-down list.
Product Select the product for this rule from the drop-down list.
State Select state for this rule (required).

IMPORTANT: When you select which escrow rule to use, the system
searches for a best match using the following attributes:

1. Company
2. Branch
3. Product
4. State

Hence, the system recommends creating one version of each rule,
where ALL is the value in these fields.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

4. Inthe Rule Details section, perform any of the Basic Operations mentioned in Navigation

chapter.
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A brief description of the fields is given below:

Field:

Do this:

Escrow Type

Select escrow type from the drop-down list.

Cushion Type

Select cushion type from the drop-down list.

Cushion Value Specify cushion value.

5. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

While considering the cushion rules, preference is provided either for all records and then

for Insurances or taxes maintained in a particular shortage or cushion rule.

4.12.1.3 Disbursement Rules

The Rules screen allows you to define the disbursement rules for your escrow.

To setup Disbursement Rules
1. Click Setup > Setup > Products > Escrow > Disbursement Rules.

2. In the Escrow Disbursement Rules section, perform any of the Basic Operations

mentioned in Navigation chapter.
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A brief description of the fields is given below:

Field:

Do this:

Disbursement Rule

Specify the disbursement rule. This is protected against the
update and cannot be changed after initial set up.
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Field: Do this:

Description Specify the description.

Company Select the company from the drop-down list.

Branch Select the branch from the drop-down list.

Start Dt Specify the start date. You can even select the date from the

adjoining calendar icon.

End Dt Specify the end date. You can even select the date from the
adjoining calendar icon.

Enabled Check this box to enable this disbursement rule.

Disbursement section

Jan% Specify the percent to be disbursed in January.

Feb% Specify the percent to be disbursed in February.

Mar% Specify the percent to be disbursed in March.

Apr% Specify the percent to be disbursed in April.

May% Specify the percent to be disbursed in May.

Jun% Specify the percent to be disbursed in June.

Jul% Specify the percent to be disbursed in July.

Aug% Specify the percent to be disbursed in August.

Sep% Specify the percent to be disbursed in September .

Oct% Specify the percent to be disbursed in October.

Nov% Specify the percent to be disbursed in November.

Dec% Specify the percent to be disbursed in December.

Total% Displays total annual disbursement percentage. This figure is
the sum of the monthly disbursements and must equal 100 per-
cent.

3. Perform any of the Basic Actions mentioned in Navigation chapter.

Note

You cannot save the disbursement rule, if the Total% is not equal to 100.
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Appendix A:System Parameters

Introduction

System defined parameters help in configuring system specific data, User-access, location of
system files; reports related URLs and other administration controlled data. These are
essential to be configured during installation and some of them by nature of application will
have to be reviewed and maintained in a regular and periodic manner.

Following are the types of parameters are used in OFSLL system depending on the areas of
the system that these would apply and impact:

System Parameters

Organization Parameters

Company Parameters

Other Parameters

Note

All the above parameters can be controlled (enabled/disabled) only by System Adminis-
trators, and users with Admin/Super User privileges who would be involved in setting-up
OFSLL system.

System Parameters

System parameters apply to the entire system. They relate to the overall processing of the
system like application server file locations, data purging configurations and so on. Table
below details the list of system parameters with their description and pre-defined values.

Parameter Description

ACA_DLQ_AMT_EX- This parameter is used to exclude delinquency amount for
CLUDED account ACH

ACA_PAYMENT_AU- This parameter is used to control posting directly from the
TO_LOAD ACH file that has been created for customer payments.

Input parameter value is Boolean (Yes/No). If the parame-
ter is set to Y’, the system automatically creates payment
batches for the payments in the ACH file and posts them
on the day of payment.

ACA_PRENOTE_DAYS This parameter is used to define the number of days the

prenote should be initiated for customer ACH (Automated
Clearing House) accounts. Input parameter value is

numeric.
ACA_PRE_PROCESS - This parameter is used to specify the number of days
DAYS before draft day for Account ACH process. Input parameter

value is numeric.

ACH_PAYEE_PRENOTE_- | This parameter is used to define the number of days for
DAYS prenote to occur for Producer or Vendor ACH accounts.

Input parameter value is numeric

A1 ORACLE



Parameter

Description

ADMIN_SERVER_URL

This parameter is used to define the admin server URL

ADR_DIRECTORY

This parameter is used to define the Oracle Directory
Object Name for ADR file location

ADR_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle Directory
Object Name for ADR file location

AGE_APPROVED_CON-
DITIONED_DAYS

This parameter is used to specify the number of days by
which an application in ‘Approved’ or ‘Conditioned’ status
is treated as Aged Application. Input parameter value is
numeric with no upper limit.

AGE_CONTRACT_DAYS

This parameter is used to specify the number of days by
which a contract is treated as Aged Contract. Input param-
eter value is numeric with no upper limit.

ASC_COL_SER_ENA-
BLED_IND

This parameter is used as the Collection Servicing Ena-
bled Indicator

CAC_DIRECTORY

This parameter is used to define the Oracle Directory
Object Name for CAC file location

CAC_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle Directory
Object Name for CAC file location

CHECK_PRINT_PREVIEW

Using this parameter we can allow preview of application in
pdf form before printing. Input parameter value is Boolean
(Yes/No).

CMN_AMOUNT_ROUND_
FACTOR

This parameter is used to define the rounding factor for
applicable fields (in this case calculated amounts). Input
parameter value is ‘ROUND AMOUNT TO 2 DECIMALS'.
Currently system supports rounding factor 2 only.

CMN_AMOUNT_ROUND_
METHOD

This parameter is used to define the amount round method
during system set-up and would be applicable for all calcu-
lated amounts (calculated fees, payment etc.) across the
application. Input values are ROUND, RAISE and CUT-
OFF:

ROUND: Rounded to nearest number higher or lower
RAISE: Rounded to the nearest higher number

CUTOFF: Truncate the digits without rounding or raising

CMN_APP_ACC_TI-

This parameter is used to set the Application or Account

TLE_FN_LN title in one of the formats — First/Last Name or Last/First
Name. Input parameter value is Boolean (Yes/No). If Yes is
chosen, title would be in the format — First/Last Name, else
the other option.

CMN_APP_- This parameter is used to set the Application Server Home

SERVER_HOME

Directory. Input parameter value is user defined.

CMN_CURRENT_MOD-
EL_YEAR

This parameter is used to default the Current Model Year.

CMN_DEBUG_LEVEL

This is the Common Debug Level
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Parameter

Description

CMN_DEBUG_METHOD

This parameter allows to define the location to which
generic debug logs (other than Alert/Warning and GRI) are
to be written. If set to ‘ADVANCE_QUEUFE’, system writes
the logs in Logs table and if set to ‘UTL_FILE’, system gen-
erates the alert log file.

CMN_-
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the incoming or outgoing files/documents are to be pro-
cessed. If set to Y’, system processes the data to/from
LOB and if set to ‘N’, system processes the data to/from
FILE.

The same is used by the batch jobs available in SET-IFP
(input file processing) Batch Job Set.

CMN_GL_POST DT

This parameter is used to specify the General Ledger Post-
ing date. If scheduler is enabled, it automatically updates
this to current system date. Else Admin User would need
to set this date manually to ensure correct posting dates in
GL.

CMN_HTTP_PROX-
Y_PORT

This parameter is enabled to specify the port to be used for
outgoing HTTP connections. Input parameter value is user
defined.

CMN_HTTP_PROXY_-
SERVER

This parameter is enabled to specify the proxy server to be
used for outgoing HTTP connections. Input parameter
value is user defined. There exists an interdependency of
this parameter with CMN_HTTP_PROXY_PORT men-
tioned above.

CMN_INT_360_ACCRU-
AL_DAYS_MTHD

This parameter is used to specify the interest accrual
method for 360 days, to be used by the System for all cal-
culations with interest. Currently two methods are sup-
ported. Input parameter value is ‘US’ or ‘EU’ representing
American and European method of interest accrual for 360
days.

CMN_TEST_TOOL_LOG-
GING

This parameter is used to set testing tool logging parame-
ter

CMN_SCHEMA_ID

This is used to specify the schema identifier for all users.

CMN_SCHEMA_NAME

This is used to specify the Oracle User Name for a specific
schema. Input parameter value is user defined.

CMN_SCHEMA_PASS-
WORD

This captures the password for Oracle, for the specific
schema. Input parameter value is user defined. This
parameter need not be enabled when in Oracle Network.

CMN_SERVER_HOME

This parameter captures the Server Home Directory. Input
parameter value is user defined.

CMN_-
SERVER_TEMP_DIR

This parameter is used to specify the temporary directory
on the server along with the path. Input parameter value is
user defined.
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Parameter

Description

CMN_SER_ENVIRON-
MENT_FILE

This parameter captures the environment file (and its path)
for running the Operating System commands from Job
Service. Input parameter value is user defined.

CMN_WALLET_PASS-
WORD

This parameter is used to specify the common wallet pass-
word. Input parameter value is user defined.

CMN_WALLET_PATH

This parameter is used to specify the common wallet path
for oracle database. Input parameter value is user defined.

CPP_NO_OF_PROMISES

This parameter is used to define the maximum number of
promises/chances allowed for a customer who is delin-
quent and promises to pay. Input parameter value is
numeric with no upper limit.

CPP_PROMISE_HELD -

This parameter is used to define the maximum number of

DAYS days after the promises made by the customer to pay are
broken to initiate further actions. Input parameter value is
numeric with no upper limit.

CRD_CHS BIN This parameter holds the value of the credit card BIN

(Bank Identification Number for Credit Cards), for CHASE
interface. Input parameter value is user defined.

(P.S: OFSLL supports CHASE interface for credit card pay-
ments processing)

CRD_CHS_CUR_CODE

This parameter is used to specify the currency code of the
transacting currency for CHASE interface. Input parameter
value is user defined.

CRD_CHS_DIR_PATH

This parameter is used to specify the directory path for
CHASE payment interface for Credit Cards. Input parame-
ter value is user defined.

CRD_CHS_IND_TYPE

This is used to specify the industry type for CHASE pay-
ment interface for Credit Cards. Input parameter value is
user defined.

CRD_CHS_MER-

This captures the merchant ID number for CHASE pay-

CHANT _ID ment interface for Credit Cards. Input parameter value is
user defined.
CRD_CHS_RE- This captures the remote host name for seeking approvals

MOTE_HOST_NAME

for CHASE payment interface. Input parameter value is
user defined.

CRD_CHS_SEC_RE-
MOTE_HOST_NAME

Similar to the previous parameter this captures the sec-
ondary remote host name of CHASE interface for seeking
approvals for credit card payments. Input parameter value
is user defined.

CRD_CHS_TIMEOUT

This parameter is used to define the timeout limit when
polling the interface for processing credit card payments.
Input parameter value is numeric.
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Parameter

Description

CRD_CHS_USR_ID

This parameter captures the user id for CHASE interface
which is required whenever the System needs to access/
seek authorizations/process payments for credit cards etc.
Input parameter value is user defined.

CRD_PTB_RE-
MOTE_HOST_NAME

This is the Protobase Remote Host Name

CRD_PTB_RE-
MOTE_HOST_PORT

This is the Protobase Remote Host Port

CRD_PTB_TIMEOUT

This is the Protobase Timeout Value

CRD_SOURCE_TYPE_CD

This is the Source Type Code

DDT_CREATE_DUE_-
DATE_HISTORY

This parameter must be enabled to create a due date his-
tory for any account. Due date history sub tab under Trans-
action history displays the delinquency history of an
account in a tabular format detailing Due date, Due
Amount, Last Payment date, Payment Amount, Balance
Amount, Days past due and Payment received flag. The
input parameter value for this parameter is Boolean (Yes/
No).

DECI-
SION_BUY_RATE_TOL-
ERANCE

This parameter is used to define the variance in buy rate

EDF_DIALER_ACCT -
TYPE

This parameter is used to set up the account number refer-
ence for the dialer file to pick-up records for Auto dialer
interface. Input parameter value is account number.

FLL_BPEL_PROCESS

This parameter is set to use BPEL process in OFSLL.
Input parameter value is Boolean (Yes/No).

ICA_INPUT_FILE_FOR-
MAT

This parameter is used to define the input call activity file
format

IFD_DIRECTORY

This parameter is used to define the Oracle directory
object name for IFD file location

IFD_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle directory
object name for IFD file location

INCOM-
ING_LOB_PURGE_DAYS

This parameter is used to define the incoming process file
table purge days

INPUT_DIRECTORY

This parameter is used to define the Oracle directory
object name for INPUT file location

ITU_DIRECTORY

This parameter is used to define the Oracle directory
object name for ITU file location

ITU_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle directory
object name for ITU file location

IVR_DIRECTORY

This parameter is used to define the Oracle directory
object name for IVR file location
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Parameter

Description

IVR_PROCESSED_DI-

This parameter is used to define the Oracle directory

RECTORY object name for IVR file location

JSC_TIMEOUT This parameter is used to set the polling interval for job
scheduler. Input parameter value is numeric. To check
whether it represents minutes/seconds.

JSV_ARCHIVE_- This parameter is used to set the configuration file for

SERVER_CONFIG

reports archive server. Input parameter value is user
defined.

JSV_ARCHIVE_-
SERVER_URL

This parameter is used to specify the archive server url.
Input parameter value is user defined.

JSV_BI_PASSWORD

This parameter is used to define the Bl Publisher Pass-
word

JSV_BI_USER

This parameter is used to define the Bl Publisher User ID

JSV_TEMPORARY_DI-
RECTORY

This parameter is used to define Oracle directory object
name for Job Service Temp file location

JSV_BI_PASSWORD-
JSV_REPORTS_RUNT-
IME

This parameter is to specify the reports runtime program.
Input parameter value is user defined.

JSV_REPORTS_RUNT-
IME_CMDFILE

This parameter is used to specify the reports runtime com-
mand file. Input parameter value is user defined.

JSV_REPORTS_-
SERVER_CONFIG

This parameter is used to specify the configuration file for
reports server. Input parameter value is user defined.

JSV_REPORTS -
SERVER_URL

This is used to specify the URL for the reports server. Input
parameter value is user defined.

JSV_REPORT_AR-
CHIVE_DIRECTORY

This is used to specify the path and directory of Reports
archive, input parameter value being numeric.

JSV_SMTP_SERVER

This parameter specifies the SMTP server used by job ser-
vice for sending email messages. Input parameter value is
user defined.

JSV_TIMEOUT

This is to specify the polling interval for the job service dur-
ing time out. Input parameter value is numeric. To check
whether it represents minutes/seconds.

JSV_USE_BI_PUBLISHER

This parameter defines whether Bl publisher should be
used to process reports are not. Input parameter value is
Boolean (Yes/No).

JSV_USE_REPORTS_-
SERVER

This parameter is used to specify whether reports server
from job service should be used or not. Input parameter
value is Boolean (Yes/No).

LBX_TXN_GROUP-
ING_CNT

This parameter is used to specify the no. of records per
batch for payment transactions and lock box batch
records. Input parameter value is numeric.
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Description

LCO_COL_LET-
TER1_GEN_DAYS

This parameter specifies the number of days post which
first collection letter should be generated for accounts with
dues unpaid. Input parameter value is numeric.

LCO_COL_LET-
TER2_GEN_DAYS

This parameter specifies the number of days post which
second collection letter should be generated for accounts
with dues unpaid. Input parameter value is numeric.

LCO_COL_LET-
TER3_GEN_DAYS

This parameter specifies the number of days post which
third collection letter should be generated for accounts with
dues unpaid. Input parameter value is numeric.

LIEN_RELEASE_DAYS

This parameter is used to define the Lien Release Days

LOCKBOX_DIRECTORY

This parameter is used to define the Oracle directory
object name for Lockbox file location

LOCKBOX_PRO-
CESSED_DIRECTORY

This parameter is used to define the Oracle directory
object name for processed Lockbox file location

LOR_ADVERSE_AC-
TION_GEN_DAYS

This parameter is used to specify the number of days after
the third collection letter post which the adverse action let-
ter is to be generated. Input parameter value is numeric.

LOG_LOB_PURGE_DAYS

This parameter is used to log files header table purge days

MAX_AGED_TXN_AU-
THORIZE_DAYS

This parameter is used to specify the maximum number of
days within which a transaction should be authorized. Input
parameter value is numeric and represents the number of
days.

MAX_VOID_TXN_AU-
THORIZE_DAYS

This parameter is used to set the maximum days to author-
ize transaction

OCP_CUSTOMER_P-
MT_SITE_ID

This parameter is used to set the customer payment
extract file site id

OCP_IN-
CLUDE_ACH_ACC

This parameter is used to set the customer payment
extract including ach accounts

OUTGO-
ING_LOB_PURGE_DAYS

This parameter is used to define the outgoing process file
table purge days

OUTPUT_DIRECTORY

This parameter is used to define Oracle directory object
name for OUTPUT file location

PAC_ARCHIVE_DAYS

This parameter is used to define number of days for peri-
odic archiving of account. Input parameter value is
numeric.

PAC_OARCHIVE_DAYS

This parameter is used to define the number of days for
archiving accounts from ‘O’ tables i.e. old tables. Input
parameter value is numeric

PAP_ARCHIVE_DAYS

This parameter is used to define the number of days for
archiving applications on a periodic basis. Input parameter
value is numeric.
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PAP_OARCHIVE_DAYS

This parameter is used to define the number of days for
archiving applications from ‘O’ tables. Input parameter
value is numeric.

PCU_CHECK_REFUND_-
DAYS

This parameter is used to specify the maximum number of
days within which an overpayment from the customer can
be refunded. Input parameter value is numeric.

PDC_PRE_PROCESS_-
DAYS

This parameter value will define the number of days prior
to the due day, regular account PDC process should be ini-
tiated. Input parameter value is numeric.

PENDING_PDC_DAYS

This parameter value will define the number of days before
the initiation day for pending PDC accounts.

PGL_ARCHIVE_DAYS

This parameter defines the number of days, post which the
transactions in GL would be archived. Input parameter
value is numeric

PGL_OARCHIVE_DAYS

This parameter is used to define the number of days, post
which the transactions in GL will be moved to the ‘O’
tables. Input parameter value is numeric.

PJR_PURGE_DAYS

This parameter is used to specify the days post which the
job requests are to be purged. Input parameter value is
numeric.

POD_PURGE_DAYS

This parameter is used to define the number of days after
which the Output data file headers are to be purged. Input
parameter value is numeric.

PPA_ARCHIVE_DAYS

This parameter is used to specify number of days after
which pools and its transactions archiving is to be done to
‘O’ tables. Input parameter value is numeric.

PPA_OARCHIVE_DAYS

This parameter is used to specify number of days after
which pools and its transactions archiving is to be done to
‘O0’ tables. Input parameter value is numeric

PPR_ARCHIVE_DAYS

This is used to specify the days for archival of producers
details on a regular basis. Input parameter value is
numeric.

PPR_OARCHIVE_DAYS

This is used to specify the days after which the producers
details from ‘O’ tables need to be archived. Input parame-
ter value is numeric.

PPX_ARCHIVE_DAYS

This is used to specify the days after which producer trans-
actions are to be archived. Input parameter value is
numeric.

PPX_OARCHIVE_DAYS

This is used to specify the days after which the producer
transactions are to be moved from ‘O’ tables. Input param-
eter value is numeric.

PJR_COPY_PURGED _-
DATA

This parameter is used to copy data into purge tables
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Parameter Description

PST_ARCHIVE_DAYS This parameter specifies the number of days for which the
statements are to be archived. Input parameter value is
numeric.

PST_OARCHIVE_DAYS This parameter specifies the number of days for which the
statements are to be archived in the ‘O’ tables. Input
parameter value is numeric.

PTT_PURGE_DAYS This is used to specify the number of days after which the
PTT table is to be purged. Input parameter value is
numeric.

PTX_ARCHIVE_DAYS This parameter is used to specify the number of days the
transactions are to be archived. Input parameter value is
numeric.

PTX_OARCHIVE_DAYS This parameter is used to specify the number of days after
which the archived transactions from ‘O’ tables are to be
moved. Input parameter value is numeric.

PUL_PURGE_DAYS This parameter is used to specify the number of days post
which the User login details are to be purged. Input param-
eter value is numeric.

PVA_ARCHIVE_DAYS This parameter stores the number of days for archival of
regular vendor assignments. Input parameter value is
numeric.

PUP_ARCHIVE_DAYS This parameter stores the number of days for archival of

transaction upload. Input parameter value is numeric

PUP_OARCHIVE_DAYS This parameter is used to specify the number of days after
which the archived transactions from ‘O’ tables are to be
moved. Input parameter value is numeric

PVA_OARCHIVE_DAYS This parameter value specifies the number of days for
archival of vendor assignments from ‘O’ tables to ‘OO’
tables. Input parameter value is numeric.

PVI_ARCHIVE_DAYS This parameter is used to specify the number of days for
which the regular vendor invoices are to be archived. Input
parameter value is numeric.

PVI_OARCHIVE_DAYS This parameter is used to specify the number of days post
which the regular vendor invoices are to be moved from ‘O’
tables to ‘OQ’ tables. Input parameter value is numeric.

RAC_LOAD_FREQUENCY | This parameter is used to specify Accounts RDH Load Fre-
quency

RAP_LOAD_FREQUENCY | This parameter is used to specify Applications RDH Load
Frequency

RAT_LOAD_FREQUENCY | This parameter is used to specify Asset Tracking RDH
Load Frequency
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Description

RBK_LOAD_FREQUENCY

This parameter is used to specify Bankruptcy Details RDH
Load Frequency

RCA_LOAD_FREQUENCY

This parameter is used to specify Call Activities RDH Load
Frequency

RCH_LOAD_FRE-
QUENCY

This parameter is used to specify Deficiency Details RDH
Load Frequency

RCO_LOAD_FRE-
QUENCY

This parameter is used to specify Contracts RDH Load
Frequency

RFO_LOAD_FREQUENCY

This parameter is used to specify Repo-Foreclosure RDH
Load Frequency

RPR_LOAD_FREQUENCY

This parameter is used to specify Producers Rdh Load
Frequency

RST_LOAD_FREQUENCY

This parameter is used to specify Setup Data RDH Load
Frequency

RTX_LOAD_FREQUENCY

This parameter is used to specify Txns RDH Load Fre-
quency

SALESAGENT -
MAIL_SEND_IND

This parameter is used to specify whether decision fax
needs to be sent to sales agent (yes/no)

SCORING_PARAME-
TER_ALERT

This parameter is used to set the scoring parameter alert

SQL_DIRECTORY

This parameter is used to set the Oracle directory object
name for SQL file location

TES_ANA_PRE_PROCES
S_CYCLES

This parameter is used to specify the pre-process cycles
required for Escrow analysis. Input parameter value is
numeric.

TES_DSB_ANALY-
SIS_PERCENT

This parameter is used to specify the percentage for
escrow disbursements. Input parameter value is numeric.

TES_DS-
B_PRE_PROCESS_DAYS

This is used to specify the number of days for pre-process
for escrow disbursements. Input parameter value is
numeric.

TPE_AMORTIZE_AC-
CRUED_INT_ONLY

This parameter is used to specify that system has to amor-
tize accrued interest at month end

TPE_APPLY_LTC -
FROM_CURR_DUE_DT

This parameter is used for pyramid law fee method to
apply late charge from current due date

TPE_ESC_ANALY-
SIS_DELQ_AMT

Parameter considers billed but uncollected amount for
escrow analysis

TPE_EXCESS_PAY-
MENT_TO_MEMO

Excess payment on the account will be moved to memo
payment.
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Description

TPE_EXCLUDE_ESC_LTC

This parameter defines whether escrow should be included
or excluded while calculating late charge. Input parameter
value is Boolean (Yes/No).

TPE_EXT_CY-
CLES_BACKDATED

This parameter is used to define the maximum extension
cycles allowed for back dating. Input parameter value is
numeric with no upper limit

TPE_FUTURE_PAYOFF _-
DAYS

The value specified in this parameter validates the ‘Valid
Up to Date’ with ‘Payoff quote’ during monetary transac-
tions posting.

TPE_GL_RE-
FUND_HOLD_DAYS

This parameter is used to define the number of days the
non-refunded amount can be held in GL. Input parameter
value is numeric.

TPE_MAX_CY-
CLES_BACKDATED

This parameter is used to define the maximum cycles that
are allowed for back dating in OFSLL. Input parameter
value is numeric.

TPE_MIN_1098_INT_AMT
_PAID

This parameter is used to specify the lower limit or mini-
mum interest amount paid for 1098 i.e. Mortgage Interest
Statement. In the US, Fls need to report mortgage interest
of $600 or more received from individuals, during the
course of their business. Input parameter value is 600, the
minimum value above which reporting by Fl is required in
form 1098 for each mortgage account.

TPE_OLDEST -
DUE_DT_NEW_MTHD

This parameter is enabled to specify whether new method
for calculation of oldest due date based on given data
should be used or not. Input parameter value is Boolean
(Yes/No).

TPE_PAID_TO_CLOSE._-
DAYS

This parameter is used to specify the number of days
allowed post which a paid account would be closed. Input
parameter value is numeric.

TPE_PAYMENT_TO_-
MULTI_ACCOUNTS

This parameter is enabled to allow one payment for dues in
multiple accounts. Input parameter value is Boolean (Yes/
No).

TPE_PAYOFF_VAL-
ID_THRU_DAYS

This parameter is used to specify the number days the
pay-off quote is valid by default. i.e. if the parameter is set
as 7, the payoff quote is valid for 7 days and customer can
pay the quoted amount as final closure amount within
those days. Input parameter value is numeric.

TPE_PMT_POST_EOD

This parameter is used to allow payments when the batch
process for End of Day is running. Input parameter value is
Boolean (Yes/No). If this is set to “Y’, payments can be
allowed during EOD.

TPE_SCHGOFF_DLQ_-
DAYS

This parameter is used to define the number of delinquent
days to treat an account for SCHGOFF (charge — off).
Input parameter value is numeric. (To verify)
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TPE_SCHGOFF_RE-
VIEW_DAYS

This parameter is used to define the number of days
allowed for review of SCHGOFF accounts. Input parame-
ter value is numeric.

TPE_SCRA_DEFAULT_IN-
TEREST_RATE

This parameter is used to define the default interest rate
that is to be applied for customers who are in military duty.
OFSLL will apply the lower of the prevailing interest rate or
SCRA default interest rate specified through this parame-
ter. Input parameter value is numeric (in this case 6, which
is interest rate to be applied for SCRA accounts.

TPE_SHOW_BACK-
DATE_WARNING

This parameter is used to define whether a warning mes-
sage is to be shown if monetary transaction is backdated

TPE_ST-
M_INC_ALL_TXNS

This parameter is enabled to define whether all transac-
tions should be included in the statements or otherwise.
Input parameter value is Boolean (Yes/No).

TPE_STOP_COMP_DELQ
_DAYS

This parameter is used to stop computation when delq
days > 60

TPE_TXN_POST_DE-
FAULT _GLDATE

This parameter is used to default GL date in date type
parameters during txn posting (y/n)

TPE_VOID_TO_CLOSE .-
DAYS

This parameter is used to define the number of days
allowed for closing Void accounts. Input parameter value is
numeric.

UIX_DEFAULT_IMAGE._-
PATH

This parameter is used to define the default image direc-
tory maintained for the purpose of online attachment of
document images to an application using documents main-
tenance section under Account documentation. Input
parameter value is user defined.

UIX_DIRECT_LOAN_-
COMBO_ULN_UFN

This parameter when set to yes allows underwriting and
funding to be carried on by a single responsibility for direct
loans only. Input parameter value is Boolean (Yes/No).

UIX_INCOMING_FILE_-
PATH

This parameter is used to specify incoming file path of app
server

UIX_LOCAL_COUN-

Through this parameter we can set the local country where

TRY_CD an Fl has multiple branches across different geographies.
Input parameter value is user defined.
UIX_LOCK_UN- This parameter is used to enable the user interface lock /

LOCK_AND_COPY

unlock and copy features. Input parameter value is
Boolean (Yes/No).

UIX_MAX_ACC._-
SEARCH_ROWS

This parameter is used to specify the maximum number of
account rows to be returned for search functionality. Input
parameter value is numeric.

UIX_MAX_APP_-
SEARCH_ROWS

This parameter is used to specify the maximum number of
application rows to be returned for search functionality.
Input parameter value is numeric.
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UIX_OUTGOING_FILE_-
PATH

This parameter is used to specify outgoing file path of app
server

UIX_REPORTS -
SERVER_CONFIG

This parameter can be used to specify the user interface
reports server configuration file. This is not required for
OFSLL.

UIX_REPORTS -
SERVER_URL

This parameter sets the URL for Reports server. Input
parameter value is user defined.

UIX_SHOW_LN_VARIA-
BLE_RATE_TABS

This parameter can be used to show loan variable rate
tabs. Input parameter value is Boolean (Yes/No). This is
not required for OFSLL.

UIX_UTILITIES_SERV-
LET_URL

This parameter can be used to specify the User Interface
utilities servlets URL. This is not required for OFSLL.

UPR_PRO_NBR_SYS-
_GENERATED

This parameter can be used to specify whether producer
number should be system generated or seek input from
user. Input parameter value is Boolean (Yes/No). Generally
this is set to yes for system generation.

VEV_NADA_TOKEN_URL

This parameter is used to set the token URL for vehicle
evaluation interface NADA. Input parameter value is user
defined.

VEV_NADA_UPDATE_-
DAY

This parameter is used to specify the day of the month to
update the vehicle evaluations every month. Input parame-
ter value is numeric.

VEV_NADA_URL

This parameter is used to set the URL for vehicle evalua-
tion interface NADA. Input parameter value is user defined.

VEV_NADA_USER_ID

This parameter is used to specify the User id for login to
the NADA interface. Input parameter value is user defined.

VEV_NADA_USER_PASS-
WORD

This parameter is used to specify the password for login to
the NADA interface. Input parameter value is user defined.

VEV_VALUATION_RE-
GION

This parameter is used to define the default region for vehi-
cle evaluation. Input parameter value is the region name,
and is user defined.
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VEV_VALUATION_-
SOURCE_CD

This parameter is used to specify the default vehicle evalu-
ation source code. Input parameter value is user defined. A
number of parameters are possible in OFSLL as below:
1.Appraisal Company

2.Broker

3.BUC GUIDE

4.DATA QUICK

5.NAMS/SAMS SURVEY - USED

6.REALTOR

7.NADA INTERFACE USED CARS

8.BLACKBOOK INTERFACE USED CARS

9.KELLY INTERFACE

10.NADA — NEW

11.NADA — USED

12.KELLY NEW BLUE BOOK

13.KELLY USED BLUE BOOK

14.INVOICE

15.BLACK BOOK

16.NADA INTERFACE COMMERCIAL TRUCKS
17.COMPANY INVOICE

18.GOLD BOOK

19.GALVS

20.0THER

21.ALG

WFP_DIRECTORY

This parameter is used to specify the Oracle directory
object name for WFP file location

WFP_MAX_CY-
CLES_BACKDT

This parameter is used to specify the back dated cycles
date for WFP.

WFP_PROCESSED_DI-
RECTORY

This parameter is used to define oracle directory object
name for wfp file location.

WFP_REVERSE_TX-
N_IND

This parameter is enabled to define the WFP reversal indi-
cator. Input parameter value is Boolean (Yes/No).

XAE_DEALUPD_MAX_AL-
LOWED_DAYS

This parameter is used to define the max allowed days for
Deal Update

XAE_DEALUPD_AL-
LOWED_IND

This parameter is used to indicate whether deal update is
allowed or not

OUTBOUND_CALL_Q

This parameter is used to generate reports (including
emailing statements/letters) using Application Server
instead of Database server.

ACA_PRE_PROCESS_-
DAYS_FIRST

This parameter is used to configure the number of days
before the debit day for ACH process in first time/ one-time
case

IPR_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle directory
object name for processed IPR file location

IPR_DIRECTORY

This parameter is used to define the Oracle directory
object name for IPR file location
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UIX_PWD_MGMT_EX-
TERNAL_URL

This parameter is used to set external password manage-
ment url, if applicable

UIX_PWD_MGMT_EX-
TERNAL

This parameter is used to define the parameter if password
management is external. (SET Y IF PASSWORD MAN-
AGEMENT IS EXTERNAL (Y/N)).

ICU_PROCESSED_DI-
RECTORY

This parameter is used to define the Oracle directory
object name for processed ICU file location

ICU_DIRECTORY

This parameter is used to define the Oracle directory
object name for ICU file location

UIX_BILL_CYCLE_AL-
LOWED_IND

This parameter is used to indicate whether Billing cycle is
allowed at the application level

CMN_EOD_SLEEP_MINS

This parameter is used to set in minutes the EOD sleep
time

CMN_CORE_BANK_TX-
N_CD

This parameter is used to set code for OFSLL and Core
Banking integration

UIX_DIRECT_DISB_MAN-
UAL_SELECT

This parameter will allow manual selection of disbursement
mode for direct loans

ICC_DLQ_AMT_EX-
CLUDED

This parameter enabling will exclude delinquency amount
for CASA account

CMN_CORE_BANK_IND

This parameter is used to set whether OFSLL can inte-
grate with Core Banking.

BKRP_FILE_REC_LIMIT

This parameter is used to set the limit of total number of
records allowed to be added in the ‘Input Data File’ shared
from external interface.

Note: if the number of records exceeds the set limit, multi-
ple ‘Input Data Files’ are to be created.

UVN_VEN_NBR_SYS-
_GENERATED

This parameter is used to validate if ‘Vendor Number’ has
to be auto generated (if set to Y) or to be specified manu-
ally in the Vendor details screen.

METRO_WITHOUT _COL-
L_IND

This parameter indicates whether Metro Il reporting is han-
dled without OFSLL Collections module being used. If the
parameter value is set as ‘Y’ i.e. collection module is not
used, system updates the collateral status directly as part
of ‘REPQO’ call activity.

However when Collections module is being used, the Col-
lateral status is tracked with the repossession details
updated in 'Repo/Foreclosure' screen of Collections mod-
ule.
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METROII_-
FIRST_DELQ_DT_ADD -
DAY

This parameter is used to calculate the first delinquency
date that needs to be reported in the Metro Il reporting file.

By default the parameter is 'disabled' indicating that the ini-
tial delinquency date calculated by the system is used for
Metro Il reporting. The same needs to be enabled to add
the parametrized number of days to the system calculated
first delinquency date for the Metro Il reporting purpose.

DAYS_TO_PULL_CR-
B_REPORT

This parameter is used to configure the number of days
permitted to pull a Bureau report from the same company
and for the same customer.

XWS_ACS_RESP_-
MULTI_RECORD_IND

This parameter is used to indicate if multiple records exist
in the response file received for account search.

Accordingly, when there are multiple records found and
this parameter is enabled and set to ‘No’ (default), system
displays an error message “Too Many Records Found.
Please Refine Search by Adding One More Parameter”

However, when this parameter is set to ‘Yes’, system only
indicates that there are multiple records/rows in response
file.

GRI_DLQ_DAYS_AU-
TO_STATUS_CHG

This parameter is used to define the delinquency days
which inturn is used to automatically update the status of a
work order to ‘PENDING ON HOLD’ status.

TPE_PMT_POSTING_-
CLS_ACCOUNT

This parameter is used to define the payment posting crite-
ria for Closed - Paid Off/ Charged-off accounts.

Accordingly, OFSLL accepts payment posting on closed
accounts only when the parameter is set to ‘Y’ and all the
payments received through Payment Entry screen or ‘Pay-
ment Upload’ file are posted to a ‘Suspense’ account.

TPE_BACKDT_P-
MT_POSTING

This parameter is used to define the payment posting crite-
ria for backdated payments for the following type of
account conditions:

- Paid off

- Charged-off

- Account under activation

- Account under conversion

- Non-performing Account

- PC2 SI (Pre-computed to Simple Interest) Reschedule

Accordingly, OFSLL accepts backdated payment posting
only when the parameter is set to ‘Y’ and all the payments
received through Payment Entry screen or ‘Payment
Upload’ file are posted to a ‘Suspense’ account.
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EXP_PA_-
SOFT_PULL_IND

This parameter when enabled allows ‘Soft Pull’ Credit
Bureau request, specifically for Experian Premier Attribute
Consumer Report without impacting the consumer FICO
score.

PMT_BATCH_POSTING

This parameter (PAYMENT BATCH POSTING PREFER-
ENCE) is used to define the status of payment transactions
which are uploaded in bulk through a batch process.

POOL_ACTIVE_AC-
COUNTS_ONLY

This parameter controls the type of accounts that can be
added to a Securitization Pool and allows adding only
‘Active’ status accounts since the same is enabled (value
set to Y’) by default. To add accounts with other status
such as Active, Paid Off, Charged Off, Void, Terminate.
and so on, set the value of system parameter to ‘N’.

AUTO_GEN_ACC_NBR -
CONV

This parameter is used for conversion accounts to decide
option of account number generation. If the value of
parameter is set to Y’ the account number is automatically
generated in OFSLL during conversion and if the value is
‘N’, then external reference number (generated in third
party system) itself is appended as the account number.

OUTBOUND_DL-
R_TRACK_Q

This parameter defines the settings for batch job
‘SET_XPR’ to either use MDB (Message Driven Bean) flow
(if value set to ‘Y’) or existing work flow (if value set to ‘N’)
to dump producer details maintained in the system into
Dealer Track.

MDB flow generates outbound JMS message though the
configured MDB interface and can avoid current database
outbound calls and session timeout.

In the existing workflow, the database makes synchronous
outbound calls to producer data dump web service, to
dump the data and acknowledge the database with the sta-
tus (success or failure).

OUTBOUND_ROUTE-
ONE_Q

This parameter defines the settings for batch job
‘SET_XPR'’ to either use MDB (Message Driven Bean) flow
(if value set to ‘Y’) or existing work flow (if value set to ‘N’)
to dump producer details maintained in the system into
ROUTEONE.

MDB flow generates outbound JMS message though the
configured MDB interface and can avoid current database
outbound calls and session timeout.

In the existing workflow, the database makes synchronous
outbound calls to producer data dump web service, to
dump the data and acknowledge the database with the sta-
tus (success or failure).
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Parameter

Description

GRI_WEBSER-
VICE_LOG_IND

This parameter is used to decide on logging GRI (Generic
Recovery Interface) communications. If enabled, system
logs all the GRI related web service communications
between OFSLL and external interfaced system.

The recorded logs can be viewed in Dashboard > System
Monitor > Database Server Log Files tab by selecting
‘Interfaces’ view option.

PVE_ARCHIVE_DAYS

This parameter stores the number of days for archival of
regular vendors. Input parameter value is humeric.

PVE_OARCHIVE_DAYS

This parameter is used to specify the number of days post
which the regular vendors are to be moved from ‘O’ tables
to ‘OO0’ tables. Input parameter value is numeric.

LBX_DR_CR_VALI-
DATE_AMT_IND

This parameter (VALIDATE LOCKBOX DR/CR BATCH
TOTALS) is used to facilitate NACHA file validation. Based
on the status of the parameter, system is either allowed to
validate the file or process without validation.

PAP_PURGE_DAYS

This parameter allows to define the number of days after
which the application data from archival folders are to be
deleted permanently. Purging happens based on elapsed
number of days i.e. if value is set to 60 days, only those
records which are older by 60 days in archival folder are
deleted.

PAC_PURGE_DAYS

This parameter allows to define the number of days after
which the accounts data from archival folders are to be
deleted permanently. Purging happens based on elapsed
number of days i.e. if value is set to 60 days, only those
records which are older by 60 days in archival folder are
deleted.

CMN_SED -
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the incoming or outgoing seed data is to be processed. If
set to Y’, system processes the data to/from LOB and if
set to ‘N’, system processes the data to/from FILE.

CMN_EDF_-
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the incoming or outgoing data from Dialer Interface is to be
processed. If set to Y’, system processes the data to/from
LOB and if set to ‘N’, system processes the data to/from
FILE.

The same is used by the batch jobs EDFADR_BJ_100_01
and EDFIVR_BJ_100_01 which are available in SET-EDF
Batch Job Set.

CMN_FAX_-
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the incoming or outgoing Fax data is to be processed. If set
to Y’, system processes the data to/from LOB and if set to
‘N’, system processes the data to/from FILE.
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Parameter

Description

CMN_RED _-
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the outgoing details of Data Masking Policy (i.e. Redaction
policy output file) is to be processed. If set to Y’, system
processes the data from LOB and if set to ‘N’, system pro-
cesses the data from FILE.

The same is used by the batch job REDPRC_BJ_100_01
available in SET-RED Batch Job Set.

CMN_WFP_-
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the incoming or outgoing WFP Unit details are to be pro-
cessed. If set to Y’, system processes the data to/from
LOB and if set to ‘N’, system processes the data to/from
FILE.

The same is used by the batch job WUPPRC_BJ_132_01
available in SET-WFP Batch Job Set.

CMN_AUD_-
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the outgoing Audit scripts are to be processed. If set to Y’,
system processes the data from LOB and if set to ‘N’, sys-
tem processes the data from FILE.

CMN_LBT -
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the incoming or outgoing Lockbox files are to be pro-
cessed. If set to Y’, system processes the data to/from
LOB and if set to ‘N’, system processes the data to/from
FILE.

The same is used by the batch jobs LBXPRC_BJ_100_01
and LBXSEP_BJ_100_01 available in SET-LBT Batch Job
Set.

CMN_ODD_-
FILE_PROCESS_TO_LOB

This parameter allows to define the location from where
the outgoing ODD or Output Data Dump files are to be pro-
cessed. If set to Y’, system processes the data from LOB
and if set to ‘N’, system processes the data from FILE.

The same is used by the batch job ODDPRC_BJ_000_01
available in SET-ODD3 Batch Job Set.

CMN_ALERT_DE-
BUG_METHOD

This parameter allows to define the location to which Alert
and Warning logs are to be written. If set to ‘ADVANCE_-

QUEUE’, system writes the logs in Logs table and if set to
‘UTL_FILE’, system generates the alert log file.

CMN_GRI_WS_DE-
BUG_METHOD

This parameter allows to define the location to which GRI
(Generic Recovery Interface) web service logs are to be
written. If set to ‘ADVANCE_QUEUE’, system writes the
logs in Logs table and if set to ‘UTL_FILE’, system gener-
ates the log file.
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Parameter

Description

UIX_CUSTOM-
ER_BASED_PMT_IND

If this parameter is set to ‘Y’ and is ‘Enabled’, system
accepts posting direct payment to an account and also
accepts customer based payments to all linked accounts.

To facilitate customer based payments, ‘Customer/Busi-
ness # and ‘Payment Hierarchy’ fields along with ‘Popu-
late Accounts’ button are enabled in ‘Payment Entry’
screen to specify required values.

PMT_HIERARCHY_CODE

In this parameter, you can specify a payment hierarchy
which is populated by default in Customer Details and
Business Details (if applicable) screen after account acti-
vation.

However, the specified value is selected by default only if
there is a matching hierarchy definition enabled record
maintained in Setup > Administration > User > Payment
Hierarchy screen. Else, ‘Equal Amount’ value is selected
which in-turn adjusts the payment equally to all customer/
business linked accounts.

Note: System does not consider this parameter value
while ‘creating account using existing customer/business
details’ since the default selection is done during the crea-
tion of existing customer / business account.

EVI_MAX_RE-
TRY_COUNT

This parameter records and controls the maximum
attempts to re-trigger FAILED Webhook requests which
cannot exceed more than 5 times. However, this parame-
ter can be modified if the maximum re-trigger attempts is to
be less than 5 times.

UIX_CUSTOM_LA-
BEL_ENABLED_IND

This parameter indicates if the field label customizations
are allowed i.e. ability to change label and provide access
to fields in Label Configuration and Security User Access
Definition Details screens.

If set to “Y’, system refers data from database

If set to ‘N’, system refers data from XLIB file.

UIX_MASTER_AC-
C_BASED_PMT_IND

If this parameter is set to ‘Y’ and is ‘Enabled’, system
accepts posting direct payment to a master account and
also accepts master account based payments to all linked
accounts.

To facilitate master account based payments, ‘Master
Account # field is enabled in ‘Payment Entry’ screen.

TPE_PMT_RE-
FUND_CURRENCY_S-
RC_CD

This parameter indicates the currency in which payment
refund has to be processed in the system as either ‘Pay-
ment Currency’ or ‘Account Currency’. The same is consid-
ered during payment refund operation in Payment
Maintenance screen.
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Parameter

Description

AUTO_GEN_ACTIVE_TX-
N_CONV

This parameter if enabled, auto posts a dummy ACTIVE
transaction on all ‘migrated accounts’ during the schedule
batch job run. This in-turn allows to post RESCISSION /
VOID transaction specifically for migrated accounts by
selecting the dummy transaction from Customer Service >
Maintenance screen or Transaction History transactions
tab,

For more information, refer ‘Voiding an Account’ section
Servicing user guides.

FLL_CMN_JET_JWT_EN-
ABLED_IND

(JET JWT TOKEN ENA-
BLE INDICATOR)

This parameter if set to 'Y’, enables the ‘Account Dash-
board’ screen in Servicing LHS menu. This screen is
based on Oracle JET framework and facilitates to view
Account summary details maintained in the system. For
information on screen functionality, refer to Servicing User
Manuals and for details on deployment and configuration,
refer to Installation Manuals.

FLL_CMN_JET JWT_TO-
KEN_URL

(JET JWT TOKEN GENER-
ATION URL)

Define the value of the O-JET URL (app-shell application
URL) in the format https://<hostname>:<port no>/ofsll-app-
shell/<token>

FLL_SER_JET_AC-
C_CREATE_URL

(JET SIMPLE ACCOUNT
CREATE URL)

Define the value of the O-JET URL (app-shell application
URL) in the format https://<hosthame>:<port no>/ofsll-app-
shell?root=accountonboarding

FLL_SER_JET_ACC_-
DASHBOARD_URL

(JET ACCOUNT DASH-
BOARD URL)

Define the value of the O-JET URL (app-shell application
URL) in the format https://<hosthame>:<port no>/ofsll-app-
shell?root=accountdetailsdashboard

FLL_SET_JET_INTELLI-
GENTSEG_URL

(JET INTELLIGENT SEG-
MENTATION URL)

Define the value of the O-JET URL (app-shell application
URL) in the format https://<hostname>:<port no>/ofsll-app-
shell?root=queuecreation

ACCOUNT_PROCESS-
ING_THRESHOLD

(ACCOUNT ON-BOARD-
ING ASYNCHRONOUS
PROCESSING THRESH-
OLD)

This parameter allows to restrict the number of accounts
that can be created ‘synchronously’ using Account on-
boarding WebService.

However, creating accounts asynchronously in the system
is further processed by the below batch jobs based on val-
ued defined in this parameter.

SET-API2 (ASYNCHRONOUS ACCOUNT CREATION)
-- ACXVAL_BJ_100_01 (VALIDATE IAPP TABS)

-- ACXAAI_BJ_100_01 (ASYNCHRONOUS ACCOUNT
CREATION)
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Organization Parameters

Organization parameters control the functions related to User login, password expirations,
responsibilities and accessibility limits in the OFSLL system. Individual parameters can be
created with different values for uniquely defined organizations, divisions, and responsibility
combinations.

There are three more dimensions other than parameter name, description and enabling
(similar to system parameters) as indicated below:

1. Organization

2. Division

3. Responsibility

These dimensions help to define the applicability of the responsibility for specific User in an
Organization across selected Divisions/departments.

When determining which parameter to use, OFSLL system selects the best match based on
a hierarchical sort by the Organization, Division, and Responsibility fields, with values of 'ALL'
being a lower order match than an exact match.

While the system allows for Organization parameters to be defined at all three hierarchical
levels (organization, division, and responsibility), not all will be applicable to each parameter.

Parameter Description

MAX_PASSWORD_HISTO- | This is used to set limit for number of times a password
RY_CHECK has been repeated during password change. This can be
set for specific branches of the Organization, Divisions and
Users based on responsibilities. Numeric value to be input
to specify the limit.

UCS_GROUP_FOL- This parameter is used to set up the number of days range
LOWUP_DAYS for Group follow-up field in customer service screen which
displays the set of accounts that share same account con-
dition as the selected account and bear the same cus-
tomer ID. The pre-requisite for this is Group Follow-up
indicator should be enabled in queue setup. Input value is

numeric.
UCS_REVIEW _- This is used to specify whether review can be done by the
QUEUE_ALLOWED specific responsibility (user group) without entering details

in call activities/activities. Parameter value to be input is
Boolean (Yes/No).

UIX_AP- The system uses this parameter to determine which users
P_VIEW_ALL_APPS have the ability to view all applications. The system selects
the best match based on a hierarchical sort by Organiza-
tion, Division and Responsibility fields, with values of ‘ALL’
being a lower order match than an exact match. Input
parameter value is Boolean (Yes/No).
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Parameter

Description

UIX_HIDE_RESTRICT-
ED_DATA

This is used to hide sensitive data relating to the Contract /
Applicant to a specific group/responsibility etc. Suppose
there is a need to hide data relating to SSN, Bank account
details etc. to a specific user responsibility who will not
need such data, this parameter can be enabled with input
value Boolean (Yes/No). If this parameter is set to Y’, the
details appear in a masked format (for e.g. SSN — XXX-
XX-456)

UIX_SMTP_SERVER

This parameter is used to set up the email server for user
interface. The input value would be ‘SETME’ and check
the ‘Enable’ flag.

UIX_VIEW_SE-
CURED_ACCOUNTS

This is used to specify whether an account can be viewed
by a specific responsibility (users). Parameter value is
Boolean (Yes/No) and when flagged as Yes, such
accounts would be viewable only by users defined in the
Organization, Division hierarchy with the specified respon-
sibilities. For example, all employee accounts may not be
viewable by all users and should be made available only to
the HR department with specific responsibility levels.
Note: While creating application, selecting appropriate
applicant’s classification would be essential for this param-
eter to be effective.

UIX_VIEW_SE-
CURED_APPLICATION

This is used to specify whether an application can be
viewed by a specific responsibility (users). Parameter
value is Boolean (Yes/No) and when flagged as Yes, such
applications would be viewable only by users defined in
the Organization, Division hierarchy with the specified
responsibilities. For example, all employee accounts may
not be viewable by all users and should be made available
only to the HR department with specific responsibility lev-
els.

Note: While creating application, selecting appropriate
applicant’s classification would be essential for this param-
eter to be effective.

ULG_DAY_END

This is used to specify the upper limit time in day for a user
to be able to work in the System. Parameter value is
numeric and range is 1-24, else system will throw error.

ULG_DAY_START

This is used to specify the lower limit time in day for a user
to be able to work in the System. Parameter value is
numeric and range is 0-24, else system will throw error

ULG_FAILED_LOGIN_TRI-
ALS_MAX

This parameter is used to specify the maximum number of
login trials allowed before disabling the User ID due to
security reasons. Input parameter value is numeric with
upper limit of 999999999999.
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Parameter

Description

ULG_INACTIVITY_DAYS_ -
MAX

This parameter is used to specify the maximum number of
days the User ID can be without utilization before disabling
the User ID due to security reasons. Within the specified
number of days the User Id must be utilized for sign in at
least once. Input parameter value is numeric with upper
limit of 999999999999.

ULG_PWD_CASE_SENSI-
TIVE_REQ

This is used to allow all passwords to be case sensitive or
otherwise. Input parameter value is Boolean (Yes/No).
When this parameter is set as ‘NO’, password would be
stored in Upper case. If this parameter is set to N. then the
ULG_PWD_LOWER_CHAR_REQ parameter should also
be set to N.

ULG_PWD_CHANGE_-
DAYS_ACTUAL

This is used to set the maximum number of days after
which system will force a password change, in cases
where the User has not changed the password. Input
parameter value is numeric with upper limit of
999999999999.

ULG_PWD_CHANGE_-
DAYS_PROMPT

This is used to set the maximum number of days after
which system will prompt the User for password change, in
cases where password has not been changed within the
set period. Input parameter value is numeric.

ULG_PWD_LENGTH_MIN

This is used to set the minimum length of password string
that is required. If this criterion is not met, system would
throw an alert specifying minimum character length
required to be input.

ULG_PWD_LOW-
ER_CHAR_REQ

This is used to allow at least one lower case character in
password strings. Input value is Boolean (Yes/No). Setting
this as ‘NO’ would mean passwords would be allowed in
uppercase only.

ULG_PWD_NBR_REQ

This parameter allows setting password with at least one
numeric character. Input value is Boolean (Yes/No) and
setting this as ‘YES’ would require passwords to have at
least one numeric character.

ULG_PWD_SPE-
CIAL_CHAR_REQ

This parameter is used to allow special characters like ‘$’,
‘#,‘@’, in passwords. Input value is Boolean (Yes/No) and
setting this as ‘YES’ would require passwords to have at
least one special character.

ULG_PWD_UP-
PER_CHAR_REQ

This is used to allow at least one upper case character in
password strings. Input value is Boolean (Yes/No). Setting
this as ‘NO’ would mean passwords would be allowed in
lowercase only.

ULG_WEEK_END

This parameter enables to set the last day of the week
when a user can have access to the system. Input param-
eter value is numeric ranging from 1 to 7. This is useful in
business requirements where the Organization does not
need a specific set of responsibilities (users) to not access
the system on a weekend / week-off day etc.
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Parameter

Description

ULG_WEEK_START

This parameter is used to set the start day of the week
when a user is allowed to access the system. Input param-
eter value is numeric.

CRB_ERROR_VALIDA-
TION_IND

This parameter is used to validate the Credit Bureau report
generation request depending on the number of days per-
mitted to pull a Bureau report from the same company and
for the same customer and report as either warning/error.

When the number of days is less than or equal to the per-
mitted days (as defined in parameter
DAYS_TO_PULL_CRB_REPORT), system displays an
‘Error’ message stating ‘Bureau Report exists for the same
Customer from the same Bureau for Account# XYZ’ along
with list of account number(s) and/or application num-
ber(s). If not, a ‘Warning’ message is display and request
is accepted for processing.

Note: Both ‘CRB_ERROR_VALIDATION_IND’ and
‘DAYS_TO_PULL_CRB_REPORT are to be enabled for
Credit Bureau report processing.

OCP_CUST_PMT_PREF

This parameter MASTER ACCOUNT ROLLUP FOR PMT
EXTRACT FILE is used to decide the basis of dues con-
solidation at master account level based on the parameter
values selected. For more information, refer to ‘Outbound
Customer Extracts To Payment Agencies Batch’ section.

Company Parameters

Company parameters control the processes associated with functions that vary for different
companies and branches. These parameters address credit scoring, credit bureau interfaces,
fax services, and fax generation.

Individual parameters may be set up with different values for uniquely defined company and
branch combinations (i.e. these can be defined to the level of branches in each company or
a group of companies in terms of applicability).

Parameter

Description

AUD_ADV_REASON_-
MODEL

This parameter is used to set-up default adverse action
reasons for scoring models during set-up in the Parame-
ters sub page. Whenever the flag ‘Bureau Score Reasons’
is unchecked during credit bureau scoring model set-up,
then automatically rejected applications scored using this
scoring model picks up the Adverse Action Reasons from
the Parameters sub page.
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Parameter

Description

AUD_SCORING_METHOD

This parameter is used to set when/where the application
scoring method has to be applied within the company. So
when the parameter value is chosen as ‘primary applicant
only’, the system will perform the application scoring for
the primary applicant only and according to other applica-
ble parameters specified. Other parameter input values
are Minimum Score, Maximum Score, Minimum Tier
(Grade), Maximum Tier (Grade).

AUD_SCORING._-
METHOD_IN_BUREAU

This parameter is used to define what value to be picked
up for application scoring from the scores returned from
the various bureaus. The input parameter values are Max-
imum Score and Minimum Score. If Maximum score is set-
up in company parameters, then for all applications where
a bureau report is pulled, the system will pick-up the Maxi-
mum score from the different bureaus.

CBU_DATA_SET_SIZE

Parameter to define the metro 2 file data selection criteria,
option values are monthly, Daily, weekly, semi monthly.

CBU_FILE_FORMAT

Metro 2 file format definition, user need to select from the
parameter value drop down.

CMN_ASE_VALIDATE_-

This parameter is set up to specify to the system whether it

MAKE_MODEL needs to validate the asset make and model at the time of
data entry. In parameter value is Boolean (Yes/No).
CMN_CMB_DE- This is used to define the default printer for printing. The

FAULT_PRINTER

input parameter value is the printer name. There is no
LOV for this field. If no default printer is defined and the
parameter enabled, the system would display ‘Undefined’.

CMN_WEEKLY_NONBUSI-
NESS_DAYS

This parameter is used to set-up the weekly holidays at
the company level. The input parameter value is character
string; if no details specified and parameter is enabled,
system would display ‘UNDEFINED’.

COR_STORAGE_DIREC-
TORY

This parameter is used to specify the path/location for Ora-
cle directory object template for correspondence docu-
ments. Input parameter value is ‘SETME’; if none is
specified and parameter enabled, ‘UNDEFINED’.

DBR_-
JOINT_INC_DEBT_WITH_
2NDRY

This parameter defines whether system should consider
income and debt details of the Spouse and Secondary
Applicant along with that Primary Applicant. Input parame-
ter value is Boolean (Yes/No).

DBR_-
JOINT_INC_DEBT_WITH_
SPOUSE

This parameter is used to define whether system should
consider the income and debt details of Spouse alone
along with that of Primary applicant details. Input parame-
ter value is Boolean (Yes/No).
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Description

DDP_CRB_EXPIRATION_-
DAYS

This parameter is used to define the credit bureau report

expiration days. So if this is set as 30, system will use all

available credit bureau reports pulled which are not older
than 30 days from current day, during de-dupe. Input value
is numeric with no upper limit.

DDP_DE-
DUP_DEBT_WITH_2NDRY

This parameter defines whether the system should de-
dupe credit bureau liabilities for Spouse and Secondary
Applicants, in addition to de-duping Primary applicant’s lia-
bilities. Input parameter value is Boolean (Yes/No).

DDP_DE-
DUP_DEBT_WITH_SPOU
SE

This parameter defines whether the system should de-
dupe credit bureau liabilities for Spouse, in addition to de-
duping Primary applicant’s liabilities. Input parameter
value is Boolean (Yes/No).

DOT_STORAGE_DIREC-
TORY

This parameter is used to define the location/path of the
Oracle Directory Object name for Account Document
Loading. Input parameter value is ‘SETME’.

ECB_EDIT -
FAIL_ANY_APL

This parameter is used to set the credit bureau edit to fail
in case the bureau report for any of the applicant fails.
Input parameter value is Boolean (Yes/No). So if this
parameter is set to ‘YES’, the edit will fail even if one of the
applicant’s bureau score fails to qualify.

ECB_USE_APL_CUR-
RENT_SCORE_CRH

This parameter is used to define whether the system
should run the credit bureau edits only on the current
scored applicant bureau. Input parameter value is Boolean
(Yes/No).

LOR_AUTOMATIC_CON_-
FUND_FAX

This is used to define the decision fax generation when an
application is funded. The input parameter value is
Boolean (Yes/No), and when this is set as ‘YES’, system
automatically generates the fax approval in the pre-
defined template whenever an application is approved.

LOG_STORAGE_DIREC-
TORY

This parameter is used to define the Oracle storage direc-
tory. Input parameter value is user (System Administrator)
defined.

LOR_AUTOMATIC_AP-
PROVAL_FAX

This is used to define the decision fax generation when an
application is approved. The input parameter value is
Boolean (Yes/No), and when this is set as ‘YES’, system
automatically generates the fax approval in the pre-
defined template whenever an application is approved.

LOR_AUTOMATIC_RE-
JECTION_FAX

This is used to define the decision fax generation when an
application is rejected. The input parameter value is
Boolean (Yes/No), and when this is set as ‘YES’, system
automatically generates the rejection fax in the pre-defined
template whenever an application is declined.
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Parameter

Description

MAX_LEAD_DAY_AGE

This parameter is used to define the maximum no. of days,
post which the sales lead would be considered cold. Input
parameter value is numeric with no upper limit.

MULTI_OFFER

Through this parameter the multiple offers (sub-tab) in
pricing can be enabled or disabled for a Company/Branch.
Input parameter value is Boolean (Yes/No). If the flag is
set as 'Y’, the underwriter can view multiple offers and
select one of them to be applied for the specific applica-
tion.

MULTI_OFFER_MAX-
_NUMBER

This parameter is used to specify the maximum number of
multiple offers that can be permitted for an application.
Input parameter value is numeric with no upper limit. If
MULTI_OFFER company parameter is set as ‘N’, this
parameter can be ignored as there is no use specifying a
value.

MULTI_OFFER_MAX-
_TERM

This company parameter sets the maximum term (as in
no. of instalments, whichever billing cycle is selected) for
which multiple offers are calculated and displayed during
pricing. Input parameter value is numeric.

MULTI_OF-
FER_MIN_TERM

This company parameter sets the minimum term (as in no.
of instalments, whichever billing cycle is selected) for
which multiple offers are calculated and displayed during
pricing. Input parameter value is numeric.

MULTI_OFFER_PMT_TOL-
ERANCE

For Multi offer variance in payment is defined in this
parameter.

MULTI_OFFER_TERM_-
VAR

For multi offer Term variance will be defined in the parame-
ter.

PRESENT_VALUE_COM-
PUTE_RATE

This parameter will perform Present Value Computation
Rate (Inflation/Discounting Rate).

RATE_CHG_L-
TR_PRE_PROCESS_-
DAYS

This parameter is used to set up the number of days prior
to rate change effective date to generate rate change let-
ters in order to provide advance intimation to customers.
Input parameter value is numeric with no upper limit.

STM_GEN_AFTER_MATU-
RITY_IND

This parameter is used to enable the statement generation
for an account after the maturity date but Account remains
unpaid. Input parameter value is Boolean (Yes/No). If this
is set to ‘Y’, statements will get generated for accounts that
remain unpaid even after maturity.

UIX_RUN_AAI_ACT

This parameter is used by the system to determine
whether to create and activate an account online. Input
parameter value is Boolean (Yes/No).

UIX_UCS_CAC_MAX_-
FOLLOWUP_DAYS

This parameter is used to set up the maximum number of
days for follow up when the account is in delinquent state.
Input parameter value is numeric with no upper limit.
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Description

UIX_UCS_CAC_MAX-
_PROMISE_DAYS

This parameter is used to set up the maximum number of
days allowed for customers who promise to pay when fol-
lowing up for delinquent accounts. Input parameter value
is numeric.

AUD_QUEUE_INI-
TIAL_CRB_FAILED

This parameter enabling will Queue the application if any
bureau failed.

UIX_UCS_CUA_MAX_-
FOLLOWUP_DAYS

This parameter will allow the user to maintain the Collec-
tions maximum follow-up days that are allowed in the sys-
tem.

XSL_TAX_INTERFACE

This parameter is used to specify the sales tax interface in
OFSLL. Input parameter value is user defined. In this case
it is held as ‘Manual’.

CMN_SYSTEM_UNDER_-
MAINTENANCE

This parameter specifies whether the system is under
maintenance or not. Input parameter value is Boolean
(Yes/No).

CMN_GL_POST DT

This parameter is used to define the GL Post Date of Com-
pany in MM/DD/YYYY format. The same is also updated
by Scheduler if ENABLED.

PTX_TX-
N_LAST PURGE_DT

This parameter stores the date when transactions were
purged last in the OFSLL system. Input parameter value is
date.

PUP_TUP_LAST_PURGE_
DT

This parameter stores the date when transactions upload
were purged last in the OFSLL system. Input parameter
value is date.

JSC_START_OF_BUSI-
NESS_TIME

This parameter is used to set the start of business time.
Input parameter value is time in 24 hour format.

CMN_PROMISE_FU-
TURE_MTHD

This parameter helps to define the future promise handling
method in the system.

When multiple ‘Promise to Pay’ records are defined on an
account and if any one of the promise is not satisfied i.e. if
there is no credit / Payment transaction of the correspond-
ing amount on the promise date, then system uses any of
the following method defined in this parameter to update
the future promises.

- No Action on future promises (default)
- Mark current and future promises as broken

- Mark current as broken but future promise as cancelled
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A.5 Other Parameters

The following additional set of parameters are also available to control system specific data
and other administration process.

Parameter Description
CRB_MAX BU- This parameter is used to determine the number of credit
REAU_PULL reports automatically per applicant. Input parameter value

is numeric.

CRB_ALL_APL_BU-
REAU_PULL

This parameter is used to set up whether credit bureau
reports should be pulled for the primary applicant only or to
all other applicants also (for joint applications), regardless
of their relationship with the primary applicant. Input
parameter value is Boolean (Y/N).

CBU_FILE_FREQUENCY

This parameter is used to set the Metro Il File Frequency
and determine whether output file is to be generated daily
or monthly. If this is monthly, then output file is written with
daily data but generated monthly.

JOINT_DE-
DUP_SPOUSE_LIABILI-
TIES

This parameter is used to determine duplicate liabilities in
the Spouse’s liabilities in de-duping logic. Input parameter
value is Boolean (Yes/No).

JOINT_DEDUP_ALLAP-
L_LIABILITIES

This parameter is used to determine duplicate liabilities of
all applicants’ liabilities in de-duping logic, irrespective of
whether they are related to each other. Input parameter
value is Boolean (Yes/No).

ASC_COL_SER_ENA-
BLED_IND

This parameter is used for enabling the Collection Servic-
ing Indicator. Input parameter value is Boolean (Y/N).

CMN_TEST_TOOL_LOG-
GING

This parameter is used to set the testing tool logging to
enable or disable testing tool log in. Input parameter value
is Boolean (Yes/No).

ICA_INPUT_FILE_FOR-
MAT

This parameter is used to specify the Input format for call
activity file. Two Parameter values are possible — US for-
mat and OFSLL format.

JSV_BI_USER

This parameter is used to define the Bl publisher User ID.
Input parameter value is user defined (Admin user).

JSV_BI_PASSWORD

This parameter is used to define the Bl publisher User
password. Input parameter value is user defined (Admin
user).

PJR_COPY_PURGED _-
DATA

This parameter is used to specify whether data should be
copied into the purge tables or not. Input parameter value
is Boolean (Yes/No).

PUP_ARCHIVE_DAYS

This parameter is used to specify the number of days after
which the transactions upload details are to be archived.
Input parameter value is numeric.
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Parameter Description

PUP_OARCHIVE_DAYS This parameter is used to specify the number of days after
which the transactions upload details are to be moved from
‘O’ tables. Input parameter value is numeric.

TPE_APPLY_LTC_- This parameter is used to specify whether late charge
FROM_CURR_DUE_DT should be applied from current due date for Pyramid Law
fee method. Input parameter value is Boolean (Yes/No).

TPE_EXCESS_PAY- This parameter will make excess payment to the memo
MENT_TO_MEMO payment by marking this Parameter as YES.

TPE_STOP_COMP_DELQ | This parameter is enabled to stop computation if the
_DAYS account is delinquent for more than 60 days.
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Appendix B:Variable and Fixed Interest Rate

Variable Interest Rate Loans

A variable interest rate loan is one in which the interest component of the payable loan can
fluctuate over time. This fluctuation can be either due to periodic changes in index rate or
varying interest rates in the market. Accordingly, the loan payment amount may increase or
decrease depending on the variable interest rate.

For Variable rate loans, the interest rate basically consists of two components:

e Index rate - The index rate component is based on the financial market and may
fluctuate accordingly.

e Margin rate - The margin rate component is the fixed rate, which normally does not
change during life of the loan.

Note

Interest rate = Index rate + Margin rate.

During loan origination and up to the funding process, the interest rate is computed based on
the prevailing index rate at the time of approval. However, once the loan is funded, the interest
rate on the loan may change when the index rate changes. This interest rate change may
causes changes in the loan’s repayment amount, if specified in the terms of the contract.

Oracle Financial Services Lending and Leasing supports the variable rate functionality for
closed-end loans during the originating, funding, and servicing of new products and loans with
interest rates based on various industry-standard interest rate indices.

Variable rate calculation for Lease is supported for ‘Interest Rate’ calculation method only.
During product setup, on selecting the lease calculation method as ‘Interest Rate’, the
following fields are enabled and also the ‘Rate Adjustments’ sub tab is available to specify the
details:

e Flexible Repayment
e Index Rounding

e Reschedule Method
e Reschedule Value

Note the following for lease variable rate calculation:

e The index rate changes are bound by ‘Rate Cap & Adjustments’ and ‘Payment Caps’
which are defined at Setup > Contract level.

e If the change payment is greater than ‘Max Pmt Inc/ Life’, system does not post ‘Rate
Change’ and ‘Term Change’ transactions and displays an error indicating ‘Rate Change
not allowed, as new payment amount exceeds max increase life’ to avoid impact on
residual value usage.
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During the Product setup, you can define and control the changes in loan payment amount
using 'Reschedule Method' and 'Reschedule Value' fields.

Products (3¢] Close
Loan e Lease E
Loan Product P 2 # Edt : 7 Aydit
View v Format v | reeze ] Detach v B NewProduc
4 @ ®
Product Description Start Dt End Dt Direct Flexible Repayment
12/31/4000 1/ N

« ] »

Loan Product
[ saveandadd | [ saveandstay | [ saveandRetum | {aRetumn

ry STANDARD =

Product Itemizations  Rate Adjustments

e When Reschedule Method is selected as 'UNDEFINED', no payment changes are
allowed.

e When Reschedule Method is selected as 'CHANGE PAYMENT', and Reschedule Value
is specified as '0', loan payment amount changes every time depending on the variable
rate.

e When Reschedule Method is selected as 'CHANGE PAYMENT', and Reschedule Value
is specified in percentage (i.e. 5%, 10%) loan payment amount changes only when the
variable rate increases upto the defined percentage. (For example, if change
percentage is specified as 10%, loan payment amount changes only if the variable rate
increases by 10%. Else, no change is allowed.)

Hence the impact of variable rates on loan payment amount can be controlled to stop negative
amortization.

'Rate Adjustments' for Variable Rate Loans

Every loan contract can have different limits on interest rate change as indicated below:

e Allowed amount for each minimum and maximum interest rate change

e Number of minimum and maximum interest rate changes allowed within a year and life
of the account

Note

These limits are enforced when processing the interest rate change on the loan.

OFSLL supports such Adjustable-Rate Mortgages (ARM) by defining them accordingly in the
'Rate Adjustment' tab of Product setup screen.

In the 'Rate Adjustment' tab (Setup > Products screen > 'Rate Adjustment' tab), multiple
records can be created depending on the limits defined for each ARM's.

For example:

e For a particular ARM if interest rate change is allowed only once in a year, then a
corresponding record in Rate Adjustments tab can created with following field details:
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— Adjustment Frequency 'RATE CHANGE OCCURS EVERY X YEARS', Period '1',
and # of Adjustment '1".

e For a particular ARM if interest rate change is allowed only once in 5 years during life of
aloan, then a corresponding record in Rate Adjustments tab can created with following
field details:

— Adjustment Frequency 'RATE CHANGE OCCURS EVERY X YEARS', Period '5',
and # of Adjustment '1".

e Similarly, foran ARM if desired number of interest rate changes are to be allowed during
first 10 years of a loan, the record in Rate Adjustments tab can have the following field
details:

— Adjustment Frequency 'RATE CHANGE OCCURS EVERY X YEARS', Period '10',
and # of Adjustment 'any value upto 999'.

B.2 Fixed Interest Rate Loans

Fixed interest rate loan is one in which the rate of interest remains fixed from funding till the
loan’s entire term. Hence, the loan payment amount does not change with fluctuations in
index rate or market rates.

In Oracle Financial Services Lending and Leasing, fixed interest rate loans can be defined in
the following way:

e Create a 'FLAT RATE' Index Type record in Index Rates screen (Setup > Products >
Index Rates) with Rate=0.00

Index Rates x [] Close
Index gpadd | ZEdt | S view || o Audt
View v Format v B Freeze i Detach Wrap [Eh)
Index Type short Description Description Enabled
FRIME RATE PRIME RATE PRIME RATE ¥
FLAT RATE FLATRATE FLAT RATE ¥
Index Details dpadd | ZEdt | [FYew || o Audt
View v Formatv [y Freeze i Detach Wrap [eh)
StartDt Rate Enabled
05/12/1994 0.0000 ¥

e Select this Index Type record during Origination/Servicing for Fixed Rate loans.

Since the index rate is always zero for this Index Type, the loan interest rate will always be
the Margin rate (i.e. contract rate) which does not change during life of the loan.
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Appendix C:Webhooks

Introduction

The Webhook option in OFSLL extends the support of interfacing with third-party applications
by sending REST API based natifications of changes through system generated Webhook
event actions.

In the Webhook integrated model, it is the server to client direction of conversation in which
the server pushes data to the client that hosts an HTTP based APl endpoint. OFSLL uses the
existing weblogic key-store to register third-party application credentials such as User Name,
Password and SSL/TSL Certificate.

Webhook Architecture
OFsLL OFSLL
REST API Third-party
Applications
Webhooks
Adapter
-~

- Webhook Third-party

ul Applications
OFSLL USER

As per the above image:

A change in the base system can either be triggered by an user performed action or
through REST API call.

The ‘Events’ refer to system generated information indicating the change in system
which is to be propagated to third-party applications that are interfaced with OFSLL. For
more information on configuring events in the system, refer to Events section.

The ‘Webhook UI’ is the Webhook setup screen in which Webhook definitions (channel)
and Event Details are defined by registering third-party applications that are interested
in OFSLL events. For more information on configuring Webhook in the system, refer to
Webhook section.

The ‘Webhook Adapter’ is Webhook MDB (Message Driven Bean) and is used to
propagate OFSLL messages to thrid-party applications.
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C.3 Webhook Workflow
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As per the above workflow:

On defining WEBHOOK, a WEBHOOK action is added to Events framework.
Based on the Event definition defined in setup, system triggers Events.

For all Events with WEBHOOK as the associated action, AQ JMS message is generated
and the same is consumed by WEBHOOK MDB adapter. If there is one Event
subscribed to 5 channels then system places 5 WEBHOOK messages into MDB.

WEBHOOK MDB read the channel configuration detail from both Database and
WebLogic CSF to propagate JSON message.

Based on the outcome of call to the third-party application, system updates the STATUS
and HTTP response code for the message.

A retry batch job picks the failed messages and then resubmit into AQ. The number of
retries is based on System Parameter which cannot exceed more than 5.

Webhook Message Format

Webhook Events are published in json message format. This message content can be
customized using Response User Defined Tables. For more information on json message
format, refer to Events section.

Processing Webhook Request

When an event is triggered in OFSLL, system checks if there are any Webhook actions
defined for different channels.

If there are multiple registries available, OFSLL creates multiple WEBHOOK messages
to propagate event details to the third-party applications.

WEBHOOK MDB reads the messages and generates response based on User Defined
Table available for individual Events.
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When response data is generated, system generates POST request to third-party
applications and marks these requests as COMPLETED on successful notification.

If the third-party notification is failed, OFSLL updates the message as FAILED.

On receiving the notifications, OFSLL expects third-party application’s POST service to
return one of the following HTTP status code:

HTTP Status Code | MDB Dashboard Status | Description

2XX, 3XX COMPLETED

4XX FAILED Need to resubmit manually.
MDB will update retry count to 5

5XX FAILED Will be resubmitted by batch job

The system parameter EVI_MAX_RETRY_COUNT records and controls the maximum
attempts to re-trigger FAILED Webhook requests which cannot exceed more than 5
times. However, this parameter can be modified if the maximum re-trigger attempts is
to be less than 5 times.

The batch job EVEPRC_BJ_100_02 in SET-EVE batch job set picks the FAILED status
messages for re-trigger and considers the above system parameter to control the
maximum attempts to re-trigger.

The system parameter CMN_HTTP_CONNECTION_TIMEOUT determines the
maximum allowed response time (in seconds) from the third-party application. If
response time exceeds than the system parameter configured value, then the status of
request is updated as FAILED with 500 HTTP Status Code.

If the system is running behind a firewall/proxy network, OFSLL provides below system
parameters to configure proxy details.

System Parameter Description

CMN_HTTP_PROXY_ENABLED_| | PROXY INDICATOR FOR ALL OUTSIDE
ND HTTP/HTTPS CONNECTION

CMN_HTTP_PROXY_PORT HTTP PROXY SERVER PORT FOR
OUTGOING HTTP CONNECTIONS

CMN_HTTP_PROXY_SERVER HTTP PROXY SERVER FOR OUTGOING
HTTP CONNECTIONS
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Appendix D:Configuration at Company Level

Introduction

OFSLL supports defining multiple Portfolio Companies in an Organization and facilitates to
configure these Portfolio Companies to operate in different time zones. The nightly batch jobs
for processing can also be configured to run as per the operating hours of the Portfolio
Companies.

Using this, system can be configured in Setup to either process at Organization level or at
Company level. To process at Organization level, no specific change is required since itis the
default setup.

The below details in this section is intended to give an overview of the changes required to
setup the system to process at Company level.

Existing Configuration

In the default setup, there is no definition of GL date at company level and this implies that
organization can define the independent companies to which accounts belongs. But the EOD
scheduling and job run happens at organization level and ‘not’ at each company level. Also
the GL date is defined at 'System Parameters' Level.

o Batch Jobs
Organization Holiday Setup
I Company 1 | Company 2 | COT:,?W

Confiquration at Company Level

Schedule EOD

In the configuration at Company level (not Branch level), the following options are supported:

e To configure only one EOD schedule for one or all companies - Configure batch jobs at
ALL level with or without having multiple company definitions. If OFSLL is upgraded
from earlier to current release version, this helps to continue with existing ALL company
level scheduling of batch job run.

e To configure EOD for each company independently - Define GL date at each Company
level to schedule and run batch jobs at each company level. The scheduler changes the
GL date of specific company, after successful completion of batch job run.

However in this setup, note that:

e Itis advised to 'Enable’ flag at ALL GL date level, but disable batch jobs at ALL level so
that scheduler does the rollover of date but does not pick-up batch jobs for EOD run.

e After EOD run, system rollovers the GL date or ALL company entry, after completion of
run of other specific company GL date rollover.

e Ensure the Company parameter ‘System Under Maintenance' is also setto Y for
corresponding company during EOD run of same company.

e Company Start of Business Time can be configured at company level. If the parameter
value is set to '0500', it implies that scheduler rollovers the GL date based on this time.
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D.4

System refers the 'Company Time Zone' (new field at company definition page) to
identify the time zone in company parameter.

Organization

Company 1 Company 2 Company “n”

Batch Jobs Batch Jobs Batch Jobs

Holiday Setup Holiday Setup
Schedule EOD Schedule EOD

Holiday Setup
Schedule EOD

Setup Company Definition

In this setup, define the company and company parameters.

1.

Define Company and date format

— Define the company in 'Companies Definition' screen and ensure to maintain
'‘Company Time Zone'.

— Define company code with 'Alphanumeric' characters only.

— Ensure to define the 'Display Format' organization Definition ' Division Definition '
Display Formats.

Note

Fixed simple date format definition is one time setup for each company and Admin user is
not expected to change it again in life time. Currently it is allowed to select only MM/DD/
YYYY format.

2. Define the following company parameters:

The default shipped seed data of Company level GL date is set to All.

— GL POST DATE - COMPANY IN MM/DD/YYYY FORMAT (UPDATED BY
SCHEDULER IF ENABLED)

— CMN_SYSTEM_UNDER_MAINTENANCE - SYSTEM UNDER MAINTENANCE

— JSC_START_OF BUSINESS_TIME (COMPANY START OF BUSINESS TIME
(24HR FORMAT)

—  PTX_TXN_LAST_PURGE_DT - LAST PURGE DATE OF TXNS
— PUP_TUP_LAST_PURGE_DT - LAST PURGE DATE OF TXNS UPLOAD

Example: The following is an illustration on how 3 companies are defined with 3 different time
Zones in USA, UK and Australia.

Parameter USA UK AUS

GL Post Date 31 Dec 2019 | 02 Jan 2020 | 02 Jan 2020
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D.4.2

D.5

Parameter USA UK AUS
CMN_SYSTEM_UNDER_MAINTENANCE | Y N N
JSC_START_OF_BUSINESS_TIME 0500 0500 0500
PTX_TXN_LAST_PURGE_DT 01/01/2019 | 01/01/2019 01/01/2019
PUP_TUP_LAST_PURGE_DT 01/01/2019 | 01/01/2019 01/01/2019

Holiday Setup and Processing

The holiday defined in setup is processed as indicated below:

Scheduler picks up the jobs for EOD run based on 'Next Date and time' set at each batch
job level.

After successful completion of job run for the individual company, system rollovers the
date for respective company.

Once the EOD run and date rollover is completed for individual company, system
verifies the 'Enabled' indicator for 'All' company. If none of batch jobs are enabled -
rollovers the ALL GL date.

If ‘01 Jan 2020’ is recorded as holiday in setup, scheduler will/will not execute the batch
jobs based on the Batch job holiday maintenance and subsequently rollovers the next
date to 02 Jan 2020, at proper start of business time for the company.

Batch Jobs Processing

The default shipped seed data of Batch Jobs is set to All. Define the company and copy the
batch jobs. Note that the ‘Copy’ option copies all the batch jobs at one go.

Setup Multiple Companies in Same/Different Time

Zone

Define company level time zone using the field ‘Company Time Zone at Companies
Definition screen.

This parameter is used to consider the Company level and Start of Business Time. The
same can be configured to the same time zone or different time zone for scheduler to
process EOD / BOD.

Company wise file upload facility is supported as follows:
As part of creating company, following are automated:

— Directory objects in db is created

— System parameter is created for directories

— External table is created for selected uploads - collateral and txn upload
automatically

— Physical directories are not created
— Directory permissions is to be defined manual

If Company specific file upload jobs are used, the file upload process happens from
company specific folders.
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D.6.1

D.6.2

D.6.3

D.6.4

D.6.5

Setup for New Company Added Subsequently

For New Company Added Subsequently (not on Day zero), follow the same steps to be
followed on Day zero setup. Raise SR to execute script of directory creation of new company
for file upload.

Impact on Defining Configuration at Company Level

System displays the following details at each configured Company level.

Company Level Configuration Settings

Company level LOV selection is available at following screens to configure:
e System Monitor > Batch Jobs
e System Monitor > Jobs > Batch
e System Monitor > Jobs > Background
e System Monitor > Jobs > Credit Request
e System Monitor > JMS Queues > Messages
e System Monitor > Events
e Data Files > Input folder

Scheduler
Once the batch jobs are completed for that specific company, scheduler picks-up the

company specific scheduled batch jobs and updates the GL Post Date of that specific
company.

Note

— No two companies should be configured to run jobs by scheduler at the same time.

— Ensure to setup the Parent and child batch jobs with marginal difference in time set-
up to get picked-up by the scheduler.

Debug Logs

e Batch level Debug logs are maintained at system parameter level and allowed to enable
/ disable debug batch job logging at system parameter level only.

e System allows to enable batch job level debug jobs by enabling in User Defined Table.
e The debug log file generated is appended with 'Company Name'.

e The date format in debug logs is MM/DD/YYYY - standard format only, irrespective of
logs generated for any company.

Setup Screens

All setup screens refers to system date for validation. Example: Start and End Date.

File Uploads

If only ALL Company Definition is used, the file upload process continues to use the existing
folder and infrastructure.

e As part of creating company, following are automated:
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D.6.8

D.6.9

— Directory objects in db is created
— System parameter is created for directories

— External table is created for selected uploads - collateral and txn upload
automatically

— Physical directories are not created
— Directory permissions is to be defined manual

e If Company specific file upload jobs are used, the file upload process happens from
company specific folders.

Input File

e Changes are accepted in same file structure and input file has to be placed under input/
directory/company specific folder.

e In case certain file does not have company definition like 'Asset Upload', the same can
be placed in any company folder to process and upload records.

e Some input files are not programmed to refer Data Files > Input file definitions and
hence any date in the file will follow MM/DD/YYYY format. For example, Call activity
posting, promise date are to be given in the same format.

e Some input files are programmed to refer Data Files > Input file definitions and hence
system expects the date in the file as defined as date format in definition.

Output File

Output file name is appended with ‘Company Name’ and is generated in one folder.

Note

A script ‘crt_company_directories.sh’ is provided with installer in the path
‘core_db\ofslldb.zip\dba_utils\' to create directories and to create folders for each defined
Company. The same is to be run during installation. Also, the CLOB indicator is retained
at system parameter level.

Transactions

e Monetary transaction refers to the company specific GL date.
e Non-Monetary transactions refers to system date.

e Transactions data in the account continues to show the dates with reference to 'Fixed
simple date format' maintained at company level.

Web Services

e GL date of service refers to company level GL date.

e 'Company'has to be passed for certain web services to take reference of corresponding
company GL date.

Letters, Correspondence

o Letters are generated based on company level batch job run.

e Date format in letter is not controlled by company level display format and refers to the
letter template.

Reports

e Changes are done to report template and reports are generated with ‘Company Name’
appended to file and generated data for specific company, where the job is run.
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e Date format in report is not controlled by company level display format and refers to the
report template.

Credit Bureau & Metro Il

e Bureau pull does not have any impact to handle because user has to select the specific
company and then bureau triggers the pull from UL.

e Metro Il - No impact. System generates file for all companies; but based on product level
flag and with configured setup.

GL

Current GL Setup (Attributes, Translations and Transaction Links and so on) is at Company
level and hence there is no impact.

ODD1, ODD2, ODD3

If job is run at company level,

e ODD1 (Producer ACH, Adverse Action letters, Adverse Action Condition Letter file) job
generates the data at company level.

e ODD2 (Account ACH, Vendor ACH, Statement, Letter File and so on) job generates the
data at company level.

e ODDa3 job generates the data at company level.

Migration

For all screens where company has been added, the default value ALL is provided and user
is expected to enable this in seed data screen.

Conversion

No specific impact since API tables have definition of company. User can upload the
conversion files based on company.

Archive

Parameter to specify the archive days are defined at system level but user can run the Archive
batch jobs at each company level and the same archives data for that specific company.

Purge

Parameter to specify the purge days and following parameters are moved to company level.

e PTX_TXN_LAST_PURGE_DT - LAST PURGE DATE OF TXNS
e PUP_TUP_LAST_PURGE_DT - LAST PURGE DATE OF TXNS UPLOAD

Standard Payees

e User would be able to define payee bank account for each company / branch
combination.

e AP Requisition batch job generates the requisition considering the account number
defined at company level.

Data Masking

Not handled and hence data masking can be configured at organization level only.
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WFP Module

Not handled.

Batch Jobs and File uploads

For list of batch jobs and File uploads handled to run at company level, refer to product

release notes.

Assumptions

System considers the criteria defined for company in Queues > Criteria Based Condition
screen and ignores the branch level differentiation across application. Hence, even if user
defines multiple records (as indicated below), system considers the combination as same and

executes records are company level.

Company = AUS and Branch = ALL

Company = AUS and Branch = Sydney

ORACLE’
Financial Services Lending and Leasing

# Welcome ABSHEKAR ¥ o

Queues

Criteria Definition

View~ Formatv B Freeze [ Detach Wrap
Name Description
ANKS_LINKED_CRITERIA ANKS_LINKED_CRITERIA
ANKS_02 LINKED_02
TSTOL TST_UDF
DSDS SDSDS
TEST_MAC_CONDITION 'CONDITION BASED ON COMPANY
TEST15 TEST
TST_02 TST USER DEFINED FIELDS
TESTI TEST_I

Criteria Definition

Name ANKS_LINKED_CRITERIA
* Description ANKS_LINKED_CRITERIA
Start Dt 06/01/2019 &

Criteria Details  Conditions

Criteria
Viewv Formatv [ Freeze [ Detach Wrap @
Seq ( Parameter
[ ACCOUNT LINKED ACCOUNT NUMBER
1 PRODUCT CODE

WM CheckCriteria

Origination ~ Criteria Based Condition  Customer Service Call Action Results ~ Activity Tracking  User Groups

Start Dt

06/01/2019
06/01/2019
12/01/2018

01/01/2019
09/01/2019
12/03/2018
01/01/2000

End Dt 12/31/2020

* Company IND

*

Branch INDB

End Dt

12/31/2020
06/30/2020
06/30/2020

01/01/2020
10/27/2019
07/28/2020
01/01/2020

Comparison
Operator
EQUAL
LIKE

Criteria Value

*Seq 0
* Enabled
4 Add | 7 Edit View Audit
Logical
) Oporator  Enbled
20190500011841 [ Y
Y

3 Close
4 Add |/ Edit View ¥ Audit
Seq Company Branch Enabled
0D INDB. N ~
oA AL N
oA AL N
0ALL ALL N
0 AUSO1 AL v
oA AL N
1AL AL Y
1AL ALL N v

[ saveand Stay | [ Save and Retum | {3 Return
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